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    Preface

    IBM® Cognos® Business Intelligence (BI) helps organizations meet strategic objectives and provides real value for the business by delivering the information everyone needs while also reducing the burden on IT. 

    This IBM Redbooks® publication addresses IBM Cognos Business Intelligence V10.1. You can use this book to:

    •Understand core features of IBM Cognos BI V10.1

    •Realize the full potential of IBM Cognos BI

    •Learn by example with practical scenarios

    This book uses a fictional business scenario to demonstrate the power of IBM Cognos BI. The book is primarily focused on the roles of Advanced Business User, Professional Report Author, Modeler, Administrator, and IT Architect.

    The team who wrote this book

    This book was produced by a team of specialists from around the world working in Ottawa, Canada, and remotely.

    Dean Browne is a Product Manager for IBM Software, Business Analytics in Philadelphia, Pennsylvania, U.S. As part of the IBM Business Analytics, Cognos Software team, Dean is responsible for IT value related features in IBM Cognos products. Before joining IBM Software Group 7 years ago, Dean worked as an IT infrastructure design and out-sourcing consultant. He designed global telecommunications and server infrastructures, standards, and out-sourced support processes for global chemical and pharmaceutical corporations.

    Brecht Desmeijter is a Proven Practice Advisor in Bedfont, U.K. He has 4 years of experience in the IBM Cognos Business Intelligence field. He holds a degree in Computer Science from Hogeschool Gent, Belgium. His areas of expertise include the IBM Cognos infrastructure and the Software Development Kit.

    Rodrigo Frealdo Dumont is an IT Specialist at the IBM Brazil Global Delivery Center. He has four years of experience in Business Analytics applications, including reporting, data integration and data modeling. Currently he acts as a Cognos development lead of Business Analytics projects at the Business Analytics Center of Competency. He writes extensively about Cognos business solutions development life cycle and Business Analytics requirements. He also acts as a technical lead and subject matter expert of IBM Cognos for the Information and Data Management Center of Competence of Application Services area in Brazil. Rodrigo is an IBM Certified Designer for Cognos 8 BI Reports and IBM Certified Developer for Cognos 8 BI Metadata Models. Rodrigo holds a bachelor degree in Systems Analysis from Pontifícia Universidade Católica of Campinas. 

    Armin Kamal is an IBM Cognos Proven Practice Advisor for Business Analytics in Canada. He has 9 years of experience working with IBM Cognos products with a focus on metadata modeling and report design. He holds a degree in Communications and Psychology from The University of Ottawa and a diploma in Information Technology from ITI. His areas of expertise include course development, technical writing, consulting, and customer support. He has written extensively on IBM Cognos Framework Manager and IBM Cognos Report Studio.

    John Leahy is a Proven Practice Team Leader with the IBM Cognos Business Analytics iApps Team. He writes extensively about IBM Cognos Financial Performance Management products and has over 9 years experience working with IBM Cognos products in various roles. John is an IBM Cognos Planning Certified Expert and an IBM Cognos TM1® Certified Developer. John holds a bachelor’s degree in Business and Economics from Ursinus College.

    Scott Masson is an IBM Cognos Senior Product Manager, working in Ottawa, Canada. With over 11 years in business intelligence and information management, he has focused on the technology and infrastructure organizations need to drive better business performance. Author of the IBM Cognos System Management Methodology, he writes extensively around IBM Cognos products and how to optimize the administration of the Business Intelligence infrastructure.

    Ksenija Rusak is a Client Technical Professional in IBM Croatia. She is a member of the Community of Practice for Central and Eastern Europe responsible for the Cognos portfolio, working with local technical communities in providing technical sales support for major prospects and customers. She holds a degree in mathematical statistics and computer science. She has 9 years of IT experience, including technical sales, implementation of business intelligence solutions, end-user education and large-scale projects. Her areas of expertise include the IBM Cognos portfolio, reporting tools such as Microsoft® Reporting Services and Crystal Reports and data warehousing implementations (Microsoft SQL Server DTS, IBM InfoSphere™ Warehouse).

    Shinsuke Yamamoto is an IT Specialist joining IBM Japan in 2001. He implemented various IBM products, including AIX®, DB2®, WebSphere®, and Tivoli®. In 2007, he moved to IBM Systems Engineering in Japan and has experience in handling DB2 projects as a subject matter expert and publishing technical guides about DB2. He is currently the leader of the Cognos support team, focusing on Cognos architecture, design and administration.

    Martin Keen is a Consulting IT Specialist at the ITSO, Raleigh Center. He writes extensively about WebSphere products and service-oriented architecture (SOA). He also teaches IBM classes worldwide about WebSphere, SOA, and ESB. Before joining the ITSO, Martin worked in the EMEA WebSphere Lab Services team in Hursley, U.K. Martin holds a bachelor’s degree in Computer Studies from Southampton Institute of Higher Education.
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    Figure 1   Ottawa team (left-to-right): Dean, Ksenija, Scott, Shinsuke, Rodrigo, Martin, and Armin
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    Now you can become a published author, too!

    Here’s an opportunity to spotlight your skills, grow your career, and become a published author—all at the same time! Join an ITSO residency project and help write a book in your area of expertise, while honing your experience using leading-edge technologies. Your efforts will help to increase product acceptance and customer satisfaction, as you expand your network of technical contacts and relationships. Residencies run from two to six weeks in length, and you can participate either in person or as a remote resident working from your home base. 

    Find out more about the residency program, browse the residency index, and apply online at:

    ibm.com/redbooks/residencies.html

    Comments welcome

    Your comments are important to us!

    We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks publications in one of the following ways:

    •Use the online Contact us review Redbooks form found at:

    ibm.com/redbooks

    •Send your comments in an email to:

    redbooks@us.ibm.com

    •Mail your comments to:

    IBM Corporation, International Technical Support Organization
Dept. HYTD Mail Station P099
2455 South Road
Poughkeepsie, NY 12601-5400

    Stay connected to IBM Redbooks

    •Find us on Facebook:

    http://www.facebook.com/IBMRedbooks

    •Follow us on Twitter:

    http://twitter.com/ibmredbooks

    •Look for us on LinkedIn:

    http://www.linkedin.com/groups?home=&gid=2130806

    •Explore new Redbooks publications, residencies, and workshops with the IBM Redbooks weekly newsletter:

    https://www.redbooks.ibm.com/Redbooks.nsf/subscribe?OpenForm

    •Stay current on recent Redbooks publications with RSS Feeds:

    http://www.redbooks.ibm.com/rss.html

  
[image: ]
[image: ]

IBM Business Analytics

  
[image: ]
[image: ]

Introduction to IBM Cognos Business Intelligence

    Organizations are pressured constantly to understand and react quickly to information. With a capable and efficient business intelligence solution, all levels of an organization can receive information how, when, and where they need it to make faster and better aligned decisions. 

    Many organizations often satisfy this complexity and these diverse demands with a number of point solutions. With IBM Cognos Business Intelligence (BI) solutions, you can satisfy needs throughout the user community and ensure that everyone can work and collaborate from a consistent set of data. In addition, IT is simplified with fewer components to deploy, manage, and maintain.

    In this chapter, we introduce IBM Business Analytics and IBM Cognos BI and discuss the following topics:

    •IBM Business Analytics

    •Introduction to IBM Cognos BI

    1.1  IBM Business Analytics

    IBM Business Analytics includes the following products:

    •IBM Cognos BI

    •IBM Financial Performance and Strategy Management

     –	IBM Cognos TM1

     –	IBM Cognos Planning

     –	IBM Cognos Controller

     –	IBM Cognos Business ViewPoint

    •IBM Analytics Applications

    •IBM Advanced Analytics (SPSS)

    •IBM Cognos Express

    1.2  Introduction to IBM Cognos BI

    IBM Cognos BI provides a unified workspace for business intelligence and analytics that the entire organization can use to answer key business questions and outperform the competition. With IBM Cognos BI, users can: 

    •Easily view, assemble and personalize information

    •Explore all types of information from all angles to assess the current business situation

    •Analyze facts and anticipate tactical and strategic implications by simply shifting from viewing to more advanced, predictive or what-if analysis

    •Collaborate to establish decision networks to share insights and drive toward a collective intelligence

    •Provide transparency and accountability to drive alignment and consensus

    •Communicate and coordinate tasks to engage the right people at the right time

    •Access information and take action anywhere, taking advantage of mobile devices and real-time analytics

    •Integrate and link analytics in everyday work to business workflow and process

    Organizations need to make the most of a workforce that is increasingly driven to multi-task, network and collaborate. IBM Cognos BI delivers analytics everyone can use to answer key business questions.

    1.2.1  Easily view, assemble, and personalize information

    Often, business users do not know how to get to the information that they need, and available tools might not provide the freedom to combine and explore information in the way they want. IBM Cognos BI features allow business users to easily view, assemble, and personalize information to follow a train of thought and to generate a unique perspective. 

    Using a single place to quickly see a view of their business, users can personalize content, build on the insights of others, and incorporate data from a variety of sources. These capabilities ensure that more people are engaged in providing unique insights and delivering faster business decisions. Giving business users greater self-service control reduces demands on IT and business intelligence systems.

    1.2.2  Explore all types of information

    If a separate tool is required, it is difficult to incorporate statistical results with core business reporting. IBM Cognos BI allows business users to consume fact-based statistical evidence to support key decisions directly in the IBM Cognos BI environment. The ability to explore all types of information from all angles to assess the current business situation provides a deeper understanding of the patterns that exist in data. These functions allow business users to deliver reports that include statistical insight and validation and to distribute these reports to the larger business community.

    1.2.3  Analyze facts and anticipate tactical and strategic implications

    Business users need tools that let them accurately evaluate and identify the impact that different scenarios will have on the business and on the bottom line. IBM Cognos BI allows the business user to analyze facts and anticipate strategic implications by simply shifting from viewing data to performing more advanced predictive or what-if analysis. Understanding the scenarios that affect business enables the business user to make informed recommendations to the business and provides an increased competitive advantage.

    1.2.4  IBM Cognos BI user interfaces

    IBM Cognos BI includes web-based and Windows®-based user interfaces that provide a business intelligence experience that is focused upon the needs of different users.

    IBM Cognos Business Insight

    With IBM Cognos Business Insight, you can create sophisticated interactive dashboards using IBM Cognos content, as well as external data sources such as TM1 Websheets and CubeViews, according to your specific information needs. You can view and open favorite dashboards and reports, manipulate the content in the dashboards, and email your dashboards. You can also use comments and activities for collaborative decision making and use social software such as IBM Lotus® Connections for collaborative decision making.

    For more information about using IBM Cognos Business Insight, see the IBM Cognos Business Insight User Guide.

    IBM Cognos Report Studio

    IBM Cognos Report Studio is a robust report design and authoring tool. Using IBM Cognos Report Studio, report authors can create, edit, and distribute a wide range of professional reports. They can also define corporate-standard report templates for use in IBM Cognos Query Studio and edit and modify reports created in IBM Cognos Query Studio or IBM Cognos Analysis Studio.

    This book does not cover use of IBM Cognos Report Studio, given the depth of features that IBM Cognos Report Studio provides. For information about using IBM Cognos Report Studio, refer to IBM Cognos Report Studio User Guide or the online Quick Tour.

    IBM Cognos Query Studio

    Using IBM Cognos Query Studio, users with little or no training can quickly design, create, and save reports to meet reporting needs that are not covered by the standard, professional reports created in IBM Cognos Report Studio.

    For information about using IBM Cognos Query Studio, see the IBM Cognos Query Studio User Guide or the online Quick Tour.

    IBM Cognos Analysis Studio

    With IBM Cognos Analysis Studio, users can explore and analyze data from different dimensions of their business. Users can also compare data to spot trends or anomalies in performance. IBM Cognos Analysis Studio provides access to dimensional, online analytical processing (OLAP), and dimensionally modeled relational data sources. Analyses created in IBM Cognos Analysis Studio can be opened in IBM Cognos Report Studio and used to build professional reports.

    For information about using IBM Cognos Analysis Studio, see the IBM Cognos Analysis Studio User Guide or the online Quick Tour.

    IBM Cognos Event Studio

    In IBM Cognos Event Studio, you set up agents to monitor your data and perform tasks when business events or exceptional conditions occur in your data. When an event occurs, people are alerted to take action. Agents can publish details to the portal, deliver alerts by email, run and distribute reports based on events, and monitor the status of events. For example, a support call from a key customer or the cancellation of a large order might trigger an event, sending an email to the appropriate people.

    For information about using IBM Cognos Event Studio, see the IBM Cognos Event Studio User Guide or the online Quick Tour.

    IBM Cognos Metric Studio

    In IBM Cognos Metric Studio, you can create and deliver a customized score carding environment for monitoring and analyzing metrics throughout your organization. Users can monitor, analyze, and report on time-critical information by using scorecards based on cross-functional metrics.

    For information about using IBM Cognos Metric Studio, see the IBM Cognos Metric Studio User Guide for Authors.

    IBM Cognos Administration

    IBM Cognos Administration is a central management interface that contains the administrative tasks for IBM Cognos BI. It provides easy access to the overall management of the IBM Cognos environment and is accessible through IBM Cognos Connection.

    For information about using IBM Cognos Administration, see the IBM Cognos Administration and Security Guide.

    IBM Cognos Framework Manager

    IBM Cognos Framework Manager is the IBM Cognos BI modeling tool for creating and managing business related metadata for use in IBM Cognos BI analysis and reporting. Metadata is published for use by reporting tools as a package, providing a single, integrated business view of any number of heterogeneous data sources.

    OLAP cubes are designed to contain sufficient metadata for business intelligence reporting and analysis. Because cube metadata can change as a cube is developed, IBM Cognos Framework Manager models the minimum amount of information needed to connect to a cube. Cube dimensions, hierarchies, and levels are loaded at run time.

    For information about using IBM Cognos Framework Manager, see the IBM Cognos Framework Manager User Guide.
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Overview of the IBM Cognos Business
Intelligence architecture

    In this chapter, we introduce the IBM Cognos Business Intelligence (BI) architecture and the IBM Cognos Platform. We discuss the various components that make up an IBM Cognos Platform deployment for business intelligence applications and how you can deploy them to meet application requirements.

    We discuss the following topics:

    •Enterprise class SOA platform architecture

    •Open access to all data sources

    •Business intelligence for all

    •Common integrated security model

    2.1  Enterprise class SOA platform architecture

    IBM Cognos BI delivers a broad range of business intelligence capabilities on an open, enterprise-class platform. All capabilities—including viewing, creating and administering dashboards, reports, analysis, scorecards, and events—are accessed through web interfaces. 

    The IBM Cognos Platform delivers the capabilities to manage business intelligence applications with centralized, web-based administration that provides a complete view of system activity as well as system metrics and thresholds so that organizations can resolve potential issues before there is a business impact. The IBM Cognos Platform is built on a web-based service-oriented-architecture (SOA) that is designed for scalability, availability, and openness. This n-tiered architecture is made up of three server tiers: 

    •The web tier

    •The application tier

    •The data tier

    The tiers are based on business function and can be separated by network firewalls.

    Reliability and scalability were key considerations when designing the IBM Cognos Platform. Services in the application tier operate on a peer-to-peer basis, which means that no service is more important and that there are loose service linkages. Any service of the same type, on any machine in an IBM Cognos Platform configuration, can satisfy an incoming request, which results in complete fault tolerance. The dispatching (or routing) of requests is done in an optimal way, with automatic load balancing built into the system. 

    The IBM Cognos Platform provides optimized access to all data sources, including relational data sources and online analytical processing (OLAP), with a single query service. In addition, this query service understands and takes advantage of the data source strength by using a combination of open standards such as SQL99, native SQL, and native MDX to optimize data retrieval for all these different data providers. The IBM Cognos BI user interfaces are accessed through the web tier. 

    Figure 2-1 illustrates a typical tiered deployment of the IBM Cognos Platform.
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    Figure 2-1   Typical distributed topology for the IBM Cognos Platform 

    2.1.1  IBM Cognos Platform server roles

    To ensure optimal performance, IBM Cognos Platform services are normally grouped together to fulfill certain roles within a distributed deployment for business intelligence applications. These server roles also define the tier within the architecture that an IBM Cognos BI server uses.

    Web tier: The IBM Cognos Gateway

    The web tier provides user session connectivity to IBM Cognos BI applications. The IBM Cognos components that fulfill this role are referred to as the IBM Cognos Gateway.

    The IBM Cognos Gateway component manages all web communication for the IBM Cognos Platform. The workload on the IBM Cognos Gateway server requires minimal processing resources. For high availability or scalability requirements, you can deploy multiple redundant gateways along with an external HTTP load-balancing router. 

    Application tier: Server components

    The application tier for the IBM Cognos Platform is made up of three main server components:

    •IBM Cognos Dispatcher

    •IBM Cognos Report Server

    •IBM Cognos Content Manager

    Application tier servers are composed of a collection of loosely-coupled Java™ and C++ services. 

    IBM Cognos Dispatcher 

    IBM Cognos Dispatcher performs the load balancing of requests at the application tier. The IBM Cognos Dispatcher component is a lightweight Java servlet that manages (and provides communication between) application services. At startup, each IBM Cognos Dispatcher registers locally available services with the IBM Cognos Content Manager. During the normal operation of IBM Cognos BI services, requests are load balanced across all available services using a configurable, weighted round-robin algorithm to distribute requests. You can tune the performance of IBM Cognos Platform by defining how IBM Cognos Dispatcher handles requests and manages services. 

     

    
      
        	
          IBM Cognos configuration: A normal configuration for IBM Cognos Dispatcher is two IBM Cognos Report Server processes (see “IBM Cognos Report Server” on page 13) per allocated processor and eight to 10 threads per processor in one of the following configurations: 

          •Three low affinity threads plus one high affinity thread

          •Four low affinity threads plus one high affinity thread 

        
      

    

    Threads within IBM Cognos Platform are managed by the type of traffic that they handle, which is referred to as high and low affinity. Affinity relates to the report service process that handled the original user request when multiple interactions need to occur to satisfy the request. High-affinity connections are used to process absolute and high-affinity requests from the report services. Low-affinity connections are used to process low-affinity requests. A high affinity request is a transaction that can gain a performance benefit from a previously processed request by accessing cache. It can be processed on any service, but resource consumption is minimized if the request is routed back to the report service process that was used to execute the original process. A low affinity request operates just as efficiently on any service. 

    You can manage the number of threads per IBM Cognos BI reporting service process through the IBM Cognos Platform administration console by setting the number of high- and low-affinity connections. For more details, refer to the IBM Cognos BI Architecture and Deployment Guide 

    IBM Cognos Report Server 

    The main service that is responsible for application-tier processing is the report or query service (often referred to as the BIBus processes). IBM Cognos Dispatcher starts IBM Cognos Report Server processes dynamically as needed to handle the request load. An administrator can specify the maximum number of processes that these services can start, as well as the minimum number of processes that should be running at non-peak times. Configure the number of processes for IBM Cognos Report Server based on the available processor capacity. 

    In general, IBM Cognos BI reporting service performance is closely tied to processor clock speed and throughput capabilities. The number of processors in a server and their clock rates are the two primary factors to consider when planning for additional IBM Cognos Report Server hardware capacity. For example, you generally configure a server with four available processors to use more report service processes than a server with only two available processors. Similarly, given two servers with an equal number of processors, configure the server with a significantly faster processor clock rate to have more report and report-service processes. 

    When configuring the IBM Cognos Platform server environment, you must set a Java heap size. The IBM Cognos BI reporting and query service is made up of two underlying components: 

    •The Java servlet-based IBM Cognos Dispatcher services 

    •Report services that are launched using the Java Native Interface (JNI)

    Set the Java virtual machine (JVM) heap-size allocation for IBM Cognos Platform so that Java memory is only as large as is necessary to accommodate the processing requirements of the Java based services. This setting ensures that as much memory as possible is available to the IBM Cognos Report Service, which is not Java. You can determine the optimal Java heap size using Java garbage collection statistics. 

    IBM Cognos Content Manager 

    IBM Cognos Content Manager is the IBM Cognos Platform service that manages the storage of the following customer application data: 

    •Security settings and configurations

    •Server configuration settings

    •Packages

    •Dashboards

    •Metrics

    •Report specifications

    •Report output 

    You use IBM Cognos Content Manager to publish models, retrieve or store report specifications, handle scheduling information and manage the IBM Cognos security name space. IBM Cognos Content Manager maintains information in a relational database that is referred to as the content store database. 

    A minimum of one IBM Cognos Content Manager service is required for each IBM Cognos Platform implementation. Content Manager performance can benefit from the availability of high-speed RAM resources and typically requires one processor for every four processors that are allocated for IBM Cognos Report Server processing. 

    IBM Cognos BI data-source performance considerations

    Query performance is typically bound to the performance of the server that hosts the data source for IBM Cognos BI. IBM Cognos BI can access many data sources, including relational and OLAP sources. Relational data sources that are tuned to meet the access requirements of the business community naturally perform better than those that are not. An experienced database administrator should monitor and tune relational database-management systems (RDBMS) to achieve optimum database performance. 

    IBM Cognos BI deployment options 

    The first step to creating a proper IBM Cognos BI environment begins with a successful installation. Use the IBM Cognos BI Installation and Configuration Guide for complete information about the installation and initial configuration process. For detailed information about IBM Cognos Platform architecture and server deployment options, refer to the IBM Cognos BI Architecture and Deployment Guide. 

    Server components within all three tiers can scale easily, either horizontally or vertically, to meet a variety of business intelligence processing requirements. At the web tier, the IBM Cognos Gateway system requirements are lightweight and can, therefore, handle large user loads with fewer system resources than other server tiers in the IBM Cognos Platform architecture. You can also deploy multiple IBM Cognos Gateway instances to meet requirements for additional user load, server availability, or other service level agreements (SLAs). 

    At the application tier, both the IBM Cognos Report Server and IBM Cognos Content Manager components can scale to meet application-processing requirements. You can deploy multiple IBM Cognos Content Manager instances. One instance actively process requests while the other instances remain in standby mode to provide high availability. IBM Cognos Content Manager server hardware can also scale vertically to provide increased throughput. IBM Cognos Report Server performs the heavy lifting within an IBM Cognos BI server deployment. You can deploy multiple IBM Cognos Report Server instances to meet the processing requirements of large applications and user populations. 

    IBM Cognos Report Server performance is tied to overall system performance and, therefore, can be affected by processor clock speed and I/O performance. 

    General guidelines 

    In general, decisions regarding the best methods for deploying IBM Cognos BI are driven by application complexity, throughput requirements, user concurrency, and systems management requirements such as availability and security. Deployment options and recommendations include:

    •Use one server and operating system instance with a single or multiple IBM Cognos Platform instances, the IBM Cognos Report Server, and IBM Cognos Content Manager are implemented in one or more WebSphere Application Server profiles or JVM instances.

    •Configure one physical server or virtualization platform guest instance per IBM Cognos Platform application tier server instance.

    •Use separate servers for the RDBMS that is hosting the content store database, relational data sources, and OLAP data source.

    •Do not over-subscribe CPU resources with IBM Cognos BI implementations, for example using a configuration in which the total number of processors that are allocated among the virtual guest servers instances for the IBM Cognos Platform exceed the number of physical CPUs that are available on the physical server or LPAR, with the exception of IBM System z® deployments that have sufficient available resources.

    •Generally, use 2 GB RAM per CPU with IBM Cognos Content Manager and IBM Cognos Report Server instances. 

    •Use IBM Cognos Report Server with two BIBus processes per processor and five threads per process (four low affinity and one high affinity).

    2.1.2  IBM Cognos BI services

    This section introduces the various services offered by IBM Cognos BI.

    Agent service

    The agent service is responsible for running agents. This service runs the conditions and creates and stores the generated event list. The service determines which tasks to execute and forwards those tasks to the monitor service for execution.

    In addition to running agents, the agent service also runs two other types of specialized tasks: 

    •Stored procedures using IBM Cognos Report Server

    •Web service tasks

    Annotation service

    The annotation service enables the addition of commentary to reports using IBM Cognos Business Insight. These comments persist throughout different versions of the report.

    Batch report service

    The batch report service manages background requests to run reports and provides output on behalf of the monitor service.

    Content manager service

    The content manager service interacts with the content store. It performs object manipulation functions such as add, query, delete, update, move, and copy. It also handles the content store management functions, such as import and export.

    Content manager cache service

    The cache service enhances the overall system performance and IBM Cognos Content Manager scalability by caching frequent query results in each dispatcher.

    Data movement service

    The data movement service manages the execution of data movement tasks in Cognos BI. Data movement tasks, such as Builds and Job Streams, are created in the IBM Cognos Data Manager Designer and are published to IBM Cognos BI.

    Delivery service

    As the name implies, the delivery service delivers content. Email, news items, and report output that is written to the file system are examples of content that is handled by the delivery service. Part of this service is a persistent email queue that is in place to guarantee that the items are forwarded to the configured SMTP server.

    Event management service

    The event management service is the service that handles scheduling. Part of the scheduling aspect is the control over cancelling, suspending, and releasing scheduled tasks. For tasks that are already entered the queue, requests to cancel, release, or suspend are forwarded from the event management service to the monitor service.

    The information found as part of the Upcoming Activities task in the IBM Cognos administration console is also provided by the event management service.

     

    
      
        	
          SDK requests: All SDK requests coming into IBM Cognos BI start with the event management services.

        
      

    

    Graphics service

    The graphics service produces graphics on behalf of the report service. Graphics can be generated in the following formats: 

    •Raster

    •Vector

    •Microsoft Excel XML

    •Portable Document Format (PDF)

    Human task service

    The human task service enables the creation and management of human tasks. A human task such as report approval can be assigned to individuals or groups on an ad hoc basis or by any of the other services.

    Index data service

    The index data service provides basic full-text functions for storage and retrieval of terms and indexed summary documents.

    Index search service

    The index search services provides search and drill-through functions, including lists of aliases and examples.

    Index update service

    The index update service provides write, update, delete, and administration functions.

    Job service

    Before jobs can be executed, they must first be prepared, meaning that the steps of a job must be analyzed for issues such as circular dependencies in nested jobs and resolution for run options that are part of the jobs. The job service completes these tasks and then sends the job to the monitor service for execution.

    Log service

    The log service creates log entries that are received from the dispatcher and other services. The log service is called regardless of which logging output is specified (for example database, file, remote log server, and so forth).

    Metadata service

    The metadata service provides support for data lineage information that is displayed in Cognos Viewer, IBM Cognos Report Studio, IBM Cognos Query Studio, and IBM Cognos Analysis Studio. Lineage information includes information such as data source and calculation expressions.

    Metric studio service

    The metric studio service provides the IBM Cognos Metric Studio user interface for the purposes of monitoring and entering performance information.

    Migration service

    The migration service manages the migration from IBM Cognos Series 7 to IBM Cognos BI version 10.1.

    Monitor service

    The monitor service handles all of the requests set to run in the background, including scheduled tasks, reports that are set to run and then email the results, and jobs. Because the monitor service can receive more requests than can be executed, it also queues requests and waits for resources to become available for the required service. 

    When a service indicates that there is sufficient bandwidth, the monitor service then forwards the task to the appropriate service for execution. Because the monitor service handles all of the background tasks, writing history information about the individual task executions is the responsibility of the monitor service. The exceptions to this process are the history details for deployment and IBM Cognos Search indexing tasks, which are written directly to the content store using the IBM Cognos Content Manager component.

    The information found as part of the Current Activities task in the administration console is also provided by the monitor service.

    Presentation service

    The presentation service provides the display, navigation, and administration capabilities in IBM Cognos Connection. It also receives generic XML responses from other services and transforms them into output format, such as HTML or PDF.

    Another function of the presentation service is to send the saved content when a request to view saved output is made. If a request to execute the report is made from inside of Cognos Viewer, the request is handled by the report service.

    Query service

    The query service manages Dynamic Query Mode requests and returns the result to the requesting batch or report service.

    Report data service

    The report data service manages the transfer of report data between IBM Cognos BI and applications that consume report data, such as IBM Cognos Analysis for Excel, IBM Cognos Office Connection, and IBM Cognos Mobile.

    Report service

    The report service manages interactive report requests to run reports and provides the output for a user in IBM Cognos Business Insight or in one of the IBM Cognos studios.

    System service

    The system service is used by the dispatcher to obtain application configuration parameters and provides methods for interfacing with locale strings that are supported by the application for support of multiple languages.

    2.2  Open access to all data sources 

    Most organizations have data sitting in different systems and data sources, which makes gaining access to all data difficult. In addition, methods to ensure that users get complete access to data can be expensive. The IBM Cognos Platform provides the ability to deliver all information from wherever it resides and isolates the user from technological complexity. The IBM Cognos Platform provides a single point to access all data sources.

    This process removes barriers to information and hides source complexity from metadata modelers. Business users can interact and view all the data they need to make the best possible decision. In addition, all capabilities that are associated with IBM Cognos BI can access data as soon as any data source is made available to it. With complete, optimized access to all information, IBM Cognos software ensures satisfaction and a successful business intelligence project that the organization will embrace and promote.

    2.3  Business intelligence for all

    IBM Cognos BI provides users with many options to access information. Each option uses common functions and interfaces. Executives can take IBM Cognos Active reports offline to keep working while out of the office. Information consumers and executives can access reports, charts, and other business intelligence objects using dashboards from IBM Cognos Business Insight. IBM Cognos Advanced Business Users and Professional Report Authors can use IBM Cognos Business Insight Advanced to create new IBM Cognos BI objects and to analyze information from any source and from new perspectives. Users familiar with office productivity tools can use IBM Cognos Analysis for MS Excel to blend the power of IBM Cognos BI information with the personal workspace of Excel. Users on the go can use IBM Cognos Mobile to stay connected to their IBM Cognos BI information.

    IBM Cognos BI also provides tools to enable equal access to business intelligence information for users with physical disabilities.

    We discuss further details about these features in subsequent chapters in this book.

    2.4  Common integrated security model

    The IBM Cognos Platform provides integration with enterprise authentication and single sign-on (SSO) solutions and a central place to control access and authorization for all IBM Cognos BI objects, capabilities, and data. 
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Business scenario and personas used in this book

    This chapter describes the fictitious business scenario and personas that we use to demonstrate IBM Cognos Business Intelligence (BI) functions and use cases that we describe in this book.

    In this chapter, we discuss the following topics:

    •Business scenario overview

    •Personas used in the scenarios in this book

    3.1  Business scenario overview

     

    
      
        	
          Fictional company used for this scenario and samples: This book uses the fictional Great Outdoors company, and IBM provided samples to describe business scenarios and product functionality. These samples are included with IBM Cognos software and install with the IBM Cognos samples database. For more information about how to install IBM Cognos samples, refer to the IBM Cognos Installation and Configuration Guide.

        
      

    

    The fictional Great Outdoors company began in October 2004 as a business-to-business company. It does not manufacture its own products; rather, the products are manufactured by a third party and are sold to third-party retailers. The company built its business by selling products to other vendors. Recently, the Great Outdoors company expanded its business by creating a website to sell products directly to consumers.

    The Great Outdoors organization is made up of six companies. These companies are primarily geographically-based, with the exception of GO Accessories, which sells to retailers from Geneva, Switzerland. Each of these countries has one or more branches.

    The Great Outdoors company includes the following subsidiaries:

    •GO Americas

    •GO Asia Pacific

    •GO Central Europe

    •GO Northern Europe

    •GO Southern Europe

    •GO Accessories

    Each of these subsidiaries sells camping equipment, golf equipment, mountaineering equipment, outdoor protection, and personal accessories. GO Accessories sells only Personal Accessories.

    Because the company has steadily grown into a worldwide operation over the last several years, it has been difficult for managers of the Great Outdoors company to run their branches and monitor only performance indicators based on sales. The Great Outdoors company executives need a clear view of where the pain points exist in the sales process.

    3.1.1  Business questions to address

    Based on this scenario, chapters within this book focus on creating a dashboard that provides insight to address the following questions, helping the Great Outdoors company sales executives to make better decisions:

    •Are we selling the right products?

    •Have we been growing our profit margin?

    •Have we had a considerable number of returns?

    •How many units of a product should we buy by each period of the year? 

    •How does the performance of our business compare to last year?

    •How does the performance of our business compare to what we planned?

    •Can we add meaningful information about our competitors?

    •How successful are our promotions?

    3.1.2  Information stored in the data warehouse of this company

    The information management team of the Great Outdoors company created a data warehouse with information about sales targets, distribution, satisfaction (customer, employee, and retailer), marketing (promotions, bundle sales, and item sales), and human resources to solve this information gap.

    In this book, we focus on the Sales perspective in order to translate the data warehouse data into meaningful insights about the Great Outdoors company.

    In our scenarios in this book, we focus on the following dimensions:

    •Organization

    •Product

    •Retailer

    •Order method

    •Sales staff

    •Purchase, charges and shipping from its warehouses

    •Metrics, such as quantity, gross margin, revenue, gross profit, planned revenue, sales target and return quantity

    3.2  Personas used in the scenarios in this book

    To demonstrate the samples and business scenarios, this book refers to user roles, called personas, that represent people in a real Business Analytics deployment. We describe scenarios are that meet the business needs of these users. A user can take on the role of one or more personas (for example Advanced Business Users and Professional Report Author).

    The six personas are as follows: 

    •Advanced Business User

    •Professional Report Author

    •Modeler

    •Administrator

    •Analyst

    •Business User

    Each these personas has different needs and expectations that must be delivered by the Business Analytics platform. IBM Cognos BI addresses these business needs with a range of integrated tools, such as IBM Cognos Business Insight and IBM Cognos Business Insight Advanced.

    3.2.1  Advanced Business User

    This persona has a deep understanding of the business needs and a good understanding of technology. The Advanced Business User leads the interpretation of business requirements and creates reports to answer business questions. In this book, the Advanced Business User’s name is Lynn Cope.

    Persona’s needs

    The Advanced Business User has the following business needs:

    •Get the right advice to senior management

    •Self-sufficiency

    •Look at the problem from different angles

    •Needs tools that integrate seamless and allow full collaboration with colleagues

    •Get things done quickly

    •Trust the data

    Solutions that can help this persona

    The following solutions can help the Advanced Business User meet the business needs:

    •IBM Cognos Business Insight

    Create and change dashboards in order to organize the information; interactive exploration and analysis, apply filters, and sort and change the display type to discover meaningful details about the information and collaborate with insights about the business performance.

    •IBM Cognos Business Insight Advanced

    Easily create new reports, perform interactive exploration and analysis, apply filters, sort, group data, add calculation and statistics, add external data, and create additional objects to existent reports.

    •IBM Cognos Query Studio

    Easily create simple reports with relational and dimensional data models, using calculations, filters, groups, and sorting.

    •IBM Cognos Report Studio

    Create professional reports with advanced features, such as prompts, multiple objects, and advanced queries.

    •IBM Cognos Analysis Studio

    Easily perform interactive exploration and analysis on dimensional data models, slicing and dicing the information.

    •IBM Cognos Analysis for Microsoft Excel

    Perform flexible, interactive exploration and analysis of multidimensional data into Microsoft Excel.

    •IBM Cognos Metric Studio

    Align tactics with strategy and monitor performance with scorecards.

    •IBM Cognos Mobile

    Consume reports and dashboards from a friendly interface on mobile devices.

    •IBM Cognos Planning

    Insert and update plans and actual data.

    •IBM Cognos TM1

    Insert and update plans and actual data

    3.2.2  Professional Report Author

    This persona has a deep understanding of Cognos tools and creating reports based on business requirements. In this book, the Professional Report Author’s name is Lynn Cope.

    Persona’s needs

    The Professional Report Author has the following business needs:

    •Scale to meet the needs of different types of users

    •Quality content regardless of locale or environment

    •Streamlined development environment 

    •Enhanced collaboration with business users 

    Solutions that can help this persona

    The following solutions can help the Professional Report Author meet the business needs:

    •IBM Cognos Business Insight

    Create and change dashboards to organize the information. Apply filters and sort and change the display type to display meaningful details about the information.

    •IBM Cognos Report Studio

    Create professional reports with advanced features, such as prompts, multiple objects, HMTL, bursting, advanced queries, conditional behaviors, and multi-language support.

    •IBM Cognos Event Studio

    Create events to monitor business performance.

    3.2.3  Modeler

    This persona works closely with the Business Analyst to understand the business needs and to translate them in data models. The Modeler has a deep understanding of technology, databases, and leading practices of data modeling to deliver the best data models to be used in IBM Cognos solutions. In this book, the Modeler’s name is John Walker.

    Persona’s needs

    The Modeler has the following business needs:

    •Complete and consistent information

    •Fewer iterations of models 

    •Ability to develop and change quickly

    Solutions that can help this persona

    The following solutions can help the Modeler meet the business needs:

    •IBM Cognos Framework Manager

    Rapidly create relational and dimensional models (Dimensionally Modeled Relational) through a guided workflow-driven modeling process, check the execution path of the queries, define filters, configure data multi-language support and security filters.

    •IBM Cognos Transformer

    Create dimensional cubes with security filters to improve performance of the Business Analytics solution.

    •IBM Cognos Administration

    Manage security of the packages and data sources.

    •IBM Cognos PowerPlay® Studio

    Perform interactive exploration and analysis on dimensional data models, slicing and dicing the information to check if the model is working as expected.

    •IBM Cognos Report Studio

    Create professional reports with advanced features, such as prompts, multiple objects, and advanced queries.

    •IBM Cognos Data Manager

    Create jobs to Extract, Transform, and Load data to the database data model.

    •IBM Cognos Connection

    Add data sources and connections to databases to be used with IBM Cognos Framework Manager and IBM Cognos Transformer.

    •IBM Cognos Query Studio

    Create simple queries to check if the model is working as expected.

    •IBM Cognos Planning

    Create dimensional cubes (OLAP) for planning purposes.

    •IBM Cognos TM1

    Create dimensional cubes (in memory OLAP) for planning purposes.

    3.2.4  Administrator

    This persona is responsible for installing the overall IBM Cognos solution, configuring it, and assuring that the IBM Cognos services running and performing properly. In this book, the Administrator’s name is Sam Carter.

    Persona’s needs

    The Administrator has the following business needs:

    •Application installation, configuration, and life cycle

    •Manage complex environments 

    •Visibility into processes and activities

    •Limit costly maintenance, upgrades, and downtime

    Solutions that can help this persona

    The following solutions can help the Administrator meet the business needs:

    •IBM Cognos Administration

    Monitor server resources, manage content, security, data sources, distribution lists, printers, styles, portlets, dispatchers, and set search indexes.

    •IBM Cognos Configuration

    Set server URLs, ports, content store database connection, LDAP preferences and start the services to run IBM Cognos.

    •IBM Cognos Lifecycle Manager

    Manage and make the transition from prior versions of IBM Cognos to the latest version.

     

    
      
        	
          Remaining personas: The remaining personas are not advanced users. They are consumers of reports and dashboards that were created by an Advanced Business User or a Professional Report Author. The personas described here might also perform ad-hoc analysis.

        
      

    

    3.2.5  Analyst

    This persona uses dashboards and reports when connected to the network (mobile computer or mobile phone) or when not able to access the network to provide consolidated, detailed reports and statistical analysis to support management decisions. The Analyst also collaborates with colleagues to provide insight about Great Outdoors business performance. In this book, the Analyst is named Ben Hall.

    Persona’s needs

    The Analyst has the following business needs:

    •Analyze large or complex data sets 

    •Explore data from new perspectives and dimensions 

    •Identify relationships and trends 

    •Freedom to apply specific styles and formatting to results

    Solutions that can help this persona

    The following solutions can help the Analyst meet the business needs:

    •IBM Cognos Business Insight

    Create and change dashboards to organize the information. Use the dashboards for interactive exploration and analysis, to apply filters, and to sort and change the display type to discover meaningful details about the information. Collaborate with insights.

    •IBM Cognos Business Insight Advanced

    Easily create new reports, perform interactive exploration and analysis, apply filters, sort, group data, add calculation and statistics, add external data, and create additional objects to existent reports.

    •IBM Cognos Query Studio

    Easily create simple reports with relational and dimensional data models, using calculations, filters, groups, and sorting.

    •IBM Cognos Report Studio

    Create professional reports with advanced features, such as prompts, multiple objects and advanced queries.

    •IBM Cognos Analysis Studio

    Easily perform interactive exploration and analysis on dimensional data models, slicing and dicing the information.

    •IBM Cognos Statistics

    Perform three different kinds of statistical calculations—Distribution of Data, Data Analysis, and Testing and Statistical Process Control—to display the best insights about the business performance.

    •IBM Cognos Analysis for Microsoft Excel

    Perform flexible, interactive exploration and analysis of multidimensional data into Microsoft Excel.

    •IBM Cognos Mobile

    Consume reports and dashboards from a friendly interface on mobile devices.

    •IBM Cognos Planning

    Insert and update plans and actual data.

    •IBM Cognos TM1

    Insert and update plans and actual data.

    3.2.6  Business User

    This persona uses dashboards and reports that have been created specifically for this persona to understand aspects of the performance for this persona’s area of the Great Outdoors company. In this book, the Business User is named Betty Black.

    Persona’s needs

    The Business User has the following business needs:

    •Access anywhere

    •No investment in training or software

    •Simple and intuitive interface

    Solutions that can help this persona

    The following solutions can help the Business User meet the business needs:

    •IBM Cognos Business Insight

    Consume dashboards and reports to help her to make decisions and take actions based on accurate analytical data.

    •IBM Cognos Connection

    Receive scheduled reports.

    •My Inbox of IBM Cognos Connection

    Store and open report views from previous executions of a report.

    •IBM Cognos Planning

    Insert and update plans and actual data.

    •IBM Cognos TM1

    Insert and update plans and actual data
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IBM Cognos metadata modelling
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Create reporting packages with IBM Cognos Framework Manager 

    This chapter provides an overview of IBM Cognos Framework Manager and illustrates several general modelling concepts through practical exercises. This chapter is not intended as a replacement for formal training on IBM Cognos Business Intelligence (BI) metadata modelling. Because metadata modeling is the foundation of business intelligence reporting on relational data sources, it is critical that the proper training and experience be gained to ensure a successful IBM Cognos BI project. The recommended training for IBM Cognos Framework Manager is IBM Cognos Framework Manager: Design Metadata Model. 

    In this chapter, we discuss the following topics:

    •IBM Cognos Framework Manager overview

    •Build a model with IBM Cognos Framework Manager

    •Add business logic to the model

    •Create dimensional objects for OLAP-style reporting

    •Create and configure a package

    •Apply security in IBM Cognos Framework Manager

    •Model troubleshooting tips

    4.1  IBM Cognos Framework Manager overview

    IBM Cognos Framework Manager is the metadata model development environment for IBM Cognos BI. It is a Windows-based client tool that you can use to create simplified business presentations of metadata that are derived from one or more data sources. With IBM Cognos Framework Manager, you can publish that metadata to IBM Cognos BI in the form of a package. You can also use it to add dimensional information to relational data sources that allow for OLAP-style queries. This type of model is known as a Dimensionally Modeled Relational (DMR) model.

    In this section, we discuss items that you need to consider before beginning metadata modeling projects. This information familiarizes you with the IBM Cognos Framework Manager user interface (UI) and terminology.

    4.1.1  Reporting requirements and data access strategies

    Before creating an IBM Cognos Framework Manager project, it is important for the modeler to understand the reporting requirements. This knowledge allows the modeler to make better decisions regarding data access strategies, metadata model design, and report package delivery to IBM Cognos BI.

    Reviewing sample or mock reports that meet the business needs is a good start, followed by identifying which data sources contain the information that is required. The modeler also needs to consider the following types of questions:

    •Are those data sources appropriate for reporting? 

    •Is it a transactional system or the preferred reporting database structure, known as a star schema data warehouse or data mart? 

    •How fresh does the data need to be? 

    •Will your reporting occur daily, weekly, or monthly? 

    The answers to these types of questions can affect dramatically the data access strategy that you choose.

    For example, if you require up-to-the-minute data in your reports, then going with the transactional database might be the only option. This choice, however, can increase the metadata modeling work drastically, because transactional systems are typically quite complex. If the intervals of data freshness are greater, by the hour day, week, or month for example, then using data warehouses or data marts that are refreshed at the required interval is a better choice. 

    IBM Cognos bases its algorithms around industry-standard star schema designs that consist of fact tables and related dimension tables. For larger warehouses that have slower response times due to the sheer volume of data, consider using some form of materialization in which views are created with pre-aggregated results.

    You can also use OLAP sources, which can bypass the requirement for metadata modeling in IBM Cognos Framework Manager. This method can reduce response times dramatically as well, because the data is already calculated and aggregated. OLAP sources provide the added bonus of dimensional analysis and reporting, which allow users to navigate through the data and to apply powerful dimensional functions. 

    Also ask the following questions before creating an IBM Cognos Framework Manager project:

    •What type of business logic needs to be implemented? 

    •Are there specific calculations, filters, or security requirements? 

    These types of questions allow you to investigate what can be done at the data source level rather than in the IBM Cognos Framework Manager model. As a general rule, it is better to off-load to the extract, transform, and load (ETL) process that populates a warehouse to avoid that processing time when running reports. In addition, it is better to push more processing to the data source, such as filters, sorting, grouping, and so on, because vendor databases are typically optimized for those types of operations.

    Give special attention to planning and scope before you embark on a business intelligence project to avoid rework down the road.

    4.1.2  Metadata model

    Before we continue, we need to define a metadata model in the context of IBM Cognos BI. A metadata model is a collection of metadata that is imported from a database. It describes the tables, columns, and relationships in the database. This metadata is published as a package to the IBM Cognos BI portal, as shown in Figure 4-1, and is used to generate appropriate SQL requests to the database when reports or analysis are run.
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    Figure 4-1   Metadata model workflow

    In most cases, the metadata is altered in IBM Cognos Framework Manager to ensure predictable results when reporting and to meet reporting and presentation requirements. The model can hide the structural complexity of underlying data sources and provide more control over how data is presented to IBM Cognos BI users. You can also choose which data to display to users and how that data is organized. The overall goal of modeling the metadata is to create a model that provides predictable results and an easy-to-use view of the metadata for authors and analysts.

    4.1.3  The IBM Cognos Framework Manager UI

    Figure 4-2 shows the IBM Cognos Framework Manager UI.
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    Figure 4-2   IBM Cognos Framework Manager user interface

    The user interface includes the following panes: 

    •The Project Viewer pane, by default, is on the left side of the window and provides an easy way to access all your project's objects in a tree format.

    •The Project Info pane is the center pane and provides access to the project’s objects through various methods. The three tabs in this pane (Explorer, Diagram, and Dimension Map) allow you to create, edit, configure, or delete objects. You use each of these tabs throughout this chapter.

    •The Properties pane, by default, is located in the bottom middle of the window and allows you to configure various properties for any of the project's objects.

    •The Tools pane, by default, is located on the right side of the window and provides several useful tools. You can use it to switch the project language quickly, to view project statistics, and to perform common tasks for selected objects. This pane also provides a search utility (second tab) and an object dependencies utility (third tab). Simply drag an object (and its children if it has any) to the top panel, select the object or one of its children in the top panel and view the dependant objects in the bottom panel. This is very useful when you want to change an object and assess the impact that the change will have on other objects in the model.

    All panes can be hidden except the Project Info pane, which is the main work area. To restore a pane, use the View menu or use the toggles on the toolbar. You can also detach and rearrange the Project Viewer, Properties, and Tools panes.

    4.1.4  Reporting objects

    In IBM Cognos Framework Manager, there are several objects with which you interact in either the Project Viewer or the Project Info panes. For simplicity, we examine the objects in the Properties pane, shown in Figure 4-3, with the exception of relationships.
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    Figure 4-3   Model objects in the Project Viewer pane

    The Project Viewer pane includes the following reporting objects:

    •The following types of query subjects:

     –	A Data Source object, shown in Figure 4-4, maps to a corresponding object in the data source and uses a modifiable SQL statement to retrieve the data. This object is identifiable by the small database icon in the top-right corner.
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    Figure 4-4   Data Source query subjects

     –	A Model object, shown in Figure 4-5, maps to existing metadata in the model.
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    Figure 4-5   Model query subjects

     –	A Stored Procedure executes a database stored procedure to retrieve or update the data. Its icon appears the same as a Data Source query subject. These types of query subjects will be beyond the scope of this book.

    •A Query item, shown in Figure 4-6, is contained within a query subject and maps to a corresponding object in the data source.
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    Figure 4-6   Query items

    •A Regular Dimension object, shown in Figure 4-7, contains descriptive and business key information and organizes the information in a hierarchy, from the highest level of granularity to the lowest, allowing for OLAP-style queries.
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    Figure 4-7   Regular Dimension

    •A Measure Dimension object, shown in Figure 4-8, is a collection of facts for OLAP-style queries.
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    Figure 4-8   Measure Dimension

    •A Shortcut object, shown in Figure 4-9, is a pointer to an underlying object that can act as an alias or reference.
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    Figure 4-9   Shortcuts

    •A Namespace object, shown in Figure 4-10, is an organizational container that also uniquely identifies the objects that it contains. For example, two different namespaces can both contain a shortcut called Products without causing a naming conflict in the model, which is useful for star schema groupings.
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    Figure 4-10   Namespaces

    •A Folder object, shown in Figure 4-11, is an organizational container for various model objects. Query item folders are also available to organize items within a query subject.
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    Figure 4-11   Folder

    Other objects are available, such as model filters and calculations, but we discuss those later. 

    The Project Info pane on the Diagram tab includes the following relationships:

    •A relationship, shown in Figure 4-12, explains how the data in one query subject relates to the data in another.
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    Figure 4-12   Relationship

    •A scope relationship, shown in Figure 4-13, exists between Measure Dimensions and Regular Dimensions to define the level at which the measures are available for reporting.
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    Figure 4-13   Scope relationship

    You might also work with the following types of objects:

    •The Data Sources folder, shown in Figure 4-14, contains the data sources that we used in the project. The data sources are defined in IBM Cognos Connection. The data sources are definitions containing the pertinent information the IBM Cognos BI requires to connect to the underlying data sources.
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    Figure 4-14   The Data Source folder

    •The Parameter Maps folder, shown in Figure 4-15, contains parameter maps that allow for data or some other model value substitution at run time. These parameter maps are useful when trying to dynamically affect the way that the model behaves when reports are run.
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    Figure 4-15   The Parameter Maps folder

    •The Packages folder, shown in Figure 4-16, contains packages that are published to IBM Cognos BI to make model metadata available to authors.
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    Figure 4-16   The Packages folder

    4.2  Build a model with IBM Cognos Framework Manager

    In the modeling scenario for this chapter, John Walker is the company modeler who is creating a basic sales model based on the Great Outdoors data warehouse. John’s requirements are to create a reporting package for IBM Cognos BI that allows authors and analysts to query the data source for sales information by product, time, and order methods and to compare the sales figures to sales target values. 

    John has already looked at various report samples and interviewed users to better understand how he needs to present the data to the authors. Some authors want to perform only basic relational queries against the data source, and other authors, particularly analysts, want the ability to navigate through the data to better understand how the business is doing and where it is being affected positively and negatively.

    To that end, John will deliver the following packages, both based on the relational data source:

    •A package for basic relational queries

    •A package for OLAP-style queries

    We provide the final result model for this chapter as a reference in the additional material that is supplied with this book.

    4.2.1  Import metadata using Model Design Accelerator

    The Model Design Accelerator is a graphical utility that is designed to guide both novice and experienced modelers through a simplified modeling process. The Model Design Accelerator applies IBM Cognos leading practices to produce single star schemas quickly. 

    You can create multiple star schemas using the Model Design Accelerator several times. Then, you can link the results together. You can add features to the model using standard IBM Cognos Framework Manager functionality. The following steps describe how to import metadata using the Model Design Accelerator.

    1.	Open IBM Cognos Framework Manager, and click Create a new project using Model Design Accelerator, see Figure 4-17. 
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    Figure 4-17   IBM Cognos Framework Manager welcome panel

    2.	Enter an appropriate project name, in this example GO Sales, as shown in Figure 4-18, and specify the location for the project. Click OK. If the specified folder does not exist, you are prompted with a message asking if you want to create one.
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    Figure 4-18   New Project dialog box

    3.	Select the design language for the project, in this example English, and then click OK.

    4.	Select the GOSALESDW data source as shown in Figure 4-19, which was already created by the IBM Cognos BI administrator, and then click Next. 
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    Figure 4-19   Metadata wizard: Select Data Source dialog box

     

    
      
        	
          Modeler permissions: If given appropriate permission, modelers can also create their own data source connections either through the Metadata wizard by clicking the New button or directly in IBM Cognos Administration by selecting Configuration → Data Source Connections. Refer to the IBM Cognos BI Administration and Security Guide for details about how to create a data source connection.

        
      

    

    5.	In the list of objects, expand GOSALESDW → Tables, and then select the following tables:

     –	GO_TIME_DIM

     –	SLS_ORDER_METHOD_DIM

     –	SLS_PRODUCT_DIM

     –	SLS_PRODUCT_LOOKUP

     –	SLS_PRODUCT_TYPE_LOOKUP

     –	SLS_PRODUCT_LINE_LOOKUP

     –	SLS_SALES_FACT

    6.	Click Continue. The IBM Cognos Framework Manager User Guide window opens, displaying information about the Model Design Accelerator. The information in this window explains the steps to create a model using the Model Design Accelerator. You can close this window.

    7.	In the Model Accelerator pane, right-click the Fact Table query subject in the center of the pane, and click Rename.

    8.	Type Sales Fact to rename the fact query subject, and then press Enter. The result displays. See Figure 4-20.
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    Figure 4-20   Model Accelerator pane

    9.	In the Explorer tree pane, expand gosalesdw → SLS_SALES_FACT, as shown in Figure 4-21, select the measures that follow, and then drag those measure to the Sales Fact query subject shown in Figure 4-22 on page 50.

    [image: ]

    Figure 4-21   Model Design Accelerator: Explorer Tree
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    Figure 4-22   Model Design Accelerator with query items added to Sales Fact

    10.	Rename New Query Subject 1 to Products. 

    11.	In the Explorer tree pane:

    a.	Expand the SLS_PRODUCT_LINE_LOOKUP table, and drag the PRODUCT_LINE_EN data item into the Products query subject.

    b.	Expand the SLS_PRODUCT_TYPE_LOOKUP table, and drag the PRODUCT_TYPE_EN data item into the Products query subject.

    c.	Expand the SLS_PRODUCT_LOOKUP table, and drag the PRODUCT_ NAME data item into the Products query subject.

    The Relationship Editing Mode for: Products dialog box opens. See Figure 4-23.
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    Figure 4-23   Model Design Accelerator Relationship Editing dialog box

    This dialog box opens because IBM Cognos Framework Manager cannot determine the relationship between the SLS_PRODUCT_LOOKUP table and the SLS_SALES_FACT table. You need to establish the relationship yourself.

    12.	Ctrl-click SLS_PRODUCT_LOOKUP - → PRODUCT_NUMBER and SLS_PRODUCT_DIM → PRODUCT_NUMBER.

    13.	Click the Create a Model Relationship icon in the top-left corner of the dialog box. The Modify the Relationship dialog box opens. See Figure 4-24.
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    Figure 4-24   Modify the Relationship dialog box

    The SLS_PRODUCT_ LOOKUP table has an entry for each product for each language, which results in a many-to-many relationship with the PRODUCT table. After you generate the basic model, you will eventually add a filter to filter out all non-English product names, thus creating a one-to-many relationship.

    14.	Click OK, and then click OK again to close the Relationship Editing Mode dialog box.

    15.	In the Explorer Tree, expand SLS_PRODUCT_DIM, and add the following items to the Products query subject, as shown in Figure 4-25.

     –	PRODUCT_KEY

     –	PRODUCT_LINE_CODE

     –	PRODUCT_TYPE_KEY

     –	PRODUTCT_TYPE_CODE

     –	PRODUCT_NUMBER

     –	PRODUCT_IMAGE

     –	INTRODUCTION_DATE

     –	DISCONTINUED_DATE
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    Figure 4-25   New Relationship and added query items to the Products query subject

    16.	Rename New Query Subject 2 to Time. 

    17.	In the Explorer Tree pane, expand the GO_TIME_DIM table, click DAY_KEY and then Shift-click WEEKDAY_EN, and then drag the selected items to the Time query subject. The results displays. See Figure 4-26.
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    Figure 4-26   New relationship and newly added query items to the Time query subject

    18.	Rename New Query Subject 3 to Order Methods. 

    19.	In the Explorer tree pane, expand the SLS_ORDER_METHOD_DIM table, and add the following items to the Order Methods query subject, as shown in Figure 4-27:

     –	ORDER_METHOD_KEY

     –	ORDER_METHOD_CODE

     –	ORDER_METHOD_EN
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    Figure 4-27   New relationship and added items to the Order Methods query subject

    20.	Click Generate Model, and then click Yes to the message. The Model Design Accelerator creates a model based on your selections. When complete, the model is visible in the IBM Cognos Framework Manager UI. See Figure 4-28.
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    Figure 4-28   IBM Cognos Framework Manager with newly created model from Model Design Accelerator

    4.2.2  Model organization

    For IBM Cognos BI, it is recommended to model in layers. The typical approach is to have three root namespaces:

    •One for the data source objects

    •One for model query subjects that are used to either model or consolidate metadata that is found in the data source query subjects

    •One for the final presentation view, which typically consists of shortcuts

    The namespace layers can use any naming convention that makes sense to you. You might see naming conventions such as Physical View, Business View, and Presentation View, which represent the views, or such as Foundation Objects Layer, Consolidation Layer, and Presentation Layer, which represent each of the layers.

    The Model Design Accelerator follows the layered modeling approach and creates a three-layered model automatically of the model that we created in the previous section, as shown in Figure 4-29.
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    Figure 4-29   Project Viewer illustrating multiple layer approach

    Physical View

    The Physical View, shown in Figure 4-30, contains the data source query subjects as they were when imported from the data source. It is best to leave these subjects as untouched as possible so that IBM Cognos BI has all the metadata that it requires to generate efficient queries at run time. However, you might have to make some exceptions. After data source query subjects are modified, extra calls to the database for metadata might be required at run time. This rule of thumb does not mean you cannot model in this layer. For example, you might choose to create a model query subject to act as an alias for a dimension table that relates back to a fact query subject.
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    Figure 4-30   Physical View layer

    Business View

    The Business View, shown in Figure 4-31, typically consists of model query subjects that are used either to remodel the Physical View to meet reporting requirements or to consolidate information from the Physical View for a cleaner presentation of the metadata to the user. 

    The Model Design Accelerator uses the consolidation methodology. This layer is the ideal location to implement filters, calculations, and any other business logic that you might require. It might not always be the case, but as a general rule, this is the layer to apply logic. This layer also acts as an insulation layer for reports. Reports are based on query items that are found in this layer. If the underlying data source changes, you can remap the Business View to the correct items in the Physical View without affecting reports.

    In our model, all query items in this layer are given user-friendly names for report authors and analysts.
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    Figure 4-31   Business View layer

    Presentation View

    The Presentation View, shown in Figure 4-32 on page 59, typically contains star schema groupings, which are logical groupings of fact and related dimension query subject shortcuts. When more than one star schema grouping is involved, namespaces are used to contain the shortcuts because facts can share one or more dimensions. Because namespaces provide uniqueness, a dimension shortcut with the same name can exist in multiple namespaces, allowing authors to query across multiple fact tables using a shared dimension.

    You can easily create separate packages for different reporting needs based on this layer.
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    Figure 4-32   Presentation View layer

    4.2.3  Verify query item properties and relationships

    After importing metadata into IBM Cognos Framework Manager, it is recommended that you verify and edit certain property settings and determine if the correct relationships are in place to meet the reporting requirements.

    Examine query item properties

    Object properties allow you to add additional information, such as descriptions and screen tips, and query item properties (shown in Figure 4-33 on page 60) let you edit the behavior of the query items, such as configuring the data format. For example, should numeric values be displayed as currency, percentage, or a just a number with comma separators?
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    Figure 4-33   Query items properties

    You need to examine two properties closely after import to ensure that they are set as expected:

    •Usage property 

    •Regular Aggregate properties

    For example, SALES_ORDER_KEY, as shown in Figure 4-33, was imported as an Int32 data type and had its Usage property set to Fact. This item is not a fact, but rather is a key. Thus, you expect to see the Usage property set to Identifier. This issue occurs because the item is not indexed in the database. Examining this setting allows you to have relevant conversations with the database administrator. If this key is to be used in a relationship or filter, it is better that the field is indexed in the database.

    The following rules explain how the Usage property is applied during import:

    •Numeric, time-interval, or non-indexed columns are set as Facts

    •Key, index, date, datetime, or any indexed columns are set as Identifiers

    •Strings and BLOBs are set as Attributes

    The Regular Aggregate property for numeric facts (measures) describes how measures should be aggregated and defaults to SUM. Sum is correct for most measures (such as SALE_TOTAL and QUANTITY); however, in some instances, you might want to set the property to Average, Minimum, Maximum, and so on.

    Another set of important properties to take advantage of are the Prompt Info properties, as shown in Figure 4-34.
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    Figure 4-34   Prompt Info properties

    You can specify the type of prompt that you want generated in the studios or the default prompt type for IBM Cognos Report Studio. The default is for the server to determine the prompt type based on data type.

    The remaining properties are used to improve performance by causing automatic retrieval through indexes while still displaying user-friendly selection values.

    Here is a brief description of the remaining properties:

    •Cascade on Item Reference is for cascading prompts in Report Studio, for example, where the list of Product Type choices is restricted to those within a selected Product Line.

    •Display Item Reference identifies the default value that a manually-created Report Studio prompt displays for a particular query item. For example, to see a list of ORDER_METHOD_EN names when using ORDER_METHOD_CODE in a prompt, set the Display Item Reference property for ORDER_METHOD_CODE to ORDER_METHOD_EN. If this field is left blank, it defaults to the values that are returned by the query item to which it belongs.

    •Use Item Reference identifies the default value that a manually-created Report Studio prompt uses in the query’s filter. For example, for a Report Studio generated prompt on ORDER_METHOD_EN to display a list of ORDER_METHOD_EN names but retrieve data through the ORDER_METHOD_CODE, set the Use Item Reference property in ORDER_METHOD_EN to ORDER_METHOD_CODE.

    •Filter Item Reference identifies the value that an IBM Cognos generated prompt uses to filter a query. For example, for Query Studio to display ORDER_METHOD_EN values but use ORDER_METHOD_CODE in the query’s filter, set the Filter Item Reference property to ORDER_METHOD_CODE, as shown in Figure 4-35.
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    Figure 4-35   Filter Item Reference property

    Examine relationships

    Relationships are maintained in the Object Diagram or Context Explorer. 

    As a quick side topic, Context Explorer, shown in Figure 4-36, is another useful UI element in IBM Cognos Framework Manager.
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    Figure 4-36   Context Explorer

    You can launch this window by selecting one or more query subjects, right-clicking one of the selected items, and then clicking Launch Context Explorer.

    For larger models, this feature is useful when working with a subset of the model. You can edit items directly in this window.

    Now, back to relationships. When verifying relationships, you must ensure that the appropriate relationships exist to meet your reporting needs, and you must decide if you require optional or mandatory cardinalities. Optional cardinalities require more processing but might be needed to return the desired results.

    Optional cardinality, which generates an outer join in the SQL, is represented by a 0, as in 0..n or 0..1. Mandatory cardinality, which generates an inner join in the SQL, is represented by a 1 as in 1..n or 1..1.

    Cardinality is used by IBM Cognos BI to determine which query subjects are facts and which are dimensions in the context of a query. This determination is important, in particular, when querying from multiple fact tables through a shared dimension. By identifying which query subjects are facts, IBM Cognos BI can aggregate the facts properly and not lose records from either fact table.

    It is important to model as a star schema so that there is no ambiguity about the nature of a query subject. In short, fact query subjects have only 1..n or 0..n cardinalities attached, and dimension query subjects have only 1..1 or 0..1 cardinalities attached, as shown in Figure 4-36 on page 63. 

    Unpredictable results can occur when query subjects have a mix of cardinalities, with the exception of when dealing with snowflake dimensions. Snowflake dimensions are where the hierarchy for the dimension is split out into two or more tables, as shown in Figure 4-37.

    [image: ]

    Figure 4-37   Snowflake dimension

    The product hierarchy is split out into the following tables:

    •Product line

    •Product type

    •Product

    In this case, there is a clear path from the highest level all the way down to the fact table. The hierarchy does not branch of at higher levels such as product type level or product line level.

    Refer to the IBM Cognos Framework Manager User Guide for more details about cardinality.

    To edit a relationship, double-click the relationship line in the Diagram pane or the Context Explorer to open the Relationship Definition dialog box, as shown in Figure 4-38.
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    Figure 4-38   Relationship Definition dialog box

    Here, you can change the cardinality on either end of the relationship, change the query items the join is based on, or create a compound definition with additional business logic by editing the expression located at the bottom of the dialog box.

    4.2.4  Import additional metadata

    Our modeler, John Walker, has created a model that contains sales facts along with its related dimensions (Products, Time, and Order Methods). However, this model also requires sales target information. So, he will use the manual import process to bring in this additional table as metadata in the model. Products and Time are both shared (conformed) dimensions for this fact table; therefore, using the Model Design Accelerator does not make sense in this case.

     

    
      
        	
          Importing SAP BW metadata: Just as a quick side note for those who want to import SAP BW metadata, time-dependant hierarchies now reflect hierarchy or structure changes automatically. When a structure is imported into IBM Cognos Framework Manager, each SAP BW time hierarchy is depicted as an individual level. IBM Cognos Report Studio users can use these structures to report on and compare levels that are valid for a specific time period.

        
      

    

    To import additional metadata manually, follow these steps:

    1.	In IBM Cognos Framework Manager, in the Project Viewer, right-click the gosalesdw namespace under the Physical View, and then click Run Metadata Wizard as shown in Figure 4-39.

    [image: ]

    Figure 4-39   Run Metadata wizard

    2.	Ensure that Data Sources is selected, and click Next.

    3.	Select the GOSALESDW data source, and click Next.

    4.	Locate and expand the Tables folder, and select SLS_SALES_TARG_FACT as shown in Figure 4-40. Click Next.
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    Figure 4-40   Metadata wizard: Select Objects dialog box

    5.	Select Between each imported query subject and all existing query subjects in the model as shown in Figure 4-41.
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    Figure 4-41   Metadata wizard: Generate Relationships dialog box

    Let us take a moment to discuss this dialog box. In the first section, in general, use the “Use primary and foreign keys” option for relational data from the same database. Typically the database will have primary and foreign keys defined. The other two options in this section are often used when importing from a different database.

    In the second section, you can request to create relationships among either the objects being imported, the objects being imported and the existing objects in the model, or both. When importing several additional tables that have relationships to each other and to objects already in the model, select the “Both” option in the wizard. By selecting this option, you do not need to create the relationships manually after import.

    In the third section, by default, an import converts outer joins to inner joins for performance reasons. You can choose to generate outer joins if that meets your business needs, or you can edit specific relationships after import to meet your needs. 

    Another option is to enable or disable fact detection. If this option is disabled, all relationships will be 1..1 to 1..1.

    6.	Click Import, and then click Finish.

    7.	Double-click the gosalesdw namespace, and click the Diagram tab to view the new query subject in the diagram, shown in Figure 4-42, and to examine any relationships.
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    Figure 4-42   New Sales Target query subject with no relationships defined

    Notice that no relationships were generated. In this case, the model should have the following relationships for sales targets:

     –	One to the time dimension 

     –	One to the product dimension

    The reason there is no relationship to the product dimension is that PRODUCT_KEY is not indexed in the database, and it is not a primary key in the table. The same issue applies to the time dimension. MONTH_KEY is not a primary key, and it is not indexed in the database. You can create the relationships manually in IBM Cognos Framework Manager, but the keys should be indexed in the database to improve performance.

    8.	In the Project Viewer, select MONTH_KEY from GO_TIME_DIM, and select MONTH_KEY from SLS_SALES_TARG_FACT.

    9.	Right-click over the selected items, point to Create, and then click Relationship as shown in Figure 4-43.
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    Figure 4-43   Create Relationship

    10.	The Relationship dialog box opens, as shown in Figure 4-44. The relationship is configured as desired. The dimension is on the 1..1 side, and the fact on the 1..n side. Click OK.
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    Figure 4-44   Relationship Definition dialog box

    The Diagram pane now shows the new relationship as shown in Figure 4-45.
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    Figure 4-45   New relationship in Diagram pane

    11.	Using the same process, create a relationship between SLS_PRODUCT_DIM and SLS_SALES_TARG_FACT on PRODUCT_TYPE_KEY as shown in Figure 4-46.
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    Figure 4-46   New relationship in Diagram pane

    Now that the new sales target object is imported and relationships are created, you need to update the Business View and Presentation View manually. The Presentation View is organized to have separate namespaces for each fact shortcut and its related dimensions. You can use the star schema groupings feature to create the grouping for the new Sales Target Fact query subject that will be created.

    12.	In the Project Viewer, right-click the Business View namespace, point to Create, and then click Query Subject.

    13.	In the Name box, type Sales Target Fact, and click OK.

    14.	A Query Subject Definition window for a new model query subject opens. Under Available Model Objects, expand Physical View → gosalesdw → SLS_SALES_TARG_FACT.

    15.	Drag SALES_TARGET to the Query Items and Calculations pane, shown in Figure 4-44, and click OK.
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    Figure 4-47   Query Subject Definition window for new Sales Target Fact model query subject

    16.	Click the new Sales Target Fact query subject in the Business View namespace, Ctrl-click Products and Time (these are related dimensions), right-click one of the selected items, and then click Create Star Schema Grouping.

    17.	In the Create Star Schema Grouping dialog box, type Sales Target in the Namespace field, shown in Figure 4-48, and then click OK.
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    Figure 4-48   Create Star Schema Grouping dialog box

    18.	Drag the Sales Target namespace to the Presentation View.

    19.	Right-click the Presentation View namespace, point to Create, and then click Namespace.

    20.	Name the namespace Sales, and then drag the Sales Fact, Products, Time, and Order Methods shortcuts into the Sales namespace, as shown in Figure 4-49.
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    Figure 4-49   Presentation View with star schema groupings

    To this point, we used the Model Design Accelerator to create a one star schema grouping, examined query item properties and relationships, and imported additional metadata which was then organized into an additional star schema for presentation purposes. Next, we describe using techniques to validate the model and the data itself.

    4.2.5  Verify the model

    You can verify independent model objects and their children, or you can verify the entire model by verifying the model’s root namespace. In this example, we verify the entire model. To verify the model:

    1.	Right-click the root model namespace, in this case called Model, and click Verify Selected Objects. The Verify Model - Options dialog box opens as shown in Figure 4-50.
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    Figure 4-50   Verify Model - Options dialog box

    In this window, you can select the types of items that you want to include in the validation process.

    2.	Click Verify Model. In this case, the model is quite simple and presents no issues as shown in Figure 4-51. In other instances where issues are found, you can choose to repair the objects, if applicable, or open the items in the model to edit their definitions to resolve any issues.
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    Figure 4-51   Verify Model Results dialog box

    3.	Click Close.

    You can verify the objects in the model, and you can also use Model Advisor, which is an automated tool that applies rules based on current modeling guidelines and identifies areas of the model that you need to examine. To assist you in understanding the nature of the highlighted issue and some possible actions, you are provided with links to the appropriate sections of the documentation. 

    To run the Model Advisor, use the following steps:

    1.	Right-click the namespace that you want to examine. In this example, we use gosalesdw. Click Run Model Advisor. The Model Advisor dialog box opens, as shown in Figure 4-52.
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    Figure 4-52   Model Advisor dialog box, Options tab

    Here you can select or deselect items to be tested.

    2.	Click Analyze. The results display as shown in Figure 4-53.
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    Figure 4-53   Model Advisor results

    In the results, you can identify items that fit certain categories and click the icon under the Action column to view the object or objects in the Context Explorer. You can also click the more information links to read the documentation regarding specific modeling recommendations.

    3.	Click Close.

    4.2.6  Verify the data

    It is also critical that you test each of your query subjects alone and in conjunction with other query subjects to ensure that authors will receive predictable results.

    In this next scenario, our modeler John Walker tests Sales Targets against the Time dimension and tests the Products dimension against Sales to ensure that the numbers come back correctly.

    John Walker renamed all the query items in the Business View to user-friendly names and organized them in a logical manner. To verify the data:

    1.	In the Project Viewer, in the Business View, select Year (formerly CURRENT_YEAR), select Month (formerly MONTH_EN) from the Time dimension, and select Sales Target (formerly SALES_TARGET) from Sales Target Fact.

    2.	Right-click one of the selected items, and click Test. Then, in the Test Results dialog box, select Auto Sum to emulate the default IBM Cognos BI behavior, which is to auto group and summarize in the studios.

    3.	Click Test Sample, and examine the results, as shown in Figure 4-54.
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    Figure 4-54   Test Results dialog box

    John Walker knows that the overall total for Sales Target for all time and products is 4,205,368,540 (over four billion), yet the results show several results all adding up to well over four billion dollars. This issue is the result of double counting that occurs because the Month Key in the Time dimension repeats once for every day in the month. Because there is a relationship on the Month Key, determinants must be defined for the underlying query subject in the Physical View layer to ensure that this double counting does not occur. We discuss this issue in the next section, 4.2.7, “Specify determinants” on page 84.

    4.	Click Close.

    5.	In the Project Viewer, in the Business View namespace, select Product Line (formerly PRODUCT_LINE_EN), select Product Name (formerly PRODUCT_NAME) from Products, and select Revenue (formerly SALE_TOTAL) from Sales Target.

    6.	Right-click one of the selected items, and click Test. In the Test Results dialog box, select Auto Sum, and click Test Sample. The results display as shown in Figure 4-55.
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    Figure 4-55   Test results dialog box

    Again, these results are questionable, because overall summaries in the studios double count Revenue values once for each product language in the data source. This issue is resolved by applying a filter in 4.3, “Add business logic to the model” on page 89.

    7.	Click Close.

    Validating the data is an important process. Validate your data often and as new items are imported or modeled to ensure predictable results.

    4.2.7  Specify determinants

    As discussed in the previous section, double counting can occur in scenarios where a a relationship based on a key that is not unique and repeats in the data is used in a query. Specifying determinants resolves this issue.

    Determinants are a feature of IBM Cognos BI that are typically used to provide control over granularity when aggregating. Determinants are required for dimensions that are connected to facts at levels of granularity that have repeating keys. You can also use them to prevent the distinct clause on unique keys, for BLOB data types in the query subject, and to improve performance on dimensionally modeled relational (DMR) metadata. In this section, we discuss double counting, which is the most common of the issues. For more detailed information about determinants, see the IBM Cognos Framework Manager User Guide.

    To specify determinants to prevent double counting:

    1.	In the Project Viewer, in the Physical View namespace, double-click the GO_TIME_DIM query subject, and then click the Determinants tab, as shown in Figure 4-56.
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    Figure 4-56   Query Subject Definition dialog box, Determinants tab

    During import, only one determinant was detected based on the table’s primary key. Because this key is unique, all items in the query subject are an attribute of the determinant key. However, there are other levels in this data, such as the MONTH_KEY, that require a group by clause to prevent double counting of facts. To that end, we create the appropriate determinants for this query subject and apply the Group by setting.

    2.	Right-click pk, click Rename, type Day, and then press Enter.

    3.	Under the Determinants pane, click Add. New Determinant displays below Day in the Determinants pane.

    4.	Right-click New Determinant, click Rename, type Year, and then press Enter.

    5.	Click the Up Arrow key on the right to move Year above Day.

    6.	With the focus still on Year, from the Available items pane, drag CURRENT_YEAR to the Key pane.

    7.	Select the Group By check box beside Year.

    8.	Repeat the steps to a create Quarter determinant, with Key = QUARTER_KEY and select the Group By check box beside Quarter.

    9.	With the focus still on Quarter, drag CURRENT_QUARTER into the Attributes box.

    Attributes are any items that are associated with the determinant key. When used in a report, the determinant configuration is implemented in the generated SQL. For example, if CURRENT_MONTH is used in a report, you find a Group By clause on the MONTH_KEY in the SQL.

    10.	Repeat the steps again to create a Month determinant, with Key = MONTH_KEY, and select the Group By check box beside Month.

    11.	With the focus still on Month, drag the following items into the Attributes box: 

     –	CURRENT_MONTH

     –	MONTH_NUMBER

     –	MONTH_EN

    Figure 4-57 shows the results.
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    Figure 4-57   Determinants tab with multiple determinants specified

    12.	Click OK.

    To test this change, conduct the same test from the previous section to see if the correct Sales Target values are returned.

    13.	In the Project Viewer, in the Business View, select Year (formerly CURRENT_YEAR), select Month (formerly MONTH_EN) from the Time dimension, and select Sales Target (formerly SALES_TARGET) from Sales Target Fact.

    14.	Right-click one of the selected items, click Test, and then in the Test Results dialog box, select Auto Sum.

    15.	Click Test Sample, and examine the results, shown in Figure 4-58.

    [image: ]

    Figure 4-58   Test Results after determinants are specified

    The values now appear correctly and double counting is prevented.

    16.	Click Close.

    This model also includes an SLS_PRODUCT_DIM dimension that has a relationship on PRODUCT_TYPE_KEY, which is also a repeating non-unique key just like the MONTH_KEY is in the GO_TIME_DIM. If you are feeling adventurous, try applying determinants for the SLS_PRODUCT_DIM query subject. The results should display as shown in Figure 4-59.
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    Figure 4-59   Determinants specified for SLS_PRODUCT_DIM

    4.3  Add business logic to the model

    Again, typically business logic such as filters and calculations are applied in the Business View layer. However, there are instances where it makes sense to implement items in the Physical View where the cost of performance and maintenance is low. One example of this is the requirement we saw earlier to apply a filter on the SLS_PRODUCT_LOOKUP query subject, which had multiple rows for the same product to support multiple languages. Another example might be the requirement to implement aliases in the Physical View to control query paths between objects. If model query subjects are used to create these aliases or to consolidate multiple underlying query subjects, then applying filters and calculations on these query subjects makes sense because they are not data source query subjects.

    4.3.1  Add filters to the model

    The first filter John Walker applies is a filter on a data source query subject. Although adding this filter goes against the general rule of thumb, the filter must be applied a level lower than the Business View layer because the filter is required only when Product Name is included in the report. For example, does it make sense to apply a product name language filter when only querying Product Line? If the filter is place in the Products model query subject in the Business View, the filter would be applied in every instance an item from that query subject was used, regardless of whether it was required. The performance hit of scanning an extra table unnecessarily in such cases is greater than the performance hit that can occur from an additional metadata call to the database.

    Filters come in two forms in IBM Cognos Framework Manager:

    •Embedded filters are created within query subjects and their scope is restricted to that query subject. They are appropriate when the filter is intended for just one query subject or dimension. Embedded filters can be converted to stand-alone filters after they are created.

    •Stand-alone filters are filters available across the model. They are appropriate when required in multiple query subjects or dimensions or to make commonly used filters readily available for authors.

    In the following steps, we apply an embedded filter to the SLS_PRODUCT_LOOKUP data source query subject to filter on English values:

    1.	In the Project Viewer, in the gosalesdw namespace under the Physical View, double-click SLS_PRODUCT_LOOKUP.

    2.	Click the Filters tab, click Add, and then in the Name box, type Language Filter.

    3.	In the Available Components pane, double-click PRODUCT_LANGUAGE.

    4.	Click in the Expression Definition pane at the end of the expression, and then type = ‘EN’. The result displays as shown in Figure 4-60.
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    Figure 4-60   Filter Definition dialog box

    5.	Click OK. The results display as shown in Figure 4-61.
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    Figure 4-61   Embedded filter

    Notice the Usage column beside the Name column. Each filter has a Usage setting with the following options: 

     –	Always 

    The filter is applied in all instances regardless of whether the filtered query item is in the query.

     –	Optional 

    The filter is not mandatory and users can choose to enter a filter value or leave it blank. (This option applies only to filters that use a prompt value or macro.)

     –	Design Mode Only 

    This option limits the amount of data that is retrieved when testing in IBM Cognos Framework Manager or at report design time (when authoring reports in IBM Cognos Query Studio, IBM Cognos Report Studio, and IBM Cognos Business Insight Advanced).

    6.	Click the Test tab, and click Test Sample. The results display as shown in Figure 4-62.
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    Figure 4-62   Test results with filter applied

    7.	Click OK.

    We conduct the same test that we conducted in the previous section between Products and Sales Fact again in the Business View to ensure that the results are as expected.

    8.	In the Project Viewer, in the Business View namespace, select Product Line (formerly PRODUCT_LINE_EN), select Product Name (formerly PRODUCT_NAME) from Products, and select Revenue (formerly SALE_TOTAL) from Sales Target.

    9.	Right-click one of the selected items, and click Test. In the Test Results dialog box, select Auto Sum, and then click Test Sample. The results display as shown in Figure 4-63.

    [image: ]

    Figure 4-63   Test results dialog box

    The overall summary totals in the studios for Product Name are now accurate and are not double counted for each product name language in the data source.

    10.	Click Close.

    We illustrate an example of a stand-alone filter in 4.3.3, “Make the model dynamic using macros” on page 97.

    4.3.2  Add calculations to the model

    You can create calculations to provide report authors with values that they regularly use. For example, you might want to include a product break even value as one of the measures in the Sales Fact query subject in the form of Quantity * Unit Cost.

    Calculations can use query items, parameters, and functions.

    There are two types of calculations:

    •If you want to create a calculation specifically for one query subject or dimension, you can embed the calculation directly in that object. For query subjects, this calculation can be done for either data source query subjects or model query subjects. However, it is recommended that you apply calculations in model query subjects wherever possible. This allows for better maintenance and change management.

    •Create a stand-alone calculation when you want to apply the calculation to more than one query subject or dimension. Stand-alone calculations are also valuable if you need to do aggregation before performing the calculation. This aggregation can be accomplished by changing the stand-alone calculations Regular Aggregate property to Calculated.

    To add an embedded calculation to a model query subject:

    1.	In the Project Viewer, in the Business View, double-click Sales Fact.

    2.	Click Add in the bottom-right corner.

    3.	In the Name box, type Break Even Point, and then double-click Quantity in the Available Components pane.

    4.	Under Available Components, click the Functions tab, expand Operators, and then double-click the multiplication operator (*).

    Notice there is a description of the function in the Tips pane as shown in Figure 4-64.
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    Figure 4-64   Calculation Definition dialog box

    5.	Under Available Components, click the Model tab, and then double-click Unit Cost. The following results display:

    [Business View].[Sales Fact].[Quantity] * [Business View].[Sales Fact].[Unit Cost]

    6.	Click Test Sample (the blue triangle button above the Name box) to verify that the calculation works.

    7.	Click OK, and then click OK again. The new calculated query item displays in the Sales Fact model query subject as shown in Figure 4-65.

    [image: ]

    Figure 4-65   Break Even Point calculation

    4.3.3  Make the model dynamic using macros

    You can modify query subjects and other model properties to control dynamically the data that is returned using a combination of session parameters, parameter maps, and macros. Let us quickly examine each piece.

    •A session parameter returns session information at run time (for example, runLocale or account.UserName).

    •A parameter map is a two-column table, mapping a set of keys (source) to a set of substitution values (target).

    •A macro is a fragment of code that you can insert within filters, calculations, properties, and so on, that are to be evaluated at run time. Macros are enclosed by the number sign (#) character.

    These items can be used to return data dynamically from specific columns or rows or even from specific data sources.

    For the scope of this book, we show one example that incorporates all three elements in an embedded filter. In this example, we alter the filter that was created for the SLS_PRODUCT_LOOKUP query subject. Authors and analysts want to be able to see product names in their language based on their local settings.

    To alter the filter, we import a parameter map. The parameter map substitutes a user’s runLocale session parameter with a language code value found in the database, such as EN for English or FR for French. This substitution is wrapped in a macro that also encloses the substitution value in single quotation marks because the filter expects a string value.

    To implement a macro to change a filter dynamically at run time, follow these steps:

    1.	In the Project Viewer, right-click Parameter Maps, point to Create, and then click Parameter Map.

    The Create Parameter Map wizard opens. You can type in the values if you support only a small set of languages, or you can import the values from a file. You can also base the parameter map on query items within the model. For this exercise, we use a text file that has the mappings already entered.

    2.	In the Name box, type Language_lookup, and then click Next.

    3.	Click Import File. Then, next to the Filename box, click Browse. Navigate to <IBM Cognos BI install location>\webcontent\ samples\models, click Language_lookup.txt, and then click Open.

    4.	Click OK. The values in the file are imported as shown in Figure 4-66.
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    Figure 4-66   Parameter Map values

    Note that en-us (and all other English variants) map to EN. The same mapping applies for other languages and their locales.

    5.	Click Finish.

    6.	In the gosalesdw namespace under the Physical View, double-click the SLS_PRODUCT_LOOKUP query subject.

    7.	Click the Filters tab, and then click the ellipsis (...) in the Source column for the Language Filter. The Filter Definition window opens.

    8.	In the Expression definition pane, remove the EN portion of the expression, and place the cursor after the equal sign (=).

    9.	Under Available Components, click the Parameters tab, and then expand Parameter Maps.

    10.	Double-click Language_lookup to add it to the expression as shown in Figure 4-67.
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    Figure 4-67   Expression definition with macro

    Notice that the parameter map is enclosed in the macro tags (#) automatically. The macro now requires a value to pass to the parameter map for substitution. In this case, the runLocale session parameter is passed to the parameter map.

    11.	Under Available Components, expand Session Parameters, and then double-click runLocale to add it to the expression. Use the following syntax:

    [gosalesdw].[SLS_PRODUCT_LOOKUP].[PRODUCT_LANGUAGE]  = #$Language_lookup{$runLocale}# 

    This syntax still shows that there is an error, indicated by a red squiggly underline. The value that the parameter map returns needs to be wrapped in single quotation marks.

    12.	Place the cursor right after the first macro tag (#), and then type sq(, which is the function for a single quotation mark. You can also find this function in the Functions folder under Available Components.

    13.	Place the cursor just before the last macro tag (#), and then type ). The final syntax displays as shown in Figure 4-68.
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    Figure 4-68   Macro expression for Language Filter

    Notice the results in the Tip pane. This pane shows what the macro resolves to based on the current runLocale. In this case, it is en, which is substituted for EN in the filter.

    14.	Click OK, click the Test tab, and then click Test Sample to ensure that all values come back in your local language.

    4.4  Create dimensional objects for OLAP-style reporting

    The IBM Cognos Framework Manager product allows you to create dimensionally modeled relational (DMR) models. A DMR refers to the dimensional information that a modeler supplies for a relational data source to allow for OLAP-style queries, which allow for navigational functionality and access to dimensional functions in studios that support dimensional functions, such as IBM Cognos Report Studio and IBM Cognos Business Insight Advanced. 

    Dimensional information is defined through the following dimensions:

    •Regular Dimensions

    •Measure Dimensions

    •Scope Relationships

    A dimensionally modeled layer can be applied to any metadata in star schema format. When your metadata is in star schema format, you can provide hierarchy information to dimensions and measure scope for each Regular Dimension created.

    4.4.1  Create Regular Dimensions

    Regular Dimensions consist of one or more user-defined hierarchies. Each hierarchy consists of the following components:

    •Levels

    •Keys

    •Captions

    •Attributes

    Level information is used to roll up measures accurately when performing queries or analyses. Regular Dimensions require that each level have a key and caption specified, and that the caption be a string data type. These items are used to generate members in the studios data trees (where applicable) and retrieve the members at run time.

    The following steps show one example of how to create a Regular Dimension. In this case, we model a Time dimension.

    1.	In the Project Viewer, create a new namespace under Model called Dimensional View.

    2.	Right-click Dimensional View, point to Create, and then click Regular Dimension. The Dimension Definition window opens.

    3.	In the Available items pane, expand Business View → Time, and then drag Year (formerly CURRENT_YEAR) into the Hierarchies pane.

    4.	Right-click the top Year in the hierarchy column, and then click Rename.

    5.	Type Time, and then press Enter.

    6.	Rename Year(All) to Time (All). If needed, rename CURRENT_YEAR to Year. The results display as shown in Figure 4-69.
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    Figure 4-69   Dimension Definition dialog box

    You need to assign a business key and member caption to each level. Remember, a caption must be a string data type. In this case Year is an integer; therefore, you need to create an item to cast Year into a string.

    7.	In the Hierarchies pane, click the Year level in the bottom pane, click the ellipsis (...) in the Role column, and then select _businessKey as shown in Figure 4-70.
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    Figure 4-70   Specify Roles dialog box for Regular Dimension

    8.	Click Close, and then click Add in the bottom-right corner.

    9.	In the Name box, type Year Caption. Then, under Available Components, expand Business View → Time, and drag Year to the Expression definition pane.

    10.	Edit the expression to display as follows:

    cast([Business View].[Time].[Year], char(4))

    This expression casts the integer value to a string.

    11.	Click OK, click the ellipsis (...) for Role for the new Year Caption item, select _memberCaption, and then click Close. The Year level now has a business key and member caption assigned as shown in Figure 4-71.
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    Figure 4-71   Year level roles

    12.	From the Available items pane, drag Quarter Key under the Year level in the Hierarchies pane.

    13.	Rename the level to Quarter, and then assign a Role of _businessKey to Quarter Key in the bottom pane.

    14.	Add a new item for this level called Quarter Caption with the following expression. Note that Quarter (numeric) was formerly CURRENT_QUARTER.

    cast([Business View].[Time].[Quarter (numeric)], char(1))

    15.	Assign the _memberCaption role to Quarter Caption, and then click Unique Level as shown in Figure 4-72.
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    Figure 4-72   Unique Level check box

    The Unique Level check box indicates that the keys in the levels above the current level are not necessary to identify the members in a level. If they are, then leave this check box clear. The top level does not need this setting, because it has no parent keys.

    16.	Drag Month Key below the Quarter level in the Hierarchies pane, rename it to Month, and then assign the _businessKey role to Month Key in the bottom pane.

    17.	Drag Month to the bottom-right pane, select _memberCaption as the role, and then select the Unique Level check box.

    18.	Drag Day Key below the Month level in the Hierarchies pane, and rename it to Day. 

    Notice that the _businessKey role is already assigned to Day Key in the bottom pane, because Day Key is an identifier as it is the primary key in the underlying table.

    19.	Drag Day Date to the bottom-right panel, set it as the _memberCaption, and then rename it to Day Caption.

    20.	Click the ellipsis (...) for the Source column for Day Caption to edit its definition, and change the expression as follows:

    cast([Business View].[Time].[Day Date], char(10))

    21.	Click OK, select Unique Level as shown in Figure 4-73.
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    Figure 4-73   Time dimension hierarchy completed

    For some dimensions, such as the Time dimension, ensure specific sorting of the data in all scenarios to take advantage of dimensional functions that navigate the data. For example, you might want to use the Lag function, which allows you to view the current month and the previous month by lagging one month from the current month in a calculation. For these types of functions to work, the order of the data must be correct and consistent. 

    If your business keys, captions, or attributes are sortable so that there is a logical order to the data, you can use the Member Sort feature for Regular Dimensions to ensure the correct structure for you data.

    22.	Click the Member Sort tab, and then, under Sorting Options, select Metadata, Data, and Always (OLAP compatible) as shown in Figure 4-74.
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    Figure 4-74   Dimension Definition, Member Sort tab

    23.	Click Detect to detect which item will be used in the Level Sort Properties pane to sort the data. In this case, the business keys for the levels are used, as shown in Figure 4-75, which is correct.
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    Figure 4-75   Dimension Definition, Member Sort tab

    For more information about the Member Sort feature, refer to the IBM Cognos Framework Manager User Guide.

    24.	Click OK, and then rename New Dimension to Time as shown in Figure 4-76.
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    Figure 4-76   New Regular Dimension for Time

    The new Time dimension is now complete and when expanded in the Project Viewer displays as shown in Figure 4-77.
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    Figure 4-77   Time dimension expanded in Project Viewer

    Again, if you are feeling adventurous, create a dimension for Products as shown in Figure 4-78, and Order Method as shown in Figure 4-79 on page 110. We include the results in the model that we provide with this book.
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    Figure 4-78   Products dimension configuration
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    Figure 4-79   Order Methods dimension configuration

    4.4.2  Create Measure Dimensions

    A Measure Dimension is a logical collection of facts that enables OLAP-style analytical querying and is related to Regular Dimensions within scope.

    To create Measure Dimensions:

    1.	Right-click Dimensional View, point to Create, and then click Measure Dimension.

    2.	In the Model Objects pane, expand Business View → Sales Fact.

    3.	Click Quantity, Shift+click Break Even Point, and then drag all the selected measures to the Measures pane as shown in Figure 4-80.
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    Figure 4-80   Sales Measure Dimension

    4.	Click OK, and rename the new Measure Dimension to Sales Fact.

    5.	Repeat the steps to create a Measure Dimension called Sales Target Fact that is based on the Sales Target Fact data source query subject in the Business View. Select only the Sales Target measure. The results display as shown in Figure 4-81.
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    Figure 4-81   Sales Fact and Sales Target Fact Measure Dimensions expanded in the Project Viewer

    4.4.3  Define scope for measures

    Measure Dimensions are related to Regular Dimensions through scope relationships that define at what levels a measure is in scope. However, underlying join relationships are still required to generate the SQL that is sent to the data source.

    A scope relationship is created automatically between a dimension and a measure dimension whose underlying query subjects have a valid JOIN relationship defined and are required to achieve predictable roll ups.

    To define the scope of a measure or group of measures, you can use the Dimension Map in the Project Info pane.

    To define the scope for the Sales Fact and Sales Target Fact Measure Dimensions:

    1.	Double-click the Dimensional View namespace to give it focus. Notice the scope relationships as shown in Figure 4-82.
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    Figure 4-82   Scope relationships

    You can double-click the relationships to edit scope. However, in our example, we use the Dimension Map because it is a central location to define scope easily for all measures. You can also create, edit, and delete Regular Dimensions and Measure Dimensions in this pane.

    2.	In the middle pane, click the Dimension Map tab, and then click Sales Fact in the Measures pane, as shown in Figure 4-83.
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    Figure 4-83   Sales Fact scope

    All levels in all dimensions are highlighted indicating that they are all currently in scope, which is correct for the Sales Fact measures. However, this is not the case for Sales Target Fact, which is at the Month level for the Time dimension and Product Type level for the Products dimension. Sales Fact is also not in scope at all for the Order Methods dimensions. We set the appropriate scope for the Sales Target measure.

    3.	Click Sales Target Fact, under Time click the Month level, and then on the toolbar click the Set Scope icon as shown in Figure 4-84.
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    Figure 4-84   Set Scope toolbar icon

    4.	Click Product Type in the Products dimension, and then click Set Scope on the toolbar.

    5.	Click the Order Methods dimension, and then on the toolbar click the Remove Scope icon (shown in Figure 4-85).
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    Figure 4-85   Remove Scope toolbar icon

    As shown in Figure 4-86, the Day level for the Time dimension and the Product Name level for the Products dimension are no longer highlighted and are out of scope for Sales Target Fact. The Order Methods dimension is completely out of scope.
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    Figure 4-86   Scope settings for Sales Target Fact

    6.	Now that the dimensional objects are created and scope is set, we create a presentation view for authors and analysts. In the Project Viewer, right-click Presentation View, point to Create, and then click Namespace.

    7.	Name the new namespace Query.

    8.	Create another namespace, and name it Analysis.

    These namespaces are used to organize the relational and dimensional presentation views.

    9.	Drag the Sales Target and Sales namespaces into the Query namespace. The results display as shown in Figure 4-87.
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    Figure 4-87   Presentation View organized

    Next, create star schema groupings for the DMR objects and place them in the Analysis namespace.

    10.	In the Dimensional View, right-click Sales Fact, and then click Create Star Schema Grouping. The result displays as shown in Figure 4-88.
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    Figure 4-88   Create Star Schema Grouping dialog box

    The Measure Dimension and all related Regular Dimensions are selected automatically based on the scope relationships.

    11.	Click OK, and then repeat these steps to create a star schema grouping for Sales Target Fact.

    12.	Drag the two new star schema grouping namespaces to the Analysis namespace. The final Presentation View displays as shown in Figure 4-89.

    [image: ]

    Figure 4-89   Final Presentation view

    4.5  Create and configure a package

    Up to this point, we have imported, validated, modeled, and organized metadata to address the requirement to report and analyze sales and sales target information by products, time, and order methods. This modeling was done for both traditional relational reporting (query) and OLAP-style reporting (analysis) using DMR. The next step is to publish packages to IBM Cognos Connection to make both the query package and analysis packages available to authors and analysts.

    You create packages, which are a subset of your model, to make metadata available to users. A package must contain all the information that a specific user or group of users needs to create reports. Each report can contain information from a single package only.

    To create packages:

    1.	In the Project Viewer, right-click the Packages folder, point to Create, and then click Package.

    2.	In the name box, type GO Sales DW (Query), and click Next.

    3.	Clear the Model namespace, expand Presentation View → Query, and select Sales Target and Sales as shown in Figure 4-90.
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    Figure 4-90   Create Package, Define objects dialog box

    4.	Click Next, and then choose the set of functions that you want to be available in the package. 

    By default, all function sets are included unless you specify which function set is associated with a data source in the Project Function List dialog box located in the Project menu.

    5.	Click Finish. 

    6.	When prompted to launch the Publish Package wizard and publish your package to the server, click Yes.

    7.	In the Select Location Type dialog box, select a location where you want to publish your package. We leave the default location of Public Folders, but you can browse to any location in IBM Cognos Connection to which you have write access.

    8.	Clear Enable model versioning. 

    This option is checked by default. It allows you to keep multiple copies of a model on the server, which can be useful if you want to publish a new version of the model but want existing reports to continue using an earlier copy. Note that all new reports that you author always use the most recent version of a published model. Opening an existing report in one of the studios will also cause the report to become associated with the latest version of the model.

    9.	Click Next.

    10.	Specify who has access to the package. Use the Add and Remove buttons to specify which groups or roles will have access to the package. When you have finished adding security, click Next.

    We discuss security in more detail in 4.6, “Apply security in IBM Cognos Framework Manager” on page 124.

    11.	To verify your package before publishing, ensure that the “Verify the package before publishing” option is selected. Click Publish.

    When this option is selected, IBM Cognos Framework Manager performs a validation of your package and alerts you to any potential issues.

    12.	Click Finish to close the Publish Wizard.

    Informational warnings that might display indicate that items in the package reference other items in the model and that those items are included in the package as well but are hidden from authors.

    13.	Click Close.

    14.	Repeat these steps to create and publish a package called GO Sales DW (Analysis). Select only the Sales Target Fact and Sales Fact namespaces in the Analysis namespace as shown in Figure 4-91.
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    Figure 4-91   Create Package, Define objects dialog box

    The packages are now available in IBM Cognos Connection, as shown in Figure 4-92, and are ready for use by authors in one of the studios.
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    Figure 4-92   IBM Cognos Connection, Public Folders

    Figure 4-93 shows the GO Sales DW (Query) package in IBM Cognos Report Studio.
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    Figure 4-93   IBM Cognos Report Studio, Insertable Objects pane

    This package displays query subjects and query items for use in studios that support relational only packages.

    Figure 4-94 shows the GO Sales DW (Analysis) package in IBM Cognos Report Studio.
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    Figure 4-94   IBM Cognos Report Studio, Insertable Objects pane

    With this package, you can work with hierarchies, levels, members, attributes, and measures. This package allows for OLAP-style queries on a relational data source.

    4.5.1  Analyze publish impact

    Before you publish your package, you can see how the changes that you make to a model will affect the package and any reports that use it. You can see details about each change that was made to the package and which reports are affected by a specific change.

    Reports that are authored using the package can be impacted by changes that you make to the model. For example, adding a new object to the model will not affect any existing reports. Changing the name of a query item in the model or deleting a query item does affect a report. The report definition will not be valid because the query item that it references is not in the package definition. It is important to note that changes to the model do not impact reports until the package is republished. Reports use the published package, so your changes do not have any impact until the package is republished.

    The analysis is done on objects that a package uses directly as well as the underlying objects. For example, you have a model query subject that references a data source query subject. If you change the model query subject, it appears as a modified object in the analysis results. If you change the underlying data source query subject, it also appears as a modified object in the analysis results.

    The following types of objects are analyzed: 

    •Query subjects

    •Query items

    •Measures

    •Regular dimensions

    •Measure dimensions

    •Hierarchies

    •Levels

    •Stand-alone filters

    •Stand-alone calculations

    To analyze a publish impact:

    1.	In the Project Viewer, click a package that was published.

    2.	From the Actions menu, click Package → Analyze Publish Impact.

    3.	The results of the analysis display, and you can choose to search for dependant reports. You can then take whatever action is necessary.

    4.	When you are finished, click Close to close the Analyze Publish Impact dialog box.

    4.6  Apply security in IBM Cognos Framework Manager

    This section discusses security at a high level. We do not implement security in our model directly but discuss generic steps about how to apply security.

    In IBM Cognos Framework Manager, security is a way of restricting access to metadata and data. There are three different types of security in IBM Cognos Framework Manager:

    •Object level security allows you to secure an object directly by allowing or denying users access to the object, or keeping it hidden from all users.

    •Row level security allows you to create a security filter and apply it to a specific query subject. This level of security controls the data that is shown to the users when they build and run their reports.

    •Package level security allows you to apply security to a package and identify who has access to that package.

    Each type of security relies on users, groups, and roles to define access. Before you add security in IBM Cognos Framework Manager, ensure that security was set up correctly in IBM Cognos BI.

    4.6.1  Object level security

    You can apply metadata security directly to objects in a model. When you add object-based security, you apply a specific user, group, or role directly to the object. In doing so, you choose to make the object visible to the select users or groups.

    If you do not set object-based security, all objects in the model are visible to everyone who has access to the package. The object inherits the security that was defined for its parent object. When you explicitly allow or deny access to an object, you override the inherited setting. When you apply security to a parent object, all of the child objects inherit the security settings. After you set security for one object, you must set it for all objects. You can set security for all objects by setting security on the root namespace.

    You might want an object to be visible only to one selected group or role. For example, in your project you might have a Salary query subject. You might want this query subject visible to a Manager role but not visible to an Employee role.

    If a user is a member of multiple groups or roles and if one group is allowed access to an object and another is denied access, the user will not have access to the secured object. In cases of conflicting access, the denied access group or role membership will have priority.

    There are two basic approaches to implementing object level security in your model:

    •Allow access to all objects and then restrict access to certain objects as required

    •Restrict access to all objects and then grant access as required

    To add object level security:

    1.	Click the object that you want to secure, and from the Actions menu, click Specify Object Security.

    2.	Select the users, groups, or roles that you want to change. You can also click Add to add new users, groups, or roles.

    3.	Specify security rights for each user, group, or role by completing one of the following steps:

     –	To deny access to a user, group, select Deny next to the name of the user, group or role. Remember that Deny takes priority over Allow.

     –	To grant access to a user, group or role, select Allow.

    4.	Click OK.

    To remove object level security from the model:

    1.	In the middle pane, click Explorer.

    2.	In the Project Viewer, double-click the Packages folder to give it focus in the Explorer. A list of all packages and any security objects that are applied in the model display.

    3.	Select any of the security objects that you want to remove from the model, and click Delete.

    4.6.2  Row level security

    You can restrict the data that is returned by query subjects in a project by using security filters. A security filter controls the data that is shown to users when they author their reports.

    For example, sales managers at the Great Outdoors company want to ensure that Camping Equipment sales representatives see only orders that relate to the Camping Equipment product line. To accomplish this, create and add members to a Sales Managers and Camping Equipment Reps groups. Then apply a security filter to the Products query subject to restrict their access to camping equipment data.

     

    
      
        	
          Multiple groups or roles: If a user belongs to multiple groups or roles, the security filter that is associated with these roles are joined together with ORs. If a group or role is based on another group or role, the security filters are joined together with ANDs.

        
      

    

    To specify row level security:

    1.	Click the query subject with which you want to work, and from the Action menu click Specify Data Security.

    2.	To add new users:

    a.	Click Add Groups.

    b.	In the Select Users and Groups window, add users, groups, or roles.

    c.	In the Select Users and Groups window, click OK.

    3.	If you want to base the group on an existing group, click the Based On column.

    4.	If you want to add a filter to a group, in the Filter column, click either Create/Edit Embedded filter or Insert from Model. These options allow you to either select an existing filter from your model to use or define the expression for a new filter.

    4.6.3  Package level security

    Package access refers to the ability to use the package in one of the IBM Cognos BI studios or to run a report that uses the package from IBM Cognos Connection. Users without these permissions are denied access, although they can still view saved report outputs if they have access to the reports. You can also grant administrative access to packages for those users who might be required to republish a package.

    You define package level security during the publish process the first time the package is published.

    To modify access to your package after it has been published:

    1.	Click the package that you want to edit, and from the Actions menu click Package → Edit Package Settings to invoke IBM Cognos Connection in a new window.

    2.	In IBM Cognos Connection, click the Permissions tab.

    3.	Create, add or remove groups or roles as required.

    4.	After you modify the package access permissions, click OK to return to IBM Cognos Framework Manager.

    4.7  Model troubleshooting tips

    This section provides some tips for troubleshooting your models.

    4.7.1  Examine the SQL

    When testing query objects in IBM Cognos Framework Manager, you can view the SQL that is generated for the query on the Query Information tab. Viewing this information can be a useful way to verify expected results and can be a valuable troubleshooting technique to help you debug a model. 

    In particular, you can verify query path and join conditions and determine if elements of the query are being processed locally by comparing the Cognos and Native SQL. Items that appear in the Cognos SQL but are not replicated in the Native SQL indicate that additional processing of the data is required on the IBM Cognos servers. This issue might be due to unsupported functions in the vendor database.

    You can also select the Response sub-tab in the Query Information tab to view the request and response sequence to and from the data source. Any warning or error messages generated are recorded here.

    To test a query and examine the generated SQL:

    1.	Right-click a query subject or multiple selected query items, and click Test.

    2.	Test the results, and then click the Query Information tab to view the SQL generated for the query as shown in Figure 4-95.
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    Figure 4-95   Query Information tab

    3.	To view the request, the response, and any warning messages that were generated, click the Response tab, as shown in Figure 4-96.
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    Figure 4-96   Response tab

    4.7.2  Object dependencies

    You can find objects easily that depend on other objects or show the dependencies of a child object. To determine object dependencies:

    1.	In the Project Viewer, click an object.

    2.	From the Tools menu, click Show Object Dependencies. The objects that depend on the selected object display under Dependent objects.

    3.	To show the object identifier for the dependent objects, select Show Object ID.

    4.	If the selected object has children and you want to see the dependencies for a child object, click the plus sign (+) beside the object that contains the child object.

    5.	Click a child object under the parent object. The objects that depend on the child object display under Dependent objects.

    You can also show object dependencies using the following methods:

    •Use the Project Viewer by right-clicking an object and selecting Show Object Dependencies.

    •Use the Context Explorer window by right-clicking an object and selecting Show Object Dependencies.

    •Use the Analyze Publish Impact window by clicking the Show Dependencies icon under Actions in the row that contains the object.

    4.7.3  Search the model

    When working with a large project, it can be difficult to locate the objects that you need to complete a task. Use the Search tab to find objects quickly by applying different search criteria, such as the location, the class, a condition, or a property.

    If the Tools pane is not visible, from the View menu, click Tools. You can drag the Tools pane to the bottom of the IBM Cognos Framework Manager window and resize it to have a better view of the search results.

    To search the model:

    1.	In the Tools pane, click the Search tab.

    2.	In the Search String field, type the text that you want to find.

    You can use uppercase, lowercase, or mixed case strings. The search is not case sensitive. Valid wildcard characters are an asterisk (*) and a question mark (?).

    3.	Click the double down arrow button to show the search criteria boxes.

    4.	In the “Condition” list, select a condition to apply to the search string.

    The Condition box determines how the Search string value is matched with text in the model. It contains a list of possible search conditions. If you want to search using wildcard characters, use the equals condition.

    5.	In the “Search in” list, select the part of the model hierarchy that you want to search.

    6.	In the “Class” list, select the single class of objects that you want to search.

    7.	In the “Property” list, select the type of property that you want to search.

    The (All Properties) property searches all properties. The Object Name property restricts the search to the name of each object. The Text Properties property searches the set of properties that contain text strings, such as Description or Screen Tip, but not the object name.

    8.	Click Search.

    The results are listed at the bottom of the Search tab. After you do one search, the Subset check box becomes available. If you select Subset, the next search operates on the existing search results. The Subset option is cleared after each search.

    9.	To see an object in the Project Viewer, click an object in the Search tab.

    10.	To see an object in the diagram, right-click an object in the Search tab, and click Locate in Diagram.

    Now that you have seen the basics of developing a simple IBM Cognos Framework Manager model, it is a good idea to augment this knowledge with formal training to ensure the success of your IBM Cognos BI project.

    The model that we describe in this chapter is just a small subset of the more robust sample models that ship with the product. For the remainder of the book, we use the sample models that ship with the product to demonstrate authoring business intelligence reports and analysis in IBM Cognos BI.
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Business intelligence simplified
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Business intelligence simplified: An overview

    In Chapter 4, “Create reporting packages with IBM Cognos Framework Manager” on page 33, we discussed metadata modelling, which creates packages to include all that information that you need for reporting purposes. In this chapter, we discuss how to deliver this information to users to help them answer key business questions. 

    Companies today have various applications that produce large amount of data. In addition, they have access to information outside their companies, such as data about their competition, and information from websites. It can be a challenge to transform all this data into complete, meaningful information therefore providing business intelligence. Business users want to have freedom to combine and explore information, to have a unique perspective on data, and at the same time to collaborate with other members of the team.

    As an introduction to how to achieve a successful business intelligence solution, we discuss the following topics in this chapter:

    •Information delivery leading practices

    •Enabling access for more people

    •Business use case

    5.1  Information delivery leading practices

    The IBM Cognos Business Intelligence (BI) product provides a unified, interactive workspace for business users to create their view on data by combining all types of information and to personalize content to provide unique insights and to deliver faster business decisions.

    With IBM Cognos Business Insight, business users can use flexible dashboards and reports. Business users can customize existing dashboards and change them in a way that answers their question or they can build completely new dashboards. From the user perspective, a dashboard needs to be an uncluttered display of relevant data, that provides an at-a-glace view of business performance with a simple and visually compelling way of presenting data.

    To achieve this goal, consider the following recommended approaches:

    •Use reports that focus on data that is of interest to the user. 

    The IBM Cognos Business Insight workspace is designed to allow a user to focus on an area for analysis, unlike production reporting, which is typically static in nature. Therefore, reports that are added to a dashboard are focused and summarized. You can include any report in IBM Cognos Business Insight. However, detailed reports with which the user does need to interact should not be included in an IBM Cognos Business Insight workspace.

    •Use saved output or views. 

    With IBM Cognos Business Insight, you can use saved output as part of the workspace. If saved output is included in a dashboard, users can change the version that they want to see, set the dashboard to open with the latest version, or execute the report.

    •Use atomic-level reports or purpose built parts.

    When creating a new report for a dashboard, build reports at an atomic level, so that a report contains one object, such as a list or chart. Turn off the headers and footers, because they can confuse the consumer. Keep reports and report parts that are candidates to be included in IBM Cognos Business Insight workspace in a specific series of folders so that they can be found easily. 

    •Change the default names of parts or components. 

    Each of the parts or components in a report has a default name. For Lists, the default name is typically List1 or, if two lists are in the report List1 and List11. A good practice is to change the default names to a name that is more meaningful to users. Prompts do not have a default name and, as such, do not display in a Content unless you give them a name. 

    •Do not overwhelm users with charts.

    When using a chart to represent the data, display only the data that is relevant for the users. For example, avoid multi-color backgrounds or third-dimensions added to bars or lines unless these features provide meaningful information.

    •Reuse prompts.

    You can use one prompt to apply the same filter to more than one report on the workspace. For example, if a report contains a date prompt, you can use that prompt to apply a filter to that report only. Alternatively, the other reports that have dates, for example the year, can respond to a year selected from the first report, as long as they share the same caption or dimension.

    •Use My Favorites.

    For quick access to the dashboards that you use on a regular basis, add them to My Favorites. After you save them, you can open the favorite dashboard or report from the Getting Started Page or the Content tab.

    •Use workarounds for the dashboard printing.

    You cannot print a dashboard directly from IBM Cognos Business Insight. However, you can save a report widget to a PDF file and then print the PDF file, or you can press Ctrl+P to use the web browser to print the information that is displayed on the screen.

    •Use multiple dashboards.

    If you want to see multiple dashboards at the same time, use the multi-tab option of the web browser. For that purpose, you need to open IBM Cognos Business Insight in chrome mode (with the web browser showing toolbars and menus). 

    •Avoid overlapping hidden widgets, and use appropriately-sized widgets.

    Widgets can get “hidden” under other widgets, so try not to overlap them. Also, do not make a widget bigger than it needs to be. Use the “Fit all Widgets to Window” option after you add all the widgets to the dashboard.

    •Use mobile support.

    When using a web page in a workspace, try using the URL and adding /m to the URL to get the mobile version (for example, www.ibm.com/m). This option typically renders smaller results that fit better in a workspace.

    You can create several different types of reports and then use them in the dashboard. In the next sections, we discuss each of these reports in detail.

    5.1.1  List reports

    A list report is a type of report that displays detailed information, such as product orders or a customer list. Figure 5-1 shows an example of a simple list report. 
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    Figure 5-1   Simple list report

    A list report shows data in rows and columns, where each column shows all the values for that item in the database. You can also group data in a list report by one or more columns, add summaries, or include headers or footers to provide additional information.

    5.1.2  Crosstabs

    Like list reports, crosstab reports (also called matrix reports) are reports that show data in rows and columns. However, the values at the intersection points of rows and columns show summarized information rather than detailed information. Figure 5-2 shows a crosstab report.
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    Figure 5-2   Crosstab report

    You can create a nested crosstab by adding more than one item to rows or columns, or you can report on more than one measure. You can add any data that can be aggregated to the body of the crosstab as a measure. Measures define that data is reported, such as revenue, quantity, or as in Figure 5-2, return quantity.

    5.1.3  Charts

    Charts are the visual representation of quantitative information. They reveal trends and relationships between values that are not evident in lists or crosstab reports. For example, you can create a report that visually compares actual sales and planned sales or that shows the percentage share of product lines in the total revenue of the company.

    IBM Cognos BI includes the following chart types:

    •Column charts

    •Line charts

    •Pie charts

    •Bar charts

    •Area charts

    •Point charts

    •Combination charts

    •Scatter charts

    •Bubble charts

    •Bullet charts

    •Gauge charts

    •Pareto charts

    •Progressive charts

    •Quadrant charts

    •Marimekko charts

    •Radar charts

    •Win-loss charts

    •Polar charts

    In the next sections, we discuss the various chart types and give suggestions about when to use each of them.

    Column and bar charts

    These charts show trends over time or compare discrete data. Column charts present data using vertical objects, and bar charts use horizontal objects. These charts make it easy to compare individual values just by comparing the heights or lengths of two bars. This type of chart is useful when you want to see how individual values are ranked from highest to lowest level where sorted column or bar charts are best.

    Figure 5-3 shows a simple column chart.
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    Figure 5-3   Simple column chart

    You can use more complex bar or column charts to display part-to-whole relationships as a stacked bar chart, as shown in Figure 5-4.
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    Figure 5-4   Stacked bar chart

    Line, area, and point charts

    Line charts are similar to column charts, but instead of using columns they plot data at regular points and connect them by lines. If you are interested only in a trend line but not individual values or when you are comparing many data series, this chart is a good choice. For example, Figure 5-5 shows the distribution of gross profit over all the months in a year for different order methods.
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    Figure 5-5   Line chart

    You can accomplish the same result with the area chart where, instead of having lines, areas below the lines are filled with colors or patterns. Figure 5-6 shows the line chart shown in Figure 5-6 as an area chart.
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    Figure 5-6   Area chart

    As for column and bar charts, you can use complex area charts (stacked area charts) to show the relationship of parts to the whole. Typically, it is best not to use stacked line charts because they are difficult to distinguish from unstacked line charts when there are multiple data series.

    Another variation of a line chart is a point chart. A point chart is similar to a line chart, but the points on the chart are not connected with lines. Just the data points are shown. Figure 5-7 shows an example of a point chart.
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    Figure 5-7   Point chart

    Combination charts

    Combination charts are a combination of the charts mentioned previously. They plot multiple data series using columns, areas, or lines all within one chart. They are useful for highlighting relationships between the various data series. Figure 5-8 shows a combination chart that displays revenue and gross profit for marketing campaigns.
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    Figure 5-8   Combination chart

    Scatter, bubble, and quadrant charts

    Scatter and bubble charts plot two measures along the same scale. Their purpose is to show correlations between two sets of data (measures). For example, Figure 5-9 shows the relationship between quantity sold and return quantity for each product line. 
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    Figure 5-9   Scatter chart

    Using this chart makes it easy to discern the following patterns:

    •Linear trends: Either positive trends (points are going up from left to right in a pattern that looks like a line) that indicate a positive correlation between two measures or a negative trend (points are going up from left to right)

    •Non-linear trends: Points in a pattern to form a curved line, indicating positive or negative correlation

    •Randomness: Points arranged randomly, indicating that there is no correlation between two measures

    •Concentrations: Points appear in particular area of the chart, for example in upper-left corner, which indicates many product or product lines with a small number of items sold and a high number of returns

    •Exceptions: Points stand out from the remaining pattern, indicating anomalies, as in the previous chart example

    In this chart, the Outdoor Protection product line has a higher number of returns than other product lines.

    Bubble charts are similar to scatter charts but contain one additional piece of information—the size of the bubble represents the third measure. These charts are used usually for showing financial data. Note that bubble charts are not supported for Microsoft Excel output.

    You can create more complex bubble (or scatter) charts by adding a forth measure to the chart by specifying that the data point appears in different colors based on that measure. 

    Figure 5-10 shows an example of a chart with a correlation between Unit Sale Price and Unit Cost. The size of the bubbles shows the Gross Profit and the color of the bubbles shows whether the quantity is less than 1,000,000 (red) between 1,000,000 and 20,000,000 (yellow) or greater than 20,000,000 (green).
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    Figure 5-10   Bubble chart

    Quadrant charts are in fact bubble charts with a background that is divided into four equal sections. Legacy quadrant charts use baselines to create quadrants, and current default charts use colored regions. You can change the size of the quadrants.

    You can use quadrant charts to present data that can be categorized into quadrants, such as strengths, weaknesses, opportunities, and threats (a SWOT) analysis.

    Figure 5-11 shows an example of the quadrant chart.
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    Figure 5-11   Quadrant chart

    Pie and donut charts

    Pie and donut charts are used to show the relationship of parts to the whole by using segments of a circle. To show actual values, a stacked bar chart or a column chart (as shown in Figure 5-4 on page 140) provides a better option. Also, pie charts are not a good choice for a chart if you have measures that have zero or negative values.

    Figure 5-12 shows a pie chart showing proportions of advertising costs.
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    Figure 5-12   Pie chart

    Note that reports in PDF format or HTML format show a maximum of 16 pie charts.

    Bullet charts

    Bullet charts are one variation of a bar charts. Bullet charts shows a primary measure, as in Figure 5-13, in comparison to one or more other measures. It also relates the compared measures against colored regions in the background that provide additional qualitative measurements, such as good, satisfactory, and poor.
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    Figure 5-13   Bullet chart

    Because they deliver compact information and do not need too much space on a dashboard, you can add bullet charts to other report objects, such as list reports as shown in Figure 5-14.
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    Figure 5-14   Combination of a bullet chart and a list report

    Gauge charts

    Gauge charts (also known as dial charts or speedometer charts) are similar to bullet charts in that they also compare multiple measures but use needles to show values. Reading a value from a gauge chart is as easy as reading a value on a dial, and each value is compared to a colored data range. 

    Gauge charts are a better option than a bullet chart in the case where you need to compare more than two values (measures). 

    These charts are usually used to show the KPIs in executive dashboards. Note that PDF output and HTML output of reports are limited to show up to 16 gauge charts. These charts are not available for Microsoft Excel output.

    Figure 5-15 shows how to compare three measures (product cost, planned revenue, and revenue) on the same gauge chart.
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    Figure 5-15   Gauge chart

    Pareto charts

    Pareto charts rank categories from the most frequent to the least frequent. They include a cumulation line that shows the percentage of the accumulated total of all the columns or bars.

    You can use these charts for quality control data, so that you can identify and reduce the primary cause of problems. You can create before and after comparisons of Pareto charts to show the impact of corrective actions.

    Figure 5-16 shows an example of a Pareto chart showing the gross profit (in millions) for regions by product lines.
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    Figure 5-16   Pareto chart

    Progressive column charts

    Progressive charts (or waterfall charts) are a variation of column or stacked charts, with each segment of a single tack displaced vertically from the next segment. Progressive charts, as well as stacked bar or column charts and pie charts, are useful for emphasizing the contribution of the individual segments to the whole. These charts are not supported for Microsoft Excel output.

    Figure 5-17 shows the contribution of each Product Line to Gross Profit (in millions).
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    Figure 5-17   Progressive chart

    Marimekko charts

    Marimekko charts are stacked charts in which the width of a column is proportional to the total of the column’s values. Individual segment height is a percentage of the respective column total value.

    Figure 5-18 shows the contribution of return quantity of returned items for product lines by order methods.
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    Figure 5-18   Marimekko chart

    Radar charts

    Radar charts compare several values along multiple axis that start at the center of the chart forming a radial figure. These charts are useful if you want to compare a couple of variations against the same set of variables or to compare multiple measures. This type of chart is also useful for spotting anomalies or outliers.

    Figure 5-19 shows an example of a radar chart that compares revenue by product lines for different retailers.
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    Figure 5-19   Radar chart

    Win-loss charts

    Win-loss charts are microcharts that use the following measures: 

    •The default measure

    •The win-loss measure

    The win-loss measure is the measure or calculation that you define. You can also define the default measure, if necessary. You can use these charts for visualizing the win-loss trends, for example the months that have revenue over a certain threshold, as shown in Figure 5-20.
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    Figure 5-20   Win-loss chart

    Polar charts

    Polar charts are circular charts that use values and angles to show information as polar coordinates. 

    Figure 5-21 shows the revenue and quantity for each product line. The distance along the radial axis represents quantity, and the angle around the polar axis represents revenue.
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    Figure 5-21   Polar chart

    Baselines and trendlines

    Baselines or trendlines provide additional details on a chart. Baselines are horizontal or vertical lines that cut through a chart to indicate major divisions in the data. For example, you can add a baseline to show a sales target (see Figure 5-22) or break-even point. Each baseline represents a value on an axis.
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    Figure 5-22   Example of baseline added to a chart

    Baseline options (depending on the type of chart where baselines are available) include:

    •Numeric value: Static numeric value

    •Mean: Statistical mean plus or minus a number of standard deviations based on all charted data values on the specified axis

    •Percentile (%): Specified percentile

    •Percent on Axis (%): Percentage of the full range of the axis

    Trendlines graphically illustrate trends in data series and are commonly used when charting predictions. A trendline is typically a line or curve that connects or passes through two or more points in the series, displaying a trend. You can add trendlines to bar, line, area, bubble, and scatter charts. 

    Figure 5-23 shows an example of adding a polynomial trendline to a chart displaying revenue by product lines over time to see the trend.
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    Figure 5-23   Example of a trendline added to a chart

    The following trendlines are available:

    •Linear, for data values that increase or decrease along a straight line at a constant rate (for example revenue that increases over time period)

    •Polynomial, for data values that both increase and decrease (as in example in Figure 5-23)

    •Logarithm, for data values that increase or decrease rapidly and then level out 

    •Moving average, for data values that fluctuate and you want to smooth out the exceptions to see trends

    5.2  Enabling access for more people

    IBM Cognos BI includes features to create reports that are more accessible to people with a physical disability, such as restricted mobility or limited vision.

    Major accessibility features in IBM Cognos Business Insight are:

    •Use of command keys or shortcut keys to navigate through the workspace. Shortcut keys directly trigger an action. IBM Cognos Business Insight uses both Microsoft Windows navigation keys (such as F1 for online help or Ctrl+C and Ctrl+V for copy and paste) and application-specific shortcut keys. For a complete list of supported shortcut keys, refer to IBM Cognos Business Insight User Guide.

    •IBM Cognos Business Insight uses Web Accessibility Initiative - Accessible Rich Internet Applications (WAI-ARIA). WAI-ARIA ensures that people with limited vision can use screen-reader software along with a digital speech synthesizer to listen to displayed information.

    •IBM Cognos Business Insight supports your system’s display settings, such as a high-contrast display.

    5.3  Business use case

    Chapter 3, “Business scenario and personas used in this book” on page 21 describes the fictitious Great Outdoors company scenario that we use throughout this book. 

    In the following chapters, we address some questions from the Great Outdoors executives and provide relevant information to help them get better insight into their business performance and ultimately get better decisions:

    •Are we selling the right products, do we need to discontinue some products?

    The Great Outdoors company does not manufacture its own products. It sells products from third-party manufacturers to resells. What are the Great Outdoors company’s lowest selling products? Are we making a profit by selling these products?

    •Are we increasing our gross profit (margin)?

    Can we compare gross profit by all the Great Outdoors company regions? And by all product lines? Which product lines are best performing so we can concentrate on them in all regions?

    •Do we have a considerable number of product returns?

    We want to see the quantity of returned products by product lines? Can we compare that with the quantity that was sold to see the percentage of returned items? Do we have some outliers among products with the higher percentage of returns? Maybe we need to consider another manufacturer for these products?

    •How many units of a product should I buy for each period of the year?

    Can we predict how many units of each product that Great Outdoors company has to buy to satisfy the needs of the market? Can we make that prediction based on the historical data?

    •How is the performance of our business against last year?

    We want a report on which we can compare current revenue data with the data from previous years. 

    •How are we doing compared to the plan (actual versus planned)?

    Can we compare our revenue with the planned revenue? Can we add some visual representation in a form of charts to get an immediate insight just by taking a quick view of a report?

    •Could we add some information about our competitors?

    Can we include data from external sources, such as the internet, to our dashboards? Or information about our competitors that is publicly available? Or reports from a stock exchange or currency exchange rates from a bank internet site?

    •How successful are our promotions?

    The marketing department is responsible for organizing campaigns and promotions. We need a deeper insight into profitability of these campaigns. We need information about achieved revenue and profit. What are the most successful campaigns? Maybe we can focus on them in all Great Outdoors company regions?
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Individual and collaborative user experience

    In this chapter, we introduce IBM Cognos Business Insight, the web-based interface that allows you to build sophisticated, interactive dashboards that provide insight and that facilitate collaborative decision making.

    In this chapter, we discuss the following topics:

    •Dashboard overview

    •Introduction to IBM Cognos Business Insight

    •Interaction with the dashboard components

    •Collaborative business intelligence

    6.1  Dashboard overview

    Dashboard is a term that is used commonly in the context of business analytics and that is a popular way of presenting important information. Different users have different understandings of what a dashboard is and how it should look, based on their business needs. Nevertheless, properties that are in common for all dashboards can be summarized in following key features:

    •At-a-glace view of business performance

    A dashboard is a visual display of the most important information about business performance. For business users, a dashboard is the key to understanding trends or spotting anomalies in performance. Information is consolidated and arranged in a way that makes it easy to monitor.

    •Interactivity and personalization

    A dashboard is more than just a static set of reports. It has to be intuitive and interactive to allow business users to personalize content to fit their needs. Business users can use a free-form layout to add dashboard elements such as reports, images, RSS feeds, textual objects, or slider filters. In addition, they can interact with reports to sort or filter data, to add additional calculation, and to change list or crosstab reports to a chart or vice versa.

    •Pro activity and collaboration 

    Business users can take action directly from within the dashboard using collaboration and workflow integration. They can collaborate with team members to make decisions.

    •Assembling information from various different sources

    Dashboards combine data from various different data sources (enterprise resource planning systems, customer relationship management, data warehouses, different data marts, and so forth) to give users a complete view on business performance.

    •Visibility on non-business intelligence content

    In addition to a variety of reports, dashboards can contain non-business intelligence data, such as websites or RSS feeds.

    6.2  Introduction to IBM Cognos Business Insight

    IBM Cognos Business Insight is a web-based user interface that allows you to open or edit a dashboard or to create a dashboard. 

     

    
      
        	
          No read-only dashboards: You cannot create a read-only version of a dashboard. If a business user has permission to access a particular dashboard, that user can also make changes to it.

        
      

    

    You can launch IBM Cognos Business Insight using one of the following methods: 

    •From the IBM Cognos Business Intelligence (BI) Welcome page

    •From IBM Cognos Connection by clicking New dashboard or by clicking the hyperlink of an existing dashboard object

    •From the Launch menu in IBM Cognos Connection and IBM Cognos Administration

    •Directly in web browser by entering a URL using the following format:

    http://machinename/ibmcognos/cgi-bin/cognos.cgi?b_action=icd

    You can open an IBM Cognos Business Insight interface in two modes:

    •Chrome mode

    •Chromeless mode

    Chrome mode includes the toolbars and menus of a web browser, and chromeless mode does not these elements.

    When you launch IBM Cognos Business Insight directly in a web browser by entering a URL, it opens in chrome mode. If you use any of the other options to launch IBM Cognos Business Insight, it opens in chromeless mode.

    Figure 6-1 shows the user interface.
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    Figure 6-1   Business Insight user interface

    The user interface has the following components: 

    •A Getting Started page that displays when you launch IBM Cognos Business Insight

    •An application bar

    •A dashboard layout area 

    •A content pane that includes the Content and Toolbox tabs

    •Widgets and filters

    6.2.1  The Getting Started page

    Figure 6-2 shows the page that opens when you launch IBM Cognos Business Insight.
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    Figure 6-2   The Getting Started page

    You can complete the following activities from this page:

    •Create a new dashboard

    •Open an existing dashboard

    •View and open favorite dashboards from Favorites

    •View how-to videos that provide an overview to Business Insight

    When you select any of the options on the Getting Started page, the page closes. If you do not want this page to display when you launch IBM Cognos Business Insight, disable it using the My Preferences menu option.

    6.2.2  Application bar

    The application bar displays the name of the current dashboard and contains the icons for different actions that you can perform in the dashboard layout area. For example, you can access the Action Menu, create a dashboard, open an existing dashboard, send an email or collaboration, change the layout, or search for content. In the following examples, we demonstrate the features of some of these icons. For the complete list of available icons, refer to IBM Cognos Business Insight User Guide.

    6.2.3  Dashboard layout area

    The dashboard layout area is the workspace on which you can combine data from different sources to gain insight into your business. You can add various widgets with BI content (lists, crosstabs, or chart reports), non-BI content (text, images, HTML pages, and RSS feeds), or you can add filters to narrow the scope of the data (sliders or select value filters).

    6.2.4  Content pane

    The content pane contains all that objects that you can add to a workspace. It is includes the following tabs:

    •The Content tab displays IBM Cognos content in a hierarchy of folders and subfolders with dashboards that you can open and reports that you can add to a workspace. This content is the same content as in IBM Cognos Connection with My Folders (personal content and dashboards) and Public Folders (content that is of interest for many business users).

    Within the Content tab, you can enable or disable the display of information cards and refresh the display to get the current content. You can display content in thumbnail, list, or tree view.

    In addition, you can filter the entire content using one of the following criteria:

     –	All Content (default): Displays all the content that is available and that is supported in IBM Cognos Business Insight

     –	My Favorites: Displays dashboards and reports that are marked as Favorite

     –	My Folders: Displays the contents only from My Folders

     –	Search: Displays the result of the search after a search is performed; otherwise, this view is unavailable

    •The Toolbox tab includes the following types of widgets that are provided by IBM Cognos Business Insight: 

     –	Widgets that can add additional content to a business user’s workspace, such as images, HTML content, or RSS feeds

     –	Widgets that allow you to filter already added content, sliders, and select value filters

    6.2.5  Widgets

    Widgets are containers for all objects that you can add to the workspace. For business users, widgets allow the interaction and manipulation with the content that they contain, whether it is a report or a filter.

    When you select a widget or it is in focus, an on demand toolbar displays, as shown in Figure 6-3. Depending on the type and content of a widget, a variety of toolbar options are available.
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    Figure 6-3   A widget with the on demand toolbar

    Widgets can communicate with other widgets. For example, you can use the slider filter to filter the data dynamically in one or more report widgets. Alternatively, if you have two report widgets that are created on the same dimensionally-modelled data source, when the data in one report is changed, the second report is updated based on user interactions in the first report.

    You can change the manner in which content displays in a widget. You can specify the title, language, top-level location where the navigation begins, summarized or detailed view, how the links in a widget are opened, and so forth. 

    There are two types of widgets inside IBM Cognos Business Insight: 

    •Content widgets

    •Toolbox widgets

    In the following sections, we discuss each of these widgets and when and how you can use them.

    Content widgets

    You can use content widgets when adding IBM Cognos content to the Content tab of a workspace. This section describes the content widgets.

    Report widget 

    Business users use the report widget to add reports or individual report parts (for example list, crosstab, or chart) to a workspace. A report widget includes the following reports:

    •IBM Cognos Report Studio 

    •IBM Cognos Query Studio 

    •IBM Cognos Analysis Studio 

    •IBM Cognos Metric Studio 

    •Report views and saved report output versions 

    Reports objects that contain prompts, drill through, and navigation are supported. 

    It is leading practice to use report parts whenever possible instead of entire reports to improve the layout and usability of dashboards. Reports parts are smaller and provide consolidated information for business users. If you add the entire report with several report parts to a dashboard, all report parts that include the header and the footer are added to a single widget, which is not the best choice for a dashboard.

    If IBM Cognos Metric Studio is installed and configured as part of your IBM Cognos BI environment, you can navigate to IBM Cognos Metric Studio content in the Content tab and add the following IBM Cognos Metric Studio content to a dashboard:

    •Watch lists

    •Scorecards

    •Strategies

    •Metric types

    •Individual metrics

    When you add an individual metric to the dashboard, historical data for the metric displays in a form of a bar chart. For any other IBM Cognos Metric Studio content that you add, the content displays as a list of metrics for the selected item. Each metric in the list has a hyperlink that opens the individual metric in IBM Cognos Metric Studio.

    If business users do not have a need for the most current data in some reports, they can use report output versions in report widgets. Users can choose to view the saved report output versions (by default, it is the latest saved output version) or the live version of the report. Users can also create watch rules based on specific conditions and thresholds for a given report version (see 6.3.6, “Work with report versions and watch rules” on page 207).

     

    
      
        	
          Support for reports in HTML format: IBM Cognos Business Insight supports only report versions that are saved in HTML format.

        
      

    

    You can change several properties of a report widget using the widget Actions Menu button. For example, you can change the title of a widget, the maximum number of rows per page, the location, or the report specification. We use some of these actions in examples later in this chapter. For details about all properties that are available refer to the IBM Cognos Business Insight User Guide.

    PowerPlay widget

    If IBM Cognos PowerPlay Studio is installed and configured as part of your IBM Cognos BI environment, you can navigate to IBM Cognos PowerPlay Studio content in the Content tab and add IBM Cognos PowerPlay Studio reports to a dashboard using this widget.

     

    
      
        	
          Communication note: IBM Cognos PowerPlay Studio report content does not interact with the slider filter and select value filter widgets. Widget-to-widget communication is also not supported.

        
      

    

    When added to a workspace, a IBM Cognos PowerPlay Studio report displays in HTML format, but you can also view the report in PDF format. 

    You can take the following standard IBM Cognos PowerPlay Studio actions on this widget:

    •Switch between crosstab and indent crosstab display

    •Select a chart to display data

    •Swap rows and columns

    •Hide and show categories

    •Create a calculation by using rows or columns

    •Rank categories

    •Zero suppression

    •80/20 suppression

    •Custom exception highlighting

    •Custom subsets

    •Drill through

    TM1 widget

    If IBM Cognos TM1 is installed and configured as part of your IBM Cognos BI environment, you can add applications that are developed in TM1 to a workspace.

     

    
      
        	
          Communication note: TM1 widgets do not interact with the slider filter and select value filter widgets. By default, TM1 Cube Viewer widgets listen to each other. 

        
      

    

    You can add the following TM1 content to a dashboard:

    •TM1 Websheet: Displays a spreadsheet with the TM1 data that you can view in a web browser

    •TM1 Cube View: Displays a view of a TM1 cube

    •IBM Cognos TM1 Contributor: Displays a web page with a URL that points to a TM1 Contributor Web Client

    TM1 objects are displayed in HTML format in a dedicated TM1 Viewer widget with TM1 toolbar buttons on top of the widget, as shown in Figure 6-4.
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    Figure 6-4   TM1 widget

    TM1 Navigation Viewer is incorporated in the Content pane and is not available as separate widget. Entire TM1 content is located in a folder in the Content pane with two main folder at the highest level of the tree, which is Applications and Views, as shown in Figure 6-5. The Views folder contains original TM1 Cubes and TM1 Cube views objects, and the Applications folder has more sub-folders, TM1 Websheet objects, or TM1 Cube Views® objects.
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    Figure 6-5   Example of TM1 Navigation Viewer

    You can add only the individual TM1 content objects to a workspace (that is, TM1 Websheets, Cube Views, or TM1 Contributors), not the entire folders.

    IBM Cognos Navigator

    The IBM Cognos Navigator is a navigation browser that displays IBM Cognos BI content such as folders, packages, and reports, as shown in Figure 6-6.
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    Figure 6-6   Navigator widget

    Toolbox widgets

    You can use toolbox widgets when adding non-Cognos content to a workspace, either to add additional information or to filter the content of existing widgets in the workspace.

    In this section, we describe the toolbox widgets.

    Web page widget

    This widget displays HTML based content such as a Web page on a dashboard.

     

    
      
        	
          Using the web page widget: You must add the web page URL to the trusted domain list as defined in the IBM Cognos Configuration tool.

        
      

    

    Image widget 

    This widget displays the image on the dashboard. The image must be a single file that is accessible by a URL. 

    The image can also be used as a link. For example, you can configure the image widget to broadcast a specified URL in the web page widget or a new browser window when the image is clicked.

     

    
      
        	
          Using the image widget: You must add the image URL to the trusted domain list as defined in the IBM Cognos Configuration tool.

        
      

    

    My Inbox widget 

    This widget displays an RSS feed of a user’s secure approval requests, ad-hoc tasks, and notification requests from My Inbox in IBM Cognos Connection. 

    Text widget 

    You can use this widget to display text on the dashboard.

    RSS feed widget 

    This widget displays the content of a Really Simple Syndication (RSS) or an Atom news feed that is specified by a URL address.

     

    
      
        	
          Using the RSS feed widget: You must add the RSS or Atom feed URL to the trusted domain list as defined in the IBM Cognos Configuration tool.

        
      

    

    The specified URL must point to a valid RSS or Atom feed and not a web page, because the valid RSS feed link opens an XML file, not a web page.

    The RSS or Atom channel includes a list of links to specific web pages. You can specify how these links open in the web page widget or whether the web page widget listens to broadcasts from the RSS feed widget automatically.

    Select value filter widget

    You can use this widget to filter report data dynamically on the report widgets that you added to a workspace previously. For example, you can filter on the product line or region, as shown in Figure 6-7.
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    Figure 6-7   Select value filter widget

    Select value filter widgets are useful in a situation when you have several reports on a dashboard that show data by a variety of locations, product lines, subsidiaries, or customers. With these filters, you can narrow the scope of data, which makes reports easier to read. 

    When adding a select value filter, you can select data items that you can filter with the corresponding report widget to which the items belong.

     

    
      
        	
          Selecting data for the filter: It is not possible to select one data item for more than one filter.

        
      

    

    You can also filter the reports on data items that are not shown in the report. The report must be authored in a way that allows this type of filtering. You must include the data item or items based on the items that you want to filter in the report query, and you must name the filter _BusinessInsight_. Therefore, additional data items must exist in the initial query (but do not have to display on the chart or crosstab) and in this separate query. 

    For example, a bar chart shows returned quantity by product lines. However, you can filter the chart by years, as shown in Figure 6-8, because the report was authored in the manner that we described previously.
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    Figure 6-8   Filter report based on data that is not displayed

    You can specify the list of values that you want in a select value filter, for example just some specific product lines or years. In addition, you can choose whether users can select single or multiple values in the filter widget.

    Slider filter widget

    You can use this widget, which is similar to the select value filter, to filter report data dynamically. Depending on the settings of the slider filter, this widget can filter single values or value range. This type of filtering is especially useful when filtering on a data range (see Figure 6-9) or numeric items, such as revenue and quantity. 
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    Figure 6-9   Slider filter widget

    As with a select value filter, you can also choose the data items on which to filter reports. In addition, you can filter data based on values that are not displayed on report widgets. 

    6.3  Interaction with the dashboard components

    Dashboards created with IBM Cognos Business Insight allow business users an integrated business intelligence experience together with collaborative decision making. Users can complete a wide variety of tasks quickly and easily. For example, you can view and interact with reports, sort data or perform additional calculations, or share information with the other members of the team. Users have different needs for reports and data, so they can make use of the free-form layout and can rearrange reports or add new reports. 

    6.3.1  Personalize content

    When launching IBM Cognos Business Insight, you can choose whether to open an existing dashboard or create a dashboard. Regardless of your selection, in the workspace that opens (either an empty dashboard or a dashboard that contains widgets), you can add and rearrange new widgets. All dashboards are editable. Thus, if business users have permission to access a particular dashboard, they can also change it.

    Advanced business users or report authors can create reports and basic dashboards for a group of business users to include all information that is necessary for that group of users to work. Then, business users can personalize the dashboards to fit specific needs. These needs might include rearranging the layout, changing a pie chart to a bar chart, sorting data easily to see how measures are ranked from highest to lowest values, and searching for an additional report and adding it to a workspace.

    We demonstrate the unified business experience that IBM Cognos Business Insight provides to using the fictional Great Outdoors (GO) company scenario that we introduced in Chapter 3, “Business scenario and personas used in this book” on page 21.

    Our goal is to create a dashboard for Great Outdoors company executives and business users that combines all the relevant information that is needed to gain better insight into business performance of the company. The dashboard must include data about sales performance as well as product returns, sales forecasting, marketing data, and external data. 

    In this scenario, Lynn Cope is an Advanced Business User in the Great Outdoors company. Her role is to enable senior management to have access to all relevant information in a dashboard. She uses the IBM Cognos Business Insight interface to create and change dashboards, including data that is relevant for the users, but is missing in the current version of a dashboard. Later, she interacts with the reports, creates additional calculations, and adds filters to allow users to narrow the scope of data. She begins by opening the current version of the GO Sales Dashboard, making some changes on the layout, and removing reports that are redundant. 

    To begin this scenario:

    1.	Open the IBM Cognos Connection using the following URL:

    http://machinename/ibmcognos 

    2.	On the My Actions pane click Create my dashboards to open a Getting Started Page of IBM Cognos Business Insight.

    On this page, you can create a new existing dashboard. Open an existing dashboard to change it by clicking Open Existing and navigating to the folder where you imported the deployment archive that is provided in the additional material that is supplied with this book. Open the Business Insight folder, and click GO Sales Initial Dashboard, as shown in Figure 6-10.
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    Figure 6-10   Getting Started Page: Open an existing dashboard

    3.	Click Open. The GO Sales Initial Dashboard opens, shown in Figure 6-11.
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    Figure 6-11   GO Sales Initial Dashboard opens in Business Insight

    4.	To better understand the information shown in each report, turn on the titles on the widgets. You usually want titles hidden so they do not take much space on a dashboard.

     

    
      
        	
          Showing titles: It is not possible to show the titles of just selected widgets. You can show or hide the titles of all widgets on a dashboard. By default, the titles are hidden. 

        
      

    

    To show titles: 

    a.	On the Application bar, click Layout and Style, and then click Edit Dashboard Style. 

    b.	In the Edit Dashboard Style window, click Show Titles as shown in Figure 6-12.
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    Figure 6-12   Turning on the titles

    5.	By taking a closer look at data in a report, you can rearrange the layout of a dashboard. Change the places of the Gross profit by Region and Revenue Planned versus Actual widgets. To move a widget, select it. Then, while hovering over the Application bar, you should see the cursor in a shape shown in Figure 6-13 on page 180. Right-click, and drag the widget to another location on the dashboard. Dotted guidelines display on the dashboard when you insert, move, or resize widgets. These lines provide a visual aid to assist you in aligning widgets.

    [image: ]

    Figure 6-13   Moving a widget

    6.	Rearrange the widgets so that they do not overlap. 

    7.	Notice that you have reports that show almost the same data and that you need space on the dashboard for additional reports. To make room for additional reports, remove the Return Quantity by Products and Order Methods report. Click the widget, click Widgets Action, and then click Remove from Dashboard. When prompted, click Remove, as shown in Figure 6-14.
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    Figure 6-14   Deleting a widget

    8.	Next, change the display type for the Return Quantity by Product Lines report. Using a column chart instead of a pie chart makes it easier to compare values for different product lines. Right-click the widget, and select Change Display Type → Column Chart, as shown in Figure 6-15.
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    Figure 6-15   Changing the display type

    9.	Turn off the widget titles in the same way as described in Step 4 on page 179. Clear the “Show titles” option.

    The dashboard should now look as shown in Figure 6-16.
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    Figure 6-16   Modified dashboard

    6.3.2  Add new content to broaden the scope

    You can add new widgets to a dashboard by dragging them from the Content or Toolbox tabs. Using the same method, you can add reports, report parts, metric lists or individual metrics, TM1 objects, or in fact, any object described in 6.2.5, “Widgets” on page 167.

    You can use the IBM Cognos Business Insight enhanced search feature to find and add relevant content to the dashboard. This feature is a full-text search similar to popular search engines.

     

    
      
        	
          Index note: IBM Cognos content must be indexed before you perform a search.

        
      

    

    When using the search capability, keep in mind the following rules:

    •Search results include only the entries for which you have permission to access at the time of the last index update.

    •Searches look for matching prompts, titles, headings, column names, row names, and other key fields.

    •Searches are not case-sensitive. For example, searching for report and Report returns the same result.

    •Searches include word variations automatically. For example, if you enter camp, results also include camps and camping.

    •When using more than one word in a search, the result includes entries that contain all of the search keywords and entries that contain only one of the search keywords. To modify this type of search, use the following operators as you use them in other search engines:

     –	A plus sign (+)

     –	A minus sign (-)

     –	Double quotation marks (“ ”)

    •If a search term matches a specific item on a dashboard, the dashboard is included in the search results, but the individual item is not included.

    When the search is complete, the results are ranked according to the search term match relevance, as shown in Figure 6-17.
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    Figure 6-17   Result of the search in IBM Cognos Business Insight

     

    
      
        	
          Search note: In addition to the IBM Cognos content, you can search annotations and IBM Lotus Connections dashboard activities.

        
      

    

    After a search is complete you can refine search results using the following filters (see Figure 6-18): 

    Result	Shows only report parts or hides report parts

    Type	The type of IBM Cognos object, such as dashboards, reports, or queries

    Part	The type of report part, such as crosstab, list, or pie chart

    Date	The year of creation

    Owner	The owner of the object

    Metadata	The metadata or packages that were used for to create this object
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    Figure 6-18   Refine search option

    Now, back to our scenario. Lynn Cope made changes to a dashboard, and it now looks as shown in Figure 6-16 on page 183. She wants to add a report that contains marketing data for the Great Outdoors company promotions, including gross profit information. 

    To add this report:

    1.	Locate the Search window in the upper-right corner of the IBM Cognos Business Insight user interface, type promotion revenue, and press Enter.

    2.	Refine the search by clicking Refine Search, as shown in Figure 6-19.
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    Figure 6-19   Search for objects containing “promotion revenue”

    3.	A window opens next to the search results. Go to the Metadata section, and click GO Data Warehouse (query) to narrow the result set.

    4.	Among the search results, locate a Promotion Data (Revenue vs Gross Profit) report, and drag it onto a dashboard.

    5.	To close a search and return to the standard Content view, click Search Results for “promotion revenue” → All Content as you shown in Figure 6-20.
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    Figure 6-20   Closing a search

    6.	To change the color palette of the report, click Change color palette → Jazz on the widget toolbar, as shown in Figure 6-21.
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    Figure 6-21   Changing the color palette of the widget

    The dashboard now looks as shown in Figure 6-22.
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    Figure 6-22   Modified dashboard

    6.3.3  Sort and filter data and perform calculations

    Apart from changes in the visual display of data in reports, you can interact with report widgets and apply custom sorting. In addition, you can add basic calculations using data in the report, and you can filter data. We describe these features in this section.

    Sorting data

    Sorting organizes data in either ascending or descending order, based on an alphabetical or numeric value. Sorting is useful when you want to see, for example, the ranking. You can sort on a column that lists revenue in descending order to view revenue data from the highest to the lowest.

    In IBM Cognos Business Insight, you can sort lists, crosstabs, and charts.

    When sorting data, consider the following rules:

    •For crosstab reports with sorting applied in IBM Cognos Report Studio, IBM Cognos Business Insight Advanced, or IBM Cognos Query Studio, the sorted information displays in the information bar in the report widget. However, with IBM Cognos Analysis Studio, sorted information for crosstabs does not displays in the information bar in the report widget.

    •Sorting by label is not available in crosstab reports for summary rows or columns, nested measures, calculations, or rows and columns based on single dimensional members.

    •Sorting by value is not supported on the outer edges of a nested crosstab or in relational crosstabs.

    In this scenario, Lynn Cope wants to use the possibility to sort the data in the report on a dashboard. For the Revenue and sales target by region report, she sorts the Revenue column to display the regions with the highest revenue at the top of the report. This sorting makes it easier for senior management to identify the best performing regions. 

    To sort this data:

    1.	On the Revenue and sales target by region report, click the information bar to see the current sorting on the report (as shown in Figure 6-23). Notice that the report is sorted in ascending order by the label Branch region.
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    Figure 6-23   Information bar with current sorting status

    2.	To sort the report on the Revenue column in descending order, click the Revenue column. Then, click Sort Descending on the toolbar, as shown in Figure 6-24.
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    Figure 6-24   Sorting column in a report

    The report now looks as shown in Figure 6-25.
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    Figure 6-25   Report with sorted column

    Adding simple calculations

    In IBM Cognos Business Insight, you can perform basic calculations for list and crosstab reports using data from one or more report items (for example, to divide the values from two columns).

     

    
      
        	
          Calculation results: The results of calculation are not stored in the underlying data source. Instead, IBM Cognos Business Insight reruns the calculation each time the report is refreshed. The results are always based on the current data in the data source.

        
      

    

    IBM Cognos Business Insight includes the following calculations:

    •Sum (+) 

    •Difference (-)

    •Multiplication (*)

    •Division (/)

    •Difference (%)

     

    
      
        	
          Performing more complete calculations: If you need to perform more complex calculations, click Do More to open the report in IBM Cognos Business Insight Advanced.

        
      

    

    Lynn Cope wants to modify the Promotion Data (Revenue vs Gross Profit) report to convert the report to a list report, to add one additional column (Gross Profit Margin=Gross Profit/Promotional Revenue), and to filter the report to obtain only the campaigns that are the most profitable.

    To modify the report:

    1.	First, convert the chart to a list report. Go to the Promotion Data (Revenue vs Gross Profit) report, and click Change Display Type → List Table.

    2.	Next, add a column by clicking the “Promotion revenue” column, pressing the Ctrl key on keyboard, and clicking the “Gross Profit” column. On the widget toolbar, follow these steps:

    a.	Click Calculate → Gross Profit/Promotion Revenue, as shown in Figure 6-26, to insert an additional column with a default name of Gross profit/Promotion revenue.
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    Figure 6-26   Perform simple calculation

    b.	To move the newly created column to the last position in a list report, right-click the column, and click Move → Right on the menu.

    The report now looks as shown in Figure 6-27.
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    Figure 6-27   Report with added calculated column

    c.	To rename a column, right-click it, and click Rename. Enter Gross Profit Margin as the name.

    3.	Next, narrow the data in a report and display only the campaigns with the high Gross Profit Margin (for example >0.4). Right-click the Gross Profit Margin for Extreme Campaign (value 0.41119418). Click Filter → > =0.41119418. You can only filter data by selecting values from a report. You cannot type the value manually.

     

    
      
        	
          Applying more detailed filtering: To apply more detailed filtering to the report, click Do More to open the report in IBM Cognos Business Insight Advanced.

        
      

    

    4.	Resize the report widget. The report now looks as shown in Figure 6-28.
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    Figure 6-28   Promotion Data report after filtering

    5.	Click Actions Menu, and click Save to save this version of the dashboard.

    Note that the changes that you made are saved with the dashboard when you save it, but the original reports are not changed. When you save a dashboard for the first time, a copy of each report widget is created for the saved dashboard. After you open and change the report (for example, you apply a sort or add a calculation), the changes are saved in this copy. If you want to revert to the original report, use the Reset option on the widget Actions Menu button.

     

    
      
        	
          Using the Reset option: The Reset option is not available for saved output reports or for the reports where the original report was deleted or disabled. When the report content is reset, any changes that you made to the content are lost.

        
      

    

    Filtering

    Filtering is a way to narrow the scope of data in reports by removing unwanted data. As shown in the previous example, only the data that meets the criteria of the filter displays.

    You can find the information about all the filters that are applied to the report on the information bar. In the case of our previous example, the applied filters look as shown in Figure 6-29.
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    Figure 6-29   Information bar displaying applied filters

    Note that if you apply a filter or sort to data in a table report that is changed to a chart, the information bar displays the filter and sort information in the chart. However, you cannot filter on chart data in the report widget by using the filter actions from the report widget toolbar or context menu.

    User can filter the data on reports using one of the following options:

    •Prompt

    •Filter in individual report widget using filter actions

    •Slider or select value filter

    You receive prompts to select the parameter values before the report runs. Based on the parameter values that you select, the report is filtered. 

    You can filter the individual report widget using filter actions on numeric and non-numeric values. When filtering on values that are non-numeric in a list or in crosstab reports, for example the name of the campaign as shown in Figure 6-30 on page 196, you can use the Include or Exclude conditions. You can select multiple non-numeric values (in list reports within the same column and in crosstabs in column or row headings) on which to filter. All values are included in the condition. 
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    Figure 6-30   Filtering non-numeric data

    For numeric data you can use conditions (for example >, >=, <, >=) if only one value is selected, or you can use Between and Not Between if two values are selected (see Figure 6-31).
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    Figure 6-31   Filtering numeric data

    In case of compound reports that consist of more report parts, if all parts share the same query, a filter applied to one report part is also applied to the other. If the query is not shared, the filter is applied only to the selected report part within the report widget.

    If you want to remove a filter from a report widget on the information bar, click the delete icon next to the filter that you want to remove, as shown in Figure 6-32.

    [image: ]

    Figure 6-32   Removing filter

    Note that you can delete only filters that are created using one of the following methods:

    •The filter button

    •The filter context menu

    •The slider filter

    •The select value filter

    You cannot remove filters applied in IBM Cognos Analysis Studio, IBM Cognos Query Studio, or IBM Cognos Report Studio in this manner.

    We discuss advanced filtering using slider filters and select value filters in the next section.

    6.3.4  Use advanced filtering

    Filtering data in the report widget using a slider widget or a select value filter widget filters data in all reports that communicate with that particular filter. Thus, if you have a select value filter for regions, it filters all reports that have regions as a data item. Also, it filters data only on those reports that communicate with that filter. When you select a value on a filter widget, the report widget refreshes to display the filtered data items that you selected.

    Widget communication

    Communication between widgets in IBM Cognos Business Insight has an important role in understanding how filter widgets work. By default, widgets communicate with each other. For example, report widgets can interact with each other and with filter widgets. Based on the type of interaction, the following types of widgets are available:

    •A source widget is a widget that is broadcasting information.

    •A target widget is a widget that is listening to other widgets.

    The results of actions in the source widgets are shown in the associated target widgets. Filter widgets broadcast the information (sending the data based on your input or selection). Report widgets can be both source and target widgets. Image and RSS feed widgets are also source widgets. For example, an image widget can broadcast a specified URL in a web page widget when the image is clicked.

    By default, two report widgets listen to each other. If they are based on the same dimensionally-modelled data source and if the report contains items from the same hierarchy, drilling in one report widget affects a drill in the other report widget.

    If you do not want a target widget to receive information from any or all source widgets, you must disable the communication in the target widget. You can also choose to disable some widget events while leaving other widget events enabled. For example, you might want a widget to listen to filter events and to not listen to drill events from another widget.

    Using filter widgets

    Filter widgets are especially useful if you have several reports on a dashboard that share the same data items. 

    In our business scenario, Lynn Cope wants to add a select value filter for regions to make filtering easier for the users of the dashboard. This filtering allows business users to narrow the scope of data and to focus on analyzing data for a specific region or to have a global overview on all regions. 

    After adding a select value filter, Lynn notices that the filter is impacting one report that she does not want to filter. She needs to modify the communication between these widgets to change this behavior. 

    The Great Outdoor company Sales Dashboard currently looks as shown in Figure 6-33.
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    Figure 6-33   Dashboard before adding filter widget

    To modify the dashboard to change the communication between widgets:

    1.	Drag Select Value Filter from the Toolbox tab to the dashboard. The Properties - Select Value Filter window opens, as shown in Figure 6-34. You can filter on the Region data item for reports Revenue Planned versus Actual and Gross Profit by Region. Select Region. Leave the default setting for the remainder of the options, and click OK. 
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    Figure 6-34   Select Value Filter properties window

    The widget opens on the dashboard (see Figure 6-35).
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    Figure 6-35   Select a value filter widget by region

    2.	Select values for Central Europe, Northern Europe, and Southern Europe, and click Apply. Note that the Revenue Planned versus Actual and Gross Profit by Region refresh and now display data just for the selected regions, as shown in Figure 6-36. 
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    Figure 6-36   Dashboard with filter applied for the region

    3.	You do not want to filter the data on the Revenue Planned versus Actual report, so you can remove filtering on that report widget. Click Action, and then click Listen to Widget Events.

    4.	Scroll down to Select Value Filter, and clear that option as shown in Figure 6-37. Now, this widget will not communicate with the select value filter widget.
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    Figure 6-37   Listen for Widget Events window

    5.	Go to the filter widget, and select Americas and Asia Pacific. Click Apply. The Gross Profit by Region report is filtered again and now shows data for these two regions. However, the Revenue Planned versus Actual report remains the same, because it is not listening to the filter widget anymore (see Figure 6-38).
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    Figure 6-38   Filtering report after changes in Listening for Widget Events properties

    6.	You want the Revenue Planned versus Actual report to display data for all regions, so you remove filtering that was applied previously with the select filter widget. Go to the information bar, and remove the filter as shown in Figure 6-39.
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    Figure 6-39   Removing filter from a report widget

    The dashboard now looks as shown in Figure 6-40.
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    Figure 6-40   Modified dashboard

    6.3.5  Add non-BI content to a dashboard

    In addition to IBM Cognos BI content, you can add non-BI content, such as images, text, web pages, or RSS feeds, to a dashboard. In our business scenario, Lynn Cope wants to include stock exchange reports and news from various websites. 

    To add non-BI content:

    1.	Assure that the Atom feed URL (*.ibm.com in this case) is added to the trusted domain list that is defined in the IBM Cognos Configuration tool.

    2.	Drag the RSS Feed widget from the Toolbox pane to the dashboard. In the Properties RSS Feed window, shown in Figure 6-41, enter the following URL: 

    http://www-03.ibm.com/press/us/en/rssfeed.wss?keyword=null&maxFeed=&feedType=RSS&topic=80

    3.	Click OK.
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    Figure 6-41   Add RSS Feed to a dashboard

    The widget is added to a dashboard (see Figure 6-42).
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    Figure 6-42   RSS Feed widget

    6.3.6  Work with report versions and watch rules

    Usually, reports are run directly against the underlying data source so that they reflect the latest data. However, at time, reports can use older data for comparisons. For example, you might want to see older data to compare monthly revenue for a region before and after features are added. Alternatively, if reports are running against a data warehouse that is refreshed once daily, you do not need reports that are executed multiple times during working hours on the same data set. In this types of scenarios, you can use the report output versions in report widgets. Report outputs are saved when the report runs in the background.

    You can choose to view the saved report output versions (by default, it is the latest saved output version) or to view the live version of the report, as illustrated in Figure 6-43. 
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    Figure 6-43   Report version options

     

    
      
        	
          Reports in HTML format: Only report versions saved in HTML format are supported in IBM Cognos Business Insight.

        
      

    

    For the output versions of the reports, you can define the watch rules to monitor events of interest. Watch rules are based on event conditions that are evaluated when the report is saved. The watch rule sends an alert when a specific condition in a saved report is satisfied. 

    Watch rules can generate one of the following types of alerts:

    •Send the report by email

    •Publish a news item

    •Send a notification to the task inbox

     

    
      
        	
          Enabling watch rules: The report owner must enable watch rules for the report to allow users to add a watch rule for the report. For the details, refer to IBM Cognos Connection User Guide.

        
      

    

    The next example shows how to use the watch rules in the business use case of the Great Outdoors company. Lynn Cope created a list report with the campaigns by product lines and the gross profit. She noticed the negative Gross Profit in case of the Extreme Campaign for Outdoor Protection product lines. To enable other users to monitor that result and to take measures if necessary, she wants to add a watch rule to that value. 

    To add a watch rule:

    1.	Open IBM Cognos Business Insight, select the Create New option, and navigate to the folder where you imported the deployment archive that we provided with the additional materials accompanying this book. Open the Business Insight Source Reports folder, and add the Campaigns by product lines report to the dashboard.

    2.	Click Actions Menu, click Versions, and inspect the options that are available. 

    3.	To add a watch rule to the negative Gross Profit value for Extreme Campaign, right-click the intersection of Gross Profit and Outdoor Protection - Extreme Campaign, and click Alert Using New Watch Rule as shown in Figure 6-44.
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    Figure 6-44   Add new watch rule

    4.	A window opens where you can specify the rule. Select the “Send an alert based on a thresholds” option. Leave the performance pattern as “High values are good.” 

    5.	Enter the value 10000 in the first box and 0 in the second (see Figure 6-45). Click Next.
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    Figure 6-45   Watch rule specification

    6.	A window opens where you can specify an alert type. You can set up a watch rule to send different alerts depending on the performance status of a condition (good, average, and poor). Set the alert to send an email in the case of average performance and to publish a news item in case of good performance. Make a selection as shown in Figure 6-46.
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    Figure 6-46   Alert type specification

    7.	Define the headline and text of the news item by clicking Edit the options for Publish a news item.

    8.	Define the list of users that you want to receive the email by clicking Edit the options for Send a notification.

    9.	Click Next. Enter the following text as the name for a watch rule:

    Gross Profit for Outdoor Protection has met a threshold condition

    10.	Click Finish.

    The watch rule is added, and you can view it if you click Watch New Versions on the report widget toolbar as shown in Figure 6-47.
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    Figure 6-47   Watch new versions menu

    6.4  Collaborative business intelligence

    Collaboration plays an important role in decision making and resolving any business issues. Creating reports and dashboards and analyzing data are tasks that are performed by individual users. However, when it comes to making business decisions based on that information, a team of users typically creates reports and dashboards and analyzes data. 

    Users can share a dashboard with other colleagues using various methods:

    •Email a link to the dashboard using the Email Link option on the Actions Menu button. Your email client opens with a message that is populated with the dashboard name in the subject line and the link to the dashboard in the message body. 

    •Send a URL in an instant message or put the URL in a document using the Copy Link to Clipboard option on the Actions Menu button. 

     

    
      
        	
          Recipient permissions: The recipients of the shared dashboard URL must have permission to view dashboards. Otherwise, they cannot access it.

        
      

    

    •Print individual reports to PDF format using the Print as PDF option on the Actions Menu button of a report widget. This option opens Adobe® Reader with a PDF version of a report with full data and a preview of how that data will print. Note that you cannot print the entire dashboard. To print the entire dashboard, you can use Ctrl+P to use the web browser printing.

    •Export individual reports to any of the following formats:

     –	PDF

     –	Microsoft Excel 2007

     –	Microsoft Excel 2002

     –	CSV

     –	XML

    In addition, you can collaborate with other users while creating reports or monitoring dashboards in IBM Cognos Business Insight. You can achieve collaboration using one of the following methods:

    •Annotations

    •IBM Lotus Connections activities

    6.4.1  Create annotations

    Comments or annotations allow users to collaborate with other members of the team on the content of an individual report on the dashboard. These comments are visible to other users who view the same report. These users can also add further comments about that report, providing additional information. For example, comments can be a reminder to investigate low sales results in a particular region or an explanation of some anomalies in data, such as low sales figures for a product that was recently released and has been on the market for a few months.

     

    
      
        	
          Using comments: Comments available in IBM Cognos Viewer are completely separate from comments in IBM Cognos Business Insight and work in a different way.

        
      

    

    You can comment live reports and saved output versions. When printing a PDF version of a report or exporting a report to PDF or Excel output, the comments are included. You can add comments to the following elements:

    •Reports or reports part

    •Data items in reports and report parts

    •Individual cells in list and crosstab reports

    You can add comments by selecting the required report cell or report widget and clicking Comment in the widget toolbar. All users who can access the report can see comments that are added to it.

     

    
      
        	
          Adding or editing comments: To add or edit comments, users must have execute access for live reports and read and traverse access for saved output versions. 

        
      

    

    When adding comments to individual cells be aware of the following rules:

    •The comment belongs to the cell, not to the value.

    In the example shown in Figure 6-48, when the report is refreshed with data and cell value changes (perhaps the percentage is significantly lower), the comment on that cell still exists and will is visible.
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    Figure 6-48   Comments on individual cells in report

    •The cell value is added to the comment by default.

    As shown in Figure 6-48, the value of a cell is added automatically. The original value stays in the comment after the report is refreshed. 

    •A comment is specific only to the cell in the current report.

    If you have another report that has the same cell (in the previous example, the same cell is the Percentage of customers who returned a product with the reason listed as Wrong product shipped), the report does not include the comment added previously. These reports are not linked and do not share the comments.

    •If there are multiple comments for the same cell or report widget, they display in reverse chronological order. 

    •For each comment, you can see the user’s name, date, and the time the comment was written (see Figure 6-48).

    You can add, edit added comments, or delete comments during the current dashboard session. You cannot edit or delete the comments added by other users.

     

    
      
        	
          Dashboard note: When the dashboard is closed, it is no longer possible to edit or delete comments from that session.

        
      

    

    6.4.2  IBM Lotus Connections activities

    One step further from collaborating by using comments is setting up activities in a web-based collaboration tool. IBM Lotus Connections is a collaboration service that allows users to interact in an online location where they can create and share ideas and resources. Users can post messages, share files, link to websites or their dashboards, and create and assign to-do items. Because activities are integrated with IBM Cognos Business Insight, users can use activities for collaborative decision-making in a single place. 

    For example, users can use activities to post a link to their IBM Cognos Business Insight dashboard so that other users can use it for future analysis or to track and audit decisions and initiatives. Users can include stakeholders or other interested parties involved in the decision-making process.

    When you want to collaborate with other members of the team to resolve an issue or to perform an investigation, start a dashboard activity from the application bar (see Figure 6-49) to create an IBM Lotus Connections activity that is connected to that particular dashboard. After that, you can work with the activity in IBM Lotus Connections.
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    Figure 6-49   Start a dashboard activity in Business Insight

    In IBM Lotus Connections you can complete the following activities:

    •Add members to an activity and change the access to an activity

    •Add entries to an activity, for example additional files or bookmarks

    •Add to-do items and assign them to activity members

    •Add comments

    •Complete to-do items or mark an activity as complete

    In IBM Cognos Business Insight, you can view the list of activities that are started for that dashboard. For each activity, the activity title, the name of the user who performed the last update, the date and time of the update, and the activity priority and due date are reported if they are set up.

    If you expand an activity by clicking More, a summary of the last three updates and the activity goal displays. When clicking an activity or specific entry within it, the activity opens in IBM Lotus Connections. 
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Self service interface for business users

    This chapter provides an overview of the features of IBM Cognos Business Insight Advanced, including statistics services and lineage and search features, based on fictitious business scenarios. Executing the step-by-step instructions that we include in this chapter, you can become familiar with IBM Cognos Business Insight Advanced and how it can address real business situations.

    In this chapter, we discuss the following topics:

    •Explore the IBM Cognos Business Insight Advanced interface

    •Choose a reporting style

    •Change existing reports

    •Create content

    •Search for meaningful information

    •Summarize data and create calculations

    •Add filters to refine data

    •Add external data

    •Create a package with the Self Service Package wizard

    •Create statistical calculations

    7.1  Explore the IBM Cognos Business Insight Advanced interface

    IBM Cognos Business Insight Advanced is a web-based tool that is used by advanced business users and professional report authors and analysts to create and analyze reports.

    IBM Cognos Business Insight Advanced allows users to create reports using relational or dimensional styles. However, it is important that you choose a reporting style that helps users make the most of their data and avoid mixing dimensional and relational concepts; otherwise, reports can display unpredictable results.

    This tool allows users to work with both relational and dimensional data sources, as well as external data, and allows them to show their data in lists, crosstabs, and charts. This tool also allows users to take advantage of the interactive exploration and analysis features while they build reports. The interactive and analysis features allow them to assemble and personalize the views to follow a train of thought and generate unique perspectives easily. Its interface is intuitive to allow the minimum investment in training.

     

    
      
        	
          Objective of this chapter: The objective of this chapter is give an overview of the major features of IBM Cognos Business Insight Advanced. This chapter does not include all the features. For more information, refer to the IBM Cognos Business Insight Advanced User Guide.

        
      

    

    The interface consists of the following key areas (see Figure 7-1): 

    •Page layers

    •Context filters

    •Insertable Objects pane

    •Page navigation

    •Work area

    •Properties pane
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    Figure 7-1   IBM Cognos Business Insight Advanced user interface

    
      
        	
          Using IBM Cognos Business Insight Advanced: IBM Cognos Business Insight Advanced is not a replacement for IBM Cognos Query Studio or IBM Cognos Analysis Studio. If you have reports that were created in these studios, you must recreate a new version of the reports in IBM Cognos Business Insight Advanced if you want to use this studio for those reports.

        
      

    

    7.1.1  Page layers

    The Page layers area is used to create sections or page breaks in reports. When you add a dimension level or dimension members in this area, notice that one block with the current selection of the hierarchy is created in your report.

    For example, to analyze the Gross Profit metric by region for separate pages for each year, you must add the Time dimension on the Page layers area, as shown in Figure 7-2. To change the section, click the arrows in the page navigation.
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    Figure 7-2   Adding Page layers

     

    
      
        	
          Page layers: The Page layers configuration is applied to the entire report.

        
      

    

    7.1.2  Context filters

    The Context filters area is used to filter reports for separate contexts of information. When you add a hierarchy or members of a hierarchy in this area, you will notice that one block with the context selection is created in your report. For example, to analyze the Gross Profit metric by region but only for web sales, you can add the order method web to the Context filter, as shown in Figure 7-3.

     

    
      
        	
          Context filters: The Context filters configuration applies only to the selected object. If you need to apply the same Context filters for two or more objects, you must select each object and then add the desired dimension member.
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    Figure 7-3   Adding Context filters

     

    
      
        	
          Adding a dimension member: You cannot add the same dimension level or members of a dimension both in the Page layers and Context filter areas, because one configuration suppresses the other configuration. Therefore, when you add a dimension member from a hierarchy that is used in the other configuration, IBM Cognos Business Insight Advanced removes the prior configuration automatically.

          For example, if you have Year in the Page layers section and you add Quarter to Context filters, the Page layers configuration is reset and the Quarter is placed in the Context filter section.

        
      

    

    7.1.3  Insertable Objects pane

    The Insertable Objects pane contains the objects that you can add to the reports. These objects are grouped in the following tabs: 

    •Source 

    •Toolbox

    The Source tab shows the data model. Exploring this data model, you can find dimensional members and metrics or query subjects and their query items. What you see in this tab depends on the selection that you made in the Insertable Objects Source toolbar. 

    As shown in Figure 7-4, the toolbar contains shortcuts to set properties that impact the behavior of the report when you insert data from a dimensional model and allow users to add external data, such as spreadsheets or comma-separated value (CSV) files. 
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    Figure 7-4   Insertable Objects Source toolbar

    The Toolbox tab contains all the objects that you can add to your report to improve the readability, separate contents, and create labels.

    View Members Tree

    For dimensional models or Dimensionally Modeled Relational (DMR) models, this view displays measures folders, measures, and dimensions. Inside each dimension, the user can see live data (Figure 7-5) and use this data to create reports easily by dragging the items into one of the areas, such as the Work, Page layers, or Context filter areas.

     

    
      
        	
          View Member Tree options: The View Member Tree options are not displayed when users select a package that contains only a relational data model.
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    Figure 7-5   View Member Tree displaying members

    View Metadata Tree

    The content of this view depends on the data model that is displayed.

    If you expand a dimensional data model (Figure 7-6), this view displays these items:

    •Folders

    •Namespaces

    •Measure folders

    •Measures

    •Dimensions

    •Hierarchies

    •Levels
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    Figure 7-6   Dimensional data source displayed on View Metadata Tree

    If you expand a Relational model (Figure 7-7), this view displays folders, namespaces, query subjects, and query items.
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    Figure 7-7   Dimensional data source displayed on View Metadata Tree

    Toolbox tab

    This tab shows objects that allow users to display data, such as lists, crosstabs, and charts, create new columns with calculations, and improve the layout, such as the text items, labels, blocks, images, and hyperlinks (Figure 7-8).
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    Figure 7-8   Toolbox objects

    7.1.4  Page navigation

    The icons in this page navigation area become enabled if the report retrieves more than one page. These icons allow users to scroll down, scroll up, and go to the top and to the bottom of the report pages without having to run the report (Figure 7-9).

     

    
      
        	
          Large reports: Do not include large reports in dashboards (IBM Cognos Business Insight workspace).
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    Figure 7-9   Page navigation on first page of report

    7.1.5  Work area

    This area contains all the objects that are dropped on the report, such as lists, crosstabs, charts, and layout components.

    If the Page Preview in the View menu is enabled, this area shows live data and the user can interact with it. If Page Design is enabled, this area does not show live data.

     

    
      
        	
          What to do if you see an asterisk (*) character: The following behavior can happen when you use IBM Cognos Transformer cubes or SAP Business Warehouse (BW) data sources. If you see an asterisk character (*) in a list, crosstab, or chart, one of the following conditions was detected:

          •An unknown currency

          •A value with an unknown or questionable unit of measure, such as separate currencies in the calculation or roll-up

        
      

    

    7.1.6  Properties pane

    This pane displays the formatting options that are available for a selected object in a report.

    Ancestor button

    The Properties pane has a icon called Ancestor, which allows users to select any part of a selected object. You typically use this icon for layout purposes, for example, to change the background of the rows inside a crosstab.

    When you select one object and then select the Ancestor icon, all levels above the selected object displays. Figure 7-10 shows the display in the Ancestor properties if the user selects a crosstab cell.
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    Figure 7-10   Ancestor properties

    Also, this feature is useful when you need to find an object inside another object, for example, a crosstab inside a table.

    Toolbar and menu

    The Business Insight Advanced interface shows a toolbar with shortcuts for commonly used features. This interface also displays a menu at the top of the window that allows users to configure more advanced features, such as the interface behavior (Figure 7-11).
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    Figure 7-11   Top toolbar menu

    The following list describes several of the options for each of the menu items:

    •Blue bullet (upper-left corner): Create, open, and save reports, PDF configuration, and report properties

    •Edit: Cut, copy, paste, and delete commands

    •View: Switch between Page Design and Page Preview, enable and disable toolbars and visual aids, and configure the number of rows that is displayed on the Work area when Page Preview is set

    •Structure: Set group configuration, swap rows and columns, add headers and footers to reports, and convert lists to pivots.

    •Data: Set configurations to filter, suppress data, sort, change summarization criteria, create calculations, and show dimensional analysis features, such as Insert Children, Explore, and Drill options

    •Style: Set styles and conditional formatting to objects

    •Run: Allow users to run the report in various output types: HTML, PDF, Microsoft Excel, CVS, and XML

    •Tools: Allow Cognos to check the report’s specification, show and copy the specification, manage external data, and configure advanced options of the interface behavior

    7.2  Choose a reporting style

    Before users start authoring reports, it is imperative that they choose the reporting style that they will adopt in working with data: relational or dimensional. 

    When choosing the reporting style, users must answer the following questions:

    •Do you think about your data as tables and columns?

    If yes, use relational reporting style.

    •Do you think about your data as a number of dimensions intersecting at cells?

    If yes, use dimensional reporting style.

    The reporting style determines how to insert, filter, sort, and customize reports. Mixing both reporting styles in one report can cause unpredictable results.

     

    
      
        	
          Resource information: You can use the relational reporting style even when you create reports that are based on a dimensional data source. For more information about leading practices when using relational or dimensional reporting styles, refer to the Relational Reporting Style and Dimensional Reporting Style sections in the IBM Cognos Report Studio User Guide. 

        
      

    

    7.3  Change existing reports

    Lynn Cope, an Advanced Business User of a GO Americas subsidiary, needs to analyze which product lines result in the greatest number of returns so that the GO Americas management can focus on these product lines to decrease the number of returns.

    Lynn knows that there is one chart inside the IBM Cognos workspace of the Great Outdoors company that already displays the return quantity by product lines. So, Lynn decides to use this existing report as a base for her analysis. To make this possible and easy, the IBM Cognos interface provides a seamless integration between the IBM Cognos Business Insight and IBM Cognos Business Insight Advanced products.

    Using this integrated approach, Lynn follows these steps:

    1.	Open the IBM Cognos workspace of Great Outdoors by clicking My Folders → Business Insight → GO Sales Dashboard_6.3.4 on IBM Cognos Connection.

    2.	Find the chart for which she is looking, and click Do more on the top of the report’s frame (Figure 7-12).
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    Figure 7-12   Business Insight and Business Insight Advanced integration: Modifying an existing report

    After Lynn clicks Do more, the IBM Cognos Business Insight Advanced interface replaces the IBM Cognos Business Insight interface and shows the selected report.

    7.3.1  Sort data

    With the IBM Cognos Business Insight Advanced interface opens, Lynn makes improvements to the report to meet her needs. First, she changes the sorting configuration for the chart to allow her to see the product lines in the chart sorted by the return quantity of their products. To execute this task:

    1.	Click in the chart area to see the chart components (see Figure 7-13).
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    Figure 7-13   Selecting the chart area

    2.	Click Product line in the Series area (Figure 7-14).

    3.	On the top toolbar, click Sort, and then click Edit Layout Sorting.

    4.	In the Sort type section, click Descending.

    5.	Click Intersection (tuple), and click the ellipsis (...), which opens a window that allows you to insert a tuple, as shown in Figure 7-14.
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    Figure 7-14   Advanced Layout Sorting option: Set Sorting window

    6.	Click GO Data Warehouse (analysis) → Sales and Marketing (analysis) → Returned items → Returned items (Figure 7-15).
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    Figure 7-15   GO Data Warehouse package tree: Expanding Returned items folder

    7.	Click the Return Quantity data item under the Returned items metrics folder, and drag it onto the Intersection members and measures area (Figure 7-16).
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    Figure 7-16   After the Return quantity member has been added

    8.	Click OK. The Set Sorting window opens again.

    9.	Click OK to close the Set Sorting window.

    After executing these steps, Lynn determines that Outdoors Protection is the product line that has the worst performance in terms of the return quantity of all Great Outdoors subsidiaries, as shown in Figure 7-17.
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    Figure 7-17   Report after sorting has been performed

    7.3.2  Filter data

    To meet her business needs, Lynn needs to filter the report to display only GO Americas and 2007 (current year) totals.

    Using Context filters

    Because Lynn is working with a dimensional data model, she can easily filter her data using the Context filter feature by following these steps:

    1.	Navigate to GO Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Organization (Figure 7-18).

    2.	Click GO Americas under the Organization dimension, and then drag it onto the Context filter area.
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    Figure 7-18   Adding a Context filter

    After performing these steps, Lynn notices that, in fact, the performance of the Outdoors Protection product line and the performance of the Camping Equipment product line in terms of return quantity are extremely close, as shown in Figure 7-19.
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    Figure 7-19   Report after GO Americas Context filter is applied

    The current report shows the total of Return Items for all of the years (2004, 2005, 2006, and 2007). To have the best insight about the return quantity for the current scenario, Lynn needs to filter the report to show only the data for the current year (2007).

    To achieve this result, she follows the same steps to apply another Context filter for 2007 (Figure 7-20):

    1.	Navigate to GO Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales.

    2.	Drag 2007 under the Year dimension to the Context filter area.

    [image: ]

    Figure 7-20   Report after 2007 Context filter is applied

    Now, Lynn can determine that, in fact, only one product line, the Camping Equipment product line, has an extremely high number of returns.

    7.3.3  Perform calculations

    If we think about the business problem, a Product line with a high number of returns for its products does not necessarily mean a large percentage of returns based on the number of products sold for the product line. To find more meaningful information, Lynn needs to calculate the percentage of returns against the number of products sold.

    Lynn can create this calculation easily by using the Query Calculation object in the Insert Objects pane, as shown in the following steps:

    1.	Click Query Calculation inside the Insert Objects pane. Drag this object to the same place as the Return quantity metric - Default measure (y-axis), as shown in the Figure 7-21 on page 241.

    2.	In the Name field, type % of Items Return.

    3.	Click Calculated measure. 

     

    
      
        	
          Measures: To create this calculation, use the following measures: 

          •One measure from the Sales folder

          •One measure from the Returned Items folder

          Do not set the Measure Dimension. 

          For more information about how to use the Measure Dimension, refer to the IBM Cognos Business Insight Advantage User Guide.
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    Figure 7-21   Creating a query calculation

    4.	Open the Data Items tab. Drag the [Return quantity1] measure to the Expression Definition area (see Figure 7-22).
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    Figure 7-22   Inserting a member from the Data items tab into Expression Definition

    5.	Open the Function tab, expand the Operators folder, and drag the forward slash character (/) into the Expression Definition area (Figure 7-23).
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    Figure 7-23   Inserting operator into Expression Definition

    6.	Open the Source tab, and navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Sales fact. 

    7.	Drag [Quantity] to the Expression Definition (see Figure 7-24). 
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    Figure 7-24   Inserting [Quantity] item into Expression Definition

    8.	To validate the expression, click the Validate icon at the top of the window (see Figure 7-25 and Figure 7-26).
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    Figure 7-25   Starting Expression Definition validation
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    Figure 7-26   Validation results

    After these changes, Lynn determines that the Camping Equipment product line has 1.8% of its items returned (see Figure 7-27).
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    Figure 7-27   Report with the new percent of Returned items metric

    After performing these steps, Lynn realizes that the sorting is not working as expected. To solve this issue, she follows these steps:

    1.	Click Product line in the Series area. 

    2.	On the top toolbar, click the Sort icon, and then click Edit Set Sorting. 

    3.	Under the Intersection (tuple), click the ellipsis (...). 

    4.	In Intersection members and measures, click Return quantity. 

    5.	Click the left arrow. 

    6.	Click the Calculate members and measures tab. 

    7.	Click % of Returned items.

    8.	Click the right arrow (see Figure 7-28). 
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    Figure 7-28   Members window after the Return quantity member has been removed

    9.	Click OK to close the Members window.

    10.	Click OK to close the Set Sorting window.

    After performing these steps, the chart shows the bars in the correct order (see Figure 7-29).
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    Figure 7-29   Report after sorting change to percent of Returned items

    7.3.4  Set the right level of detail for the analysis

    To complete her analysis, now Lynn needs to discover which brands have the highest percentage of returned items. She uses the drill-down and drill-up features as follows:

    1.	To drill down into the data, double-click Camping Equipment, and the report is updated to show the product types (see Figure 7-30). 
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    Figure 7-30   Drill down on the product line

    2.	After this action, double-click again on the Lanterns product type (see Figure 7-31). 
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    Figure 7-31   Drill down on the product type

    3.	After this action, Lynn is satisfied with the results, but she needs to fix the sorting of the report. To fix the sorting (as shown in Figure 7-32 on page 252):

    a.	Click in the chart area. 

    b.	In the Series section, click the <#children(Lanterns)#> data expression. 

    c.	On the top toolbar, click the Sort icon. 

    d.	Click Edit Set Sorting. 

    e.	On the Set Sorting window, click Descending.

    f.	Click Intersection (tuple). 

    g.	To the right of the Intersection (tuple) field, click the ellipsis (...). 

    h.	Click the Calculated members and measures tab.

    i.	Click % of Returned items.

    j.	Click the right arrow. 

    k.	Click OK to close the Members window. 

    l.	Click OK to close the Set Sorting window. 
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    Figure 7-32   Set Sorting properties for percent of Returned items

    After performing these steps, Lynn has a report that shows the products that have a higher percentage of returned items (Figure 7-33).
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    Figure 7-33   Report after drilling down, ordered by percent of Returned items

    7.4  Create content

    Now, Lynn Cope, an Advanced Business User of the GO Americas subsidiary, needs to create two reports that answer the following questions:

    •Are we selling the right products?

    •How does this year’s performance compare with the prior year’s performance?

    Lynn inserts these reports in the Great Outdoors company workspace.

    7.4.1  Create a crosstab

    To answer the first question, Lynn decides to create a list that shows the bottom ten product sales by region.

    To create this report, Lynn uses IBM Cognos Business Insight Advanced and follows these steps:

    1.	In IBM Cognos Connection, launch Business Insight Advanced (see Figure 7-34). The Select a package window opens.

    2.	Navigate to Cognos → Public Folders → Samples → Models.

    3.	Click GO Data Warehouse (analysis) to create a report that is based on this package. 
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    Figure 7-34   Opening IBM Cognos Business Insight Advanced from IBM Cognos Connection

    4.	Click Create new to create a report (Figure 7-35). 
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    Figure 7-35   Welcome window of IBM Cognos Business Insight Advanced

    5.	Click the Crosstab report type (Figure 7-36). 
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    Figure 7-36   Default report types on IBM Cognos Business Insight Advanced

     

    
      
        	
          Flexibility: Even if a you initially selected a List, Crosstab, Chart, or Financial report type, you can include other charts, crosstabs, and lists on the report. IBM Cognos Business Insight Advanced provides a flexible approach to develop reports.

        
      

    

    6.	First, rename the text header to Bottom 10 product sales by region. To insert the text, double-click Double-click to edit text (Figure 7-37). 
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    Figure 7-37   Inserting a report name

    7.	On the Insertable Objects pane, click View Metadata Tree to see the data model structure instead of live data (Figure 7-38). 
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    Figure 7-38   Switch to View Metadata Tree

    8.	On the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Sales fact.

    9.	Drag the Quantity metric under Sales Fact to the Columns area. 

    10.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Products.

    11.	Drag the Product level to the Rows area. 

    After performing these steps, Lynn has a list of all products with their quantities (Figure 7-39).
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    Figure 7-39   Crosstab after adding columns and rows

    12.	Click any product in the rows. 

    13.	Click the Explore icon of the toolbar. 

    14.	Click Top or Bottom, and then click Bottom 10 based on Quantity (Figure 7-40). 
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    Figure 7-40   Using Bottom 10 feature

    After performing these steps, Lynn is able to see the bottom 10 performing products (Figure 7-41).
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    Figure 7-41   Report after Bottom 10 function has been applied

    Including accessibility features

    Now, Lynn wants to insert a summary text item to be used by screen readers for the crosstab. Using the acessibility features of IBM Cognos Business Intelligence Advanced, she can add the text for objects using the Summary text property.

    To include accessibility features:

    1.	Click anywhere in the crosstab (columns, rows, or metrics) area. 

    2.	Click the Ancestor icon. 

    3.	Click Crosstab. 

    4.	Click the Summary text property. 

    5.	Click Specified text. 

    6.	Click the ellipsis (...). 

    7.	In the Default text field, insert the summarization text. 

    If you want to insert summarization text for multiple languages, click Add, select the language, and then insert the summary text for the chosen language (Figure 7-42):

     –	Default text: Bottom 10 product sales by region

     –	Spanish text: Los 10 productos menos vendidos por region
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    Figure 7-42   Adding localized text for internationalization

    Now, Lynn can save this report to use it in the Great Outdoors company workspace in IBM Cognos Business Insight Advanced.

    7.4.2  Create a chart

    Lynn needs too answer the second question asked earlier:

    How does the performance of this year compare with the prior year?

    She decides to create a chart that shows a line chart, which compares historic information from the current year (2007) and the prior year (2006).

    To create this report, Lynn uses IBM Cognos Business Insight Advanced to access a relational data source of Great Outdoors data and follows these steps:

    1.	In IBM Cognos Connection, launch Business Insight Advanced. The Select a package window opens.

    2.	Navigate to Cognos → Public Folders → Samples → Models.

    3.	Click GO Data Warehouse (query) to create a report that is based on this package.

    4.	Click Create New to create a report. 

    5.	Click the List report type. 

    6.	Drag the following items to the list:

    a.	Go Data Warehouse (query) → Sales and Marketing (query) → Sales → Time → Month

    b.	Go Data Warehouse (query) → Sales and Marketing (query) → Sales → Sales fact → Revenue

    7.	Click in one column of the list.

    8.	On the top toolbar, click Insert Chart (Figure 7-43).
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    Figure 7-43   Creating a chart that is based on a list

    9.	In the Insert Chart window, in the left pane, click Line. 

    10.	In the right pane, click Clustered Line with Circle Markers (Figure 7-44). 

    11.	Click OK. 
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    Figure 7-44   Selecting a chart type

    12.	Click in the list, and in the Properties pane, click Ancestor.

    13.	On the top menu bar, navigate to Edit, and click Delete (Figure 7-45). 
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    Figure 7-45   Deleting option

    14.	Drag the Revenue metric from Default measure (y-axis) to Series (primary axis), as shown on Figure 7-46.
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    Figure 7-46   Move Revenue metric from Default measure (y-axis) to Series (primary axis)

    After performing these steps, Lynn has a line chart showing the total Revenue of all Great Outdoors subsidiaries by month (see Figure 7-47).
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    Figure 7-47   Line chart displaying Revenue by Month

    To separate the data by years, Lynn follows these steps:

    1.	In the Insertable Objects pane, navigate to Go Data Warehouse (query) → Sales and Marketing (query) → Sales (query) → Time.

    2.	Drag Year to the Series (primary access) area, as a child of Revenue, as shown in Figure 7-48. 

     

    
      
        	
          Placing a data item: You can choose where to place a data item if there is a data item already in the same area. When you place a data item inside one of these areas, the following behaviors are expected:

          •The entire area flashes. Dropping the item replaces the existing item. 

          •A flashing black bar displays on the right or left side of the data item. If you place the data item in this situation, the item is included as a new stack of data, for example Years followed by Revenue. 

          •A flashing black bar displays on the top or bottom side of the data item. If you place the data item in this situation, the item is included as a nested data item. 
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    Figure 7-48   Adding a child member of Revenue in the Series area

    After the report refreshes, it displays the Revenue by Year. With this view, Lynn can easily compare the Revenue trends between the years (see Figure 7-49).
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    Figure 7-49   Revenue by Year

    To simplify the presentation and because Lynn wants to analyze the differences between the current year and the prior year only, she filters the report as follows:

    1.	Click the chart.

    2.	On the top toolbar, click the Filters icon, and then click Edit Filters.

    3.	Click the Add icon. A small window opens to allow users to select if they want to create a complex filter (with AND and OR clauses) or a simple filter that is based on one data item. 

    4.	Ensure that Custom based on data item is selected. 

    5.	In the drop-down list box under the radio button, click Year, and then click OK.

    6.	In the Filter Condition - Year window, change the operator to filter by values that are greater than or equal to (≥) 2006, as shown in Figure 7-50. 

     

    
      
        	
          Override: To allow other users to show another range of years for comparison, Lynn also selects the “Prompt for values when report is run in viewer” option.

          Notice that when the report is displayed in IBM Cognos Business Insight Advanced, the prompt does not display. The prompt displays only when a user runs this report in IBM Cognos Connection or IBM Cognos Business Insight.
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    Figure 7-50   Setting Year filter

    7.	Click OK, and then click OK again.

    After performing these steps, the report shows the comparison between 2007 (current year) and 2006 (last year), which was the requirement (see Figure 7-51). Lynn also provides flexibility to other users who want to use this report by allowing them to select other years for analysis.
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    Figure 7-51   Report showing the Revenue comparison between current and prior years 

    7.4.3  Set conditional formatting

    Lynn needs to create a report to deliver to all Great Outdoors subsidiaries that gives highlights about which product lines match their sales targets for the month and which product lines do not. She decides to create a crosstab that compares Revenue with Sales target, is grouped by Product line and Product type, and is filtered by the current year.

    To create this report, Lynn uses IBM Cognos Business Insight Advanced to access a Dimensional data source for the Great Outdoors data by following these steps:

    1.	In IBM Cognos Connection, launch IBM Cognos Business Insight Advanced. The Select a package window opens. 

    2.	Navigate to Cognos → Public Folders → Samples → Models.

    3.	Click GO Data Warehouse (analysis) to create a report that is based on this package. 

    4.	Click Create New to create a new report. 

    5.	Click the Crosstab report type. 

    6.	In the Insertable Objects pane, click the View Member Tree icon. 

    7.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Products. 

    8.	Click Camping Equipment under Products. 

    9.	With the Shift key pressed, click Golf Equipment under Products (last item). 

    10.	Drag the data items to the Columns area (see Figure 7-52). 
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    Figure 7-52   Adding multiple dimension members to a crosstab 

    11.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Time. 

    12.	Drag the 2007 member under Time to the Columns area (see Figure 7-53). 
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    Figure 7-53   Adding a member with its children

    13.	On the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Sales fact. 

    14.	Drag Revenue under Sales Fact and place it as a child of Year members in the Columns area (under the Year column), as shown in Figure 7-54. 
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    Figure 7-54   Adding a child member in the column

    15.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales target → Sales target fact. 

    16.	Drag Sales target, which is under Sales target fact, to the right of Revenue, as shown in Figure 7-55. 
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    Figure 7-55   Adding a nested member in a column

    17.	Lynn notices that the Revenue and Sales target values do not appear under the 2007 column (total). To correct this situation, she drags the same metrics under the quarters total column, as shown in Figure 7-56.
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    Figure 7-56   Total line after inserted Revenue and Sales target metrics

    18.	Now, Lynn notices that there are columns without data in any rows, so she decides to suppress the null values. She can suppress the null values easily by following these steps:

    a.	On the top toolbar, click the Suppress icon. 

    b.	Click Suppress Columns Only (see Figure 7-57). 
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    Figure 7-57   Suppress null data

    After performing these steps, Lynn has a crosstab report, which displays Revenue and Sales target by Product lines and 2007 quarters (Figure 7-58), but to meet her requirements, she needs to include the metrics’ values for Product type.
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    Figure 7-58   Report with crosstab displaying Revenue and Sales target by Product line and 2007 quarters

    To include this new level on the report, Lynn can opt for one of three approaches: Expand members (Figure 7-59), Next Level Down (Figure 7-60), or nest the new column by dragging it to the right of Product line (Figure 7-61). 
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    Figure 7-59   Using Expand members feature
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    Figure 7-60   Using Next Level Down feature
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    Figure 7-61   Nesting a column

    For this report, Lynn decides to use the Next Level Down approach. To implement this approach, she performs the following steps:

    1.	Click one of the members in the Rows area. 

    2.	On the top toolbar, click the Explore icon. 

    3.	Click Create → Next Level Down (Figure 7-62). 
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    Figure 7-62   Inserting a Next Level Down

     

    
      
        	
          Expand Member: To use the Expand Member approach, select one member in the Rows or Columns area, click the Explore button on the top toolbar, and click Expand Member. This approach expands only one row per click. If you want to expand all five Product lines, click each Product line and follow these steps.

        
      

    

    After Lynn performs these steps, the report shows Product line and Product type in the Rows area, as shown in Figure 7-60.

    To make the analysis for the executives easier, Lynn decides to add a calculated column that shows the percentage between current Revenue totals and Sales targets. She can easily include this column by using the calculation features that are included in IBM Cognos Business Insight Advanced and by following these steps:

    1.	In the Columns area, click Revenue. 

    2.	Press Shift, and click Sales target. 

    3.	On the top toolbar, click the Insert Calculation icon. 

    4.	Click % (Revenue, Sales target). 

    Notice that the formulas that are shown use your data and reflect the formula that IBM Cognos Business Insight Advanced creates (see Figure 7-63). 
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    Figure 7-63   Inserting a calculated column using pre-built calculations

    Lynn also performs the same steps for the 2007 column. 

    After Lynn performs these steps, the report is displayed with Revenue, Sales target, and the percentage calculation between these two columns by Product line and Product type (see Figure 7-64). 
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    Figure 7-64   Report after adding calculations

    Executives need to make decisions and give answers quickly. To improve the readability of this report, Lynn decides to configure conditional formatting for the percent column, which helps executives to differentiate good and bad performance quickly.

    To implement this conditional formatting, Lynn follows these steps:

    1.	Click one of the values in the % (Revenue, Sales target) column, and then on the top menu, click Style → Conditional Styles (Figure 7-65). 

    2.	In the Conditional Styles window, click the Add icon. 

    3.	Click New Conditional Style. 

    4.	In the New Conditional Style window, click % (Revenue, Sales target), as shown on Figure 7-65. 
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    Figure 7-65   Setting a new conditional style for % (Revenue, Sales target) metric

    5.	In the Conditional Style - Numeric Range window, in the Name field, type
% target. 

    6.	Click Add in the lower-left corner of that window. 

    7.	Type 100%, and click OK. 

    8.	Click Add. 

    9.	Type 90%, and click OK. 

    10.	Click Add. 

    11.	Type 120%, and click OK. 

    12.	Change the values to the drop-down list box options that are displayed in the Style column, as shown in Figure 7-66.

     

    
      
        	
          Condition style options: Users can use the pre-built styles or create their own styles for a condition. To change the style, click the pencil icon on the right side of the style drop-down list box.
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    Figure 7-66   Add intervals to a Conditional Style

    13.	Click OK twice to exit the Conditional Styles windows. 

    After Lynn performs these steps, the report displays, as shown in Figure 7-67.
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    Figure 7-67   Example of one Product line’s values after applying a conditional style

    To improve the readability of the report, Lynn wants to change the label of the new percentage columns. She follows these steps for the percent columns under the quarters and the total columns:

    1.	Right-click the column and click Edit Data Item Label (Figure 7-68). 

    2.	In the Data item name field, type % of target. Repeat these steps for the calculation under the 2007 column. 
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    Figure 7-68   Changing the label of a column

    Now, Lynn needs to deliver this report to the six Great Outdoors subsidiaries with a clear separation between the performance of each region. To separate the information for each subsidiary, she drags the Organization member to the Page layers area, as shown on Figure 7-69.
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    Figure 7-69   Adding a member on the Page layers area

    Finally, she renames the report to Sales Revenue x Target.

    After all these steps, Lynn can deliver reports comparing the current revenue and sales targets for 2007 for each subsidiary (Figure 7-70 and Figure 7-71).
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    Figure 7-70   Report to be delivered to GO Accessories subsidiaries
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    Figure 7-71   Report to be delivered to GO Americas subsidiaries

    7.4.4  Analyze the execution query path

    The Lineage feature of IBM Cognos makes it easy for report authors and business analysts to examine the origin of the data that is used in the reports and their query paths.

     

    
      
        	
          Lineage feature: You can use the Lineage feature when executing a report on IBM Cognos Viewer.

        
      

    

    Lynn Cope, an Advanced Business User, wants to understand how the Planned Revenue metric is calculated. She uses the Lineage feature to help her identify what calculation was applied to create the metric and if there is a filter applied for it. To analyze the execution query path:

    1.	In IBM Cognos Connection, launch Business Insight Advanced. The Select a package window opens. 

    2.	Navigate to Cognos → Public Folders → Samples → Models. 

    3.	Click GO Data Warehouse (analysis) to create a new report that is based on this dimensional package. 

    4.	Click Create New to create a new report, and then click in List. 

    5.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Sales fact, and then right-click Planned Revenue. 

    6.	Click Lineage (Figure 7-72). 
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    Figure 7-72   Selecting the Lineage feature

    The Business View window opens. In this view, you can see an overview of the data’s definition (Figure 7-73).
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    Figure 7-73   Lineage: Business View window

    7.	Click the Technical View tab. 

    The Technical View tab shows detailed metadata of the data item. With this view, advanced business users and professional report authors can analyze the filters and calculations that are applied to the data (see Figure 7-74).
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    Figure 7-74   Lineage: Technical View

    On the Technical View, users can click each item in the diagram to see its metadata and definition.

    Clicking the Planned revenue metric, Lynn notices that it is calculated based on the formula Unit price * Quantity (see Figure 7-75).
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    Figure 7-75   Lineage: Planned revenue formula

    7.4.5  Render output in various formats and print content

    IBM Cognos supports various types of output formats, such as HTML, PDF, Microsoft Excel 2007, Microsoft Excel 2002, delimited text (CSV), and XML. All of these formats are available in IBM Cognos Business Insight Advanced.

    Ben Hall, an Analyst for the Great Outdoors company, wants to export Microsoft Excel and PDF formats for the Sales Revenue x Target report that Lynn Cope created.

    Render in Microsoft Excel format

    To render the report in Microsoft Excel format, on the top menu, click Run → Run Report - Excel 2007 (see Figure 7-76). 
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    Figure 7-76   Selecting Run option

    IBM Cognos generates a new Excel file, with the same name as the report and splits the content of the pages into tabs in Microsoft Excel (Figure 7-77 and Figure 7-78).
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    Figure 7-77   Report rendered in Microsoft Excel: First page
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    Figure 7-78   Report rendered in Microsoft Excel: Second page

    Render in PDF format

    To render the report in PDF format, click Run → Run Report - PDF (see Figure 7-79). 
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    Figure 7-79   Report rendered in PDF format

    Save reports locally

    IBM Cognos Business Insight Advanced and IBM Cognos Report Studio provide a feature that allows you to save and open reports on the local hard drives. This feature can be useful when backing up and managing reports using a configuration management tool, such as IBM Rational® ClearCase®.

    To save a report, click the blue bullet on the top menu, and click (Local) Save As (see Figure 7-80). 

    [image: ]

    Figure 7-80   Saving a report locally

    Feature requirements

    To save and open reports locally, users must register the LFA.dll on Microsoft Windows. To enable (Local) Save As for IBM Cognos Business Insight Advanced, follow these steps:

    1.	Obtain the LFA.dll from your IBM Cognos Business Insight administrator.

    The dynamic link library (DLL) is located in the bin directory where IBM Cognos Business Insight is installed.

    2.	Open a command prompt window to the location of the LFA.dll file.

    3.	Register the LFA.dll file by typing the following command:

    regsvr32 LFA.dll

    4.	In your browser, set your computer and the IBM Cognos Business Insight server as trusted sites.

    5.	In IBM Cognos Business Insight Advanced, from the Tools menu, click Options.

    6.	Click the Advanced tab.

    7.	Select the “Allow local file access” option, and then click OK.

    The menu items (Local) Open and (Local) Save As displays in the File menu.

    8.	Close and restart IBM Cognos Business Insight Advanced.

     

    
      
        	
          Internet Explorer: This feature is supported only for Internet Explorer, because it is based on ActiveX technology. To use this feature, you must enable ActiveX in your browser. If you have problems running this feature, check the ActiveX configuration for your browser.

        
      

    

    7.5  Search for meaningful information

    For dimensional data sources, online analytical processing (OLAP) data sources, and dimensionally modeled relational (DMR) data sources, you can perform a member search in IBM Cognos Business Insight Advanced to find the data that you need for your report quickly.

    Lynn Cope, the Advanced Business User for the Great Outdoors company, has to create a report for senior management that contains quantity, product cost, profit margin, and revenue figures for all Seeker products in their portfolio. The senior managers need this information for their meeting with the manufacturer of these products. Lynn is unsure to which product line these products belong, so she uses the Search option in IBM Cognos Business Insight Advanced to find them. 

    To use the Search option to find meaningful information:

    1.	Launch Business Insight Advanced, open the GO Sales Cube package, and then click Create New.

    2.	Click Crosstab, and then click OK.

    3.	On the Source tab, navigate to GO Sales Cube → Measures, and then select Quantity sold, Product cost, Profit margin %, and Revenue (press Ctrl to select all members). 

    4.	Drag the selected items to the Columns area of the crosstab.

    Now, perform a search on Product dimension to find the Seeker products. 

    5.	Right-click the Products dimension, and click Search, as shown in Figure 7-81.
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    Figure 7-81   Search option on a menu

    6.	In the Member Search window, enter the keyword Seeker. Leave the option Starts with any of these keywords selected, but click Search all descendants to include searching on all levels of the Product dimension 
(see Figure 7-82). 
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    Figure 7-82   Search options

    7.	Click Search. The new Search tab opens with the results of the search, as shown in Figure 7-83.
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    Figure 7-83   Results of the search

    You can browse the hierarchy to explore members at lower levels, or you can directly add members from the Search tab to a report. 

    8.	Select all members (press Ctrl), and drag them to the Rows area.

    You save time with this method, because instead of inserting all of the products into a report and adding a filter, you can search quickly and insert them from here. 

    The end report displays, as shown in Figure 7-84.
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    Figure 7-84   Report containing results of the search

    7.6  Summarize data and create calculations

    IBM Cognos Business Insight Advanced provides a range of summarization functions and calculations that can be applied to reports to help advanced business users get the best insight from their data.

    7.6.1  Summarization

    IBM Cognos Business Insight Advanced provides the following summarization functions to users:

    •Total

    •Count

    •Average

    •Minimum

    •Maximum

    The first calculation applied depends on what is set on the data model. Nonetheless, despite it, users can create new summarized columns and rows using these functions if it makes sense to them.

    To apply a summarization function, follow these steps:

    1.	Click one member of a set or data item (depending on the type of data source that you use) to create a summarization column or row. 

    2.	On the top toolbar, click the Summarize icon. 

    3.	Click the desired summarization function (Figure 7-85). 
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    Figure 7-85   Inserting a summarization column

    After you follow these steps, a new column is created on the right side of the crosstab with the Average title (Figure 7-86).
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    Figure 7-86   Report after an Average summarization function is applied

    Create reports using a dimensional data source

    Reports that are based on a dimensional data source always apply summarization to sets. If the user does not turn on the Create Sets for Members option in the Insertable Objects pane (Figure 7-87), the user is unable to insert additional summarization columns and rows.

    In the case of relational data sources, the summarization functions are applied to the nodes of the crosstabs, charts, and to the entire list.
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    Figure 7-87   Create Sets for Members option

    7.6.2  Calculation

    IBM Cognos Business Insight Advanced provides several calculations for users. Several of the calculations that are available for relational and dimensional data sources differ.

    Calculations available for relational data sources

    When using a relational data source, IBM Cognos Business Insight Advanced allows users to deal easily with strings and remove blank spaces (remove trailing spaces), as well as truncate blank spaces based on a number of characters (First ? characters, Last ? characters).

    If the columns or rows are measure items, users can apply a range of calculations, such as addition, subtraction, multiplication, and division of a column, Absolute, Round, Round up, Round down, percentage, and difference. Several of these calculations require a number value if the calculation involves one measure only. The number can be provided when the user clicks the Custom option.

    Figure 7-88 and Figure 7-89 show examples of applied calculations.

    [image: ]

    Figure 7-88   List report showing truncate, percent, and round calculations
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    Figure 7-89   Crosstab report showing addition calculation

    Calculations available for dimensional data sources

    When using dimensional data sources, IBM Cognos Business Insight Advanced provides a capability to perform calculations across rows and columns, which is an advantage for the dimensional approach. Users can calculate the percent of the difference between the first product line in terms of revenue and all other product lines easily.

    If the columns or rows are a measure, users can apply a range of calculations, such as addition, subtraction, multiplication, and division of a column, percentage, and difference. Several of these calculations need a number value, which is set when the user clicks the Custom option.

    When using dimensional data sources, IBM Cognos Business Insight Advanced does not display the calculations for string.

    Figure 7-90 and Figure 7-91 show examples of how to work with the calculations.
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    Figure 7-90   Revenue percent of Base (Revenue, Personal Accessories) calculation
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    Figure 7-91   Percent difference (Planned revenue, Revenue), division, and subtraction calculations

    Example

    Lynn Cope, an Advanced Business User of the Great Outdoors company, wants to make a quick comparison between the top product type in the Personal Accessories product line and the other product types in the same line using a dimensional data source.

    To create a percent of base calculation, she follows these steps:

    1.	Create a simple report that groups Revenue by Product types under the Personal Accessories product line using a crosstab (Figure 7-92). 
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    Figure 7-92   Simple report

    2.	Click the Revenue measure. 

    3.	On the top toolbar, click the Sort icon. 

    4.	Click Descending (Figure 7-93). 

    [image: ]

    Figure 7-93   Sorting the Revenue column in descending order

    5.	Click the Revenue measure and press Ctrl. 

    6.	Click the first member of the Rows area (Eyewear), right-click one of the selected items, click Calculate, and then click % of Base (Revenue, Eyewear), as shown in Figure 7-94. 
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    Figure 7-94   Creating a percent of Base calculation

    After performing these steps, Lynn can see the percent of the Revenue of all product types against the Eyewear revenue (Figure 7-95).
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    Figure 7-95   Percent of Revenue of all types against Eyewear type Revenue

     

     

    
      
        	
          Resource: For more information about how to work with calculations, refer to the IBM Cognos Business Insight Advanced User Guide.

        
      

    

    7.7  Add filters to refine data

    To create reports that meet clients’ expectations, provide accurate information, and avoid unpredictable results, advanced business users, report authors, and analysts must understand how to use filters. Also, they must understand the differences when a filter is applied in a report that uses dimensional data sources as opposed to relational data sources. This section describes the behavior differences between the two data source types.

     

    
      
        	
          Resource: For more information about leading practices on filtering, refer to the Focusing Relational Data and Focusing Dimensional Data sections of the IBM Cognos Report Studio Guide.

        
      

    

    7.7.1  Filter reports for relational data sources

    Consider the following points when filtering reports for relational data sources.

    Summary and detailed filters

    When creating a report, which is based on a relational data source, users can filter the data that is retrieved in the queries and apply the filter before or after auto aggregation. To apply a filter before or after auto aggregation, open the Edit Filters dialog box, and make the appropriate selection in the Application section (see Figure 7-96).
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    Figure 7-96   Creating a filter in a report that is based on a relational data source

    Combined filters

    A complex filter is a combination of two or more filters creating AND or OR logic. With this feature, advanced business users can create advanced filtering expressions easily, as illustrated in Figure 7-97.
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    Figure 7-97   Complex filtering expression created using Combined Filter feature

     

    
      
        	
          Expressions: To create AND, OR, and NOT expressions with parentheses, click the expressions that you want to place inside the parentheses with the Shift key pressed, and select OR, AND, or NOT.

        
      

    

    Filtering features

    You can use the Filter menu (shown in Figure 7-98 on page 302) to create filter expressions easily. For example, the following list shows several commonly used filter expressions:

    •Include x, y and Exclude x, y: Focus on data that is based on the selection, or exclude the selection from the results. 

    •Greater and Lower: Retrieve data that is Lower than (<), Lower than (<) or Equal (=), Greater than (>), or Greater than (>) or Equal (=) a specific value. 

    •Between x and y and Not Between x and y: Retrieve data that is between or not between selected values. 

    •Include Null and Exclude Null: Include or exclude null values for the selected column. 
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    Figure 7-98   Filter features menu

    7.7.2  Filter reports for dimensional data sources

    Use filters to remove unwanted data from reports. Data is retrieved from the database only if it meets the filter criteria. When working with dimensional data sources, you can filter only by members and measures. When creating a report, which is based on a dimensional data source, users can focus the data that is retrieved in the queries using several options:

    •Specifying members instead of data items during report development

    •Applying filters within a set

    •Using the filter function

    •Using context filters

    •Using the Explore menu features

    Using any other filtering options available on IBM Cognos Business Insight Advanced can cause unpredictable results.

    Focus reports using members

    You can specify the members who you want to see in a report using the View Member Tree on the Insertable Objects pane toolbar.

     

    
      
        	
          View Member Tree option: Using the View Member Tree on the Insertable Objects pane toolbar is a quick option to focus the data that the users want to see. If the users know what they want to see and will always use the same set, they need to choose this option.

        
      

    

    To specify a member, the user clicks one or more members of a dimension and drags them to the report object (list, crosstab, or chart), as shown in Figure 7-99.
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    Figure 7-99   Inserting members in a crosstab

     

    
      
        	
          Create Sets for Members option: If the Create Sets for Members option is enabled, a new set is created for the selection of members, allowing the user to summarize and create calculations with the data.

        
      

    

    Applying filters to members within a set

    Filters on dimensional reports need to be applied to a Set of members. Filtering the members in a Set is not the same as relational detail or summary filters. To apply filters in a Set:

    1.	Click the Set that you want to filter. 

    2.	On the top toolbar, click Explore. 

    3.	Click Filter Set. 

    Figure 7-100 shows the Set Filter Condition window. In this window, you can select the kind of filter that you want to apply. 
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    Figure 7-100   Applying a filter within a Set

    You have the following options for filtering:

    •Caption: Filter by the member caption value, which is indexed data

    •Property: Filter by a descriptive data value, which is not indexed data

    •Intersection: Filter by an intersection of members and metrics (tuple) that you define

    After applying a filter, you can verify that the filter logic was applied or you can change the logic that was applied by clicking Explorer → Edit Set (see Figure 7-101). 
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    Figure 7-101   Visualizing the Set Definition

    Context filters

    When working with dimensional data, you can use context filters, or slicer filters, to focus your report on a particular view of the data quickly. For example, the following crosstab contains product lines in the rows, years in the columns, and revenue as the measure. We want to filter the values to show us the revenue for only web orders from Asia Pacific. To change the context, you drag Asia Pacific and web from the source tree to the Context filter section of the overview area. The crosstab then shows the revenue for only Asia Pacific and web. Changing the context changes only the values that appear. It does not limit or change the items in the rows or columns.

     

    
      
        	
          Context filters: Context filters differ from other filters. When you filter data, members that do not meet the filter criteria are removed from the report. A context filter does not remove members from a report. Instead, their values are filtered, and you see blank cells.

        
      

    

    The members that are used as the context filter appear in the report header when you run the report. Any summary values in the report are recomputed to reflect the results that are returned by the context filter.

     

    
      
        	
          Guideline: When creating context filters, use only members from hierarchies that are not already projected on an edge of the crosstab, and use only one member per hierarchy.

        
      

    

    Explore features

    IBM Cognos Business Insight Advanced also provides several ways to filter dimensional data using the Explore button:

    •Top or Bottom filters: Focus data on the items of greatest significance to your business question (for example, Top 5 Sales’ Performers or Bottom 10 Clients’ Revenue). 

    •Exclude and Include Member: Exclude members from current set or initial set

    •Drill down and drill up: Display parents or children of the selected valued in the dimension hierarchy

    If the set definition has more than one level, for instance, consider a crosstab with a Top 3 filter applied (Figure 7-102). 
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    Figure 7-102   Crosstab with a Top 3 filter applied

    If you exclude a member from the initial set, the crosstab applies the Top 3 filter again and excludes the selected member (Figure 7-103). 
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    Figure 7-103   Exclude a member from the initial set 

    If you exclude a member from the current set, the Top 3 filter is kept, and the crosstab shows only two values on the edge on which the Exclude logic was applied (Figure 7-104).
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    Figure 7-104   Exclude a member from the current set

    Using custom filters

    When report developers need to create complicated logic for filtering in a dimensional data source, they can create customized expressions to filter members on reports.

    For example, Lynn Cope, who is a Professional Report Author, wants to filter a crosstab to show only the Product lines that have Revenue greater than USD5,000,000 (this condition hides Outdoor Protection from the results).

    To implement this logic, Lynn must replace the default row or column with a new expression. 

    Figure 7-105 shows the report.
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    Figure 7-105   Initial result for the report: Revenue by Product line for 2007

    Lynn follows these steps:

    1.	In the Insertable Objects pane, on the Toolbox tab, drag Query Calculation to the same place as Product line (Rows area), as shown in Figure 7-106.

    2.	In the Name field, type Filtered Product line, select Other expression, and then click OK.

    3.	In the Expression Definition section, type the following expression:

    filter([Sales (analysis)].[Products].[Products].[Product line], [Revenue] > 5000000)

    4.	Click OK. 
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    Figure 7-106   Creating a filter expression

    After performing these steps, Lynn notices that the Outdoor Protection product line is removed from the results (Figure 7-107).
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    Figure 7-107   Final result for the report: Revenue by Product line for 2007

    7.7.3  Suppress data

    When a user works with dimensional data sources and creates an analysis nesting dimensions (in a crosstab or chart), the user notices that there are many rows with no values on the report. When working with dimensional data sources, IBM Cognos returns all the members of the hierarchy, even if they do not have values for the metrics.

    To avoid this scenario, IBM Cognos Business Insight Advanced provides the Suppress data feature that hides all the rows or columns (or both) that do not have data for the intersections, as shown in Figure 7-108 and Figure 7-109.
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    Figure 7-108   Report without the Suppress data feature applied
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    Figure 7-109   Report with the Suppress data feature applied

    The rows with all null values are removed.

     

    
      
        	
          Suppress feature: When using the Suppress feature, calculations are always performed before the suppression.

        
      

    

    7.7.4  Example

    Lynn Cope, an Advanced Business User for the Great Outdoors company, wants to create a report to show data for the Camping Equipment Product line, for 2007 and 2006, and for GO Americas only.

    To create this report:

    1.	In IBM Cognos Connection, launch Business Insight Advanced. The Select a package window opens. 

    2.	Navigate to Cognos → Public Folders → Samples → Models. 

    3.	Click GO Data Warehouse (analysis) to create a new report that is based on this package. 

    4.	Click Create New to create a new report, and then click the Crosstab icon. 

    5.	In the Insertable Objects pane, navigate to Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Products. 

    6.	Drag Camping Equipment under Products to the Rows area. 

    7.	Drag Time under the Sales folder to the Columns area. 

    8.	Drag Revenue under Sales fact to the Measures area (Figure 7-110). 
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    Figure 7-110   Initial report showing the Revenue for all Camping Equipment members by year

    9.	Click 2006, press Ctrl, and click 2007. 

    10.	On the top toolbar, click the Filters icon. 

    11.	Click Include 2006, 2007 (Figure 7-111). 
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    Figure 7-111   Filtering a report based on a selection

    After performing these steps, the report is displayed with the Revenue totals for 2006 and 2007 grouped by Camping Equipment product types (Figure 7-112), but Lynn wants to filter this report to show information for GO Americas only. 
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    Figure 7-112   Revenue by Camping Equipment product types, 2006 and 2007 years only

    Lynn decides to slice the report for GO Americas, by creating a Context filter, as shown in Figure 7-113.
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    Figure 7-113   Final report filtered for GO Americas scenario

     

    
      
        	
          Resource: For more information about how to work with multiple types of filters, refer to the IBM Cognos Business Insight User Guide or contact IBM Cognos Education services.

        
      

    

    7.8  Add external data

    IBM Cognos Business Insight and IBM Cognos Report Studio allow users to integrate external data, such as spreadsheets, into their reports.

    When users import external data using this feature, a package with a new data model merging the data source of the report and the external data is created. Only a link for the local data source is created; the users cannot store the data on the server.

    To be successful when creating reports using external data, users need to follow the workflow that is shown in Figure 7-114.

    [image: ]

    Figure 7-114   Workflow: How to work with external data

    Prepare your external data file for import

    Advanced business users, professional report authors, and analysts must know their external data (the enterprise data to which they are trying to connect to make their analysis) and the objective of their analysis.

    Import your external data

    This step depends on the data source. If the user wants to merge external data with a relational data source, the user can link the external data directly with the enterprise data source or to a list report. 

    If the user wants to merge external data with a dimensional data source, the user must create a list report and link the external data source to the content of the list report (Figure 7-128 on page 328 shows an example).

     

    
      
        	
          Maximums: The maximum file size that a user can import is 2.5 MB, with a maximum of 20,000 rows. A user can import a maximum of one external data source file per package. The IBM Cognos modeler can override these governors in IBM Cognos Framework Manager.

        
      

    

    Create reports with your external data file

    After IBM Cognos Business Insight Advanced creates the package, users can create their reports with the new data source in the same manner as with regular packages. Users can create reports with their data and perform many operations, such as creating crosstabs, lists, and charts, summarizing data, applying sorting, and grouping and adding calculations.

    Determine whether to share the reports

    After you create a report using external data, you usually save the report in you My Folders folder. If a you want to share the report, the people who are to see the report need to obtain the file that is used by the external data source for their computers and have it located in the same location so that IBM Cognos BI can find the source file. Another option is to place the source file on a shared drive that IBM Cognos BI can access and create the external data source based on that location. With this second method, it is easier to share reports, because you do not have to distribute your file to each person with whom you want to share a report.

    If you want to share a report, you must maintain the report to keep it current.

     

    
      
        	
          Resource: For more information about working with the External Data feature, refer to the IBM Cognos Business Insight Advanced User Guide.

        
      

    

    7.8.1  External Data feature example

    Lynn Cope, an Advanced Business User of the Great Outdoors company, needs to create a catalog report with product sizes and quantity available in English and French units, grouped by Product line and Product type.

    Lynn has received a spreadsheet with the translation of the units to English and French. She wants to use this information to build her report, because she knows it is not available in the data warehouse. She can easily create this report in IBM Cognos Business Insight Advanced using the External Data feature.

    Create the External Data package

    Because Lynn wants to merge external data with a dimensional data source, she needs to create a list report with the data that she wants to be available in the external data package. 

    To create the External Data package:

    1.	In IBM Cognos Connection, launch Business Insight Advanced. The Select a package window opens.

    2.	Navigate to Cognos → Public Folders → Samples → Models. 

    3.	Click GO Data Warehouse (analysis) to create a new report based on this dimensional package. 

    4.	Click Create New to create a new report, click List, and then click OK. 

    5.	If required, click View Metadata Tree. 

    6.	In the Insertable Objects pane, drag the following data items to the list (Figure 7-115 on page 317):

     –	From Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Products → Products: 

     •	Product line

     •	Product type

     •	Product

     –	From Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Products → Products details: 

     •	Product key

     •	Product number

     •	Product size code

     •	Product size

     –	From Go Data Warehouse (analysis) → Sales and Marketing (analysis) → Sales → Sales fact: 

     •	Quantity

    7.	Save the report in the My Folders folder with the name Product information. 

    8.	Click the Manage External Data icon (Figure 7-115). 
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    Figure 7-115   Simple list report with Product data and Quantity values

    9.	Click Browse and choose the location of the external data (Figure 7-116 on page 318).This location can be on the local machine or on a network share. The following extensions are supported: 

     –	Microsoft Excel (.xls) spreadsheet software files

     –	Tab-delimited text (.txt) files

     –	Comma-separated value (.csv) files

     –	XML (*.xml) files

    Here, users can specify which data they want to include on their reports.

    The users need to specify a namespace to use. The namespace provides a unique name to associate with the data items that the users import. The namespace appears in the data tree of the Source tab in the Insertable Objects window and is used to organize the data items. By default, the namespace is the imported file name without the extension.

    If you change the default name for the namespace, you are prompted to select the external data file each time that you run the report. To avoid this step, select the “Allow the server to automatically load the file” check box.
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    Figure 7-116   Selecting an external data source

    10.	Click Next. 

    11.	In the Existing report section, click the ellipsis (...). 

    12.	Browse to the My Folders folder. 

    13.	Click the Product information report, and then click Open. 

    14.	In the External data list, click PRODUCT_SIZE_CODE. 

    15.	In the Existing report list, click Product size code. 

    16.	Click New Link (Figure 7-117). 

     

    
      
        	
          Linking columns: Before you create the data mapping, make sure that the columns that will be linked match (for example, product size code).
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    Figure 7-117   Mapping the external data against an IBM Cognos data source

     

    
      
        	
          Relational data source: When using the External Data feature with a relational data source, users do not need to create a report to link the data. They can link the external data to the relational IBM Cognos package.

        
      

    

    17.	Click Next twice. 

    18.	In the Existing query subject items section, click Some values exist more than once (Figure 7-118). 
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    Figure 7-118   Setting mapping options

    19.	Click Finish. 

    20.	On the Manage External Data window, click the ellipsis (...), as shown in Figure 7-119. 

    21.	Set the location of the Package to My Folders, and name it:

    Go Data Warehouse (analysis) External Data with Dimensional

    22.	Click Save. 
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    Figure 7-119   Manage External Data window

    23.	Click Publish. 

    A message displays with information about the new package that will be created (see Figure 7-120).
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    Figure 7-120   External data source information message

    24.	Click OK. 

    After the package is created, the package that is used for the current report is changed, and the new package appears in the Insertable Objects pane (see Figure 7-121).

     –	This new package consists of two subjects: 

     –	One subject accesses the external data 

    The other subject accesses the dimensional data that is extracted from the Product information report. 
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    Figure 7-121   External Data package

    25.	On the top toolbar, click the New icon. 

    26.	Click No to saving the existing report because it is saved already, and then click List. 

    27.	Drag the following data items from the Insertable Objects pane (Figure 7-122):

     –	From Go Data Warehouse (analysis) External Data → product_size → Product information: 

     •	Product line

     •	Product type

     •	Product
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    Figure 7-122   Including Product information from the query subject created with the dimensional data

    28.	Drag the following data items from the Insertable Objects pane (Figure 7-123):

     –	From Go Data Warehouse (analysis) External Data → product_size → product_size → : 

     •	PRODUCT_SIZE_EN

     •	PRODUCT_SIZE_FR
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    Figure 7-123   Including Product size information from the query subject created with the external data

    29.	From Go Data Warehouse (analysis) External Data → product_size → Product information, add Quantity (Figure 7-124). 
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    Figure 7-124   Including Quantity measures from the query subject created with the dimensional data

    30.	In the crosstab, click Product line, Product type, Product, PRODUCT_SIZE_EN, and PRODUCT_SIZE_FR. 

    31.	On the top toolbar, click the Group/Ungroup icon (Figure 7-125). 
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    Figure 7-125   Grouping list columns

    32.	In the crosstab, click Product line. 

    33.	On the top toolbar, click the Sort icon. 

    34.	Click Edit layout sorting (Figure 7-126). 
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    Figure 7-126   Edit Layout Sorting option

    35.	Drag each member from the Data items area to the Groups section, as shown in Figure 7-127. 
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    Figure 7-127   Setting Grouping & Sorting configuration

    36.	Click OK.

    After performing these steps, the report shows the information from both external data and enterprise data sources, ordered by Product line, Product type, and Product (Figure 7-128).
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    Figure 7-128   Report showing external and enterprise data ordered by Product line, Product type, and Product

    7.9  Create a package with the Self Service Package wizard

    In Chapter 4, “Create reporting packages with IBM Cognos Framework Manager” on page 33, we discussed metadata modeling and how to create a reporting package in IBM Cognos Framework Manager. For certain online analytical processing (OLAP) sources, you must create and publish a package from IBM Cognos Framework Manager. For SAP Business Information Warehouse (SAP BW) and IBM Cognos PowerPlay Studio PowerCube data sources, however, you can create packages in IBM Cognos Connection, and they will be listed in Public Folders or My Folders.

    You must meet two prerequisites to perform this task:

    •The user must have execute permissions for the Self Service Package wizard capability. Select IBM Cognos Administration and navigate to the Security tab. Then, click Capabilities → Capability → Self Service Package Wizard. For details about setting the permission, refer to IBM Cognos Administration and Security Guide.

    •You must enable the self-service package capability for a data source; it is a property of a data source in IBM Cognos Administration. On the Connection tab, you have to enable the option Allow personal packages (see Figure 7-129).
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    Figure 7-129   Enabling self-service package capability for a data source

    7.9.1  Create a package for Cognos PowerCubes

    If you have an IBM Cognos PowerPlay Studio PowerCube as a data source and if you want to use it in one of the IBM Cognos Studios for creating reports or analysis, you first must create a package. In our example, the data source is a Sales and Marketing Cube that is part of the IBM Cognos samples. The data source must have the self-service package capability enabled to be listed as a data source in the Self Service Package wizard (see Figure 7-129 on page 329). 

    To create a package for a PowerCube data source, follow these steps:

    1.	Open the IBM Cognos Connection, and in the upper-right corner, click the New Package icon, as shown in Figure 7-130. 
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    Figure 7-130   Creating a new package from IBM Cognos Connection

    2.	Select the data source that you want to add from a list. For our example, click Sales and Marketing Cube (see Figure 7-131), and then click OK.
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    Figure 7-131   Select a data source for a package

    3.	Enter the name for the package (leave the default name, Sales and Marketing Cube). Select a location for a package. The default location for packages is My Folders, but you can change that here if you click Select another location. Click Next.

    4.	You can define null-suppression options here:

     –	Allow null suppression: Enables suppression.

     –	Allow multi-edge suppression: Allows the studio user to suppress values on more than one edge.

     –	Allow access to suppression options: Allows the studio user to choose which types of values will be suppressed, such as zeros or missing values.

    By default, all options are checked, as shown in Figure 7-132.
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    Figure 7-132   Null suppression options for a Cognos PowerCube

    5.	Click Finish. 

    6.	A new package for a Cognos PowerCube is added to IBM Cognos Connection, as shown in Figure 7-133. Any of the IBM Cognos Studios can use this package for reporting.
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    Figure 7-133   New package for a Cognos PowerCube

    7.9.2  Create a package for SAP BW

    For SAP BW data sources, the prerequisites are the same, but creating a package has additional SAP BW-specific steps. To add an SAP BW data source in a package, follow these steps:

    1.	In IBM Cognos Connection, click the New Package icon in the upper-right corner.

    2.	Type the name for the package, and click Next. 

    3.	Select the objects that you want to include. 

    The number of objects that you can select is limited. By default, you can select a maximum of two cubes and five info queries. You can change these settings, but be aware that the longer an SAP BW import takes, the more time the server spends processing the request, which might have an impact on its performance for other applications. For details about how to set these parameters, refer to the IBM Cognos Administration and Security Guide.

    4.	To import SAP BW queries that contain dual structures and use the structures in IBM Cognos queries to control the amount and order of information that your users see, click Enable SAP BW Dual Structures support. Click Next.

    5.	Select the languages to include in the package, and click Next.

    6.	Specify the object display name. 

    7.	To have objects in the model organized in the same way that they are organized in Business Explorer Query Designer, click Enhance the package for SAP BW organization of objects.

    8.	If you want to use Dynamic Query Mode with the data source, select Use Dynamic Query Mode.

    9.	Click Finish. 

    10.	When the “Package successfully created” message appears, you can edit variable properties (click Edit the SAP BW variable properties for the package after closing this dialog) or click Close to finish creating the package.

    A new package for an SAP BW will be added to IBM Cognos Connection.

    7.10  Create statistical calculations

    IBM Cognos Statistics, powered by IBM SPSS, provides analysts with the ability to distribute reports with statistical insight to the larger business community, further expanding the breadth of reporting capabilities provided by IBM Cognos software. Whether you are obtaining additional insight into key business variables or predicting future outcomes, IBM Cognos Statistics provides the necessary fact-based statistical evidence to support key organizational decisions.

    Because IBM Cognos Statistics is seamlessly integrated into IBM Cognos Report Studio, analysts no longer need to extract standardized trusted data from their business intelligence (BI) data warehouse into a separate tool to analyze and report on statistical information. Now, analysts can assemble reports containing statistical information easily and distribute the information across the enterprise, saving valuable time. The statistical capabilities that are provided by IBM Cognos Statistics are powered by the trusted market-leading IBM SPSS statistical engine, enabling you to make the most of best-in-class analytics within your organization.

    IBM Cognos Statistics is easy to use for existing IBM Cognos Report Studio authors, because it uses IBM Cognos Report Studio objects and provides a convenient wizard interface.

    In this section, we introduce and provide a use case of IBM Cognos Statistics.

    7.10.1  IBM Cognos Statistics overview

    In this section, we provide the functions of IBM Cognos Statistics and sample images that were created from the Great Outdoors sales company data. With these images, we introduce each statistical function.

    For more information about any of these features, see the IBM Cognos Report Studio User Guide.

    Descriptive Statistics

    Descriptive Statistics quantitatively summarize a data set. For an overall sense of the data being analyzed, you can show descriptive statistics along with more formal analyses. In this section, we describe the types of statistical objects in Descriptive Statistics.

    Basic Descriptive Statistics

    Descriptive tables describe the basic features of data in quantitative terms: 

    •Summary descriptive statistics: One value

    In this table, we use the Salary to Analysis variable and the Employee to Case variable (see Figure 7-134). You can see that the average salary of this company is 49,664.18 and that the standard deviation is extremely high: 31189.147.
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    Figure 7-134   Summary descriptive statistics: One value

    Notes regarding Figure 7-134:

    Mean	The arithmetic mean is the sum of samples divided by the number of cases.

    Std. Deviation	A measure of dispersion around the mean.

    N	The number of cases, observations, or records.

    Median	Half of the cases fall above the median, and half of the cases fall below the median.

    Minimum	The smallest value of a numeric variable.

    Maximum	The largest value of a numeric variable.

    •Summary descriptive statistics: Multiple values

    In the table in Figure 7-135, we use the Salary and Bonus value to Analysis variable and the Employee to Case variable. You can see that the standard deviation of Bonus value is lower than the standard deviation of Salary in this company.
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    Figure 7-135   Summary descriptive statistics: Multiple values

    •Descriptive statistics by grouping variable

    In the table in Figure 7-136, we use the Salary to Analysis variable, Employee to Case variable, and Country to Grouping variable. You can compare the salary of each country.
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    Figure 7-136   Descriptive statistics by grouping variable

    Histogram

    Histograms display the range of variable values in intervals of equal length. You can use a histogram to summarize the frequency of observations graphically.

    Figure 7-137 uses the Unit price to Analysis variable, Product to Case variable, and Country to Grouping variable. Unit price distribution regarding all the products of this company displays.
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    Figure 7-137   Histogram

    Boxplot

    A boxplot, which is also known as a “box-and-whisker” chart, is a convenient way to show groups of numerical data, such as these types:

    •Minimum and maximum values

    •Upper and lower quartiles

    •Median values

    •Outlying and extreme values

    Figure 7-138 uses the Gross profit to Analysis variable, Retailer name to Case variable, and Region to Grouping variable. You can see the Gross profit distribution of retailers of each region and that VIP Department Stores is an excellent retailer in the U.S.
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    Figure 7-138   Boxplot

    Q-Q Plot

    You can create a quartile-quartile (Q-Q) plot to chart the quartiles of a variable’s distribution against a distribution of your choice, including the normal distribution.

    Figure 7-139 uses the Salary to Analysis variable and Employee to Case variable. You can see that several of the high-salaried and low-salaried employees are out of range in the normal distribution in this company.
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    Figure 7-139   Q-Q Plot

    Means comparison

    You can compare the means of two or more groups to determine if the difference between the groups is statistically significant, that is, if the difference is due to something other than random chance.

    You can use two types of statistical objects in means comparison.

    One-Sample t-Test

    The One-Sample t-Test tests the probability that the difference between the sample mean and a test value is due to chance. Probabilities of .05 or less are typically considered significant.

    In this table, we use the Revenue to Analysis variable, Product to Case variable, Product line to Grouping variables, and 30000000 to Test value. One-Sample t-Test provides two types of results: one type is One-Sample Statistics (Figure 7-140) and the other type is One-Sample Test (Figure 7-141). Check the Sig. or significance values in the One-Sample Test, and you can see that Camping Equipment, Personal Accessories, and Golf Equipment do not differ significantly compared to the Test value, but Mountaineering Equipment and Outdoor Protection differ significantly.
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    Figure 7-140   One-Sample Statistics
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    Figure 7-141   One-Sample Test

    One-Way ANOVA

    You can use One-Way ANOVA to assess whether groups of means differ significantly. ANOVA assumes that there is homogeneity of variance, that is, that the variance within each of the groups is equal. You can check for homogeneity of variance by using the Levene’s test. Probabilities of .05 or less are typically considered significant.

    In this table, we use Salary to Dependent variables, the Branch region to Independent variable, and the Employee to Case variable. One-Way ANOVA provides various kinds of results. For example, this test provides these three tables and one chart (see Figure 7-142, Figure 7-143, Figure 7-144, and Figure 7-145). The Multiple Comparisons table shows the salary difference for each country.
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    Figure 7-142   ANOVA
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    Figure 7-143   Multiple Comparisons
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    Figure 7-144   Homogeneous subsets
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    Figure 7-145   Means Plots

    Nonparametric tests

    You use nonparametric tests to compare frequencies in categorical data. You test for significant differences between observed frequencies and expected frequencies in data that does not have a normal distribution.

    One-Way Chi-Square Test

    One-Way Chi-Square Tests, which are also known as chi-square goodness-of-fit tests, compare observed frequencies against expected frequencies using data from a single categorical variable.

    In this table, we use the Branch region to Analysis variable, Vacation days taken to count variable, and Employee to Case variable. The One-Way Chi-Square Test provides the types of results that are shown in Figure 7-146 and Figure 7-147. You can see Central Europe is the region whose employees take the most vacation.
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    Figure 7-146   Frequencies by Branch region
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    Figure 7-147   Test Statistics

    Two-Way Chi-Square Test

    Two-Way Chi-Square Tests, which are also known as chi-square tests of independence, compare observed frequencies against expected frequencies using data from two categorical variables.

    In this table, we use Level of education to Analysis variable1, Previous defaulted to Analysis variable2, and the Customer ID to Case variable. The Two-Way Chi-Square Test provides various types of results (Figure 7-148, Figure 7-149, and Figure 7-150). You can see Pearson Chi-Square is significant (<0.5), which means that there is a significant difference between the default rates of customers with differing levels of education.
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    Figure 7-148   Case Processing Summary
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    Figure 7-149   Crosstabulation
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    Figure 7-150   Chi-Square Tests

    Correlation and Regression

    Correlation and regression analysis let you examine relationships between variables.

    Basic Correlation

    Basic Correlation is a measure of association between two variables. The existence of a correlation does not imply causality, but simply helps you to understand the relationship.

    This table uses Unit price to Analysis variable1, Quantity to Analysis variable2, and the Product to Case variable. Basic Correlation provides these kinds of results (see Figure 7-151, Figure 7-152, and Figure 7-153). You can see that the Pearson Correlation is 0.904, which means that there is a positive relationship between Product cost and Gross profit.
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    Figure 7-151   Basic Correlation chart
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    Figure 7-152   Basic Correlation Descriptive Statistics
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    Figure 7-153   Basic Correlation correlations

    Linear Regression

    Linear Regression examines the relationship between one dependent variable and one or more independent variables. You can use Linear Regression to predict the dependent variable when the independent variables are known.

    In this table, we use the Gross profit to Dependent variable, Product cost to Independent variable, and Product to Case variable. Linear Regression provides various types of results (see Figure 7-154, Figure 7-155, Figure 7-156, and Figure 7-157). 

    The key statistic of interest in the coefficients table is the unstandardized regression coefficient, Product cost 0.528.

    The regression equation is as follows:

    dependent variable = slope * independent variable + constant

    The slope is how steep the regression line is, based on a scatterplot. The constant is where the regression line strikes the y-axis when the independent variable has a value of 0.

    In this example, the slope is 0.528, and the constant is 2861822.972. So, the regression equation is the predicted value of Gross profit = 0.528* Product cost + 2861822.972.
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    Figure 7-154   Linear Regression Variables Entered/Removed
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    Figure 7-155   Linear Regression Model Summary
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    Figure 7-156   Linear Regression ANOVA
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    Figure 7-157   Linear Regression Coefficients

    Curve Estimation

    You can use Curve Estimation to plot a curve through a set of points to examine the relationship between one independent variable and one or more dependent variables. The aim of Curve Estimation is to find the best fit for your data, expressed as the correlation coefficient R square.

    You can choose one or more curve estimation regression models:

    •Linear

    •Logarithmic

    •Inverse

    •Quadratic

    •Cubic

    •Power

    •Compound

    •S

    •Logistic

    •Growth

    •Exponential

    This table uses the Gross profit to Dependent variable, Product cost to Independent variable, and Product to Case variable with Linear model. Curve Estimation provides these kinds of results (Figure 7-158, Figure 7-159, Figure 7-160, and Figure 7-161). You can see differences between the estimated line and the actual value. You can try using separate models with your data to help you find the model with the optimum fit.
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    Figure 7-158   Curve Estimation chart
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    Figure 7-159   Curve Estimation Model Summary
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    Figure 7-160   Curve Estimation ANOVA

    [image: ]

    Figure 7-161   Curve Estimation Coefficients

    Control Charts

    All processes show variation, but excessive variation can produce undesirable or unpredictable results. You use statistical process control (SPC) to monitor critical manufacturing and other business processes that must be within specified limits.

    Control Charts plot samples of your process output collected over time to show you whether a process is in control or out of control.

    X-Bar

    Plot the average of each subgroup. An X-Bar chart is often accompanied by either the R chart or S chart (Figure 7-162, Figure 7-163, and Figure 7-164).
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    Figure 7-162   X-Bar chart
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    Figure 7-163   X-Bar Rule Violations
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    Figure 7-164   X-Bar Process Statistics

    R charts

    R charts plot range values by subtracting the smallest value in a subgroup from the largest value in the same subgroup. The center line on the chart represents the mean of the ranges of all the subgroups (Figure 7-165).
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    Figure 7-165   R chart

    S charts

    S charts plot the standard deviations for each subgroup. The center line on the chart represents the mean of the standard deviations of all the subgroups (Figure 7-166).
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    Figure 7-166   S chart

    Moving Range

    Moving Range charts plot the difference between each sample value and the preceding sample value. The center line on the chart represents the average change from one sample to another sample (Figure 7-167).
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    Figure 7-167   Moving Range

    Individuals

    Individuals charts plot the measured value of each individual sample. The center line on the chart represents the average of all individual samples in the chart (Figure 7-168 and Figure 7-169).
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    Figure 7-168   Individuals chart
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    Figure 7-169   Individuals Rule Violations

    p chart

    The p chart plots the percentage of defective units, such as the percent of automobiles with defects per shift. Sample sizes do not need to be equal. They can vary between collection periods.

    np chart

    The np chart plots the number of defective units, such as the number of automobiles with defects per shift. Sample sizes must be equal.

    c chart

    The c chart plots the number of defects, such as the total number of defects per shift. Sample sizes must be equal.

    u chart

    The u chart plots the number of defects per unit, such as the number of defects per automobile per shift. Sample sizes do not need to be equal. They can vary between collection periods.

    7.10.2  IBM Cognos Statistics use case: 
Create an IBM Cognos Statistics report

    Chapter 3, “Business scenario and personas used in this book” on page 21 introduces the Great Outdoors company business scenario. We use IBM Cognos Statistics to answer the following business question for the company: 

    •How many units of a product should I buy by each period of the year?

    The executives wants a summarized report of sales performance that shows the relationship between the sales quantity and inventory of each product.

    In this scenario, Ben Hall is the Analyst. He wants to create a sales summary report that shows the statistical relationship between the sales quantity and the inventory in the second quarter (2Q) of 2007 with IBM Cognos Statistics. Also, he wants to show which product is a “pain” point or poor seller.

    Create a statistics chart

    First, Ben creates a statistics chart. To create the chart:

    1.	Launch IBM Cognos Report Studio with the Go Data Warehouse (query) package.

    2.	Click the Insert Table icon, and create a 1 x 2 table.

    3.	Drag a Curve Estimation statistic object from the Insertable Objects pane to the left side of the table.

    4.	In the Select Statistic dialog box, expand Correlation and Regression, and click Curve Estimation, as shown in Figure 7-170. Click OK. In the next window, click Cancel.
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    Figure 7-170   Select Statistic dialog box

    5.	Insert the following measures and items, as shown in Figure 7-171:

     –	Quantity to Dependent variable 

     –	Opening inventory to Independent variable 

     –	Product to Cases variable 
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    Figure 7-171   Insert measures and items

    6.	Create an advanced filter with Year=2007 and Quarter=’Q2’.

    7.	Run a report. 

    Figure 7-172 shows the result. The red circles show the pain points. These points are much lower than the estimated line, which means that these items had too much inventory compared to their sales quantities. 

    If you want to identify the item name of the pain point, there is no direct way to identify the pain points at this point. So, you can use the crosstab to identify them.
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    Figure 7-172   Curve Estimation chart

    Create crosstab to identify pain point

    Next, Ben creates a crosstab. To create a crosstab:

    1.	Before creating a crosstab, make a note about the following information in the statistical report (see Figure 7-173): 

     –	Slope: 0.533

     –	Constant: 17297.425

    From this information, you can recognize the following equation:

    predicted value of Quantity = 0.533* Opening inventory + 17297.425
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    Figure 7-173   Coefficients

    2.	Drag a Crosstab object from the Insertable Objects pane to the correct table. 

    3.	Insert Product in the Rows area. Insert Quantity and Opening inventory in the Columns area, as shown in Figure 7-174.
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    Figure 7-174   Crosstab 

    4.	Create the same advanced filter for the crosstab that you created in the statistic report.

    5.	Create the estimated column:

    a.	Click Opening inventory, and add a custom calculation.

    b.	Click *(multiplication) in the operation, type slope value(0.533) in the Number field, and click OK.

    c.	Click the (Opening inventory * 0.533) column, and add a custom calculation.

    d.	Click +(addition) in operation, type Constant value(17297.425) in the Number field, and click OK.

    e.	Delete the (Opening inventory * 0.533) column.

    f.	Click the ((Opening inventory * 0.533) + 17297.425) cell, and rename it as “Regression” in the property pane (Figure 7-175).
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    Figure 7-175   Crosstab

    6.	Click the Regression, Quantity cell, and add the calculation (Regression - Quantity).

    7.	Move (Regression - Quantity) to the right edge of the crosstab.

    8.	Click the (Regression - Quantity) cell, and set the order as Descending (Figure 7-176).
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    Figure 7-176   Crosstab

    9.	Adjust the crosstab location appropriately.

    10.	Run the report.

    In this report, the crosstab shows the order of difference between the estimated line and the actual sales Quantity. You can identify the item name of the pain points with Quantity and Opening inventory values, as shown in Figure 7-177. You can see that these item names are “Glacier Basic” and “Double Edge”.
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    Figure 7-177   Statistic report
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Actionable analytics everywhere

    IBM Cognos Business Intelligence (BI) offers various capabilities that allow more people to take advantage of business intelligence in more places. Having access to the data that you, when you need it, so that you can make the best decisions possible is best described as actionable analytics.

    In this chapter, we introduce the actionable analytics that are available with IBM Cognos BI. This chapter includes the following topics:

    •Accessibility and internationalization

    •Disconnected report interaction

    •Interact with IBM Business Analytics using mobile devices

    •IBM Cognos Analysis for Microsoft Excel

    •Business driven workflow

    8.1  Accessibility and internationalization

    IBM Cognos BI includes features to help you create reports that are more accessible to people with a physical disability, such as restricted mobility or limited vision.

    In this section, we introduce functions that you can use to enhance accessibility and the support language of IBM Cognos BI.

    8.1.1  Enabling access for more people

    When creating reports using IBM Cognos Report Studio and IBM Cognos Business Insight Advanced, you can do the following activities:

    •Add alternative text for non-text objects, such as images and charts

    •Add summary text for crosstabs, lists, and tables

    •Specify whether table cells are table headers

    When using IBM Cognos Business Insight or IBM Cognos for Microsoft Office, report consumers can do the following activities:

    •Navigate without a mouse using arrow keys and function keys. 

    For example, you can move to the first item or object with the Ctrl+Home key combination. Additionally, you can open and display the contents of a drop-down list with the Alt+Down arrow key combination.

    For more information, see the IBM Cognos Business Insight User Guide.

    •Use any combination of high contrast system settings and browser minimum font settings to control the display.

    For example, when you set the operating system to high contrast, graphic icons are replaced with text icons for easier viewing, as shown in Figure 8-1.
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    Figure 8-1   Text icons for high contrast

    •Use the Freedom Scientific JAWS screen reader. 

    JAWS is supported only with the Mozilla FireFox browser for this release of IBM Cognos Business Insight.

    •Switch from graphs to tables and control the palette settings to meet specific accessibility needs.

    IBM Cognos Business Insight is accessibility enabled. The documentation includes alternate text for all graphics so that screen readers can interpret graphics. The accessibility features, including keyboard shortcuts, are documented as well. For more information, see the IBM Cognos Business Insight User Guide.

    IBM Cognos BI provides the ability to enable accessible output at many levels. Users can enable accessible output by report, or they can choose to enable accessible output for all reports using a user preferences setting. Administrators can control assessable output as a server-wide option, so that all reports for all IBM Cognos BI users have accessibility features enabled. Accessibility settings in the user preferences and report properties overwrite this setting. For more information, see the IBM Cognos Connection User Guide and the IBM Cognos Administration and Security Guide.

    8.1.2  Providing internationalization

    IBM Cognos BI now expands language support for IBM Group 1 translations. The following Group 1 languages are supported in the product user interface, the search functionality, and the indexed search functionality (see Figure 8-2).

    •Existing Group 1 language translations

    French, German, Japanese, Spanish, Brazilian Portuguese, and Simplified Chinese

    •New Group 1 language translations

    Traditional Chinese, Korean, and Italian
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    Figure 8-2   Setting for supported language

    8.2  Disconnected report interaction

    IBM Cognos BI offers a report function called IBM Cognos Active Report. IBM Cognos Active Report is a disconnected and interactive report that is developed for employees in the field and growing ranks of telecommuters and business partners who are not connected to an intranet and need information and analytics to make quick decisions and actions.

    8.2.1  IBM Cognos Active Report overview

    IBM Cognos Active Report includes reports that are built for business users, allowing them to explore data and derive additional insight. IBM Cognos Active Report extends the reach of business intelligence and analytics to employees in the field and business partners. IBM Cognos Active Report can be consumed by users who are offline, making this an ideal solution for remote users such as the sales force. 

    You use IBM Cognos Report Studio to create active reports. IBM Cognos Active Report is a report output type that provides a highly interactive and easy-to-use managed report. Report authors build reports that are targeted at users’ needs, keeping the user experience simple and engaging. 

    8.2.2  IBM Cognos Active Report features

    IBM Cognos Active Report produces reports that are an extension of existing IBM Cognos Report Studio values and the IBM Cognos Platform. Users continue to benefit from the enterprise value of one version of the truth, and new interactive control types in IBM Cognos Report Studio serve as building blocks for creating active reports.

    You use active report controls to create the layout of an active report and to filter and sort data in the report.

    Layout

    Users need data organized in a way that is easy to consume and understand. Some users prefer viewing the numbers, and other users prefer viewing a visualization, such as a chart. 

    To help report authors deliver content in the most consumable way possible, IBM Cognos Report Studio provides the following layout controls:

    •Tab controls for grouping similar report items, as shown in Figure 8-3
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    Figure 8-3   Tab controls

    •Decks of cards for layering report items

    You can use decks and data decks to show different objects and different data respectively based on a selection in another control. For example, clicking a radio button in a radio button group control shows a list object and clicking a different radio button shows a chart object.

    •Control data for hiding or showing list columns

    Users can control the data that displays using check boxes. You can show or hide a column in a list or a column or row in a crosstab when the report is viewed.

    Filtering and sorting

    Users need to focus on the data in which they are most interested. By allowing report authors to add easy to-use controls to a report, users can interact with the data and filter it to obtain additional insight.

    To help report authors deliver the content in the most consumable way possible, IBM Cognos Report Studio provides several filtering controls:

    •List and drop-down list control (as shown in Figure 8-4)

    Use list boxes and data list boxes to provide a list of items that users can choose from. In data list boxes, the lists are driven by a data item that you insert in the control. 

    In reports, users can select one or more items in a list box.
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    Figure 8-4   Drop-down list

    •Interactions with charts (as shown in Figure 8-5)

    Use list boxes and data list boxes to provide a list of items from which users can choose. In data list boxes, the lists are driven by a data item that you insert in the control.

    In reports, users can select one or more items in a list box.
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    Figure 8-5   List box

    •Radio buttons (as shown in Figure 8-6)

    Use radio button groups and data radio button groups to group a set of buttons that have a common purpose. In data radio button groups, the radio buttons are driven by a data item that you insert in the control.

    In reports, users can click only one radio button at a time.
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    Figure 8-6   Radio buttons

    •Check boxes (as shown in Figure 8-7)

    Use check box groups and data check box groups to group a set of check boxes. In data check box groups, the check boxes are driven by a data item that you insert in the control.

    In reports, users can select one or more check boxes simultaneously.
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    Figure 8-7   Check boxes

    •Toggle buttons (as shown in Figure 8-8)

    Use toggle button bars and data toggle button bars to add a group of buttons that change appearance when pressed. In data toggle button bars, the buttons are driven by a data item that you insert in the control.

    In reports, users can click one or more buttons simultaneously.
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    Figure 8-8   Toggle buttons

    •Push button controls (as shown in Figure 8-9)

    Use button bars and data button bars to add a group of push buttons. In data button bars, the buttons are driven by a data item that you insert in the control.

    In reports, users can click only one button at a time.
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    Figure 8-9   Buttons

    Upgrade considerations

    IBM Cognos Active Report is an extension of traditional IBM Cognos reports. Authors can upgrade existing reports to be interactive by adding the controls that we mentioned previously, providing users with an easy to consume interface.

    Similar to existing IBM Cognos reports, you can run active reports from IBM Cognos Connection, and you can schedule and burst these reports to users.

    8.2.3  IBM Cognos Active Report use case

    In Chapter 3, “Business scenario and personas used in this book” on page 21, we introduce the Great Outdoors company business scenario. We can use IBM Cognos Active Report to answer the following business questions for Great Outdoors company: 

    •Are we selling the correct products? 

    •Do we need to discontinue products?

    Company executives want to send a summarized report of sales performance to a business partner by email. The business partner is not connected to the Great Outdoors company intranet or the IBM Cognos BI infrastructure. The generated report needs to be interactive and must show data without requiring a connection to the IBM Cognos Platform.

    Create IBM Cognos Active Report

    Lynn Cope, who is in the role of the Professional Report Author in this example, creates a sales summary report that shows the lowest sold products in 2007 3Q. The report is divided by Product Line.

    To allow users to use the Active Report feature:

    1.	Create a list report. 

    Launch IBM Cognos Report Studio and create a list with Product line, Product type, Product, and Quantity of [GO Data Warehouse(analysis)]-[Sales and Marketing(analysis)]-[Sales].

    Add a Context filter with Q3 2007, and set the order to Ascending to Quantity and the grouping to Product line.

    2.	Convert the report to an active report by clicking File → Convert to Active Report.

    3.	Add an Active Report Object. Insert a Data Tab Control object from the Insertable Objects pane to the left side of the list table and insert the Product line to Drop Item here as shown in Figure 8-10.
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    Figure 8-10   Insert Data Tab control

    4.	Create a connection by clicking the Interactive Behavior icon. Then, select Create New Variable and enter Product line Variable 1, as shown in Figure 8-11.
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    Figure 8-11   Create a connection

    5.	Save and run the report. Figure 8-12 shows the result. If your result data rows are more than 5,000, change the limit setting within Active Report Properties.

    [image: ]

    Figure 8-12   Active report

    For more information, see the IBM Cognos Report Studio User Guide.

    Download IBM Cognos Active Report

    Lynn Cope is also an Advanced Business User. She wants to download the Active Report as a local file and send it to a business partner. 

    To download a report:

    1.	Click the developed Active Report in IBM Cognos Connection and then select download to local storage. The file has a .mht extension. (as shown in Figure 8-13).
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    Figure 8-13   Downloaded Active Report file

    2.	Send the .mht file to the business partner by email.

    Using the active report

    When the business partner receives an email from Lynn Cope, he can use the report that is attached to the email to analyze the data to determine the lowest sold product at each product line in 3Q 2007. To analyze the report:

    1.	Open the active report. To open the active report file, right-click the file, and select appropriate browser (for example, use Internet Explorer (V7 or higher) or Mozilla Firefox (with UnMHT) to open an active report. If you use Mozilla Firefox, delete the URL filter by selecting Tools → IE Tab option → Delete /^file:\/\/\/.*\.(mht|mhtml)$/.

    2.	Click each Product Line button to find the lowest sales quantity of each product line as shown in Figure 8-14.
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    Figure 8-14   Disconnected active report

    IBM Cognos Active Report can provide a robust and interactive experience for disconnected analysis of business information. For more information, see the IBM Cognos Report Studio User Guide.

    8.3  Interact with IBM Business Analytics using mobile devices

    IBM Cognos Mobile provides timely and convenient access to IBM Cognos BI information from a mobile device. Mobile users want to take advantage of personal mobile devices while interacting with business intelligence on the device. This function provides decision makers with access to business critical information wherever they are and whenever they need it.

    In this section, we introduce supported devices and a use case for IBM Cognos Mobile.

    8.3.1  Extended device support

    IBM Cognos Mobile now supports the mobile devices that we describe in this section.

    Support for Apple iPhone, Apple iPad, and Apple iPod Touch

    IBM Cognos Mobile now supports Apple iPhone, Apple iPad, and Apple iPod Touch devices. Users can use familiar iPhone actions to access the same business intelligence content and IBM Cognos Mobile features that are available on other devices in previous releases. In addition, users can create a list of favorites and select one dashboard or report to display automatically on the Welcome window when they start IBM Cognos Mobile.

    Support for RIM BlackBerry Smartphones

    IBM Cognos Mobile now supports the enhanced BlackBerry user interface for BlackBerry OS 4.2 and higher. The new user interface is easier to navigate and provides an improved overall experience when accessing IBM Cognos BI content.

    Support for Symbian S60 and Microsoft Windows Mobile 6.1 devices 

    IBM Cognos Mobile continues support for Symbian S60 and Microsoft Windows Mobile 6.1 devices.

    8.3.2  Simplified experience across all devices

    You can connect to, interact with, and make decisions with IBM Business Analytics on your mobile device as we describe in this section.

    Support for IBM Cognos Business Insight

    In addition to reports and analyses, users can have dashboards that were created in IBM Cognos Business Insight delivered to their devices.

    Improved prompting

    IBM Cognos Mobile offers improved prompting in the web application for the Apple iPhone. Prompting uses prompt identifiers and the surrounding text and formatting that desktop users see. Users can run prompted reports intuitively by using prompting mechanisms that suit the mobile device.

    Drill up and drill down

    IBM Cognos Mobile offers drill up and drill down capabilities. These features allow users to gain additional insight into the information that they are consuming. Users can see the fields within the IBM Cognos BI content on their devices on which they can drill up or drill down. After drilling up or drilling down on one or more of those fields, users can return to the original report where they began the drilling process.

    Browsing improvements

    IBM Cognos Mobile offers Report Thumbnails, Panning, and Zooming functions.

    Zero footprint

    IBM Cognos Mobile for the Apple iPhone and Apple iPod Touch is an HTML 5 web application. It enables the following functions:

    •Rapid mass deployment to enterprise mobile users

    •Faster device support to sustain the speed at which new devices enter the marketplace

    •Instantaneous software updates that occur at the server

    You do not need to update mobile client software, which makes deployment transparent to users.

    8.3.3  IBM Cognos Mobile use case

    Lynn Cope is an Advanced Business User who wants to reference a sales summary report on her Apple iPhone. When you connect to IBM Cognos Mobile on the Apple iPhone, see the Welcome window opens, as shown in Figure 8-15.
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    Figure 8-15   IBM Cognos Mobile welcome window on Apple iPhone 

    Figure 8-16 shows the Favorites tab.
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    Figure 8-16   Favorites tab 

    The third tab shows recently run reports by thumbnails, as shown in Figure 8-17.
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    Figure 8-17   Recently run reports 

    The Explorer tab shows IBM Cognos reports (similar to using IBM Cognos Connection) as shown in Figure 8-18.
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    Figure 8-18   Explorer tab

    The Search tab allows you to use the search function. In this example, Lynn searches for Sales reports as shown in Figure 8-19.
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    Figure 8-19   Search tab

    You can use the text prompt as shown in Figure 8-20.
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    Figure 8-20   Text prompt

    You can use the zooming function to show report detail as shown in Figure 8-21.
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    Figure 8-21   Zooming function

    8.4  IBM Cognos Analysis for Microsoft Excel

    IBM Cognos Analysis for Microsoft Excel offers enhanced value as a Microsoft Office based authoring and analysis tool that can share resulting work back to a common business intelligence portal and can improve the user experience for financial analysts who work with a variety of data sources.

    In this chapter, we introduce the features and a use case for IBM Cognos Analysis for Microsoft Excel.

    8.4.1  Features of IBM Cognos Analysis for Microsoft Excel

    This section introduces the features of IBM Cognos Analysis for Microsoft Excel.

    Calculation

    Calculations are now supported for explorations and lists, which enables you to create and maintain reports using advanced functions in an easy-to-use environment with drop zones. You can add business calculations, such as totals and percentage change between years. You can use the calculation function without converting to formulas.

    In addition, you can convert an exploration to a formula. When you convert your exploration, you have the option of converting data on the current worksheet, copying and moving the data to a new worksheet, or specifying the location for the converted data.

    Cell formatting

    Additional custom styles are available for formatting cells. You can gain access to IBM Cognos Analysis Studio styles, such as IBM Cognos - Calculated Row Name or IBM Cognos - Measure Summary, through the Microsoft Excel function by clicking Style from the Format menu. The IBM Cognos styles are listed along with default Microsoft Excel styles. You can modify attributes, such as font and alignment, and then save the changes to a template to use again.

    After items are placed in the cells of a worksheet, you can rename column and row headings, and you can reorder items.

    Publish Microsoft Excel reports

    You can publish explorations and lists directly to IBM Cognos Connection. You can save an exploration as a web report, which enables Microsoft Excel users to author reports in Microsoft Excel and distribute them as secured web reports without the additional step of using a studio package, such as IBM Cognos Analysis Studio.

    You can open these Microsoft Excel reports using IBM Cognos Business Insight Advance, IBM Cognos Report Studio, and IBM Cognos Analysis Studio.

    User-defined rows and columns

    You can add user-defined rows and columns in the middle of explorations and lists to add calculations. You can create Microsoft Excel calculations for the entire row, column, or block. You can also add blank rows and columns in the middle of explorations or lists to enhance readability.

    Comments

    You can add and preserve user comments and values. If you refresh the data in a Microsoft Excel sheet, these comments and values are not deleted.

    Performance

    A streaming data mode for list-oriented queries supports large volumes of data requests with speed. You can change the format of data that is received from the IBM Cognos BI server to CSV. Receiving the data as unformatted data can speeds processing time.

    8.4.2  IBM Cognos Analysis for Microsoft Excel use case

    Lynn Cope is an Advanced Business User who wants to create a sales summary report in Microsoft Excel. To allow users to use the IBM Cognos Analysis for Microsoft Excel feature:

    1.	Create a sales report. First, create a crosstab report with IBM Cognos Analysis for Microsoft Excel. Then, create an exploration, and insert Product to row, Time to column, Revenue to data in [GO Data Warehouse(analysis)]-[Sales and Marketing(analysis)]-[Sales] as shown in Figure 8-22.
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    Figure 8-22   Create an exploration

    2.	Add a calculation. First, add a column to show the difference of revenue between 2006 and 2007. Then, press Ctrl while you click the 2007, 2006 cell, click the calculation button, and select 2007 - 2006 as shown in Figure 8-23.
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    Figure 8-23   Add a calculation

    Figure 8-24 shows a new column that reports the difference between 2007 revenue and 2006 revenue.
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    Figure 8-24   Calculated column

    3.	Change the new column name to Latest Difference. Then, order the columns by right-clicking the year cell (for example 2004) and clicking IBM Cognos Analysis → Reorder / Rename (see Figure 8-25).

    [image: ]

    Figure 8-25   Change name and order

    You can change the cell format by clicking the Camping Equipment cell and clicking Format → Style → Modify as shown in Figure 8-26.

    You can reflect the cell attribute to other cells by selecting the appropriate Style name in the Style window.
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    Figure 8-26   Cell formatting

    4.	Add rows and columns by clicking the Insert User Row / Column icon, shown in Figure 8-27, and changing cell attributes, text, and create formula.
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    Figure 8-27   User-defined column

    5.	Add comments to appropriate cells (see Figure 8-28).
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    Figure 8-28   Add comment

    6.	Publish the Microsoft Excel report to IBM Cognos Connection as shown in Figure 8-29.
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    Figure 8-29   Publish

    Figure 8-30 shows the published Microsoft Excel report in IBM Cognos Connection.
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    Figure 8-30   Published Microsoft Excel report in IBM Cognos Connection

    8.5  Business driven workflow

    In this version, IBM Cognos Platform introduces the ability to encompass user actions into business intelligence events and processes in a way that can be managed and audited. In previous versions, event authors could configure agents that detected events within a business intelligence data source and that took action based upon reconfigured criteria. However, user interaction with these events was provided only using email and IBM Cognos portal news items.

    With email and news item posts, you cannot define how users are expected to respond to the event. In addition, you cannot capture what a user does with information that is provided by the event agent. 

    The enhanced event management features of this version permit event authors to configure tasks to be assigned to individual users or groups of users. These tasks can include expectations around when work on a task must be started by and completed by. Tasks can request approval for actions to be taken based upon an event, or they can request that a user decide how the agent should proceed to execute configured tasks based upon the user's analysis of or reaction to the event condition or task contents.

    In this section, we introduce WS-Human Tasks and features and provide a use case of IBM Cognos Event Studio and My Inbox.

    8.5.1  Enhanced event management

    The IBM Cognos Platform includes a new service to support enhanced event management functionality called the Human Task Service. This service is based upon an open specification called WS-Human Tasks. IBM is leading the working group to define the WS-Human Task standards along with participation from other web standards community members.

    IBM Cognos BI includes the following types of human tasks that you can see in the task inbox: 

    •Approval requests

    •Ad-hoc tasks

    •Notification requests

    You can create tasks from the following components:

    •IBM Cognos Event Studio (notification requests and approval requests)

    For more information, see the IBM Cognos Event Studio User Guide.

    •The My Inbox area of IBM Cognos Connection (notification requests and ad-hoc tasks)

    •A watch rule set up for a report (notification requests only)

    For more information, see the IBM Cognos Administration and Security Guide.

    Features of IBM Cognos Event Studio

    You can create the following human tasks in IBM Cognos Event Studio:

    •Approval request task

    You can create an approval request task to an agent when you want an event to occur only after approval. This task sends an approval request related to an event to the task inbox of specified recipients in IBM Cognos BI.

    •Notification request task

    You can create a notification request task to an agent to send a secure notification about an event to the inbox of specified recipients in IBM Cognos BI. You can include content, such as report output, in a notification request.

    My Inbox

    A task inbox contains the following human tasks:

    •Notification task

    You can also create a notification request task in My Inbox.

    •Ad-hoc task

    You can create an ad-hoc task to send a task to the task inbox of the recipients you specify. You can add deadlines to an ad-hoc task when you create it. Alternatively, potential owners or stakeholders can add deadlines at a later date, by updating the task from their task inbox.

    8.5.2  Human task service use case

    In this section, we provide two use cases that use the human task service.

    Approval Request scenario

    In this example, Lynn Cope is a Professional Report Author who wants to take a sales report definition and burst it into reports for the following countries: 

    •USA

    •Japan

    •Brazil

    Before the bursted report is sent, it must be approved by the Sam Carter, the Administrator, for a quality check.

    To submit the report for approval, perform the following:

    1.	Launch the IBM Cognos Event Studio with Go Data Warehouse (analysis) package and add the Run a report task as shown in Figure 8-31.
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    Figure 8-31   Task list

    2.	Select the burst report, and change settings as shown in Figure 8-32.
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    Figure 8-32   Burst report task

    3.	Add Run an approval request, and set Sam Carter as a potential owner. Enter a subject and body, and attach the bursted reports as shown in Figure 8-33.
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    Figure 8-33   Approval request task

    4.	You can select Due Dates, Priority, Options (Send email or not on each phase), Icon, Task Owner Action as shown in Figure 8-34.

    For more information, see the IBM Cognos Event Studio User Guide.
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    Figure 8-34   Approval request task options

    5.	Add a Send an email task, and set Lynn Cope as the recipient. Enter a subject and body, and attach the bursted reports as shown in Figure 8-35.
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    Figure 8-35   Email task

    6.	Save the agent and schedule an appropriate time.

    7.	Approve the request. Sam Carter receives an email with the approval request as shown in Figure 8-36.
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    Figure 8-36   Email for approval

    8.	When Sam Carter logs in to IBM Cognos Connection, he can find a message in “My Inbox” as shown in Figure 8-37.
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    Figure 8-37   Approval request message in My Inbox

    9.	Sam Carter can open the message and approve it, also providing a comment, as shown in Figure 8-38.
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    Figure 8-38   Approve operation

    10.	Lynn Cope receives an email that the approval is granted, and the report is complete, as shown in Figure 8-39.
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    Figure 8-39   Email after approval

    Notification Request scenario

    In this scenario, Lynn Cope wants to create an automatic notification process to be altered to exceptionally high performances by the sales staff. Lynn wants to be notification if a sales person’s sales amount exceed 300,000.

    To create an automatic notification process:

    1.	Launch IBM Cognos Event Studio, and create an event with an expression such as:

    [Employee name (multiscript)] = [Employee name (multiscript)] and [Year] = '2007' and aggregate ( [Quantity] ) > 300000

    2.	Add a Run a notification request task, and set Lynn Cope as the recipient. Enter a subject and body, and attach an Event list as shown in Figure 8-40.
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    Figure 8-40   Notification request task

    3.	Save the agent and schedule it execute every day.

    4.	You can receive messages in My Inbox if when a sales person reaches 300,000 in sales as shown in Figure 8-41. In this message, you can find the Event list is attached and open it to see whom the sales person is.
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    Figure 8-41   Notification message in My Inbox

    5.	You can receive an email as shown in Figure 8-42. In this email, you can also see the Event list and discover the highest performing sales person.
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    Figure 8-42   Notification email
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Enterprise ready platform
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Enterprise ready performance and scalability

    Today’s companies need a flexible decision making processes that can adapt quickly to changing opportunities and challenges within the market place. IBM Cognos BI meets that need with Dynamic Query Mode, an in-memory query generation and caching technology that delivers fast results. This feature enables you to analyze your business faster and allows for quicker decisions making based on this analysis which in turn increases business satisfaction.

    This chapter includes the following topics:

    •Overview of Dynamic Query Mode

    •Configuring Dynamic Query Mode

    •Query Service Administration

    •Analyzing queries

    9.1  Overview of Dynamic Query Mode

    In this section, we provide a basic overview of the high performance in-memory query mode known as Dynamic Query Mode.

    9.1.1  What is Dynamic Query Mode

    Dynamic Query Mode is an enhanced Java-based query execution mode that addresses increasing query complexity and data volumes through key query optimizations and in-memory caching. These improvements benefit the query planning, query execution, and results that are returned while maintaining the security context.

    Depending on the data source that you use, the Dynamic Query Mode offers different performance optimizations to improve the speed of data analysis. Table 9-1 lists these optimizations.

    Table 9-1   Key optimizations

    
      
        	
           

        
        	
          IBM Cognos TM1

        
        	
          Oracle Essbase

        
        	
          SAP BW

        
      

      
        	
          Java Connectivity

        
        	
           

        
        	
          X

        
        	
          X

        
      

      
        	
          Null Suppression optimization

        
        	
          X

        
        	
          X

        
        	
          X

        
      

      
        	
          Master-detail optimization

        
        	
          X

        
        	
          X

        
        	
          X

        
      

      
        	
          In-memory Cache

        
        	
           

        
        	
          X

        
        	
          X

        
      

      
        	
          64-bit connectivity

        
        	
          X

        
        	
           

        
        	
          X

        
      

    

    In-memory caching

    As users run and build interactive and batch reports on packages that are Dynamic Query Mode-enabled, a cache is built. Running and building reports requires several requests, such as metadata and data requests, to be made to the data source. As these requests return, the Dynamic Query Mode caches the results, whether those results are metadata or data, for future re-use. This caching results in fewer request sent to the underlying data source and, thus, provides better query performance.

    This cache is data source and user specific and can be shared across report processes that are running on the same dispatcher.

     

    
      
        	
          Dynamic Query Mode cache: The Dynamic Query Mode cache is not maintained for packages that are based on IBM Cognos TM1 cubes, because IBM Cognos TM1 implements its own caching.

        
      

    

    Enhanced null suppression

    Deeply nested reports generate large amounts of cells. In addition, there is a higher probability that null values can occur where the relationship between the nested edges returns no data. These issues can make reports large and difficult to read. The higher the amount of cells, the longer it takes for the report to evaluate which rows and columns contain only null values. 

    IBM Cognos Query Studio, IBM Cognos Business Insight Advance, and IBM Cognos Report Studio include an enhanced suppression feature that can reduce the amount of cells that need to be evaluated to achieve the desired result.

    Optimized master-detail relationships

    A master-detail relationship links information and queries from the following types of data objects within a report: 

    •A master data object

    •A detail data object

    Using a master-detail relationship, you can use a single report to display information that normally would take multiple reports. You can, for example, create a list report that contains an Order Method and link a crosstab inside this list to display detailed information in the context of this particular Order Method.

    In Compatible Query Mode, these master-detail relationships generate a separate query for every element in the master result set. Thus, the underlying data source has to endure high work loads, which can impact performance.

    With the Dynamic Query Mode, the master query is pushed as a separate edge to the detail query, resulting in only one query sent to the data source for all output formats. 

    Query visualizations

    To get the best performance possible from your IBM Cognos investment, it is important that you can troubleshoot unexpected results or slow run times easily. The Dynamic Query Analyzer allows for easy access and analysis of Dynamic Query Mode log files using a graphical user interface. For more information about this tool, refer to 9.4, “Analyzing queries” on page 424.

    9.1.2  Why use Dynamic Query Mode

    Using Dynamic Query Mode and its features offers some significant benefits to the IBM Cognos administrator. The new query mode can provide the following benefit to both the administrator and users: 

    •Better query performance

    •Re-use of frequently used results

    •Easily identify issues

    Enhancements in the inner workings of the query planning process have generated more optimized queries that are specific to the OLAP data source vendor and version. The query mode is also streamlined to take advantage of the metadata and query plan cache, which results in faster executing queries.

    The implementation of various caching containers allows report authors and analysis users to take advantage of another performance optimization. The cache allows for report authors to make minor modifications, such as adding a calculation, to a report without this change resulting in another query to the underlying data source. In case the added calculation is based on measures already present in the initial report, the modification can be performed on the measures already in cache. The same is true for executing reports in different output formats. Changing a reports output format from, for example, CSV to PDF format does not trigger a new query to the data source because all that data is already in the cache.

    Analysis users also benefit from caching but in a slightly different way. The nature of analyzing data requires a lot of metadata requests to present results to the user. These requests can create a high load on the underlying data source, affecting both speed and performance. With the introduction of Dynamic Query Mode, more types of metadata results can be cached, which results in faster navigation and exploration of the hierarchy.

    9.1.3  Technical overview

    To truly understand the nature of the features in Dynamic Query Mode, we need to take a quick look at how the query mode is built. 

    Dynamic Query Mode is a Java-based query mode that addresses the increasing query complexity and data volumes. Implementing the query mode in Java allows it to take advantage of a 64-bit enabled Java Virtual Machine (JVM). 

    For Dynamic Query Mode, running in a 64-bit JVM provides the advantage of an increased size of the address space. Thus, the 64-bit JVM is capable of addressing more virtual memory than its 32-bit variant. This increase in addressable memory allows Dynamic Query Mode to maintain more of the metadata and data cache in memory as long as needed.

    To improve performance and reduce interference with the dispatcher or content manager, Dynamic Query mode is spawned in its own JVM instance as a child process of the dispatcher. No Java heap memory space is shared with the content manager or dispatcher, which enables the Dynamic Query Mode cache to use as many resources as possible.

    From a software architecture point of view, Dynamic Query Mode consists of the following main components: 

    •The transformation layer 

    •The execution layer

    The transformation layer provides for a runtime environment where, during the planning phase, query transformations can be performed. The execution layer executes and processes the result from the planning phase during the execution phase. 

    When Dynamic Query Mode receives a query request, it converts this request into a tree structure called a plan tree. After this conversion is complete, the tree can be passed on to the transformation layer so that the query planning can begin. The transformation layer then goes through every node on this tree and checks for nodes that qualify for transformation. This process can take several iterations to finish. It is these transformations that allow the query mode to generate customized and enhanced MDX that is specific to your OLAP source. These transformations that implement the query planning logic are contained within separate transformation libraries and are called by the transformation layer to execute the node conversions.

    When the planning iterations are complete, the plan tree is transformed in to a run tree and is now ready for execution by the execution layer.

    Both layers have security-aware, self learning caching facilities for improved performance. Every time a query is executed, the results from the planning phase and execution phase are placed into the respective layer’s cache container. These layers reuse data from the cache only if the data that is needed exists and if the users security profile matches. 

    After the execution layer completes its process, the results are passed onto the report service to render the report.

    9.2  Configuring Dynamic Query Mode

    For a package to use Dynamic Query Mode, you need to make configuration changes. As with Compatible Query Mode, prior to a data source connection and before a package can be created, you need to install the appropriate database client software. 

    9.2.1  Creating a connection in IBM Cognos Administration

    The first step in enabling Dynamic Query Mode connectivity, after installing the database client software, is to create a data source connection to the OLAP database. The connection can be used later when creating the IBM Cognos Framework Manager model and package. 

    For the purpose of this example, we use the Great Outdoors sample database, IBM Cognos TM1, that comes with the IBM Cognos Business Intelligence (BI) version 10 samples package.

    To create a connection:

    1.	Open IBM Cognos Administration by clicking Launch → IBM Cognos Administration as shown in Figure 9-1.
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    Figure 9-1   Launch IBM Cognos Administration

    2.	Click the Configuration tab.

    3.	In the Data Source Connections section, click New Data Source.

    4.	Specify the data source name, and click Next. Optionally, you can also specify a description and tooltip for this entry.

    5.	Choose IBM Cognos TM1 as the as data source type, and click Next.

    6.	Specify the IBM Cognos TM1 connection string details, such as Administration host and server name, and complete the required credentials. Click Test the connection to verify the current configuration.

    Note that the result page now shows a successful state for both Compatible Query Mode and Dynamic Query Mode, as illustrated in Figure 9-2. 
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    Figure 9-2   Connection test

    7.	Return to the page where you entered the connection string details, and click Finish to end the wizard.

    9.2.2  Creating a package in IBM Cognos Framework Manager

    After you create the connection to the OLAP database server, you can create an IBM Cognos Framework Manager model and import cubes to publish to IBM Cognos Connection as a package,

     

    
      
        	
          Using multiple data sources: With IBM Cognos Framework Manager, you can include and mix multiple data sources in a package. However, when using Dynamic Query Mode, all data sources that are referenced in the package must be supported by the query mode. Otherwise, the publish will not succeed.

        
      

    

    Creating an IBM Cognos Framework Manager project and package to use with Dynamic Query Mode is similar to creating those for Compatible Query Mode. At the end of the publishing wizard, you need to specify to use Dynamic Query Mode. To create a new project and publish the default package using the Dynamic Query Mode, follow these steps:

    1.	Open IBM Cognos Framework Manager, and click the Create a new project link.

    2.	Give the project a name, and click OK.

    3.	IBM Cognos Framework Manager   presents a list of supported metadata sources from which you can choose. Choose Data Sources, and click Next as shown in Figure 9-3.
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    Figure 9-3   Metadata source

    4.	Choose the data source that you created in 9.2.1, “Creating a connection in IBM Cognos Administration” on page 408, and click Next.

    5.	Choose the plan_Report cube, and click Next to continue.

    6.	Continue until you reach the Metadata Wizard - Finish window, as shown in Figure 9-4. At this point, IBM Cognos Framework Manager has detected that no additional modeling is required and suggests that a package is created for publishing. Verify that the “Create default a package” option is selected, and click Finish.
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    Figure 9-4   Create a default package

    7.	Give the package a name, and click Yes on the subsequent prompt to launch the package Publish wizard.

    8.	Click Next until you reach the Options page of the Publish wizard. Then, select the “Use Dynamic Query Mode” option, and click Publish as shown in Figure 9-5.

    [image: ]

    Figure 9-5   Use Dynamic Query Mode

    9.	If the package is published, the final window of the publishing wizard displays. Click Finish.

    10.	After the package is published and available in IBM Cognos Connection, click the package’s properties icon to verify that the query mode is in use, as shown in Figure 9-6.
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    Figure 9-6   Package properties

    9.2.3  Transitioning to Dynamic Query Mode using 
IBM Cognos Lifecycle Manager

    IBM Cognos Lifecycle Manager assists you and enables you to be successful in the critical process of verifying upgrades from IBM Cognos ReportNet®, previous versions of IBM Cognos 8, or IBM Cognos BI version 10 to IBM Cognos BI version 10. It provides a proven practice upgrade process where you execute and compare report results from two different IBM Cognos releases to let you identify upgrade issues quickly.

    With the introduction of Dynamic Query Mode, IBM Cognos Lifecycle Manager also provides the possibility to verify and compare reports using this query mode.

    If you take these two features into consideration, IBM Cognos Lifecycle Manager is also a great tool to identify any issues with the transition of your current IBM Cognos version 10 packages and reports, based on Compatible Query Mode, onto Dynamic Query Mode. An additional advantage to this approach is that you are not affecting any packages and reports that users currently access. 

    You can enable IBM Cognos Lifecycle Manager the Dynamic Query Mode on either a global project level or on a individual package basis.

    To enable the use of the Dynamic Query Mode on all packages in an IBM Cognos Lifecycle Manager project, click Settings → Configure, and navigate to the Preferences tab as shown in Figure 9-7.
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    Figure 9-7   IBM Cognos Lifecycle Manager project settings

    In the Dynamic Query Mode Options section, notice two drop-down lists where you can enable Dynamic Query Mode, one for the source environment and one for the target environment. You can now choose one of the following options:

    •The Default option instructs IBM Cognos Lifecycle Manager to validate or execute reports and packages using the query mode that is specified on the individual package.

    •The DQM Disabled option instructs IBM Cognos Lifecycle Manager to validate or execute all reports and packages in this project using Compatible Query Mode.

    •The DQM Enabled option instructs IBM Cognos Lifecycle Manager to validate or execute all reports and packages in this project using Dynamic Query Mode.

    If you select the Default option, you can specify the query mode on the package views individually, as shown in Figure 9-8.
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    Figure 9-8   Specify query mode

    In the Options column, the DQM in bold means that Dynamic Query Mode engine is enabled on this package. Double-clicking DQM disables the use of the new query mode and the DQM is no longer bold.

     

    
      
        	
          Testing note: Attempt testing against Dynamic Query Mode only if all data sources that are included in the package are supported by this query mode. Validating and executing packages that contain unsupported data sources will fail.

        
      

    

    9.3  Query Service Administration

    A vital part of running and maintaining a successful IBM Cognos implementation is administration. By this we mean that knowing exactly what is going on in your system at any time and reacting to those events appropriately is essential for you to get the most out of your IBM Cognos investment.

    IBM Cognos Administration allows for easy monitoring, configuring, and tuning of services that re available in the IBM Cognos instance. With the addition of Dynamic Query Mode, exposed as the Query Service in IBM Cognos Administration, new metrics and tuning options are added, as shown in Figure 9-9. 
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    Figure 9-9   IBM Cognos Administration

    9.3.1  Query Service metrics

    You can monitor and configure the Query Service status and its thresholds, a starting point of a new state, in IBM Cognos Administration by opening the Metrics pane for the respective service. By default, all metrics record performance information, but no thresholds are configured because acceptable threshold values depend on the IBM Cognos operating environment and need to be configured accordingly. 

    You can define the thresholds for the following Query Service metrics:

    •Last response time: The time taken by the last successful or failed request	

    •Number of failed requests: The number of service requests where a fault was returned

    •Number of processed requests: The number of processed requests

    •Number of successful requests: The number of service requests where no fault was returned

    •Percentage of failed requests: The percentage of processed requests that failed

    •Percentage of successful requests: The percentage of processed requests that succeeded

    •Response time high watermark: The maximum length of time taken to process a successful or failed request

    •Response time low watermark: The minimum length of time taken to process a successful or failed request

    •Seconds per successful request: The average length of time taken to process a successful request

    •Service time: The time taken to process all requests

    •Service time failed requests: The time taken to process failed requests

    •Service time successful requests: The time taken to process successful requests

    •Successful requests per minute: The average number of successful requests processed in one minute

    You can also create an agent that notifies you when thresholds are exceeded. Sample agents that monitor the audit database for threshold violations and perform common actions when violations are detected are included in the audit samples package. 

    9.3.2  Manage the cache in IBM Cognos Administration

    To increase the performance of recurring reports and to minimize the load on underlying data sources, Dynamic Query Mode includes a self-learning in-memory cache. The query mode can store the data cache in memory as long as needed.

    One side effect that stems from caching metadata and data request on an ever-changing data source is the possibility that the data that is contained in the cache has become old and stale. This issue leads to reports that do not display the most recent data.

    To help overcome this issue, IBM Cognos Administration includes flexible cache maintenance features.

    You can locate the first feature by clicking Configuration → Query Service Caching as depicted in Figure 9-10.
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    Figure 9-10   Query Service Caching

    This new entry in the IBM Cognos Administration tool allows the administrator to clear the cache and write cache statistics to file on a Server Group basis in a ad-hoc fashion. After this task runs, all report servers in the selected server group that host a Query Service clear the cache or dump the statistics to a file.

    If you write the cache statistics disk, a new file is created in the ../logs/XQE/ folder on all IBM Cognos servers in that particular server group that host an instance of the Query Service. The file name adheres to the following template:

    SALDump_<datasource>_<catalog>_<cube>_<timestamp>.xml

    Example 9-1 shows an example of this file.

    Example 9-1   Server group cache statistics file
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    SALDUMP_all_all_all_1283781787890.xml
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    Figure 9-11 shown an example of the content of this file.
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    Figure 9-11   Cache state

    This example illustrates a cache state that contains metrics for a package called DQM_GODB - DAN. This package is based of the GODB cube using the Essbase data source Essbase_DAN.

    Under the Cache Metrics comment, notice that for this package, 285 query requests were issued with five requests not being fulfilled by the package cache. 

    Other than clearing the cache per Server Group, you can now also create or schedule Query Service Administration tasks. You can locate these tasks by clicking Configuration → Content Administration as shown in Figure 9-12.
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    Figure 9-12   Query Service Administration task

    The cache maintenance tasks that you can create are the same as under the Query Service Caching section, with the only difference being the granularity. You can schedule these tasks to clear or to write statistics to file based on data source, catalog, and cube as shown in Figure 9-13. After this task runs, all report servers that host a Query Service clear the cache or dump the statistics to file.
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    Figure 9-13   Query Service Administration task options

    You can determine the values that you need to enter here by examining Figure 9-11 on page 419. For example, a task that is clearing the cache will dump a a file according to the following template as shown in Example 9-2. 

    SALDump_<datasource>_<catalog>_<cube>_<timestamp>.xml

    Example 9-2   Individual cache statistics file
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    SALDUMP_Essbase_DAN_GODB_GODB_1283781787890.xml
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    9.3.3  Query Service settings

    In addition to the cache maintenance dialog boxes, there is another area in IBM Cognos Administration that deals with the administration of the Query Service. This dialog box allows you to modify logging information and connection time-out. You can locate this dialog box by clicking Configuration → Dispatchers and Services → Query Service properties as illustrated in Figure 9-14.
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    Figure 9-14   Query Service properties

    Figure 9-15 shows the Settings tab within this dialog box.
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    Figure 9-15   Query Service settings

    The Settings tab allows you to modify the following settings:

    •Audit Logging level

    Controls the amount of audit information that is recorded for this service. The higher you set the logging level, the more it degrades system performance.

    •Query execution trace

    This switch toggles the recording of the run tree or also known as the query execution phase.

    •Query plan trace

    This switch toggles the recording of the plan tree or also known as the query planning phase.

    •Write model to file

    This switch toggles the model information to be written to file for a given package when a report is run against it. The file will be saved in the ../logs/XQE/model/ folder as <packagename>.txt and is typically requested by Customer Support as an aid in troubleshooting. See Example 9-3. 

    Example 9-3   Model file
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    GreatOutdoors.txt
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    •Disable query plan cache

    This switch toggles the caching of the plan tree or also known as the query planning phase.

    •Idle connection timeout

    This setting controls how long connections can be idle for before being terminated. 

    9.3.4  Disabling the Query Service

    The Query Service is spawned as a child process of the dispatcher JVM process and, as with other process, it takes up memory and resources. If for some reason you do not use the Query Service, disable this service so that the resources that might be used by the Query Service can be used by other components running on this instance.

    To disable the Query Service:

    1.	Open IBM Cognos Configuration.

    2.	Click the IBM Cognos services entry under the Environment section.

    3.	Find the Query Service enabled entry, and set this to False.

    4.	Save and restart the IBM Cognos Service.

    Figure 9-16 shows where in IBM Cognos Configuration you can disable the Query Service to give those expensive resources back to the system.
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    Figure 9-16   Disable the Query Service

    9.4  Analyzing queries

    This section introduces Dynamic Query Analyzer.

    9.4.1  What is Dynamic Query Analyzer 

    Dynamic Query Analyzer provides a graphical flow representation of the dynamic query run tree. This feature allows for a better understanding when it comes to important query decisions, rather than looking through text-based log files. Modelers and professional report authors can use this tool to tune and improve the model and reports that they build.

    9.4.2  Working with Dynamic Query Analyzer

    As a prerequisite, you need to configure Dynamic Query Mode to log the run trees to a file for every query that it handles. You can find more information about enabling this query execution trace in 9.3.3, “Query Service settings” on page 421. 

    After this setting is applied, a new folder is created in the ../logs/XQE/ folder for every report that is executed using this query mode. The new folder is labeled according to the <date>_<time>_<reportname> template, shown in Example 9-4, and contains the trace files that can be interpreted with Dynamic Query Analyzer.

    Example 9-4   Query plan trace folder
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    20100901_16h56m243s_Quantity_Per_Year
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    The tool can open these file types either from the local file system or remotely using the HTTP protocol. In the case of a web server, create a virtual directory pointing to the ../logs/XQE folder, and amend Dynamic Query Analyzer Remote Log Access preferences as shown in Figure 9-17. You can launch the Preferences dialog box by clicking Window → Preferences.
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    Figure 9-17   Dynamic Query Analyzer preferences

    Note that in case the remote location is secured, you can also specify credentials to use for authenticating to that remote location.

    Other than the Remote Log Access, you can also specify IBM Cognos version 10 server and authentication information. Supplying this information enables Dynamic Query Analyzer to browse the content manager and run reports from within the tool. 

    By default, the Content Store view does not display. You can add this view by opening the Show View dialog box:

    1.	Click Window → Show View.

    2.	Expand Navigation (Figure 9-18), and double-click Content Store to add the view.
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    Figure 9-18   Show View dialog box

    A new view is added to the Dynamic Query Analyzer interface. This view is similar to the view shown in Figure 9-19. If you entered the server information in the Preferences dialog box (Figure 9-17 on page 426) correctly, the view displays the packages and reports that are available in the Content Store.
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    Figure 9-19   Content Store view

    Expanding reports entries that have been run with the Query execution trace enabled will display the trace entries found in logs folder as shown in Figure 9-19 on page 428. Double-clicking the Runtree entry opens the trace (Figure 9-20) in the same way as when using File → Open log.
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    Figure 9-20   Query run tree

    Apart from the Tree Graph view, which can be exported by clicking File → Export Graph, there two more views that can be of great interest when analyzing report queues. The first view is the Graph Navigation view, shown on the left side in Figure 9-21, which displays the same run tree in another graphical tree that is easily expanded or collapsed.
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    Figure 9-21   Graph Navigation and Query views

    The second view is the Query view, shown on the right side in Figure 9-21, which displays the data source specific query in a conveniently formatted syntax.
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IBM Cognos system administration

    In this chapter, we discuss new administration capabilities introduced as part of the IBM Cognos Business Intelligence (BI) version 10.1 release. The focus is broken into the following main topics:

    •IBM Cognos Administration overview

    •Moving to IBM Cognos BI version 10.1 from a previous release

    •Using the administrative features

    •Managing the environment

    •Auditing

    10.1  IBM Cognos Administration overview

    Meeting service commitments to the business and anticipating and responding to changing business requirements—all within tight budget constraints—are fundamental IT tasks. 

    As noted in The Performance Manager: Proven Strategies for Tuning Information into Higher Business Performance (ISBN-10: 0973012412), IT also has a strategic role to play, which means going beyond the fundamentals. IT can be to your company what high-tech firms have been to the economy—a catalyst for change and an engine driving rapid growth. Why? Technology and information have become so important to how companies operate that even small changes can dramatically affect your ability to manage the performance of the business.

    If IT spends all of its time and resources ensuring service commitments, it is impossible to initiate and support more strategic opportunities. In this way, any way in which to reduce the time and effort to administer and maintain enterprise applications becomes a strategic gain.

    IT publications often compare IT’s job and the managing of enterprise applications to conducting an orchestra. There are multiple moving parts (databases, servers, networks) that must all work together to provide a positive user experience. Working in concert, the application can become a critical part of the business. Out of tune, it can become an immediate distraction, a critical failure, or worse, something deemed untrustworthy by users. If this happens, IT has lost user buy-in and, most likely, a portion of its return on investment.

    10.1.1  IBM Cognos Administration capabilities

    IBM Cognos Administration provides capabilities for IT professionals to manage their business analytics systems proactively to prevent problems before they occur. These system administration capabilities (Table 10-1) let IT address the important considerations necessary to exceed commitments to the business while respecting budgetary and other resource constraints.

    Table 10-1   System administration capabilities

    
      
        	
          Category

        
        	
          System administration capability

        
      

      
        	
          Knowing the business intelligence system

        
        	
          Understand usage patterns.

        
      

      
        	
          Understand the IBM Cognos BI system environment.

        
      

      
        	
          Understand the business expectations.

        
      

      
        	
          Resolving and preventing issues

        
        	
          Determine what thresholds to address.

        
      

      
        	
          Track and evolve over time.

        
      

    

    Understand usage patterns

    Understanding usage patterns is important for both troubleshooting immediate system issues and for performance-tuning activities over the life cycle across the many components of the business intelligence system.

    There is no one simple approach to understanding usage patterns. They are unique to the cycle of how the organization gathers information, reviews it, and distributes it. For example, managing a centrally located user community that distributes pre-generated reports over email is not the same as managing a group of users who are always on the road and who want to access all information with a mobile device.

    Certain patterns are more obvious and better defined. For example, quarter-end and year-end typically generate extra system activity for most departments. Others vary depending on the industry or the culture of how the organization communicates.

    Understanding usage patterns means knowing the number of users that access a system at any given period of time, where these users are located, how much time they spend using the solution, and how they use the solution.

    To gain a better understanding of usage patterns, certain metrics provide a good indication of how well the business intelligence solution is adapting to how people use it. Whereas no one metric provides a complete picture of the system, these metric examples are a starting place for tracking usage patterns:

    •Number of sessions

    This system-level metric provides the number of user sessions actively logged onto the system. Whereas this does not tell you how the business is using the system, it does provide insight into how many people choose to use the system. 

    •Number of processed requests

    This metric provides the number of requests received at a specific point in time. Looking at processed requests alone provides a sense of magnitude in terms of system usage. What are the peak periods versus the slower periods? How much are business intelligence applications being used? This is useful for determining optimal times to schedule batch reporting.

    •Number of queue requests

    This metric provides the number of requests that have gone through the queue. A high number of queue requests might indicate a high volume of system activity at a particular point in time or an issue that needs to be addressed. With a more consistent and deeper understanding of usage patterns, an IBM Cognos BI system administrator can determine whether this is regular activity or an anomaly that needs explanation and potential action.

    •Longest time in queue

    The time in queue high watermark metric provides the longest time that a request has been in the queue. As it increases, it indicates more system activity and longer waits. This is a useful metric to monitor for changes on a regular basis. If queue times increase over a short period, there might be a change to the usage patterns that requires further investigation.

    Understand IBM Cognos BI system environment

    IBM Cognos BI is built on a modern service-oriented architecture (SOA) platform. This flexible platform offers many deployment options based on the preferred IT infrastructure and enterprise architecture strategy. As the organization extends the IBM Cognos BI system, it should monitor the initial deployment strategy to ensure that it still fits the current deployment landscape. 

    For example, you might have initially deployed business intelligence in a centralized server environment with certain affinities in place to handle usage patterns for the initial deployment. You might have decided to dedicate a particular server to running reports that are processing intensive or you might have allocated a local server for a geographic location without adequate network access. As the solution expands, the assumptions driving the initial architecture infrastructure might change. You might need to revisit them to ensure optimal solution performance.

    To better understand the overall health of the business intelligence system environment, consider the following metrics:

    •Successful requests per minute

    This metric shows the average amount of successful requests relative to the amount of processing time it took to execute them. The algorithm for this metric was devised to provide a real measure that is not impacted by periods of inactivity. This metric is useful for determining and tracking server throughput. 

    •Number of processed requests per dispatcher

    The number of processed requests per dispatcher is a good indicator of load balance in the business intelligence system. If one dispatcher is handling a heavier load, you need to understand why. Is this a deliberate configuration choice based on the usage patterns, or does it require further review?

    •Percentage of failed requests

    This metric provides the percentage of failed requests based on the total number of requests handled. This metric gives you trending information over longer periods of time to understand how the business intelligence services are performing.

    Understand the business expectations

    Whereas formal service level agreements (SLAs) provide a structured approach to communicate and set system expectations, IT needs to keep the communication channels open with business owners and ensure that priorities align with organizational strategy.

    Business expectations set the agenda for what metrics to track, the thresholds to set, and how to prioritize follow-up actions. For example, a company’s strategy might center on customer service with an objective to improve call center performance. Ensuring that critical call center information is readily available on demand will be at the top of the priority list. IT would want to monitor and ensure system uptime and report response times related to the call centers.

    By contrast, if an organization is trying to reduce costs through process optimization, then weekly or monthly reports are critical to manage. These reports might not demand faster response times, but monitoring failure rates would be key to ensuring that they are delivered in time to enable a streamlined process.

    Determine what thresholds to address

    Setting metrics and gathering data on usage patterns and technology environments and understanding business expectations, is important to effective system management. Identifying thresholds for those metrics simplifies IT’s task (and communication with business owners) by giving the context to determine when to take action. Thresholds make IT proactive. IT can flag issues before they affect users, breach SLAs, and lead to support calls.

    There can be hundreds of system metrics. Taking time to understand what metrics are vital for system management of your business intelligence solution is essential before setting any thresholds. IT is no different from the users it supports. Too much information makes taking the right course of action as difficult to determine as having no information at all. 

    For example, if the longest time in queue starts increasing, it might require further investigation. If queue and wait times increase, users might wonder whether there is a system issue. Having an agreed-upon threshold on this metric would identify the point when IT needs to take further action to understand what is happening. Users would know the threshold and also know that their IT department is dealing with the issue.

    Track and evolve over time

    After IT has identified key metrics and set thresholds, it can respond to current situations proactively to avoid business disruption. The next consideration for system management is making system metrics work for IT and the business over the long term.

    Metrics provide IT and business users with insight into changing usage patterns and technology environments over time. With this information, IT can tune the business intelligence solution and adapt metrics and thresholds to maintain, meet, and improve service standards.

    To accomplish this, IT needs business intelligence reporting on its system information. As described in The Performance Manager, IT must use dashboards, scorecards, reports, analysis, and alerts to deliver the correct information to drive improved decisions within the IT department. Better IT decisions can affect everyone across the organization.

    Summary: Five steps to effective business intelligence system management

    To effectively manage their business intelligence solution, IT managers need to understand their business intelligence solution: 

    •Usage patterns

    •Business intelligence system environment

    •User expectations

    It also means being able to resolve problems and take actions quickly to prevent issues from occurring. To do this, IT needs to monitor metrics, set thresholds, and analyze usage patterns and key aspects of the business intelligence system environment. IT professionals can use this data to initiate conversations with their business partners—bridging technology and information requirements—to stay in touch with user expectations and service commitments.

    IT has the facility to adapt to changes in usage and new business needs. This becomes the means to drive continuous improvement in the performance of your business intelligence solution, and the roadmap to more effective performance management.

    With IBM Cognos BI, business intelligence administrators and IT professionals gain new facilities to manage the health of the business intelligence system. Task-oriented system monitoring gives administrators a new, consolidated view of all system activity, from scheduled and interactive reports to servers and dispatchers. Proactive administration through detailed system metrics and the ability to set thresholds that can be monitored let IT professionals identify and correct anomalies.

    IBM Cognos BI, using the IBM Cognos Platform, delivers broad system management for IT to confidently deploy business intelligence, proactively manage the system, and respond to new requirements while meeting on-time service commitments.

    With these system management capabilities, IT can deliver on its fundamental tasks (that is, meeting service-level commitments and responding to changing business requirements within budgetary constraints) and have the capacity to drive strategic objectives. In this way, IT can realize its full potential as leaders and change agents within organizations.

    10.1.2  The IBM Cognos Administration user interface

    IBM Cognos BI provides a centralized, web-based administration console that provides administrators with the tools that are necessary to manage the IBM Cognos application.

    To launch the administration console, use one of the following methods:

    •Click the IBM Cognos Administration link from the Launch menu within IBM Cognos Connection (Figure 10-1)
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    Figure 10-1   Launching the administration console from IBM Cognos Connection

    •Select the Administer IBM Cognos content link from the welcome menu (Figure 10-2)
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    Figure 10-2   Welcome to IBM Cognos software menu

    The administration console includes the following tabs (Figure 10-3):

    •Status

    •Security

    •Configuration 

    •Index Search

    Each tab contains a set of logically grouped functions, called tasks, on the left side of the user interface.
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    Figure 10-3   Administration console tabs

    Status tab

    The Status tab is designed to provide administrators with the visibility and insight into which objects are currently running both interactively and in the background (scheduled or batch), which have executed in the past, and those that have been slated to execute in the future. In addition to the object execution details, the Status tab provides a health check of the overall IBM Cognos environment (Figure 10-4).
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    Figure 10-4   Status tab and the associated tasks

    Current activities task

    The current activities task exposes all the objects in the environment (interactive or background) that are currently running in an executing, pending, waiting, or suspended state.

    Looking at the top of the Current Activities interface, a summary graph displays all of the current objects and the state that they are in. The default view displays what is currently being handled through the background (batch) processes. It is possible to toggle between background and interactive activities, but it is not possible to view both simultaneously. 

    1.	Locate the Filter frame in the lower-left side of the page.

    2.	Toggle between the background activities and interactive activities by selecting the appropriate radio button.

    3.	To change the display in the right part of the interface, click Apply.

    Focusing first on the background activities, in addition to the summary chart, all of the objects currently in the system display in a paginated list. Looking at an entry, the following items are visible in the default view (Figure 10-5):

    •The object name

    •The time that it was requested

    •Who executed the object

    •The dispatcher and process ID handling the request

    •The last successful execution time

    •The status 

    •The priority assigned to the object
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    Figure 10-5   Executing job in the current activities task

    Figure 10-5 shows a job in an executing state that was requested by Sam Carter. To see more details about the object, click the Show Details icon on the toolbar. This expands the list to include a second line of detail. Conversely, the Hide Details icon removes the additional line of detail. Keep in mind that the details that are shown might differ from task to task due to the nature of the task and the level of information available to the task. 

    To help reduce the number of objects displaying or to quickly isolate and focus in on particular objects, a series of filter options are included in the Filter section in the lower-left frame (see Figure 10-6).
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    Figure 10-6   List of filters available to help reduce the results displayed in the list

    The default filter options allow the result set to be filtered by user running the object, the current state that it is in, and the priority that has been assigned to the object. Clicking the Advanced options link allows for filtering by the owner of an object being executed, the type (job, report, agent, import, and so on), a dispatcher (which provides administrators with the insight to identify which dispatcher is handling which objects), and scope (package or folder in which the object resides). Any single filter option or a combination of options can be selected, and after the options have been determined, click Apply for the result set to be updated. 

    Moving on to the interactive activities, most of the level of detail that was available in the background activities view is still applicable, with a couple of minor exceptions:

    •The objects running interactively have fewer states. Either it is pending (queued) or is executing. 

    •The only default filter option available for the interactive view is the ability to filter by status. 

    The advanced options provide the ability to filter by dispatcher.

    Past Activities task

    As the name implies, this task displays objects that were executed in the past. One important thing to note about this interface is that only the objects that were executed in the background will be recorded. Interactive requests do not record histories that can be displayed through this task. For this type of information, you need to use the audit data (see Figure 10-7).
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    Figure 10-7   Result list displaying past activities based on filter criteria

    The interface groups objects into three execution states:

    •Succeeded

    •Failed 

    •Cancelled

    The basic filter options permit filtering on predefined time periods or a user-defined custom period. As with the current activities task, the result set can be narrowed down to objects run by an individual user.

    Upcoming activities task

    This task has gone through changes in the IBM Cognos release. An interactive chart was introduced to better represent the estimated pending load on the system. This is accomplished by displaying an hourly breakdown of the amount of objects that have been scheduled to start in that particular hour timeslot (Figure 10-8).
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    Figure 10-8   Hourly breakdown of scheduled activities in the system

    In addition to the filter options on the left part of the interface, it is possible to scroll between days by using the Next and Previous buttons beside the date at the top of the chart. Beneath the chart is a filtered list of the individual activities that are scheduled to execute. Clicking a specific hour bar in the chart automatically filters the results in the list. To provide visual context to the filtered list, the currently applied filters are included above the list (Figure 10-9).
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    Figure 10-9   List of scheduled objects based on the criteria set in the chart

     

    
      
        	
          More information: Using the buttons to scroll the chart between days does not automatically change the filtered list. This enables administrators to select a specific scheduled object and postpone the execution time, which can be at a later date. For more details regarding postponing scheduled executions, see 10.4.2, “Reacting to bottlenecks due to unexpected events” on page 495.

        
      

    

    When creating a schedule, privileged users can assign a priority of 1 (high) to 5 (low) for the object. All other users have a default priority of 3 when defining a schedule. Priority indicates in which order the dispatcher processes requests when items are queued. That is, in a busy environment where report executions are submitted when the engine is at capacity, they will be placed into a queue and processed when the engine resources become available. When the engine is ready to handle a new request it takes the oldest priority 1 request before it takes requests with a priority of 2 or higher. 

     

    
      
        	
          Priority reports: Priority does not mean that a long-running priority 5 report execution, in the process of executing, is terminated when a priority 1 request is received. It means that the priority 1 request is executed first after the priority 5 request has completed executing.

        
      

    

    System task

    This task provides administrators with an overall glimpse of how the system is faring through the use of status indicators on a dashboard. The System task interface is divided into three fragments:

    •Scorecard: Left frame that displays a summary of the overall health of the components that make up the environment.

    •Metrics: Upper-right frame that lists all of the metrics, and their score, that pertains to the object in focus (from the scorecard fragment). The default is to display the metrics for the overall system (environment).

    •Settings: Lower-right frame that shows a read-only view of the configuration parameters that pertain to the object in focus.

    The scorecard frame provides two views:

    •The default standard view, which allows administrators to navigate through the system topology to verify the health of the servers, dispatchers, and services, as well as their corresponding metrics

    •The comparative view, which provides the ability to watch predefined key metrics as they relate to similar objects (see Figure 10-10)
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    Figure 10-10   Scorecard view of the servers in the topology

    Figure 10-10 provides administrators with a view of the entire IBM Cognos BI topology. The sample shows that there are two servers that make up this particular environment. Besides the indicator lights that show the overall health of the object based on tolerance thresholds that can be applied to the metrics, the status of the object is also displayed. Industry standard terms employed are:

    •Partially available: Indicates that one or more of its children is unavailable

    •Available: Indicates that the object is online

    •Unavailable: Indicates that the object is offline or is not started

    In the previous example, the wottmassons server is online and available, while the ca093489 server is partially available. The net effect is that the overall system status becomes partially available due to the fact that at least one child is unavailable. The underlying dispatchers and services can be viewed by drilling down on the server name, which maintains the parent/child relationships. For example, drilling down on the ca093489 server name reveals the dispatchers running on that server (Figure 10-11).
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    Figure 10-11   Server dispatchers, each with a different status

    Besides the ability to drill up and down, using the Change view button beside an entry allows the results to be filtered to obtain the desired view. This drop-down menu allows for filtering of all servers, server groups, dispatchers, and services, as well as selecting individual services. Selecting a service, for example, report service, provides a list of all report services, their overall health, and their current state. The ability to perform metric comparisons is not be possible though unless you switch focus back and forth between report services.

    Monitoring services side by side in the Scorecard view does not provide the ability to easily compare metrics across similar services in the environment. There is, however, a comparative view that allows administrators to see certain predefined metrics as they pertain to related objects in one single view. 

    To access this view, expand the scorecard frame by clicking Maximize. This maximizes the frame within the interface and provides a comparative view (Figure 10-12).
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    Figure 10-12   Comparative view of services in the environment

    At first glance it is difficult to determine which dispatcher each of the report services belongs to. The parent dispatcher is visible by hovering over the service icon, which produces a tooltip with the parent’s name (Figure 10-13).
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    Figure 10-13   Tool tip on icon displays the dispatcher name

    Schedules task

    The schedules task displays all of the active (enabled or disabled) schedules in the environment and which user scheduled the object. The summary chart is grouped by status (Figure 10-14).
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    Figure 10-14   Summary chart displaying the status of the schedules

    The result list shows the scheduled objects along with the last modified date, who created the schedule, and the status and the priority assigned to the schedule (Figure 10-15).
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    Figure 10-15   Detailed list of schedules in the system

    Security tab

    The Security tab contains all of the tasks that are required for managing the namespaces and capabilities.

    Users, groups, and roles task

    This task allows administrators to create and manage application-specific groups and roles in the built-in Cognos namespace. In addition, the external third-party security namespaces can be browsed and the contents of the users’ My Folders area can be viewed.

    Capabilities task

    Capabilities, not to be confused with security, is a collection of features that can be granted, or denied, to the user community. The capabilities task is the tool that allows administrators to set the global capabilities that dictate which features and functionality are available to the users logging in to access the application. The IBM Cognos BI release allows for a customizable approach to administration and responsibility so that various areas of responsibility can be delegated to more focused administrators. This helps to effectively distribute the administrative duties across users and groups.

    Configuration tab

    The Configuration tab is a collection of administrative tasks pertaining to managing the content and the various aspects of the environment. Items such as managing printers, data source connections, and configuring parameters as they relate to the dispatchers and services that make up the IBM Cognos topology, are located on this tab.

    Data source connections task

    The data source connections task permits administrators to define and manage connections to data sources and the signon credentials associated with them.

    Content administration task

    This task is the interface that allows for the creation and management of content import and export definitions. In addition to the content deployment objects, this task also provides the ability to create consistency checks and enhanced search index updates, and then either execute or schedule them. 

    Printers task

    This task is where printer connections are defined, created, and managed for the IBM Cognos BI solution.

    Styles task

    This task allows administrators responsible for the IBM Cognos Connection portal to assign privileges to the various styles (skins) available to the user community. Access can be granted or denied to each style in the list as required. Denying access to a particular style for a user removes the ability to select that style as part of the user’s preferences.

    Portlets task

    The portlets task is the mechanism within the product that allows administrators to manage and control the access rights to the portlets that are part of the IBM Cognos BI solution.

    Dispatchers and services task

    This task provides server administrators with a tool to manage the configuration settings of the dispatchers and services in the IBM Cognos topology. Configuration parameters can be set at the highest level and pushed down to the individual dispatchers through acquired properties, or they can be set individually on each dispatcher independent of the parent settings.

    Index Search tab

    The Index Search tab provides administrators with the settings and parameters required to create and manage the enhanced search index. This index provides search results to enhanced consumers when executing searches to answer key business questions. For more information regarding the Index Search tab, see 10.3.1, “Enhanced search” on page 464.

    10.2  Moving to IBM Cognos BI version 10.1 from a previous release

    Upgrading, and the management of business intelligence applications, is made easy with use of IBM Cognos Lifecycle Manager. This section describes the features of IBM Cognos Lifecycle Manager and how they can be used to manage application life-cycle tasks.

    10.2.1  Using IBM Cognos Lifecycle Manager to test the IBM Cognos environment

    IBM Cognos Lifecycle Manager is a utility that performs automated testing of IBM Cognos BI report content in multiple environments. This testing is achieved by programatically validating, executing, and then comparing report output to ensure that there are no deltas between versions when upgrading.

    Before you can start testing, you must deploy content from an IBM Cognos 8.x Business Intelligence source environment and upgrade the content to the IBM Cognos target environment following IBM Cognos documented upgrade practices. You can find information about these practices at:

    http://www.ibm.com/developerworks/data/library/cognos/cognosproven
practices.html

    To successfully complete the report executions and comparisons, the folder structures in both environments must be identical.

    Creating an IBM Cognos Lifecycle Manager project

    To do this:

    1.	Start the IBM Cognos Lifecycle Manager process by going to Windows Start → All Programs → IBM Cognos Lifecycle Manager → IBM Cognos Lifecycle Manager Startup.

    2.	Launch the application by going to Windows Start → All Programs → IBM Cognos Lifecycle Manager → IBM Cognos Lifecycle Manager URI.

    3.	From the IBM Cognos Lifecycle Manager interface, there are options to open an existing project or to create a new project. Click the new project link (Figure 10-16).
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    Figure 10-16   IBM Cognos Lifecycle Manager welcome panel

    4.	On the New Project dialog box, select the Create blank project radio button.

    5.	Provide a name for the project. It is a good idea for the name to be indicative of the versions or content to be included.

    6.	Select Validation Project from the drop-down Project Type menu (Figure 10-17).
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    Figure 10-17   Creating a new IBM Cognos Lifecycle Manager project

    7.	Click Create.

    8.	Back in the IBM Cognos Lifecycle Manager interface, click Configure to launch the Configure dialog box, where the configuration parameters for both the target and source environments can be supplied.

    9.	On the Basic tab, supply the following information for both the target and source environment:

     –	Name

     –	Gateway URI

     –	Dispatcher URI

     –	Version

     –	Maximum number of connections that IBM Cognos Lifecycle Manager will make to the individual environments

    The more connections specified, the more simultaneous requests will be made to each of the environments. In theory, more connections will result in a shorter time to complete the report executions, but there are many influencing factors (Figure 10-18).
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    Figure 10-18   Defining the servers to use for the project

     

    
      
        	
          Information unknown note: If certain required information is unknown, obtain the parameter values by launching the appropriate versions of IBM Cognos Configuration.

        
      

    

    10.	On the Security tab, supply the username, password, and namespace ID that will be used to connect to each environment (Figure 10-19).
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    Figure 10-19   Supply the required security credentials and ensure that they test successfully

    11.	Click Test Connection to test the validity of the credentials.

    There is an option to save the passwords, which removes the need to supply the passwords every time that the project is opened, but it is advisable that you do not use this option because of the persistence of the password on the file system.

    12.	Click Save.

    The Advanced tab contains various options that can be selected and customized. For this example, none of the default options are modified. 

    The Preferences tab controls the various types of output and locales that will be generated for comparison. The default PDF option is used for this example.

    Generate report content to be validated

    For IBM Cognos Lifecycle Manager to validate, execute, and perform report comparisons between the target and source environments, the list of content to include in the project must be specified.

    To generate report content to be validated:

    1.	From the IBM Cognos Lifecycle Manager interface, click Generate Report List.

    2.	Using the Select Search Paths dialog box, select the desired collection of folders and the package to include by clicking the appropriate check boxes (Figure 10-20).
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    Figure 10-20   Selecting content to include in the validation project

    Click OK.

     

    
      
        	
          Excluding objects: If there is content that is included as part of this process that you later determine is not required, you can exclude objects from the project by clicking their status and selecting Out of Scope (see Figure 10-21).
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          Figure 10-21   Out of scope content for an IBM Cognos Lifecycle Manager project

        
      

    

    After the content is loaded, it displays in the IBM Cognos Lifecycle Manager interface and is ready for the validation and execution steps (Figure 10-22).

    [image: ]

    Figure 10-22   The IBM Cognos Lifecycle Manager project is now ready for comparative testing

    10.2.2  Validating the target environment 

    Although there are both source and target environments, only the target environment needs to be validated. We assume that the collection of reports in the source environment is functional, so the reports should be validated in the IBM Cognos BI target environment to ensure consistency.

    Automatically generating prompt values

    One of the advantages of IBM Cognos BI reports is the ability to author a single report to satisfy different requests. This is achieved by including prompts in the reports that can change the results returned based on the selected prompt values, as usage of report prompts is common. It is more than likely that there will be required prompts contained within the reporting environments, which means that the prompt values must be supplied before IBM Cognos Lifecycle Manager can programatically execute the reports. 

     

    
      
        	
          Value import note: If prompt values are defined and saved in IBM Cognos Connection, they are imported automatically into the IBM Cognos Lifecycle Manager projects and used when the reports are executed. In certain cases, such as a type in prompt control, you must supply the values for the prompts manually.

        
      

    

    To generate a prompt value automatically:

    1.	Select the Target Validate task from the left side of the IBM Cognos Lifecycle Manager interface.

    2.	Click the check box in the upper-right corner of the header to select all of the content, or individually select the objects that have prompt values missing.

    3.	Using the drop-down menu in the footer, select Automatic Prompt Values Generation (Figure 10-23).
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    Figure 10-23   Automatically generate prompt values for missing report prompts

    4.	Click GO.

    The process of examining all of the selected content begins and verifies whether there are prompt values that need to be satisfied. If there are missing prompt values, IBM Cognos Lifecycle Manager attempts to generate a prompt value automatically. 

    If there are prompt values that are still required after automatically generating them, complete these steps:

    1.	Navigate to a particular report with a Prompt Values Missing status.

    2.	Click the report name to change to the Properties page for that report.

    3.	Select the Prompt Values tab.

    4.	Click the action for Manual Prompt Capture (Figure 10-24).
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    Figure 10-24   Manual prompt generation for a report

    5.	A Prompt dialog box opens. Manually enter a prompt value that satisfies the prompt criteria (Figure 10-25).
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    Figure 10-25   Manually enter a prompt value

    Click OK.

    6.	Click Back.

    7.	Verify that the status of that report is changed to New.

    Continue the process until all missing prompt values are defined, the objects are marked as out of scope for the project, or both. Then, follow these steps:

    1.	From the main IBM Cognos Lifecycle Manager interface, select Validate models/reports.

    2.	Click GO to start the validation process (Figure 10-26).
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    Figure 10-26   Completing the validation process

    10.2.3  Executing target and source content

    After the validation process has completed successfully, you need to execute reports in both the source and target systems. IBM Cognos Lifecycle Manager does not retrieve output from IBM Cognos Content Store. Instead, it generates all content, from both systems, based on the format and language options and the supplied prompt values, which ensures that the report output that is created for comparison contains the same parameters.

    Initially, execute only report content that is required immediately to keep the amount of time to generate the output to a minimum. Typically, a project contains all of the necessary content, but the content is in different stages of validation. Based on priority, folders and packages are validated, executed, and compared incrementally.

    Because report executions are submitted through the SDK and executed on the system (target, source, or both), it is advisable that you execute the reports incrementally in smaller batches, versus submitting all content for execution.

    To execute target and source content:

    1.	Click the Source Execute task.

    2.	Select the content to execute by clicking the appropriate check boxes.

    3.	Using the drop-down menu, select Execute reports.

    4.	Click GO.

    5.	After the reports have finished executing, click Target Execute.

    6.	Repeat steps 2 through 4 for the target environment.

    Figure 10-27 shows the Source Execute window within IBM Cognos Lifecycle Manager.
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    Figure 10-27   Performing the Source and Target Execute tasks (source shown)

    10.2.4  Compare the output to ensure consistency

    If the report comparison indicates deltas, you need to complete further analysis to determine the nature of the difference and whether the difference is expected or acceptable.

    There are two options for comparison. The first option uses Adobe Flash as part of a visual comparison tool, and the other option does a PDF text comparison looking for changes to the contents. Given that IBM Cognos Lifecycle Manager saves all data locally, you do not need to be connected to the source and target systems to complete the compare task. 

    Before comparing output versions, you need to validate and execute a report in both the source and target systems. 

    To compare report output versions:

    1.	Click Output Compare to navigate to the Output Compare window.

    2.	Click the check boxes next to the reports that you want to compare.

    3.	Use the drop-down menu to click Compare reports and click Go.

    Figure 10-28 shows an example of the Output Compare window.
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    Figure 10-28   Output Compare showing reports that have been compared with no differences

    The compare task executes, and the status of each report is updated to show the result of the compare task. 

    IBM Cognos Lifecycle Manager provides content validators with the ability to annotate any content object. Because validation projects can span multiple days or weeks, and there might be multiple people participating, the ability to comment on the status or progress is critical. In addition to the commentary, content validators can also approve or reject the comparisons based on the findings. For example, if one report in a package produced a delta, and the difference is approved, the approved status causes the status on the package to change to Completed.

    10.2.5  Analyzing the project status

    A summary of project status can be viewed at any time throughout the validation process by opening IBM Cognos Lifecycle Manager’s Task Summary view. As each step in the project completes, the status of each task is updated and rolled up into the summary view. The Task Summary view in IBM Cognos Lifecycle Manager has a print option and is also exportable to an Adobe Flash file, which can then be opened in most web browsers. The page is separated into the following sections:

    •Tasks

    •Validate

    •Run

    •Compare 

    •Total (which is a list of every report in the project along with the report execution times in both the source and target systems)

    Figure 10-29 shows the IBM Cognos Lifecycle Manager Task Summary window.
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    Figure 10-29   IBM Cognos Lifecycle Manager: Task Summary (status summary for a project)

    Clicking around the Task Summary interface provides a filtered view of the statuses of project tasks for each phase of an IBM Cognos Lifecycle Manager project. Each section shows the total number of objects that are in or have passed through each status within each project phase. Every IBM Cognos Lifecycle Manager project moves through five phases and various states within each phase:

    •Validate source/validate target.

     –	Valid: Following validation, indicates that the object is valid

     –	Invalid: Following validation, indicates that the object is invalid

     –	New: Indicates that the validation, execution, or output comparison operation has not been performed on the object

     –	Prompts Missing: Indicates that certain reports in the package or folder require prompts, and no prompt values are defined 

    If a report has required prompts, you must provide a prompt value for each one before you can execute the report.

     –	Out of Scope: Informs IBM Cognos Lifecycle Manager to ignore this object during the validation, execution, or output comparison operation. When this value is specified, you can apply it to all of the object's children by selecting the Apply to all actions target and source check box

    •Execute source/execute target.

     –	Succeeded: Following execution, indicates that the object executed successfully

     –	Fail: Following validation, execution, or output compare, indicates that the object failed the operation

     –	New

     –	Prompts Missing

     –	Out of Scope

     –	In Progress: Indicates that the validation, execution, or output comparison operation has not been performed on all children of an object or has failed for one or more children of an object

     –	Partial Success: Indicates that the execution or output comparison operation was partially successful

    For example, you compare reports in XML and PDF formats, and the XML reports are identical, but there are differences in the PDF output.

    •Compare

     –	No Differences: Following output comparison, indicates that no differences were found

     –	Differences: Following output comparison, indicates that differences were found

     –	New

     –	Prompts Missing

     –	Out of Scope

     –	In Progress

     –	Partial Success

     –	Visual: The output type that the report was executed in requires a visual compare using the compare tool

     –	Approve: Following output comparison, indicates that differences found were approved

     –	Reject: Following output comparison, indicates that differences detected were rejected

    For quick visual reference, the bottom panel of the IBM Cognos Lifecycle Manager Task Summary window also provides a status icon displaying the status for each phase of the project:

    •A green dot on a report icon indicates that a phase completed successfully. 

    •A red dot on a report icon indicates that a phase failed or was rejected. 

    •A black dot indicates that the status for that phase is new. 

    •A missing icon indicates that phase has not yet been started. 

    Hovering the mouse pointer over the status icons in the Progress column for a report provides a pop-up containing the status of each phase in text form. Figure 10-30 shows an example of status icons for a single report in IBM Cognos Lifecycle Manager.
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    Figure 10-30   Task status icons in IBM Cognos Lifecycle Manager

    Another element of the Task Summary window within IBM Cognos Lifecycle Manager is the Notes column. IBM Cognos Lifecycle Manager allows a report administrator to provide commentary related to specific reports. When a note exists for a report within a project, an icon displays in the row for that report under the Notes column. 

    Hovering the mouse pointer over the note icon for a report provides a pop-up containing text-based commentary associated with the report. Figure 10-31 shows an example of commentary added to an IBM Cognos Lifecycle Manager entry using the Note column.
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    Figure 10-31   Notes associated with a rejected report in IBM Cognos Lifecycle Manager

    10.2.6  One-click comparison

    Now that the phases of the IBM Cognos Lifecycle Manager utility are understood, there is a way to streamline the process.

     

    
      
        	
          Comparison note: This method of comparing reports simultaneously submits requests to both the source system and the target system.

        
      

    

    To perform a one-click comparison:

    1.	In the IBM Cognos Lifecycle Manager interface, click the Output Comparison task.

    2.	Select the new content to be compared by clicking the appropriate check boxes.

    3.	Change the drop-down menu to the Compare reports option.

    4.	Click GO.

    Performing this type of comparison executes the following operations: 

    •The reports are sent to the source for execution and the output is returned to IBM Cognos Lifecycle Manager. 

    •The reports are sent to the target for execution and the output is returned to IBM Cognos Lifecycle Manager. 

    •Both versions of the output are compared.

    These steps are performed without any user interaction.

    After the comparison finishes, the project is ready for analysis of any reported deltas.

    10.3  Using the administrative features

    This section highlights administrative features in IBM Cognos BI version 10.1.

    10.3.1  Enhanced search

    When trying to answer critical business questions, gain insight, or identify new trends, users might potentially execute many reports, and spend large amounts of time browsing report output searching for desired results. With IBM Cognos BI, licensed enhanced consumer users have the ability to search for keywords located in report names, modelled metadata, report output, values in the reporting databases, and results returned from an external third-party search engine, such as the Google search appliance.

    When performing a search through IBM Cognos Connection, enhanced consumers are presented with an interface that contains the following frames (Figure 10-32 on page 466):

    •Refinement

    The left frame that allows users to further refine the search results by filtering by various elements. The types of filters that are available are creation date, object type, owner of the object, and metadata. Selecting one of these refinements filters the results contained in the results frame.

    •Results

    Center frame that displays the search results based on the search criteria and the refinements applied. Based on the search criteria, there can be multiple sections within the search results returned. The standard section contains the search results directly related to the criteria used to perform the search. 

    The Create and Explore section provides the user with a default query that is based on the search criteria on which to start building a report. This display is an excellent way to provide users with a headstart on getting the information that they are after when there are no existing reports that provide the necessary detail. Users can use the default query and then customize to query to create a report that can be reused or shared with others. 

    The last section provides users with suggested content based on predefined suggestions that are defined on the Index Search tab. For example, if there is a report template that should be used for financial reports, then a suggested definition can be created that displays the link to the report template any time that users searched on words such as sales, profit, results, or budget.

    •Related 

    The related frame brings back results from an external third-party search source, such as the Google search appliance, which is an excellent way to include content that is not IBM Cognos so that users are presented with more inputs to help answer their questions.
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    Figure 10-32   Enhanced search user interface

    Before users can use the new search capabilities with IBM Cognos, an enhanced search index must first be constructed. Administrators can influence the contents of an index by customizing the types of objects that are included as part of the build process. Because creating an index can be a lengthy process, depending on the types of objects included and whether reporting data is being indexed, build an initial index that just includes IBM Cognos content. This type of index results in a shortened time to build the search index and allows users to perform searches for content immediately versus having to wait for a full index to be constructed. After the first index has been created, incremental additions can be made to the index to expand the search results returned to business users.

    Table 10-2 provides steps for building an effective enhanced search index.

    Table 10-2   Steps to building an effective enhanced search index

    
      
        	
          Step

        
        	
          Index scope

        
        	
          Proven practice

        
      

      
        	
          Define indexable object types.

        
        	
          Not applicable

        
        	
          Reduction of content types to index results in faster build times. Typically defined once and only changed when the business requires.

        
      

      
        	
          Build and schedule initial index.

        
        	
          All entries

        
        	
          Initial index containing only IBM Cognos content to quickly enable search capabilities for enhanced consumer users. Executed once when the initial reporting content is ready to be used.

        
      

      
        	
          Refresh the search index.

        
        	
          Only entries that have changed

        
        	
          As the reporting environment evolves, the index will have to be refreshed to reflect the changes. Reoccurring task that can be run nightly or weekly depending on the frequency of changes to the content.

        
      

      
        	
          Expand the index to include reporting data values.

        
        	
          Only entries that have changed

        
        	
          Monitor usage and business requirements so that data values for popular reports and packages are incrementally added to the index. 

        
      

    

    Define indexable object types

    Although the default parameter settings for enhanced search allow administrators to build an initial index, it is good practice to verify that all of the content types are required for a particular environment or to meet business requirements. 

    To modify the types of content included in the search index:

    1.	On the Index Search tab from within the administration console, select the Index task from the left frame and the General tab in the right frame (Figure 10-33).
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    Figure 10-33   Index Search General tab

    2.	In the Indexable Types section, select the object types to be included in the initial search index. For the initial build, deselecting the output type eliminates the time required to crawl through the report output results stored in the IBM Cognos content store (Figure 10-34).
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    Figure 10-34   Indexable object types

    3.	After the desired object types have been selected, click Save.

    Securing the index and search results

    The index update service can retrieve the access control list from IBM Cognos Content Manager during indexing. This option consumes additional resources, but is turned on by default because it speeds up searching. 

    To secure the index and search results:

    1.	In IBM Cognos Connection, in the upper-right corner, click Launch IBM Cognos Administration.

    2.	On the Index Search tab, click Index → General.

    3.	Under Security, review the settings listed in Table 10-3.

    Table 10-3   Index search security considerations

    
      
        	
          Setting

        
        	
          Description

        
      

      
        	
          Index Access Control List

        
        	
          Specifies whether the access control list for each object is retrieved from Content Manager during indexing. When selected, the internal security check is used. When deselected, the Content Manager security check is used. Also, Index Access Control List in Search, General and in Storage, General must be selected. If all three settings do not match, the Content Manager security check is used. All three index access control list settings are selected by default.

          For more information, see the IBM Cognos Installation and Configuration Guide.

        
      

      
        	
          Update Policies

        
        	
          Specifies whether the index access control list is updated when an incremental index is run.

          The setting is selected by default.

        
      

    

    These are the minimum considerations required to build the initial index. For more information regarding the index search options, how to include third-party search engine content, or how to predefine suggested content for users, consult the “Managing Index Search” chapter in the IBM Cognos Administration and Security Guide.

    Build an initial index

    Search results depend on the access permissions of the person who indexes the content and the user who searches the content. Build the search index with an account that has access to all content in the public folders so that all content is available to users.

     

    
      
        	
          User permissions note: Regardless of the user permissions that built the enhanced search index, search results only show content to which the user performing the search has access.

        
      

    

    To build an initial index:

    1.	Navigate to the Content Administration task on the Configuration tab within the administration console.

    2.	Select the New Index Update icon from the toolbar, which launches the New Index Update wizard.

    3.	Specify a name of Initial Index for the new index update task on the Specify a name and description wizard page. Only the name is required, but, if desired, the other values can be supplied as well. Click Next.

    4.	On the Select the content  wizard page, the content to be included in the search index can be specified. By default, all of the reporting content located in the Public Folders is included. Content can be selected for exclusion if desired, but for the initial index, index all Public Folder content unless there is absolutely content that should not be included. Click Next.

    5.	On the Select an action wizard page, click Save only, and then click Finish.

    This results in an index update definition being created, but will not have executed the actual build process because the Save only option was selected (Figure 10-35).
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    Figure 10-35   Index update definition created and ready to be executed

    Building the initial index for enhanced search can be a lengthy, resource-intensive process, depending on the options selected to index, whether metadata and reporting data values are included, and the topology of the installed IBM Cognos components. To help ensure that building the initial index has limited impact on users, the common practice is to schedule the index build process to not occur during periods of heavy reporting usage:

    1.	Click the Run with options icon in the Actions list, which launches the Run with Options dialog box.

    2.	Assuming that the task is to be run at a later time, select Later.

    3.	Using the drop-down calendar control beside the date field, select a month and day on which the task will execute.

    4.	Modify the time that the task will run so that it does not coincide with heavy reporting periods.

    5.	Because the initial index should just include the reporting content, ensure that only the Properties and metadata option is selected for the content options.

    6.	The scope should be set to All entries, as this is the initial creation of an index. If an index had previously been created, the All entries option would replace the older index with the index created as part of this task.

    7.	Click Run (Figure 10-36).
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    Figure 10-36   Scheduled initial index update task definition

    To verify that the index update task has been scheduled for the desired time, navigate to the Upcoming Activities task on the Status tab and then use the graph Next control to scroll to the appropriate date. If the task was set to run at a much later date, you can use the Advanced options in the Filter section. After the date is located, the index update task displays in the results list (Figure 10-37).
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    Figure 10-37   Upcoming scheduled index update task

    Refresh the search index

    As the content of the IBM Cognos BI analytics solution evolves, administrators must ensure that the contents of the search index remain as accurate as the business demands. Neglecting to periodically update the search index results in search results returning links to reports that are no longer present, or incomplete results because newer content is not highlighted. 

    To avoid staleness of the search index, it is important to first determine how frequently the content is changing. If auditing is enabled, the easiest way to check the volume of change to the content for a given period of time is to execute a report against the audit database. Refer to 10.5, “Auditing” on page 503, for more details regarding the audit facility within IBM Cognos BI.

    After the frequency of change has been detected, it is essential to understand how long it takes to build the search index. Because the only point of reference at this juncture is the initial index update task, the execution duration for that task must be used.

    1.	In the administration console, navigate to Status → Past Activities.

    2.	To locate the history detail for the index update task, use either the Period drop-down menu in the Filter section to select one of the pre-generated periods, or click the Edit link to define a date range using calendar controls, that corresponds to the date and time when the index update task was started.

    3.	If a lot of results are expected for the selected date range, click the Advanced options link and select Type → Index update.

    4.	Click Apply.

    5.	In the list of results on the right frame of Past Activities interface, locate the index update in question and select Initial Index → View run history details (Figure 10-38).
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    Figure 10-38   Viewing the run history details of an index update task

    6.	Examining the upper portion of the “View run history details” dialog box reveals the start time, end time, and date, in case the duration spanned more than one day. Because future index updates will not likely include all of the content that this task did, administrators are now provided with the maximum amount of time that should be required to update the index incrementally (Figure 10-39).
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    Figure 10-39   Verifying time taken to execute the initial index update task

    Expand index to include reporting data values

    With an incremental index update strategy defined and in place, you might expect there will no longer be any additional search index updates required. However, there is still a factor missing from the equation. 

    The previous sections covered creating the search index and populating it with both modeled metadata and object properties, but the last dimension to providing users with a complete enhanced search index is the inclusion of data values from the underlying reporting databases.

    As shown in Figure 10-36 on page 472, only the object metadata and properties were included as part of the initial index. To expand this data to include actual data values that are contained within the report and the reporting database, modify the index update task to include one of the following types of data:

    •Referenced data 

    Specifies that only data referenced by the expressions encountered in reports, queries, and analyses that are included in the scope of the indexing task are indexed

    •All data 

    Specifies that all data encountered in the models that are within the scope of the indexing task are indexed, regardless of whether the metadata has been used in reports, queries, or analyses

    After a strategy is devised for which content will have data included in the index, create a new index update task with the appropriate settings and ensure that the scope is set to include only entries that have changed so that this new content is added to the index incrementally.

    10.3.2  Restricting the scheduling options

    Administrators for IBM Cognos environments are able to control user access to object such as reports, packages, and data sources, as well as access to functionality within the application. Users can access current activities, past activities, upcoming activities, and schedules on the Status tab in IBM Cognos Administration to monitor the server activities and manage schedules (as long as they have been granted access). To grant access to the scheduling functionality independently from the monitoring functionality, use the scheduling capability.

    The scheduling capability controls access to the scheduling functionality for items that can be run, such as reports. The following secured features are associated with this function:

    •Schedule by day

    Users can schedule entries daily.

    •Schedule by hour

    Users can schedule entries by the hour.

    •Schedule by minute

    Users can schedule entries by the minute.

     

    
      
        	
          User denied access to schedule by minute: If a user is denied access to the schedule by minute capability, by minute scheduling is also denied for other capabilities that allow by minute scheduling, for example, the schedule by month capability.

        
      

    

    •Schedule by month

    Users can schedule entries monthly.

    •Schedule by trigger

    Users can schedule entries based on a trigger.

    •Schedule by week

    Users can schedule entries weekly.

    •Schedule by year

    Users can schedule entries yearly.

    •Scheduling Priority

    Users can set up and change the processing priority of scheduled entries.

    Sam Carter is the Administrator for the IBM Cognos environment at the Great Outdoors company. Sam is busy and decides to delegate several of his more simple tasks so that he can pay more attention to other work. Sam decides to permit certain users at the Great Outdoors company to access the IBM Cognos scheduling features so that they can create and manage their own schedules. Because Lynn Cope is an Advanced Business User and Report Author at Great Outdoors company, Sam decides to grant her access to IBM Cognos scheduling capabilities. 

    To simplify the addition of this capability for more users in the future, Sam creates a new role in the Cognos namespace called self-serve scheduling and adds Lynn Cope to that role. Sam now grants scheduling capabilities to the new self-serve scheduling role.

    To grant access to scheduling capabilities within IBM Cognos BI:

    1.	Log on to IBM Cognos BI using credentials for a user with access to administrative features and open IBM Cognos Administration.

    2.	Click the Security tab.

    3.	Click Capabilities.

    4.	The default display settings for IBM Cognos BI only display 15 items per window. Scheduling capabilities are controlled through a capability called Scheduling. If necessary, you can display the scheduling capability by clicking the Next icon.

    5.	Note that the scheduling capability is highlighted as a live link. This indicates that there are additional features associated with this capability that can be secured individually. Click Scheduling. Figure 10-40 shows the Capabilities panel.
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    Figure 10-40   The Capabilities panel within IBM Cognos Administration

    6.	Access to secured functions can be configured through the capability’s properties. Click the down arrow next to Schedule by hour, and then click Set Properties. Figure 10-41 shows the features that are available within the scheduling function.
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    Figure 10-41   Setting properties to grant access to schedule by hour capabilities

    7.	When the Set Properties window opens, click Permissions.

    8.	Click Add and browse to the Cognos namespace by clicking Cognos.

    9.	Select the role by selecting Self-serve Scheduling, click the add arrow, and then click OK. Figure 10-42 shows the process of selecting the role that will be granted access to the schedule by hour capability.
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    Figure 10-42   Selecting the custom self-serve scheduling role

    10.	Grant self-serve scheduling execute and traverse rights for the schedule by hour capability by selecting Self-serve Scheduling and then selecting Execute and Traverse under the Grant column. Click OK. Figure 10-43 shows an example of granting access to a capability for an IBM Cognos role.
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    Figure 10-43   Granting access rights

    11.	Members of the self-server scheduling custom-created role can now access scheduling functionality and schedule their own activities without administrator involvement.

    You can also use the process that we described previously to restrict access to scheduling capabilities. Administrators can permit or deny users the right to schedule their own activities based on schedule frequency or by trigger. For example, one group of users can be granted full access to scheduling functionality, whereas another can be limited to only scheduling activities on a weekly basis.

    10.3.3  Intra-day scheduling window

    Administrators can further manage the distribution of system processing load through the use of intra-day scheduling features for IBM Cognos. Activities within IBM Cognos can be scheduled to execute on a recurring basis within a window of time during a single day. For example, a job can be scheduled to run every 5 minutes between the hours of 6:00 a.m. and 8:00 a.m. on Mondays. Figure 10-44 shows an example schedule frequency setting that uses the intra-day scheduling feature.
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    Figure 10-44   Schedule frequency set to run every 5 minutes between 6:00 a.m. and 8:00 a.m. on Mondays

    10.3.4  Allowing users to persist personal database signons

    As an administrator, it can become challenging to manage user signons for large volumes of users across multiple data sources. IBM Cognos allows administrators to empower selected users to manage their own database credentials. This is essential when certain reports require a personalized view of the data instead of a generic result set. For example, a generic database credential is employed when running a summary call center report that compares the hourly breakdown comparison of incoming calls versus resolution rates. If deeper personalized analysis was required, such as managers looking to see their teams’ individual call closure rate, managers could provide, and persist, their own unique database signon. 

    Empowering users to manage signons

    Administrators can provide users with the ability to manage signons by granting them access from within the administration console:

    1.	Launch the administration console by selecting either the Administer IBM Cognos content link from the Welcome menu or by clicking the IBM Cognos Administration link from the Launch menu within IBM Cognos Connection.

    2.	On the Security tab, select the Capabilities task from the left frame.

    3.	Using the Actions drop-down menu for the manage own data source signons capability, select Set Properties (Figure 10-45).
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    Figure 10-45   Setting the properties on the manage own data source capability

    4.	On the Permissions tab, ensure that the Override the access permissions acquired from the parent entry check box is selected.

    5.	Click the Add link to add users, groups, or roles to the capability access control list.

    6.	Navigate to a specific user, group, or role by browsing the namespaces from the “Available entries” dialog box. 

    a.	If the namespace is large, there are numerous namespaces, or the location of the desired entry is unknown, administrators can search for specific accounts by selecting the Search link in the upper-right corner of the page.

    b.	Remember to select Show users in the list if browsing for a user account. Otherwise, only groups and roles display.

    7.	After you locate the appropriate user, group, or role, select it by clicking the corresponding check box. Then, click the green arrow button to the right of the dialog box to add the object to the “Selected entries” dialog box. Click OK.

    8.	From the access control list on the left, select the newly added entry by clicking the appropriate check box.

    9.	To enable this capability, the execute and traverse actions must be granted. Select the Grant check boxes for both of these actions, and the policy in the left frame updates automatically (Figure 10-46). Click OK.
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    Figure 10-46   Assigning execute and traverse actions

    Removing the IT burden of managing signons

    There are a few scenarios in which the management of data source signons should be managed by IT, for example, when standard defined signons are required to ensure data consistency for all users executing reports. However, in most cases, providing that the users are aware of the necessary credentials, it is a good idea to empower users to manage their own signons. 

    For users to manage their signons, they must be granted the ability execute and traverse on the manage own data source signons capability, and they cannot have any access to an existing defined signon, managed by IT. There is an order of operation in effect when the query layer is determining which signon to use when the query is executed (Table 10-4).

    Table 10-4   Order of preference for data source signons

    
      
        	
          Signon type

        
        	
          Storage location

        
        	
          Behavior

        
      

      
        	
          Defined and managed by IT

        
        	
          Defined and stored under the data source connection name in the administration console (data source connections task).

        
        	
          If a user has access to multiple signons for the same data source, he is prompted to select one to use.

        
      

      
        	
          Personal 

        
        	
          Stored as part of the user profile and accessible through the My Preferences interface.

        
        	
          Created at the request of the user. There cannot be more than one signon per data source connection.

        
      

      
        	
          Prompt

        
        	
          When a user does not have access to a defined signon or a personal signon in his profile, a prompt is presented to execute the report.

        
        	
          When the prompt is presented, the user is optionally able to persist that signon in their profile if he has access to the correct capability (Figure 10-47).
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    Figure 10-47   Privileged users can optionally persist data source credentials

    The key element to this feature is that although it empowers the user to manage his own data source credentials, IT always retains control of the data source authentication strategy. In an IBM Cognos environment that has been deployed with IT managing the data source signons, either deleting the signons or denying everyone access to the existing signons (the most advisable approach), quickly converts the authentication strategy and shifts the responsibility to the user. If corporate policy changes and IT needs to assume responsibility once again, granting the user community access to at least one signon forces the usage of the defined signons, while ignoring the existence of any saved personal credentials.

    10.4  Managing the environment

    The IBM Cognos BI release contains a variety of features around the area of system management. One of the primary features is the metrics that are a part of the system task that pertain to the various components that make up the IBM Cognos BI environment: 

    •Services

    •Dispatchers

    •Servers 

    •Server groups

    These metrics provide administrators with better insight into the status and overall health of the various components that make up the business analytics solution. The system metrics are broken into three dimensions: 

    •Individual metric

    •A metric group 

    •The service to which these pertain

    Individual metrics

    Key individual metrics that are monitored as part of a solid system management methodology are:

    •AverageTimeInQueue 

    The average time in queue is calculated based on the total amount of time that all requests have spent in the queue divided by the total number of requests that have been in the queue. This averaged value maps to the latency metric in the administration console.

    •FailedRequestPercent and SuccessfulRequestPercent 

    This metric displays the percentage of failed/successful requests that have occurred. The calculation is simple:

    (Number of failed or successful requests / number of received requests) * 100

    These percentage metrics are excellent metrics to monitor when resetting the metrics is either not possible or is not going to be done. The reason for this is that tolerance thresholds built on the percentage metrics are always relevant regardless of when the last reset occurred. With count metrics for failed and successful requests (NumberOfFailedRequests and NumberOfSuccessfulRequests), thresholds are eventually reached after a period of time, and never return to a green status. 

    For example, if the threshold score is set to turn red after 50 failed requests, after the threshold is exceeded (one day, one week, one month, and so on), the threshold score is always red until the service is restarted or the metrics are reset. The percentage metrics change over time. 

    Using the previous example, if the failed requests hit 50 after the first 50 requests, the value is 100% and more than likely results in a threshold score of red. From that point forward, if every request is successful, the metric value decreases, thus moving the red score to yellow and then eventually green. Due to this, if only the percentage metrics are monitored through thresholds, no resetting of metrics ever needs to occur.

    •MillisecondsPerSuccessfulRequest 

    This is the average amount of time spent processing a successful request.

    •NumberOfFailedRequests 

    Number of failed requests, not to be confused with the failed request percentage metric, is a cumulative count of the number of failed requests that have occurred since the last reset.

    •NumberOfProcessedRequests 

    This specifies the amount of received requests that have been processed by the dispatcher.

    •NumberOfRequests 

    This specifies the amount of requests that have passed through the queue since the last time that the metrics were reset. This value maps to the number of queue requests in the administration console.

    •NumberOfSessions 

    This indicates the amount of user sessions that are currently active in the environment.

    •NumberOfSessionsHighWaterMark 

    This indicates the maximum amount of user sessions that were active in the environment at one time.

    •NumberOfSuccessfulRequests 

    Number of successful requests, not to be confused with the successful request percentage metric, is a cumulative count of the number of successful requests that have occurred since the last reset.

    •QueueLengthHighWaterMark 

    The value for this metric is an indication of what the highest amount of requests in the queue has been since the metric was last reset.

    •ResponseTimeHighWaterMark 

    The value for this metric shows the longest period of time spent processing a request, either successful or failed.

    •ServiceTimeAllRequests 

    The service time metrics show the amount of time that was spent processing the requests. This particular metric value is the total amount of processing time that was used for all requests, including both failed and successful.

    •ServiceTimeFailedRequests 

    This metric value is the total amount of processing time that was used for all failed requests.

    •SuccessfulRequestsPerMinute

    The definition of this metric slightly differs from the traditional definition, or perception, of successful requests per minute. This value does not indicate an ongoing average from minute to minute, but rather it is an indication of how many requests have been processed during the amount of time that the system has spent processing them. The formula is:

    (Number of successful requests * service time for successful requests) / 60 seconds

    For example, 10 requests are executed successfully and the server has spent 30 seconds executing the requests. When looking at the metric after a minute, the traditional definition would indicate the average is 10 requests per minute. After the second minute, the value would be 5, and so on. The actual use of this metric in IBM Cognos BI would be 20 after one minute and would still be 20 after 2 minutes. 

    This algorithm shows that what the average successful requests is based on is the amount of processing time that it took to execute them and not the actual time. This is done to provide a real value that is not impacted by periods of inactivity. This metric is a great way to track server throughput.

    •TimeInQueue 

    This cumulative metric shows the total amount of time that has been spent by all objects in the queue. For example, if 30 requests have been in the queue at some point, each with a queue time of 1.5 seconds, the value for the metric is 45, as the total time spent (30 * 1.5) is 45 seconds.

    •TimeInQueueHighWaterMark 

    This displays the longest amount of time that one object has spent in the queue.

    Metric groups

    The individual metrics are divided into three main metric groups:

    •Request 

    These metrics pertain to the specific requests that are handled by each component in the environment. Notable metrics that are included in this group are:

     –	Amount of processed requests

     –	The percentages of successful versus failed requests

     –	The amount of processing time for these requests

    •Queue 

    These metrics provide insight into the amount of requests that are not handled immediately and therefore are placed into a queue to be processed when the resources become available. Several metrics in this group are the amount of requests that have been in the queue, the length of the queue, and how much time requests have spent in the queue.

    •Process 

    These metrics display information regarding the amount of processes required by the product to function. Metrics such as the number of current processes and the maximum number of processes that were spawned are available. 

    There are a few metrics located outside of the three main metric groups (JVM uptime and heap size information, for example), but the majority of the individual metrics are a part of the three metric groups.

    Services

    The final dimension to the system metrics is how the individual metrics and metric groupings relate to the service to which they are associated. Understanding what actions are performed by each of the services provides greater insight into the values that are being reported. For more information about the services that make up the IBM Cognos BI solution, see 2.1.2, “IBM Cognos BI services” on page 16.

    The system task displays metrics at all of the levels of the topology. The metrics are collected at the service level, which is the lowest level in the topology. From the service level, metrics are then consolidated through the rest of the topology: services to dispatcher, dispatchers to the server, and then the servers to the system level. Therefore, requests to the individual services affect the metric values at the higher server and system levels. 

    This is an important fact when working with environments that are made up of multiple servers or dispatchers. When viewing the metrics scorecard that is available as part of the system task in the administration console, the green, yellow, and red traffic light indicators reflect the most severe indication value in the hierarchy. That is, the poorest indication rises to the top. This was done to provide administrators with the ability to visually see, at a glance, whether any key metrics are not performing as well as expected without having to drill down to lower levels of the hierarchy.

    The metric values are updated in real time and reside in an MBean within the dispatcher Java process. Because the metrics are live, they are dynamic and are only reset when the IBM Cognos BI service or process is restarted or when an explicit request, either manual or programmatic, is executed. 

    As the metrics are dynamic and reside as part of the dispatcher, they are volatile and thus are reset every time that the service or server is restarted. In certain situations it might be desired to have the metrics reset without restarting the entire application. This is possible by using the Reset button beside the metric grouping name in the Metrics dialog box. When the Reset is clicked, all of the metrics that belong to the service in context are reset. If a higher level is in context, such as a server or the system, all of the metrics that pertain to that object are also reset (Figure 10-48).
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    Figure 10-48   Reset the request metrics as they pertain to the Content Manager service

    An important note regarding the metrics, and the administration console in general, is that there is no auto-refresh feature. It was a design decision, based on the general feedback from administrators, that this limited the ability to thoroughly analyze a series of metrics if the values changed on a regular basis. 

    That said, there are a few manual refresh options available within the administration console:

    •Fragment refresh 

    This is the button located in the upper-right corner of the fragment that refreshes the values of the contents in the frame. For example, in the system task, refreshing the metrics frame updates the metric values, but does not change the contextual object or refresh any of the values in any of the other windows (Figure 10-49).
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    Figure 10-49   Refresh button will retrieve the current values for the metrics

    •Page refresh 

    This button is available on the main IBM Cognos BI toolbar located at the top of the browser page. When clicked, the entire page being viewed is refreshed. For example, clicking this button when viewing the system task refreshes the scorecard, metrics, and settings frames without losing context (Figure 10-50).
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    Figure 10-50   Button to refresh the entire page

    •Browser refresh 

    Using the browser refresh button to update the administration console causes all pages to be refreshed. This action causes all context to be lost and, after the refresh has occurred, the default view allowed by your administrative capabilities displays.

    To provide a reference as to the timeliness of the information being viewed, there is a summary bar at the bottom of each frame that displays the last time that a refresh occurred (Figure 10-51).
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    Figure 10-51   Bottom of frame indicates when the values were generated and displayed

    10.4.1  Metric tolerance thresholds

    Whereas the ability to have real-time metrics displayed in the administration console provides valuable information when monitoring the environment, the value all but disappears when not actively in the console watching the metrics. With this in mind, it is possible to manually set a tolerance threshold on the individual metrics, which can provide the basis for automated alerts through IBM Cognos Event Studio, or by creating self-service personal alerts in IBM Cognos Viewer. 

    These thresholds allow administrators to set ranges that provide them with a quick overall view into the system health. The current metric values are displayed in the system task as green, yellow, and red traffic light indicators, based on the range that the value resides. When a series of thresholds is assigned to key indicators that pertain to the specific environment, an overall scorecard is possible (Figure 10-52).
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    Figure 10-52   System Scorecard showing all dispatchers

    A quick glance at the scorecard indicates that there is a dispatcher that has a yellow indicator, which means that certain underlying service metrics have values that are nearing the acceptable norm and might warrant further investigation.

    Creating a threshold

    Before an overall scorecard can be established, tolerance thresholds must first be defined on the key metrics:

    1.	Launch the IBM Cognos administration console.

    2.	Select the System task on the Status tab.

    3.	In the scorecard frame, drill down on an available server.

    4.	Drill down again on an available dispatcher to reveal the underlying services.

    5.	Click BatchReportService.

    Clicking the BatchReportService object changes the focus of the metrics frame on the upper-right side so that all of the relevant metrics for the batch report service are displayed (Figure 10-53).
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    Figure 10-53   Request metrics for the batch report service

    The metrics batchreportservice frame consists of two metric groupings:

    •Process, which provides metrics about the amount of configured and running batch report processes

    •Request, which displays metrics about the amount and duration of requests handled by the batch report service

    Take the following steps:

    1.	Expand the Request metric grouping by clicking the plus sign (+).

    2.	Locate the percentage of failed requests metric and click the pencil icon.

    3.	The “Set thresholds for metric - Request - Percentage of failed requests” dialog box opens. This dialog box is divided into two sections. The first section is the Performance pattern, which specifies whether high, middle, or low values are good (a green traffic light indicator). The second section is where the actual threshold values or ranges that will drive the type of indicator are defined.

    4.	Because failed requests are undesirable, select Low values are good.

    5.	Enter a value in both of the boxes to define the range. Figure 10-54 shows that the indicator light is green until the value for the particular metric hits 3%, then it turns yellow. If the metric value continues to increase and a value of 5% is obtained, the indicator light changes to a red.
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    Figure 10-54   Defining a metric threshold

     

    
      
        	
          Light indicator: The yellow indicator light value is 3.0%, which means that at 3% the indicator changes from green to yellow. Clicking the down arrow beside 3.0% moves the box down to the green threshold, which results in 3.0% remaining green, but anything higher changing the status to yellow.

        
      

    

    6.	Click OK to save the threshold.

    Returning to the metrics frame, the status indicator for the newly created metric threshold is displayed (Figure 10-55).
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    Figure 10-55   Metrics frame with newly created metric performance pattern

    After you define metric thresholds, if auditing is enabled for the IBM Cognos BI version 10.1 environment, any threshold exceptions (changes to the indicator light color) are written to the COGIPF_THRESHOLD_VIOLATIONS table. This table allows administrators to proactively create IBM Cognos Event Studio agents that monitor the audit table for exceptions and that notify the required administrators. The audit database entries also provide the information that is required to report on the volume and severity of the exceptions over time. This reporting is key in indicating peak periods of usage and keeping track of unexpected changes to usage patterns.

    Programatically setting thresholds

    One of the most common questions that is asked is why there are no default thresholds? The is because there are many factors that influence metric values, such as size of the user base, number of concurrent users, volume of reports being executed, server hardware, available memory, and so on, it is impossible to provide defaults that would have any relevance in all environments. 

    Not only could setting metric thresholds be a timely exercise based on the volume of metrics available, but what values should be used that make sense for the environment in question? Are the values being used based on the current settings? If so, are these values indicative of a typical day? What about during peak periods? Won’t all of the metric thresholds turn red during peak period usage?

    There is help for this. Using the metric export capability, it is possible to gather metric exports for a period of time, typically spanning a high reporting period when available, and then using the metric exports, programatically through the SDK, set the threshold ranges based on the real-world usage statistics for a given environment. 

    For more information about setting the metric thresholds, see the System Management Methodology located at:

    http://www.ibm.com/developerworks/data/library/cognos/page258.html

    10.4.2  Reacting to bottlenecks due to unexpected events

    System administrators are occasionally faced with unexpected environmental events or unforeseen changes to usage patterns. Reacting to these occurrences is critical to maintaining service level agreements and ensuring that the data in reports is accurate and not out of date. 

    Using a Great Outdoors company scenario, Sam Carter, the IBM Cognos Administrator, receives a message indicating that there will be a 60-minute outage of the reporting database from 1 p.m. to 2 p.m. due to scheduled routine maintenance. To ensure that any reports scheduled during this time do not fail, Sam must react to the situation by taking the following steps:

    1.	Launch the IBM Cognos administration console.

    2.	Select the Upcoming Activities task on the status task.

    3.	Select the 1 p.m. to 2 p.m. time slot on the chart by clicking the bar above 13 along the x-axis, which changes the list display at the bottom of the page.

    4.	Select all of the entries by clicking the check box in the upper-left corner or the list, or if only certain entries will be impacted by the database outage, manually select the objects or use the Advanced options on the left to filter the results to display only the impacted objects and select all.

    5.	After you select the objects, use the Actions drop-down menu beside one of the selected items to choose the Suspend option or use the Suspend button from the toolbar menu.

    6.	In the Suspend Activities dialog box, select Until, and change the calendar control to reflect a period when the reporting database is back online. For example, the reports can be shifted to 3 p.m. to compensate for any additional minor delays.

    7.	Click OK.

    8.	The Upcoming Activities chart updates to reflect the changes.

    The scenario describes reacting to a planned database outage, but the ability to suspend reports for a predefined period of time can also be used to help spread an unexpected scheduling load across other less active periods. The ability to allocate scheduled objects throughout the day can help ensure system throughput, so it is a good practice for IBM Cognos administrators to proactively examine the upcoming load for the day and make changes were necessary.

    Building on the previous scenario, Sam Carter receives word that there are complications with the database maintenance and that the outage will last longer than the previously anticipated 60 minutes. Unfortunately, there is no new estimate as to when the database will be back online and available for reporting. Sam must now react differently to this unforeseen hurdle because there is no estimated time for the resolution. He must take the following steps:

    1.	Launch the IBM Cognos administration console.

    2.	Select the Upcoming Activities task on the status task.

    3.	Click the bar above 15 along the x-axis to change the filtered list to the objects scheduled to run from 3 p.m. to 4 p.m.

    4.	Select the objects that had been previously rescheduled.

    5.	Using the Actions drop-down menu beside one of the selected items, or using the toolbar menu, Sam chooses to Suspend the selected items.

    6.	In the Suspend Activities dialog box, select Indefinitely. Click OK.

    Contrary to when the schedules were postponed and a new time was defined in the first scenario, the rescheduled items do not appear in any specific time slot in the chart. Because they were suspended indefinitely, there is no defined time for their execution, so there is no way to represent them on the chart. To identify that there are items that are suspended indefinitely, there is an entry in the chart legend called Suspended that indicates the number of suspended objects (Figure 10-56).
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    Figure 10-56   Upcoming activities chart with legend

    10.4.3  System trending

    Through the combination of viewing the metrics available in the aDministration Console and proactively monitoring metric thresholds using IBM Cognos Event Studio alerts, it is possible to quickly respond to unexpected changes in usage patterns.

    But how is the system doing today in comparison to last week or last month? Is the system handling more or fewer requests than last month? Are the response times and queue lengths increasing due to higher system usage? Because the metrics in the console are essentially a current snapshot of the environment, it becomes almost impossible to answer these questions without a mechanism to record the metric values.

    There are a couple of ways to accomplish the recording of the metrics. The first mechanism uses product functionality to export the metrics to a text file and then using an extract, transform, and load (ETL) tool to load them into a reporting database. After they are loaded into the database, reports can be created so that analysis of key metrics can be tracked. This is a continual process of exporting and then loading the metrics so that the reports are always current.

    The other mechanism is to use a tool that is both capable of connecting to the Java environment directly and writing the values to the reporting database. One such tool is IBM Tivoli Directory Integrator, which connects to the IBM Cognos JVM, reads the metrics from a customizable list of services, and then writes out the values to a relational database. This process is automated and can be scheduled so that there is no manual intervention required, and the metric values can be written to the database at almost any interval.

    For more information regarding system trending, see the System Management Methodology located at:

    http://www.ibm.com/developerworks/data/library/cognos/page258.html

    10.4.4  Consuming system metrics from external tools

    This section discusses Java Management Extensions and JConsole.

    Java Management Extensions

    Java Management Extensions (JMX) is a Java technology that supplies tools for managing and monitoring applications and service-orientated networks. These resources are represented by objects called MBeans. MBeans, which stands for Managed Bean, represent a resource running in the Java Virtual Machine (JVM).

    How this translates to the IBM Cognos topology is that the dispatcher component stores the raw metrics in an MBean within the JVM running the IBM Cognos BI application. Besides the administration console, the metrics are accessible externally by using the industry-standard JMX. Thus, for tools such as IBM Tivoli Monitoring to connect to the IBM Cognos metrics, a JMX agent must be created to interface with the IBM Cognos MBean. 

    Connecting to metrics using JConsole

    This section describes the steps required to view the metrics externally using the JConsole application, which is available as part of the Java V1.5 JDK package. Before the metrics can be exposed to external sources, the Java MBean must first be made available for external access. To accomplish this, a parameter must be added to one of files within the application server. 

    For a default Tomcat installation, complete the following steps:

    1.	Navigate to the <install_dir>\webapps\p2pd\WEB-INF directory and open the p2pd_deploy_defaults.properties file in a text editor. Uncomment the existing rmiregistryport line by removing the # symbol (and modify the port number if required) (Figure 10-57).
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    Figure 10-57   Enabling the rmi registry port for JMX support

    2.	Save the file.

     

    
      
        	
          Port number note: The number specified in the added string pertains to a port number. Ensure that the port number specified is available for use and is not being occupied by another application.

        
      

    

    It is important to note that there is no security associated with the JMX implementation, so after the entry has been added to the file, anybody can connect to the MBean if the proper connection string is known. That is, product access to the metrics can be locked down through the security policies in IBM Cognos Connection and the administration console, but these policies do not apply when connecting externally. 

    To enforce user name and password external access:

    1.	Open IBM Cognos Configuration.

    2.	In the explorer frame, select Environment.

    3.	Locate the External JMX Port property in the Environment - Group Properties dialog box and type 9999 (to match the port number used for the rmiregistryport entry from a previous step).

    4.	Click the value field of the External JMX credential property, and then click the pencil icon.

    5.	On the “Value - External JMX credential” dialog box, specify the user ID and password that will be used to secure the IBM Cognos MBeans (see Figure 10-58).
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    Figure 10-58   Securing the IBM Cognos JMX interface

    6.	Click OK.

    7.	Save the new configuration parameters.

    Because this is a setting that is read when the application is started, a restart is required if the IBM Cognos BI application is already running. 

    After you start or restart the application:

    1.	Locate the jconsole.exe executable in the bin directory of the Java JDK and launch it.

     

    
      
        	
          JMX implementation note: The JMX implementation does not allow for spaces in the install path when using a JRE other than the default IBM JRE provided with the IBM Cognos installation. If there are spaces in the installation path and the non-default IBM JRE is being used, JConsole must be executed using the following command line:

          Jconsole -J-Djava.rmi.server.useCodebaseOnly=true

        
      

    

    2.	When presented with the JConsole: Connect to Agent dialog box, switch to the Advanced tab (see Figure 10-59). Connect to the following JMX URL:

    service:jmx:rmi://machine_name/jndi/rmi://machine_name:9999/proxyserver
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    Figure 10-59   Connecting to IBM Cognos using JMX

     

    
      
        	
          Connection note: The machine_name entry must be the server name and cannot be localhost.

        
      

    

    3.	Supply the proper credentials if the External JMX credential value was supplied in IBM Cognos Configuration.

    4.	Click Connect to connect to the system metrics using JMX.

    5.	Ensure that the MBeans tab is selected (if not selected by default).

    6.	Expand the com.cognos section of the tree. This is the location of all of the metrics that reside in the administration console.

    7.	View the metrics for a service, for example, report service, by expanding the reportService entry to expose the objects beneath.

    8.	If more than one dispatcher is present in the environment, select one of them and expand the dispatcher name entry in quotation marks.

    9.	Click the Metrics option beneath the dispatcher, which displays all of the metric names and values in the right frame.

    To compare the metrics displayed in the IBM Cognos administration console and JConsole:

    1.	Open a web browser session, launch IBM Cognos BI, and navigate to the System task within the administration console.

    2.	Drill into the same dispatcher as used in the JConsole interface.

    3.	Keep drilling down until the ReportService entry is located.

    4.	Click ReportService to filter the metrics in the upper-right frame.

    Providing that no additional report service requests were made, the values displayed in the Metrics - ReportService frame are identical to the values displayed in JConsole, although there might be slight formatting differences (Figure 10-60 and Figure 10-61).
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    Figure 10-60   Report service metrics in IBM Cognos administration console
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    Figure 10-61   Identical report service metrics in JConsole

    10.5  Auditing

    IBM Cognos Platform provides a complete auditing capability that permits administrators to report on and manage system usage. The information logged by IBM Cognos Platform auditing can be used to support administrative requirements such as:

    •Capacity planning

    •Licensing conformance reporting

    •Performance monitoring

    •Identifying unused content

    By default, system messages, errors, and other product details are logged to flat files that reside in the <c8_install>/logs directory. Although the information provides the ability to identify possible errors that have occurred in the environment, the information is volatile because of the versioning mechanism (that is, file rollover parameter in IBM Cognos Configuration). Even if the desired date range was still accessible, viewing or reporting on the data is complicated and difficult to manage. Use the data contained in the default log files primarily for troubleshooting and not for tracking usage.

    IBM Cognos BI provides the ability to output usage information to a relational database. With the usage audit data stored in a relational data source, reporting then becomes possible. In fact, a sample audit model is supplied that includes several sample reports to assist in providing immediate benefit from the audit data.

    10.5.1  Configure the audit database

    For the usage data to be captured in a relational source, an audit destination must first be configured in IBM Cognos Configuration:

    1.	Open IBM Cognos Configuration.

    2.	Within the Explorer pane, expand Environment, right-click Logging, and then click Resource → Destination.

    3.	In the New Resource – Destination dialog box, type a name (we used Audit in our example) and click Database as the type.

    4.	Right-click the newly created Audit database and click New Resource → Database.

    5.	In the New Resource – Database dialog box, type the database name and, using the drop-down menu, click the type of database target (DB2, Informix®, SQL Server, and so on).

    6.	In the Explorer pane, click the newly created database name and type the necessary parameters, such as database host name and port number, database login credentials, and the database name, into the fields in the Properties pane.

    7.	Test the audit database connectivity either by right-clicking the newly created database name in the Explorer pane and then clicking Test or by clicking the new database name and then clicking the Test icon from the IBM Cognos Configuration toolbar. 

    8.	Save the configuration by clicking Save on the IBM Cognos Configuration toolbar.

    9.	Start (or restart if already running) the IBM Cognos BI services by clicking the Start icon (or the Restart icon) from the toolbar.

    Changes do not take effect until after the IBM Cognos BI services have been restarted. These steps define the JDBC connection that will be used to populate the audit database. During the start phase, the configuration change is identified, which prompts the application to create the necessary tables within the configured database.

    10.5.2  Audit table definitions

    After an audit database has been added to the configuration parameters in IBM Cognos Configuration, the audit database schema is added to the database the next time that the application is started. When the application starts, 18 tables are added to the audit database, but only 11 are used for auditing usage. The COGIPF_SYSPROPS table contains a single record that indicates logging version detail. The COGIPF_MIGRATION table is reserved for an upcoming migration application, and the COGIPF_THRESHOLD_VIOLATIONS records metric threshold exception details that are derived from the IBM Cognos BI system metrics (Figure 10-62).
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    Figure 10-62   IBM Cognos Audit database tables

    Table 10-5 shows audit database table definitions.

    Table 10-5   Audit database table definitions

    
      
        	
          Table name

        
        	
          Description

        
      

      
        	
          COGIPF_ACTION

        
        	
          Stores information about operations performed on objects

        
      

      
        	
          COGIPF_AGENTBUILD

        
        	
          Stores information about agent mail delivery

        
      

      
        	
          COGIPF_AGENTRUN

        
        	
          Stores information about agent activity including tasks and delivery

        
      

      
        	
          COGIPF_ANNOTATIONSERVICE

        
        	
          Stores audit information about annotation service operations

        
      

      
        	
          COGIPF_EDITQUERY

        
        	
          Stores information about query runs

        
      

      
        	
          COGIPF_HUMANTASKSERVICE

        
        	
          Stores audit information about human task service operations (tasks and corresponding task states)

        
      

      
        	
          COGIPF_HUMANTASKSERVICE_DETAIL

        
        	
          Stores additional details about human task service operations (not necessarily required for every audit entry, for example, notification details and human role details)

        
      

      
        	
          COGIPF_NATIVEQUERY

        
        	
          Stores information about queries that IBM Cognos software makes to other components

        
      

      
        	
          COGIPF_PARAMETER

        
        	
          Stores parameter information logged by a component

        
      

      
        	
          COGIPF_RUNJOB

        
        	
          Stores information about job runs

        
      

      
        	
          COGIPF_RUNJOBSTEP

        
        	
          Stores information about job step runs

        
      

      
        	
          COGIPF_RUNREPORT

        
        	
          Stores information about report runs

        
      

      
        	
          COGIPF_THRESHOLD_VIOLATIONS

        
        	
          Stores information about threshold violations for system metrics

        
      

      
        	
          COGIPF_USERLOGON

        
        	
          Stores user logon and logoff information

        
      

      
        	
          COGIPF_VIEWREPORT

        
        	
          Stores information about report view requests

        
      

    

    10.5.3  Audit levels

    The auditing facility within IBM Cognos BI provides five levels of detail. The levels start at minimal, which for the purposes of auditing means disabled, and at the end of the spectrum is full, which should only be used for troubleshooting purposes under the guidance of customer support. For collecting audit detail, the only choices are minimal (disabled) and basic (enabled). Request provides essentially the same level of detail as basic. Only use trace, similar to the full level, under the guidance of IBM Customer Support. Table 10-6 shows IBM Cognos audit and logging levels.

    Table 10-6   IBM Cognos audit and logging levels

    
      
        	
          System activity type

        
        	
          Minimal

        
        	
          Basic

        
        	
          Request

        
        	
          Trace

        
        	
          Full

        
      

      
        	
          System and service startup and shutdown, runtime errors 

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
      

      
        	
          User account management and runtime usage

        
        	
           

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
      

      
        	
          User requests

        
        	
           

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
        	
          Y

        
      

      
        	
          Service requests and responses

        
        	
           

        
        	
           

        
        	
          Y

        
        	
           

        
        	
          Y

        
      

      
        	
          All requests to all components with their parameter values

        
        	
           

        
        	
           

        
        	
           

        
        	
          Y

        
        	
          Y

        
      

      
        	
          Other queries to IBM Cognos components (native query)

        
        	
           

        
        	
           

        
        	
           

        
        	
          Y

        
        	
          Y

        
      

    

    10.5.4  Audit and logging for IBM Cognos BI services

    The IBM Cognos BI architecture comprises various services. Each of these services has a configurable audit level. Assigning the correct level of audit detail to the appropriate service provides a customized view of usage data. For example, if only login information is desired, the only service that needs to have auditing enabled is the Content Manager Service. 

    Understanding what functions are performed by each of the services provides greater insight into the audit detail that they record. For more information about the IBM Cognos services, see 2.1.2, “IBM Cognos BI services” on page 16.

    10.5.5  Setting audit levels

    Setting the audit levels is done through the dispatchers and services task in the administration console in IBM Cognos Connection:

    1.	From within IBM Cognos Connection, click Launch → IBM Cognos Administration to launch the IBM Cognos administration console.

    2.	Click the Configuration tab, and then click Dispatchers and Services.

    3.	On the Configuration pane of the Dispatchers and Services window, click the Set properties - Configuration icon on the main toolbar (Figure 10-63).
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    Figure 10-63   Selecting the Configuration Properties to set audit levels

    4.	When presented with the Set Properties dialog box, click the Settings tab.

    5.	Filter the displayed settings to show only settings related to logging by clicking the Category drop-down menu, and then clicking Logging.

    6.	Using the drop-down menus or check boxes, set the auditing level for each of the services that make up the IBM Cognos BI environment.

    7.	After the levels have been specified for the desired services, click OK to save the new parameter values.

    Because of the inheritance model, audit settings made at the top level will be pushed down to all dispatchers and services that make up the environment. This is the suggested way to set the audit settings, as typically all dispatchers should be recording the same level of detail. However, other unique situations might require that settings differ from the dispatcher, and in those cases, audit settings must be configured for each dispatcher individually.

    To configure customized settings on a dispatcher, select the dispatcher by clicking the link with the dispatcher’s name. This reveals the list of services that make up the dispatcher. Repeat the steps above to set the individual audit settings on the dispatcher. After you configure the customized settings for an individual dispatcher, examine the properties shows that the value changed from Yes to No.

    Overriding the settings on a dispatcher breaks the inheritance model, and parameters with an acquired value of No will no longer be acquired from the parent configuration. To re-synchronize the parameters so that the values can be acquired:

    1.	Select the dispatcher that you want to configure by clicking the dispatcher’s link in the Configuration pane.

    2.	Click the Set properties – dispatcher icon. 

    3.	On the “Set properties – Dispatcher” dialog box, click the Settings tab.

    4.	Change the drop-down menu to Logging, which filters the parameter list to only display the audit-related entries.

    5.	Click the check box in the upper-left corner, which selects all of the logging configuration settings.

    6.	Click the Reset to parent value link at the bottom-right corner of the window, which resets the parameter values to the parent configuration and resets the acquired values to Yes.

    7.	Click OK to save the changes.

    Alternatively, the configuration settings can be reset from the top level and pushed down to the dispatchers in the environment. To do this:

    1.	Click the Set Properties - configuration icon on the main page of the Dispatchers and Services panel. 

    2.	Click the Settings tab. 

    3.	At the bottom of the dialog box, there is an option to delete the configuration settings of the children. This does not really delete them, it simply overwrites them with the current configuration settings from the global configuration. Select this option, and then click OK to save the changes (see Figure 10-64).
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    Figure 10-64   Option to reset all dispatcher configuration settings to the parent values

    10.5.6  Maintaining audit detail while troubleshooting

    Among applications, there is a periodic need for troubleshooting. One of the troubleshooting mechanisms with the IBM Cognos BI application is through the IPF component, called IPF traces.

     

    
      
        	
          IPF trace note: Implement IPF trace only with the guidance of IBM Support.

        
      

    

    Enabling an IPF trace does not require a restart of the application and is enabled when a file called ipfclientconfig.xml is found in the <install_location>/configuration directory. Within that file, various levels of detail can be output to different sources. 

    By default, the master template file called ipfclientconfig.xml template is configured to continue recording regular audit detail to the audit database, providing that server logging configuration settings are correctly entered into the ipfclientconfig.xml file. Each IBM Cognos software component provides a sample IPF Client Trace file to be used when instructed by IBM Support, for example, ipfRSVPclientconfig.xml.sample.

     

    
      
        	
          Take care when editing the ipfclientconfig.xml file: Improper editing of the ipfclientconfig.xml file when troubleshooting might cause regular audit information to stop being recorded to the audit database.

        
      

    

    Example 10-1 highlights the fields that are important to ensuring that audit logging is not interrupted during IPF trace activities. As long as the TCP connectivity parameters are correct and the audit level is set to warn, the IPF client trace functions and audit records continue to be logged to the audit database.

    Example 10-1   Important fields to ensure uninterrupted audit logging
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    <appender name="clientTCP" class="com.cognos.indications.LogTCPSocketAppender">

    		<param name="remoteHost" value="127.0.0.1"/>

    		<param name="Port" value="9362"/>

    		<param name="LocationInfo" value="false"/>

    		<param name="ReconnectionDelay" value="30000"/>

    	</appender>

    	<appender name="clientRemote" class="com.cognos.indications.LogLocalUDPAppender">

    		<param name="Port" value="9362"/>

    	</appender>

     

    <category name="Audit" class="com.cognos.indications.LogTypedLogger">

    		<level value="warn"/>

    		<appender-ref ref="clientRemote"/>

    	</category>
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    Example 10-1 highlights the TCP connection parameters and the important parameter for the audit level. Change the remoteHost value and the Port value to match the log server host and port number in IBM Cognos Configuration. Change the appender reference within the <category name=”Audit”> section to match the Log Server Enable TCP value in IBM Cognos Configuration. 

    To verify whether clientRemote or clientTCP needs to be used as the appender-ref value, the parameters within IBM Cognos Configuration need to be examined. Selecting the Logging entry beneath the Environment section displays the logging parameters in the right frame. If the Enable TCP? parameter is set to False, then the clientRemote must be used. If the value is set to True, the clientTCP will be the require entry in the IPF file (Figure 10-65).
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    Figure 10-65   Logging server port and TCP settings in IBM Cognos Configuration

    10.5.7  Audit scenarios

    In discussing audit scenarios, we apply audit functionality and walk through common scenarios to provide an overview of how IBM Cognos audit data can be used to provide a complete view of system activity. 

    The database used to record audit information for IBM Cognos BI can also be used as a reporting data source for system administrators. IBM Cognos BI can be used to create reports to show information from the audit database and provide insight into what is happening on the entire IBM Cognos Platform. IBM provides sample reports to be used for various auditing scenarios. Given that the audit information for IBM Cognos BI is stored in a relational database, administrators can also use SQL queries to get a detailed view of system activities. 

    To demonstrate possible uses for the information stored within the IBM Congos audit database, we explore the table structures of the audit database and provide example queries to satisfy common audit requirements. More detailed examples of using audit information gathered by the IBM Cognos Platform can be found by referring the IBM Cognos Administration and Security Guide or by referring to the proven practices found within the IBM Congos System Management Methodology located on the IBM developerWorks® website:

    http://www.ibm.com/developerworks/data/library/cognos/cognosproven
practices.html

    Tables within the IBM Cognos audit database can be joined to provide further information about user sessions, reporting activity, jobs, and so forth. Details about parameters used by IBM Cognos components can be obtained by query interactions with the COGIPF_PARAMETER table using COGIPF_REQUESTID. Details about user sessions, logons, security events, and so on can be obtained by query interactions with the COGIPF_USERLOGON table using COGIPF_SESSIONID. Detailed information about jobs and job steps can be obtained from the COGIPF_RUNJOB and COGIPF_RUNJOBSTEP tables using COGIPF_REQUESTID.

    Authentication

    Authentication is handled through the IBM Cognos Content Manager Service. Therefore, recording authentication-related detail requires auditing to be enabled for the IBM Cognos Content Manager Service. In the following scenario, auditing is set to minimal for all services except the IBM Cognos Content Manager Service.

    Logging into IBM Cognos Connection causes audit data to be written into two tables:

    •COGIPF_USERLOGON 

    •COGIPF_ACTION 

    The primary information related to the user logon (that is, user name and authenticating namespace) is contained in the COGIPF_USERLOGON table, and secondary information such as group membership is recorded in the COGIPF_ACTION table. For example, John Walker (jwalker) logs into IBM Cognos Connection. Upon examining the COGIPF_USERLOGON table, we see a single entry for the login process (Example 10-2).

    Example 10-2   Sample SQL query to retrieve user logon information
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    SELECT COGIPF_HOST_IPADDR, 
		 COGIPF_LOCALTIMESTAMP, 
	 COGIPF_LOGON_OPERATION, 
	 COGIPF_USERNAME, 
	 COGIPF_USERID, 
	 COGIPF_NAMESPACE, 
	 COGIPF_STATUS 
FROM COGIPF_USERLOGON
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    Figure 10-66 shows the results of the query.
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    Figure 10-66   Results of a query showing the audit table row created for user John Walker’s logon

    As shown in Figure 10-66, the user logging in and the time of the operation are recorded. The namespace that the user belonged to is also included, so it becomes possible to identify users from different business units if they are not part of the same security namespace.

    The same login operation also records two audit entries in the COGIPF_ACTION table. The only record that is important from an audit standpoint is the record that queries the security namespace for the group membership of the user. (The complete entry is truncated in Example 10-3 due to the length of the field.)

    When users log out of the application, a single record is written to both the COGIPF_USERLOGON and COGIPF_ACTION tables.

    User session expirations (the default passport timeout is 60 minutes of inactivity) are also indicated in the COGIPF_USERLOGON table.

    Records are logged to the audit database, which shows logon operations and sessions expiring due to inactivity. The default inactivity timeout is 60 minutes. In a busy environment where many users are logging in, the records are not consecutive and therefore are hard to correlate. To identify corresponding entries, the records must be matched on COGIPF_SESSIONID (Example 10-3). 

    Example 10-3   SQL query using COGIPF_SESSIONID to select record for one session

    [image: ]

    SELECT COGIPF_HOST_IPADDR,
	 COGIPF_LOCALTIMESTAMP,
	 COGIPF_LOGON_OPERATION,
	 COGIPF_USERNAME,
	 COGIPF_USERID,
	 COGIPF_NAMESPACE,
	 COGIPF_STATUS
FROM COGIPF_USERLOGON
	 WHERE (COGIPF_SESSIONID LIKE 'F37A9BB97C040B4FF7CE95FDEEE51314F55B83B1')
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    Whereas tracking user authentication is crucial for identifying usage patterns and license management, the ability to track unsuccessful login attempts is critical for identifying unauthorized user access. Whenever an unsuccessful login attempt occurs, a record is written to the COGIPF_USERLOGON table (Figure 10-67).

    [image: ]

    Figure 10-67   An audit entry for a failed login attempt

    Examining the COGIPF_ERRORDETAILS column reveals the true source of the failure. Figure 10-68 shows a record from COGIPF_USERLOGON.
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    Figure 10-68   An audit entry for user logon attempts - both failed and successful 

    Example 10-4 shows the value for the COGIPF_ERRORDETAILS column for an invalid logon attempt.

    Example 10-4   COGIPF_ERRORDETAILS column for an invalid logon attempt
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    <messages xsi:type="SOAP-ENC:Array" SOAP-ENC:arrayType="bus:message[3]">
<item xsi:type="bus:message">
<messageString xsi:type="xsd:string" xml:space="preserve">CAM-AAA-0055 User input is required.</messageString></item>

    <item xsi:type="bus:message"><nestingLevel xsi:type="xsd:integer">1</nestingLevel>
<messageString xsi:type="xsd:string" xml:space="preserve">CAM-AAA-0036 Unable to authenticate because the credentials are invalid.</messageString></item>

    <item xsi:type="bus:message"><nestingLevel xsi:type="xsd:integer">2</nestingLevel>
<messageString xsi:type="xsd:string" xml:space="preserve">CAM-AAA-0125 The user 'baduser' does not exist in this namespace.</messageString></item>
</messages>
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    Because the audit record only indicates a success or failure status, paying attention to the error details is important when trying to isolate unauthorized access to the application versus users incorrectly typing their passwords. In the case of incorrect passwords, the records are identical except for the error details (Example 10-5).

    Example 10-5   Error message
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    <messages xsi:type="SOAP-ENC:Array" SOAP-ENC:arrayType="bus:message[2]">

    <item xsi:type="bus:message">

    <messageString xsi:type="xsd:string" xml:space="preserve">CAM-AAA-0055 User input is required.</messageString></item>

    <item xsi:type="bus:message"><nestingLevel xsi:type="xsd:integer">1</nestingLevel>
<messageString xsi:type="xsd:string" xml:space="preserve">CAM-AAA-0036 Unable to authenticate because the credentials are invalid.</messageString></item>
</messages>
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    A sample report called security risk mitigation is available as part of the IBM Cognos System Management Methodology. This report was created to help identify unauthorized access to the IBM Cognos environment. 

    Viewing a saved report

    Serving up saved content is the responsibility of the presentation service. Therefore, to just track saved report access, auditing for the presentation service must be enabled. In the following scenario, auditing is set to minimal for all services except the presentation service. Example 10-6 shows the SQL query.

    Example 10-6   SQL query
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    SELECT COGIPF_LOCALTIMESTAMP,
	 COGIPF_REQUESTID,
	 COGIPF_TARGET_TYPE,
	 COGIPF_STATUS,
	 COGIPF_REPORTPATH,
	 COGIPF_PACKAGE,
	 COGIPF_REPORTFORMAT
	FROM COGIPF_VIEWREPORT
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    By joining the COGIPF_VIEWREPORT and COGIPF_PARAMETER tables on COGIPF_REQUESTID, additional information can be obtained, such as the package used and the format in which the report was viewed. All of this information is also available as part of a single record in the COGIPF_VIEWREPORT table. You can also determine the internal storeID of the report that was viewed, and using the operation type of VIEW indicates that saved content has been viewed, versus a report actually being executed.

    The information that is missing is the ability to identify which user viewed the saved report output. By enabling auditing for the Content Manager service, it becomes possible to obtain that level of detail. Logging audit data for the Content Manager service is done by setting the logging level for the Content Manager service to basic.

    Running the same report view query again with the additional auditing enabled reveals an entry in the COGIPF_USERLOGON table.

    If the COGIPF_USERLOGON table is joined with the COGIPF_VIEWREPORT table on COGIPF_SESSIONID, it becomes possible to tie the report view with the correct user (Example 10-7).

    Example 10-7   Linking the report view with the correct user
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    SELECT a.COGIPF_REPORTPATH, b.COGIPF_USERNAME
FROM COGIPF_VIEWREPORT AS a CROSS JOIN COGIPF_USERLOGON AS b
WHERE (a.COGIPF_SESSIONID LIKE b.COGIPF_SESSIONID)
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    Viewing different types of report output produces different entries in the COGIPF_REPORTFORMAT column. Listed in the following section is a sample of all the types of report output formats.

    Executing a simple report interactively

    There are various items of detail that might be required when tracking report executions. The most basic requirement is tracking the fact that a report was executed. Because interactive reports are handled by the report service, enabling auditing on the report service at a basic level records individual report executions (Example 10-8).

    Example 10-8   SQL query
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    SELECT COGIPF_PROC_ID,
	 COGIPF_LOCALTIMESTAMP,
	 COGIPF_REQUESTID,
	 COGIPF_TARGET_TYPE,
	 COGIPF_REPORTPATH,
	 COGIPF_STATUS,
	 COGIPF_RUNTIME,
	 COGIPF_PACKAGE
FROM COGIPF_RUNREPORT
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    The SQL statement in Example 10-8 provides the necessary information to obtain details such as the report name and where the report was executed from (COGIPF_REPORTPATH), the amount of time it took to execute in milliseconds (COGIPF_RUNTIME), the package that the report was executed against (COGIPF_PACKAGE), and the time of the execution (COGIPF_LOCALTIMESTAMP). The COGIPF_TARGET_TYPE contains various pieces of information that are all part of the same record. 

    For example, the type of object executed (report or analysis), the service that handled the request (report or batch report), and certain records indicate whether the action was from a series of steps involved in a prompted report. The sample audit package has all of this information contained in the same query item, but the package that was modified as part of the IBM System Management Methodology isolates each piece of information in its own query item.

    In addition to these details, it also becomes possible to correlate the report execution to the BIBUS process that handled the execution. By examining the COGIPF_PROC_ID column, the BIBUS process ID (PID) can be obtained.

    As part of the report execution audit detail, fourrecords is written to the COGIPF_PARAMETER table. From an information standpoint, there are no useful parameter details for a report execution unless the internal object storeID is required.

    What is missing from this level of detail is the ability to determine who executed the report. For this to occur, auditing must be enabled for the Content Manager Service (Example 10-9 and Example 10-10).

    Example 10-9   SQL query
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    SELECT COGIPF_HOST_IPADDR,

    COGIPF_LOCALTIMESTAMP,

    COGIPF_LOGON_OPERATION,

    COGIPF_USERNAME,

    COGIPF_USERID,

    COGIPF_NAMESPACE,

    COGIPF_STATUS

    FROM COGIPF_USERLOGON
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    Example 10-10   SQL query
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    SELECT COGIPF_HOST_IPADDR,

    COGIPF_LOCALTIMESTAMP,
COGIPF_LOGON_OPERATION,
COGIPF_USERNAME,
COGIPF_USERID,
COGIPF_NAMESPACE,
COGIPF_STATUS

    FROM COGIPF_USERLOGON
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    Joining the COGIPF_USERLOGON and COGIPF_RUNREPORT tables on COGIPF_SESSIONID provides a list of reports executed and the users who executed them (Example 10-11).

    Example 10-11   List of reports executed and the users who executed them
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    SELECT a.COGIPF_REPORTPATH, b.COGIPF_USERNAME
FROM COGIPF_RUNREPORT AS a CROSS JOIN
COGIPF_USERLOGON AS b
WHERE (a.COGIPF_SESSIONID LIKE b.COGIPF_SESSIONID)
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    One of the major differences between viewing saved report output is that running a report interactively executes queries at the database layer. By enabling an auditing parameter called audit the native query for report service, it becomes possible to isolate the queries being sent to the reporting database.

    Examining a sample from COGIPF_REQUESTSTRING shows that the SQL statement being used in the query is contained within the record detail (Example 10-12).

    Example 10-12   Sample from COGIPF_REQUESTSTRING
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    <thirdparty><![CDATA[select

    "COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_LOCALTIMESTAMP", convert(datetime,

    convert( char(8), current_timestamp, 112 ), 112),

    "COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_METRIC_NAME", case when

    substring("COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE",1,10) = 'com.cognos' then

    substring("COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE",charindex('service

    =',"COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE") +

    8,LEN("COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE") -((charindex('service=',"COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE") + 8)- 1)) else

    "COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_RESOURCE_TYPE" end from "dbo"."COGIPF_THRESHOLD_VIOLATIONS" "COGIPF_THRESHOLD_VIOLATIONS" where

    "COGIPF_THRESHOLD_VIOLATIONS"."COGIPF_METRIC_HEALTH" in ('poor', 'average')]]></thirdparty>
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    To determine which user executed the SQL statement, join the COGIPF_NATIVEQUERY and COGIPF_USERLOGON tables on COGIPF_SESSIONID (Example 10-13).

    Example 10-13   Determining which user executed the SQL statement
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    SELECT a.COGIPF_REQUESTSTRING, b.COGIPF_USERNAME
FROM COGIPF_NATIVEQUERY AS a CROSS JOIN
COGIPF_USERLOGON AS b
WHERE (a.COGIPF_SESSIONID LIKE ‘b.COGIPF_SESSIONID’)
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    Executing reports through a job

    Depending on the steps contained within the job, various tables can be written to as a result of a job execution. This scenario details the audit entries that are recorded when a job is executed that contains two report steps.

    Setting the audit level to basic for the job service provides a a sufficient amount of audit data pertaining to the job execution to complete this task.

    Executing the job produces a lone record in the COGIPF_RUNJOB table (Example 10-14).

    Example 10-14   SQL query
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    SELECT COGIPF_LOCALTIMESTAMP,
	 COGIPF_SESSIONID,
	 COGIPF_REQUESTID,
	 COGIPF_TARGET_TYPE,
	 COGIPF_JOBPATH,
	 COGIPF_STATUS,
	 COGIPF_RUNTIME
FROM COGIPF_RUNJOB
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    Examining the audit entry provides information such as the path to the executed job, when it was executed, and how long it took to run in milliseconds (COGIPF_RUNTIME) (Figure 10-69).
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    Figure 10-69   Query results showing records related to running jobs

    What is not provided are the details regarding the contents of the executed job. Because the job service is responsible for executing jobs, it is not the component responsible for executing the report steps. Therefore, it does not record specifics regarding the report steps.

    To capture that additional level of detail, logging for the batch report service must be set to Basic.

    Executing the same job results in a single entry in the COGIPF_RUNJOB table and two entries in the COGIPF_RUNREPORT table. There are two entries because there were two report steps contained within the job (Example 10-15).

    Example 10-15   SQL query
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    SELECT COGIPF_LOCALTIMESTAMP,
	 COGIPF_REQUESTID,
	 COGIPF_TARGET_TYPE,
	 COGIPF_REPORTPATH,
	 COGIPF_STATUS,
	 COGIPF_RUNTIME,
	 COGIPF_PACKAGE
FROM COGIPF_RUNREPORT
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    With auditing enabled at both the job service and batch report service levels, the information is there to determine that one job and two reports were executed. But further examination of the audit records indicates that there is no association between the job and reports. This is because the request IDs are different, and joining the tables on this field does not provide the necessary information (Figure 10-70).
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    Figure 10-70   Query results showing the two batch report service entries for the steps in our job

    The constant that ties these records together is the user that executed the job and reports. Even if the job was scheduled to run during off hours, the schedule object uses trusted credentials to authenticate the user. By enabling auditing at a basic level for the IBM Cognos Content Manager Service, the user authentication action is recorded (Example 10-16).

    Example 10-16   SQL query
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    SELECT COGIPF_SESSIONID,
	 COGIPF_LOCALTIMESTAMP,
	 COGIPF_LOGON_OPERATION,
	 COGIPF_USERNAME,
	 COGIPF_USERID,
	 COGIPF_NAMESPACE
FROM COGIPF_USERLOGON
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    The identifier of a user’s session is the session ID. Therefore, joining the three tables together on that column provides the necessary detail to see who executed the job and which reports were associated to that job. Figure 10-71 is based on the job execution with contents – by user report that is available as part of the System Management Methodology content package.
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    Figure 10-71   Query results showing logon and logoff for job step execution

    10.5.8  Sample audit package

    This section introduces the IBM Cognos Framework Manager model and DS Servlet.

    IBM Cognos Framework Manager model

    IBM Cognos Framework Manager is a model that is based on the audit detail contained within the audit database. Although the metadata is designed to provide a head start to interpret and analyze the usage detail, the IBM Cognos Framework Manager model can be modified to suit any particular need. Keep in mind that additional changes might cause the provided reports in the audit content package to fail when executed.

    DS Servlet

    Audit detail is captured as actions occur within the application. For example, when a user logs in and runs a report, the login event is recorded along with the report execution details. This allows activities to be traced, but what about the need to trace something that does not happen and therefore is not recorded? Specifically, there might be a desire to discover content that is not being used. The fact that a report is never accessed means that it will never appear in the audit files.

    To obtain this information, an SDK application is provided with IBM Cognos BI that queries the IBM Cognos Content Manager component and provides a list of content. The information is returned in an XML format that can be consumed as a data source and can therefore be reported on. For more information about the DS Servlet, see IBM developerWorks:

    http://www.ibm.com/developerworks/data/library/cognos/page258.html

    10.5.9  Audit content package

    This section provides a summary of the default sample audit package that is provided with IBM Cognos BI, as well as the additional content that is part of the IBM Cognos System Management Methodology. Before any deployments are executed, perform an entire backup of the content store. Consult the IBM Cognos Administration and Security Guide documentation regarding the steps required to perform a content store backup, how to create data sources, and how to import content packages.

    Sample audit reports

    The audit package provided as part of the IBM Cognos BI samples contains various reports that are intended as a head start to begin the analysis of the usage data contained within the audit database. Additional information regarding the configuration and deployment of the audit reports can be found as part of the core product documentation.

    Table 10-7 shows reports available with the System Management Methodology.

    Table 10-7   Reports available with the System Management Methodology

    
      
        	
          SSM report name

        
        	
          Description

        
      

      
        	
          Active user sessions

        
        	
          Provides a list of active user sessions in the environment, which includes their user name, login time, and session ID. The list is sectioned by namespace ID. Active means that users are currently logged in and using the product or sessions that are waiting for the inactivity timeout to be reached before they are logged out. There is a filter set to only show the current day's sessions, as certain conditions might affect logoff operations, thus providing inaccurate entries.

        
      

      
        	
          Daily job execution failures

        
        	
          Agent that checks for daily job execution failures and sends out an email notification when failures are detected. The email, by default, does not have any recipients specified. Before running the agent, add at least one valid email recipient.

        
      

      
        	
          Daily report failures

        
        	
          Agent that checks for daily report execution failures and sends out an email notification when failures are detected. The email by default does not have any recipients specified. Before running the agent, add at least one valid email recipient.

        
      

      
        	
          Data source signon usage - by package

        
        	
          Tracks the data source signons being used for each package and which users are using them.

        
      

      
        	
          Failed interactive report executions - by package

        
        	
          The previous activities task in the administration console only tracks histories of objects run in the background. This report lists all of the failed interactive report executions. The prompted list report provides a date and package filter and is sectioned by package.

        
      

      
        	
          Process IDs for active reports - by IP address

        
        	
          Shows the reports along with the process ID associated with them for reports that do not have a termination status. The report is sectioned by dispatcher IP.

        
      

      
        	
          Report content by job

        
        	
          Displays all of the reports that are executed as part of a job and the last that time the job was executed. The report contents that are displayed are the reports that made up the last job execution.

        
      

      
        	
          Security risk mitigation

        
        	
          Prompted report (date range) that tracks the failed login attempts. Useful for identifying potential unauthorized access attempts.

        
      

      
        	
          Successful interactive report executions - by package

        
        	
          The previous activities task in the administration console only tracks histories of objects run in the background. This report lists all of the successful interactive report executions. The prompted list report provides a date and package filter and is sectioned by package.

        
      

      
        	
          Threshold exceptions

        
        	
          The multiple chart report provides insight into threshold exceptions: frequency, severity, and the services to which they pertain. The charts are filtered with a date range prompt.

        
      

    

    In addition to the reports that are based on the sample audit package, reports have been created based on the Audit Extension SDK application (Table 10-8). The reports are located in the folder within the System Management Methodology folder.

    For more information about the Audit Extension application, extract the files from the file located in the \SMM - Version 2\SDK Applications directory.

    Table 10-8   Audit extension reports

    
      
        	
          Additional report name

        
        	
          Description

        
      

      
        	
          Object security policies

        
        	
          Provides the list of all permissions for each user, group, or role that is explicitly part of an object’s security policy. The report shows a graphical representation of whether the action is granted or denied.

        
      

      
        	
          Security Policy - EVERYONE

        
        	
          Provides the list of all permissions for the EVERYONE role that is explicity part of an object’s security policy. The report shows a graphical representation of whether the action is granted or denied.

        
      

    

    10.5.10  Audit extension

    The standard auditing features with IBM Cognos cover many aspects of operation. However, certain areas, such as the auditing of users and capability assignments, are not included. The aim of the audit extension application is to provide additional auditing for these areas. It currently covers the following areas:

    •Account audit

    An audit of all the user accounts that are found in all configured namespaces and certain properties of those accounts (basic details, portal pages, created and modified dates, and so on). This allows reporting on the IBM Cognos user base.

    •Content audit

    An audit of all the objects that exist in the main content store. This audit processes through the content store tree and logs all the objects (folders, reports, queries, and so on) that it finds. It logs the basic information (such as name, search path, object permissions, created and modified date) and certain details more specific to the item types (such as the specification XML of reports and queries, any saved parameter values applied to saved reports, and the details of report output versions).

    •Status audit

    An audit of the current state of a server and related dispatchers. For each dispatcher registered in the target system, the configuration and activity is logged, saving information such as time taken to connect, number of active processes, and request duration.

    Usage

    The application is managed through a web front end that allows the configuration of server and namespace information and can be used to turn on or off individual audit types for a given server.

    Audits can be initiated in three ways:

    •Using the management web interface

    •Using a web services call (that is, from Event Studio)

    •Using a simple URL/web form call

    The results of each audit are logged to a database, and an IBM Cognos Framework Manager model is provided to help report the data.

    For more information and to download the application, see:

    http://www.ibm.com/developerworks/data/library/cognos/page155.html
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Complete IBM Business Analytics solution
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Integrating IBM Cognos BI with IBM Cognos Business Analytics solutions

    This chapter provides an overview on integration of IBM Cognos Business Intelligence (BI) and solutions from the remainder of the IBM Cognos portfolio:

    •IBM Cognos TM1

    •IBM Cognos Enterprise Planning 

    •IBM Cognos Controller

    Integrated solutions allow you to have a complete corporate performance management solution as a single product with integrated data and functionality that connects forecast, metrics, actual data, and reports seamlessly.

    In this chapter, we discuss the following topics:

    •Overview of IBM Cognos Business Analytics solutions

    •Business scenarios and roles to take advantage of IBM Business Analytics

    •Integrating IBM Cognos TM1 with IBM Cognos BI

    •Integrating IBM Cognos Planning Contributor with  IBM Cognos BI

    •Integrating IBM Cognos Controller with  IBM Cognos BI

    11.1  Overview of IBM Cognos Business Analytics solutions

    This section provides an introduction to the IBM Cognos Financial Performance Management portfolio of products. It gives an overview on basic functionality and features of IBM Cognos TM1, IBM Cognos Planning, and IBM Cognos Controller.

    11.1.1  IBM Cognos TM1

    Complex planning, analytics, and real-time reporting to high levels of detail with millions of items require the power of IBM Cognos TM1. The OLAP 64-bit technology of IBM Cognos TM1 meets even the most complex, multi-dimensional analytics needs of large-scale operations. So, you can query data when you need to, no matter how vast the data set might be. In addition, you can view instant updates from streamed data and drill through to transaction systems for added context and, thus, greater accuracy in decision making.

    IBM Cognos TM1 addresses all interrelated planning, analysis, and reporting needs with the following capabilities:

    •Exceptionally fast analytics

    •Data and user scalability

    •Data integrity

    •A multi-dimensional database and data tools

    •Workflow 

    •A choice of interfaces, including Microsoft Excel, the web, and the IBM Cognos TM1 Contributor for managed participation

    11.1.2  IBM Cognos Planning

    Planning, budgeting, and forecasting are critical financial management processes in most organizations. These processes are critical because they enable organizations to define strategic goals, to create tactical plans, and to track the progress on achieving those plans and goals. 

    IBM Cognos Planning provides the capabilities to create long-range strategic plans, intermediate-range budgets, and short-term or continuous forecasting. These functions exist within inter-connected models that are fed from as many planning participants as an organization needs to include in the planning process. 

    IBM Cognos Planning allows you to maximize the accuracy and efficiency of the planning, budgeting, and forecasting processes by providing the following capabilities:

    •Aggregation and consolidation of planning data in a centralized location

    •Scalability for large amounts of plan contributors, large and complex plan models, and large amounts of plan data

    •Increased plan accountability through visual workflow status indicators and full audit tracking capabilities

    •Powerful user features, such as Breakback (goal allocation), external data linking, data validations, commentary, versioning, and dimensional pivoting and nesting for analysis

    •Separate environments for development and production that allows continuous server uptime even when incorporating structural changes to the planning model during a planning cycle

    •Automated administration capabilities to reduce overhead and maintenance

    •Integration with IBM Cognos BI solutions for full reporting, analysis, and scorecarding capabilities

    IBM Cognos Planning has the following major components:

    •IBM Cognos Planning Analyst 

    •IBM Cognos Planning Contributor

    IBM Cognos Planning Analyst

    IBM Cognos Planning Analyst is a powerful business modeling tool that allows financial specialists to create models for planning, budgeting, and forecasting. These models include the drivers and content that are required for planning, budgeting, and forecasting. The models can then be distributed to managers using the web-based architecture of IBM Cognos Planning Contributor.

    IBM Cognos Planning Contributor

    IBM Cognos Planning Contributor streamlines data collection and workflow management. It eliminates the problems of errors, version control, and timeliness that are characteristic of a planning system solely based on spreadsheets. Users have the option to submit information simultaneously through a simple web or Microsoft Excel interface. Using an intranet or secure Internet connection, users review only what they need to review and add data where they are authorized.

    11.1.3  IBM Cognos Controller

    The ability of an organization to close its books, consolidate its accounts from all operations and partnerships, and prepare accurate and auditable financial statements is critical to maintaining credibility with existing and potential investors and financial markets. Adding to that challenge is that many times an organization has disparate financial information systems within various operating divisions and geographies. To meet these requirements and to handle new governance and financial reporting standards, organizations can rely on IBM Cognos Controller. 

    A key component of the IBM Cognos performance management platform, IBM Cognos Controller is a comprehensive, web-based solution that offers power and flexibility for streamlined, best-practice financial reporting and consolidation—all in one solution. With IBM Cognos Controller, finance organizations can prepare financial information and analyze and then investigate and understand it in a centralized, controlled, and compliant environment. IBM Cognos Controller supports IFRS, FASB, Basel II, and Sarbanes-Oxley requirements and can handle any GAAP or regulatory environment—all from a single application. It also enables individual segment reporting by customer, product, or market and generates an extensive audit trail to satisfy the needs of external and internal auditors.

    IBM Cognos Controller includes the following features:

    •Web-based, fully scalable for any size organization

    •Flexible processing of modifications to corporate and account structures and group histories

    •Integrated scenario manager for simulation and modeling

    •Real-time reconciliation of internal balances in data input

    •Allocations that are automatically included in consolidation with status 

    •Extensive process monitoring and control

    •Practical, automatic report book generation and distribution

    •Support for IAS, IFRS, US GAAP, local GAAPs, and other regulatory requirements

    •Standard reporting that provides information about financial performance for business stakeholders and managers

    •Financial and management measures and metrics for scorecards, dashboards, and analytics

    11.2  Business scenarios and roles to take advantage of 
IBM Business Analytics

    In this section, we present a business scenario that integrates the IBM Cognos TM1, IBM Cognos Planning, and IBM Cognos Controller applications with IBM Cognos BI. This scenario shows how to provide a reporting source for IBM Cognos BI professional authors and analysts. After reporting sources for each of the IBM Cognos Financial Performance Management applications are provided, you can use the reporting techniques that we discuss in this book to create IBM Cognos BI content. 

    In addition, this scenario shows how to integrate the IBM Cognos TM1 applications in the dashboard to allow business users a single place to complete the following activities:

    •Managed planning through an intuitive workflow process

    •What-if analysis

    •Reporting and analysis on planned and actual data 

    Each of the IBM Cognos Financial Performance Management applications hold critical business information for planning, budgeting, forecasting, financial consolidations, product costing, workforce information, and other information, depending on the models that are defined within the applications. This information is valuable and must be presented to decision-makers on a timely basis along with the capability for the decision-maker to perform analysis and drill-down to details. IBM Cognos BI and the integration between the IBM Cognos Financial Performance Management applications provide these capabilities. 

    We use the following roles in these sections:

    •Modeler: John Walker (skills include IBM Cognos TM1 and IBM Cognos Business Intelligence Framework Manager).

    •Professional Report Author: Lynn Cope (skills include report and dashboard authoring)

    11.3  Integrating IBM Cognos TM1 with IBM Cognos BI

    In this section, we show how to create a dashboard in IBM Cognos Business Insight for the users who are involved in the planning process. The dashboard can include the following objects:

    •IBM Cognos TM1 Contributor gives users access to a secure workflow that guides users through the planning process (see the IBM Cognos TM1 Planning Contributor item in Figure 11-1).

    •IBM Cognos TM1 Websheets or Cube Views enables users to write back to the underlying TM1 database, change drivers such as Cost or Price, or even add metadata (see the Applications and Views folder under GreatOutdoors_SalesPlan in Figure 11-1).

    •You can view reports that are created in IBM Cognos BI (for example IBM Cognos Report Studio or IBM Cognos Business Insight Advanced) with live IBM Cognos TM1 data with zero latency. You can also drill down to the IBM Cognos TM1 database in real time (see reports in the SalesPlan Reports folder in Figure 11-1).
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    Figure 11-1   IBM Cognos TM1 items in the Content tab

    We use the Great Outdoors company use case to show how to create a dashboard for the sales department. Lynn Cope, the Advanced Business User, uses IBM Cognos TM1 data to create reports, add these reports to the dashboard, and add IBM CognosTM1 Websheets or a link to the application for managed distribution. 

    In this section, we do not discuss the IBM Cognos TM1 modeling and how to create an IBM Cognos TM1 Contributor application for a managed contribution. We assume all this work has been done previously. We also assume that IBM Cognos TM1 is configured to work with IBM Cognos BI. For details about configuring IBM Cognos TM1 to work with IBM Cognos BI and to use the same security, refer to the IBM Cognos TM1 Installation Guide. 

    11.3.1  Creating a data source and package

    For IBM Cognos TM1 data to be available for professional report authors to create reports the modeler, John Walker must create an IBM Cognos TM1 data source and publish a package to the IBM Cognos Connection portal. We give an overview of the steps for that process in this section. For details, refer to the IBM Cognos BI Administration and Security Guide.

    To create a data source and package:

    1.	Open IBM Cognos Administration, and add an IBM Cognos TM1 cube as a data source.

     

    
      
        	
          Prerequisite: The prerequisite is that you have the IBM Cognos TM1 client installed on the same computer as the IBM Cognos Business Intelligence installation.

        
      

    

    You need the following connection parameters to create a data source:

     –	Administration Host: The name of a system where the IBM Cognos TM1 server resides that can be identified by the network

     –	Server Name: The IBM Cognos TM1 server name as configured in the TM1s.cfg file

    2.	Open the IBM Cognos Framework Manager and create a package for IBM Cognos TM1 data using the data source created in the step 1. Select the cube you want to import. After the import is complete, click the “Create a default package” option, give a name to the package (that name will be visible to the business authors in IBM Cognos Connection portal and studios) and publish a package.

    The new package displays in IBM Cognos Connection, as shown in Figure 11-2.
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    Figure 11-2   IBM Cognos TM1 package added to IBM Cognos Connection portal

    11.3.2  Objects used in the dashboard

    Now that the IBM Cognos TM1 package is available for the professional report authors, they can use IBM Cognos Report Studio to create reports. The reports use live IBM Cognos TM1 data so that users can see the change in data immediately after a value is entered to the IBM Cognos TM1 cube by a planning contributor. Users can monitor the planning process or change drivers to see how that influences the entire performance. 

    Figure 11-3 shows the following objects in IBM Cognos Connection that we used when creating this dashboard:

    •Reports (SalesPlan Reports) are part of samples that are coming with the IBM Cognos Business Intelligence installation. They are created in IBM Cognos Report Studio and are using IBM Cognos TM1 greatoutdoors server as a data source. 

    The deployment archive that contains these reports is located in the following directory:

    <c10_location>\webcontent\samples\content\TM1 

    •The TM1 Sales Plan package that uses the greatoutdoors IBM Cognos TM1 server. The server data is located in the following directory: 

    <c10_location>\webcontent\samples\datasources\cubes\TM1 

    •TM1 Contributor Applications is created in IBM Cognos TM1 Contributor and we will use a link to the application and add that to a dashboard.
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    Figure 11-3   IBM Cognos TM1 objects in IBM Cognos Connection

    11.3.3  Configuration steps

    To have IBM Cognos TM1 server objects (cube views and websheets) available in IBM Cognos Business Insight (as shown in Figure 11-4), you need to complete the configuration steps that we discuss in this section. 
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    Figure 11-4   Contents of IBM Cognos TM1 Server in IBM Cognos Business Insight

    This section provides only an overview of the steps. For details, refer to the IBM Cognos TM1 Operations Guide. Complete the following steps:

    1.	Specify the URL that is used for web access and the server host and server name so that IBM Cognos Business Insight can connect to the IBM Cognos TM1 servers. 

    A sample contribution file is provided with IBM Business Insight, that includes properties for an IBM Cognos TM1 server that uses CAM authentication and properties for a server that does not use CAM authentication. 

    A sample file is located in the following directory:

    <c10_location>\configuration\icd\contributions\contrib directory\tm1_contribution.atom.sample 

    2.	Configure the Tm1s.cfg file of the IBM Cognos TM1 Server to add the ServerCAMURI and ClientCAMURI properties that point to IBM Cognos BI and to add the CAMPortalVariableFile=portal/variables_TM1.xml file.

    3.	Configure the variables_TM1.xml.sample sample file that is located in the following directory:

    <c10_location>\templates\ps\portal\variables_TM1.xml.sample

     

    
      
        	
          Additional configuration steps: When you use IBM Cognos authentication, you need to perform additional configuration steps. For details regarding the IBM Cognos authentication security configuration, refer to the IBM Cognos TM1 Installation Guide.

        
      

    

    11.3.4  Business case

    After professional report authors create and save the reports on the IBM Cognos Connection portal, Lynn can use them on the dashboard that she wants to create. Apart from that, she uses the IBM Cognos TM1 Websheets and IBM Cognos TM1 Contributor application to create a dashboard with all the components that are necessary for the users who are involved in the planning process for the Great Outdoors company.

    To complete this example, follow these steps:

    1.	Launch IBM Cognos Business Insight, and select Create New.

    First, add an existing report. In this case, the existing report was created in IBM Cognos Report Studio. If you do not have an existing report, you can use IBM Cognos Business Insight Advanced and create one from scratch. In this scenario, we continue with a report from the IBM Cognos samples.

    2.	Navigate to Public Folders → SalesPlan Reports → Channel Pricing Comparison → Crosstab1, and add the report part to the dashboard. The report widget looks as shown in Figure 11-5.
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    Figure 11-5   IBM Cognos TM1 report widget

    The reports shows the Unit Sale Price for Channels and Product by different versions of budget, including the difference and the percentage of difference. This data is the data that was entered in to a planning application by the contributors in the Sales department during the planning process.

    3.	Now, add a link to the IBM Cognos TM1 Contributor planning application so that users can open it directly from this dashboard. Navigate to Public Folders → TM1 Contributor Applications → TM1 Planning Contributor, and drag it to the dashboard. When added, it looks as shown in Figure 11-6.
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    Figure 11-6   IBM Cognos TM1 contributor application

    4.	Click TM1_SalesPlan_application, and the Contributor workflow opens with all the tasks that belong to the user who is logged in (see Figure 11-7).
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    Figure 11-7   IBM Cognos TM1Contributor workflow

    5.	Lynn wants to add the widget that contains an IBM Cognos TM1 Cube View that allows a user to write directly to the IBM Cognos TM1 cube. Navigate to GreatOutdoors_SalesPlan → Views → Sales Plan → SalesPlan_View. (This view is a view that was created in IBM Cognos TM1 Architect and is looking at a Sales Plan cube.) Drag the view to a dashboard. When added, it looks as shown in Figure 11-8.
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    Figure 11-8   IBM Cognos TM1 Cube View

    6.	In the same view, you can add items from GreatOutdoors_SalesPlan → Applications → Great Outdoors, where the IBM Cognos TM1 Websheets are stored. IBM Cognos TM1 Websheets also allow writing directly to the IBM Cognos TM1 cube.

    7.	The dashboard looks as shown in Figure 11-9. It combines objects that were created in IBM Cognos TM1 and IBM Cognos BI, but all objects pull the data from an underlying IBM Cognos TM1 Server.
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    Figure 11-9   Dashboard that contains various IBM Cognos TM1 widgets

    11.4  Integrating IBM Cognos Planning Contributor with 
IBM Cognos BI

    IBM Cognos Planning Contributor allows you to provide users access to the system at all times, without interruption, for efficient global planning, budgeting, and forecasting processes using a transactional data store that uses the efficiency of XML-formatted data. This data store design is the most efficient for a transactional system of this nature. However, it is not designed for efficient and scalable enterprise reporting needs. 

    To enable organizations to design and distribute reports that use the IBM Cognos Planning Contributor planning data, a process of publishing that data into a star schema data store is required. After the data is initially published to the star schema data store, it can be refreshed incrementally to achieve near real-time reporting from the transactional planning datastore. 

    You can use the star schema data store as a source of data for IBM Cognos BI. For details about how to publish a IBM Cognos Planning Contributor application to a star schema data store, refer to the IBM Cognos 8 Planning Contributor Administration Guide.

    As with IBM Cognos TM1 data, you can use IBM Cognos BI to report on and analyze real-time IBM Cognos Planning Contributor data. To use the data in IBM Cognos studios, you must create the IBM Cognos Planning Contributor package. 

    You can create an IBM Cognos Planning Contributor package in one of the following ways:

    •Using the IBM Cognos Planning Contributor administration console, you can create a package that contains all the cubes in the IBM Cognos Planning Contributor application. When you open the package in IBM Cognos studios, you are presented with metadata for all the cubes in the application and can choose from multiple cubes to create reports. 

    •Using IBM Cognos Framework Manager, you can determine how many cubes to expose in a package. By default, you get one cube in each package. However, opening just one cube in each package can result in a large number of packages in IBM Cognos Connection, which sometimes can be difficult to manage.

    11.5  Integrating IBM Cognos Controller with 
IBM Cognos BI

    IBM Cognos Controller is delivered with an integration component, Financial Analytics Publisher, that automates the process of extracting data in near real-time from IBM Cognos Controller into IBM Cognos TM1. After the data is a source in IBM Cognos TM1, it can then be accessed as a data source for IBM Cognos BI for enterprise reporting purposes. The IBM Cognos Controller data in IBM Cognos TM1 is refreshed on a near real-time basis through an incremental publishing process from the controller transactional database.

    The Financial Analytics Publisher component is added on top of IBM Cognos Controller and uses a temporary storage area before populating an IBM Cognos TM1 cube. When configured, the IBM Cognos TM1 cube is updated continuously, and you can define how often the service settings run. 

    From the IBM Cognos TM1 cube, the IBM Cognos Controller data can be accessed by a number of reporting tools, including IBM Cognos studios. For more information about using IBM Cognos Controller Financial Analytics Publisher, see the IBM Cognos Controller Financial Analytics Publisher User Guide.

    Figure 11-10 shows the data flow from IBM Cognos Controller to IBM Cognos TM1 for enterprise reporting using IBM Cognos BI. 
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    Figure 11-10   IBM Cognos Controller data flow
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Appendixes
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Additional material

    This book refers to additional material that you can download from the Internet as we describe in this appendix. 

    Locating the web material

    The web material that is associated with this book is available in softcopy on the Internet from the IBM Redbooks web server. Point your web browser at:

    ftp://www.redbooks.ibm.com/redbooks/SG247912

    Alternatively, you can go to the IBM Redbooks website at:

    ibm.com/redbooks

    Select the Additional materials and open the directory that corresponds with the IBM Redbooks form number, SG247912.

    How to use the web material

    Create a subdirectory (folder) on your workstation, and extract the contents of the web material .zip file into this folder.
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    Understand core features of IBM Cognos BI V10.1

Realize the full potential of IBM Cognos BI

Learn by example with practical scenarios

    IBM Cognos Business Intelligence (BI) helps organizations meet strategic objectives and provides real value for the business by delivering the information everyone needs while also reducing the burden on IT. 

    This IBM Redbooks publication addresses IBM Cognos Business Intelligence V10.1. You can use this book to:

    •Understand core features of IBM Cognos BI V10.1

    •Realize the full potential of IBM Cognos BI

    •Learn by example with practical scenarios

    This book uses a fictional business scenario to demonstrate the power of IBM Cognos BI. The book is primarily focused on the roles of Advanced Business User, Professional Report Author, Modeler, Administrator, and IT Architect.
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